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Notice

While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.

Documentation disclaimer

“Documentation” means information published in varying mediums
which may include product information, operating instructions and
performance specifications that are generally made available to users
of products. Documentation does not include marketing materials.
Avaya shall not be responsible for any modifications, additions, or
deletions to the original published version of Documentation unless
such modifications, additions, or deletions were performed by or on
the express behalf of Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all
claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.

Link disclaimer

Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.

Warranty

Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailld=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.

“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription, the
foregoing limited warranty may not apply but You may be entitled to
support services in connection with the Hosted Service as described
further in your service description documents for the applicable
Hosted Service. Contact Avaya or Avaya Channel Partner (as
applicable) for more information.

Hosted Service

THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO UNDER
THE LINK “Avaya Terms of Use for Hosted Services” OR SUCH
SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE
TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR IF

YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.

Licenses

THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA
AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License as set forth
below in the Designated System(s) License (DS) section as
applicable. The applicable number of licenses and units of capacity
for which the license is granted will be one (1), unless a different
number of licenses or units of capacity is specified in the
documentation or other materials available to You. “Software” means
computer programs in object code, provided by Avaya or an Avaya
Channel Partner, whether as stand-alone products, pre-installed on
hardware products, and any upgrades, updates, patches, bug fixes,
or modified versions thereto. “Designated Processor” means a single
stand-alone computing device. “Server” means a set of Designated
Processors that hosts (physically or virtually) a software application
to be accessed by multiple users. “Instance” means a single copy of
the Software executing at a particular time: (i) on one physical
machine; or (ii) on one deployed software virtual machine (“VM”) or
similar deployment.

License type(s)

Designated System(s) License (DS). End User may install and use
each copy or an Instance of the Software only: 1) on a number of
Designated Processors up to the number indicated in the order; or 2)
up to the number of Instances of the Software as indicated in the
order, Documentation, or as authorized by Avaya in writing. Avaya
may require the Designated Processor(s) to be identified in the order
by type, serial number, feature key, Instance, location or other
specific designation, or to be provided by End User to Avaya through
electronic means established by Avaya specifically for this purpose.

Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time. A “Unit” means the unit on which
Avaya, at its sole discretion, bases the pricing of its licenses and can
be, without limitation, an agent, port or user, an e-mail or voice mail
account in the name of a person or corporate function (e.g.,
webmaster or helpdesk), or a directory entry in the administrative
database utilized by the Software that permits one user to interface
with the Software. Units may be linked to a specific, identified Server
or an Instance of the Software.

Cluster License (CL). End User may install and use each copy or an
Instance of the Software only up to the number of Clusters as
indicated on the order with a default of one (1) Cluster if not stated.
“Cluster” means a group of Servers and other resources that act as a
single system.
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Enterprise License (EN). End User may install and use each copy or
an Instance of the Software only for enterprise-wide use of an
unlimited number of Instances of the Software as indicated on the
order or as authorized by Avaya in writing.

CPU License (CP). End User may install and use each copy or
Instance of the Software on a number of Servers up to the number
indicated in the order provided that the performance capacity of the
Server(s) does not exceed the performance capacity specified for the
Software. End User may not re-install or operate the Software on
Server(s) with a larger performance capacity without Avaya'’s prior
consent and payment of an upgrade fee.

Named User License (NU). You may: (i) install and use each copy or
Instance of the Software on a single Designated Processor or Server
per authorized Named User (defined below); or (ii) install and use
each copy or Instance of the Software on a Server so long as only
authorized Named Users access and use the Software. “Named
User”, means a user or device that has been expressly authorized by
Avaya to access and use the Software. At Avaya’s sole discretion, a
“Named User” may be, without limitation, designated by name,
corporate function (e.g., webmaster or helpdesk), an e-mail or voice
mail account in the name of a person or corporate function, or a
directory entry in the administrative database utilized by the Software
that permits one user to interface with the Software.

Shrinkwrap License (SR). You may install and use the Software in
accordance with the terms and conditions of the applicable license
agreements, such as “shrinkwrap” or “clickthrough” license
accompanying or applicable to the Software (“Shrinkwrap License”).

Heritage Nortel Software

“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/Licenselnfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.

Copyright

Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.

Virtualization

The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Note,
unless otherwise stated, that each Instance of a product must be
separately licensed and ordered. For example, if the end user
customer or Avaya Channel Partner would like to install two
Instances of the same type of products, then two products of that
type must be ordered.

Third Party Components

“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third

Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.

The following applies only if the H.264 (AVC) codec is distributed with
the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA,
L.L.C. SEE HTTP://WWW.MPEGLA.COM.

Service Provider

THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER'’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY FROM
THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS MUST BE AUTHORIZED IN
WRITING BY AVAYA AND IF THOSE HOSTED PRODUCTS USE
OR EMBED CERTAIN THIRD PARTY SOFTWARE, INCLUDING
BUT NOT LIMITED TO MICROSOFT SOFTWARE OR CODECS,
THE AVAYA CHANNEL PARTNER IS REQUIRED TO
INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE
AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE,
DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.

WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE G.729 CODEC, H.264 CODEC, OR H.265 CODEC, THE
AVAYA CHANNEL PARTNER ACKNOWLEDGES AND AGREES
THE AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY
AND ALL RELATED FEES AND/OR ROYALTIES. THE G.729
CODEC IS LICENSED BY SIPRO LAB TELECOM INC. SEE
WWW.SIPRO.COM/CONTACT.HTML. THE H.264 (AVC) CODEC IS
LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR
THE PERSONAL USE OF A CONSUMER OR OTHER USES IN
WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I) ENCODE
VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC
VIDEO”) AND/OR (Il) DECODE AVC VIDEO THAT WAS ENCODED
BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR
WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO
PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION
FOR H.264 (AVC) AND H.265 (HEVC) CODECS MAY BE
OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.

Compliance with Laws

You acknowledge and agree that it is Your responsibility for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.

Preventing Toll Fraud

“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.
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Avaya Toll Fraud intervention

If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.

Security Vulnerabilities

Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.

Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).

Downloading Documentation

For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.

Contact Avaya Support

See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.

Trademarks

The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, its licensors, its suppliers, or other third parties. Users are
not permitted to use such Marks without prior written consent from
Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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Chapter 1: Introduction

Related links
Purpose on page 25

Document changes since last issue on page 25

New in Release 10.1 on page 26

Purpose

This document contains descriptions of the configuration fields and the configuration procedures
for administering Avaya IP Office Platform using the IP Office Manager application. This document
principally covers Release 10.1 of those products.

Intended audience

The primary audience for the Administering Avaya IP Office using IP Office Manager is the
customer system administrator. Implementation engineers and support and services personnel
may also find this information helpful, however, they are not the primary audience.

Related links

Introduction on page 25

Document changes since last issue

Table 1: Changes summary for release 10.1

Section

Summary of changes

Security | Rights
Group | External

Media Manager administrator and Media Manager standard have been added to
the IP Office Service Rights.

System | Voicemail

Voicemail code complexity, minimum and maximum length, and enforcement
information have been updated.

System | Telephony

Login code complexity, minimum and maximum length, and enforcement
information have been updated.
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Section

Summary of changes

System | Voicemail

Content about a new field Internal Ring on Transfer has been added. When this
feature is enabled, transfer enquiry calls ring with internal ring tone.

System | Contact
Center

Content about new Contact Center Application — IP Office Integrated Contact
Reporter have been added to this topic and all the related configuration topics
have been added to other sections of the document.

User | Telephony |
Supervisor Settings

Content about a new field Privacy Override Group has been added.

User | Telephony |
Supervisor Settings

Content about enabling Media Manager Replay Self-Administration for end
users and related fields have been added.

Button
Programming
Actions | MADN Call
Appearance

Information about Multiple Appearance Directory Number (MADN) Call
Appearance has been added.

Security
Administration |
Access Control

Information about granular access to Web Manager user interface for Service
Users has been added.

Security Mode |
Rights Group | Web
Services

The description of default access using each of the fields for Web Manager Rights
have been added.

Short code overview

Information about new short code ?D(x) for default number dialing has been
added.

Line | SIP Line | SIP
Advanced

Information about new field Add UUI header and Add UUI header to redirected
calls have been added.

User Settings |
Mobile Call Control

The descriptions of three new FNEs that provide simplified mobile access have
been added.

Related links

Introduction on page 25

New in Release 10.1

Integrated Contact Reporter

IP Office R10.1 has provision for a simple Contact Center involving five to twenty five agents and
up to five supervisors. IP Office uses hunt groups to distribute calls to the Contact Center agents.
IP Office Integrated Contact Reporter supports real-time dashboard that displays hunt group
membership of agents, agent state, abandoned call monitor, average wait time, availability of
agents, and so on. For detailed information on IP Office Integrated Contact Reporter, see
Administering Avaya IP Office™ Integrated Contact Reporter guide.
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New in Release 10.1

Media Manager

Media Manager supports remote archiving of call recordings that are generated by IP Office
Voicemail Pro. Users can now archive the locally available Voicemail Pro recordings at remote
locations such as NAS, Google drive, and DVD as per convenience. Media Manager runs as a
Web application and archives the recordings at locations selected by users. Users can also log on
to the Web user interface and search, play, and download the available recordings. For detailed
information on Media Manager configuration, see the Administering Avaya IP Office™ Platform
Media Manager guide.

Test SMTP settings in VMPro

IP Office R10.1 supports testing of SMTP connectivity through Test Connection button available
on the SMTP Sender Configuration window. This feature is available only on Web Manager view.

SIP Trunk User-to-User Information support

IP Office now has two new parameters, Add UUI header and Add UUI header to redirected calls,
to convey User-to-User Information element. These settings are located at Line | SIP Line | SIP
Advanced.

Internal ring tone on transfer

The transfer enquiry calls are presented to the target with an internal ring tone even if the call
being transferred is an external call. If the user transferring the call completes the call when the
call is ringing, the ring tone changes as per the call being transferred. The setting is located at
System | Telephony.

Multiple Access Directory Number (MADN) Call Appearance support

IP Office R10.1 supports MADN Call Appearance when IP Office users have MADN numbers
assigned to them. The settings can be located at User | Button Programming.

Modification to telephony PIN complexity, length, and enforcement

The complexity, length, and enforcement of PIN required to log in to endpoints have been modified
in IP Office R10.1. The default code length has been modified to six digits. System does not allow
repeated digits and digits in forward or backward sequence. The settings can be located at
System | Telephony.

Modification to voicemail PIN complexity, length, and enforcement

The complexity, length, and enforcement of PIN required to log in to voicemail have been modified
IP Office R10.1. The default code length has been modified to six digits. System does not allow
repeated digits and digits in forward or backward sequence. The settings can be located at
System | Voicemail.

Granular access to Configuration objects in Web Manager

IP Office R10.1 provides the option to control the access to the Web Manager interface. The
access to granular objects in Web Manager can now be provisioned using Manager by assigning
appropriate Web Manager access rights to a Rights group. All users of the Rights group can then
have access to the Web Manager objects.

Delayed dial on pickup

A new short code ?D(x) has been added in this release. If a phone is off-hook or speaker is
enabled and no number is dialed for x seconds, the phone automatically makes a call to the
defined phone number.
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Simplified mobile access

There are three new FNEs, FNE35, FNE36, and FNE37 for simplified mobile access. In addition to
the features provided by the existing FNEs FNE31, FNE32, and FNE33, the new FNEs clear the
dial tone at mobile twin when a recipient ends a call. Mobile twin users can make outbound calls
when the current call is cleared.

Related links
Introduction on page 25
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Chapter 2: Overview

This documentation covers the use of the Avaya IP Office Manager. Manager runs on a Windows
PC and connects to the IP Office system via Ethernet LAN or WAN connections.

© Important:

Manager is an off-line editor. It receives a copy of the system's current configuration settings.
Changes are made to that copy and it is then sent back to the system for those changes to
become active. This means that changes to the active configuration in the system that occur
between Manager receiving and sending back the copy may be overwritten. For example, this
may affect changes made by a user through their phone or voicemail mailbox after the copy of
the configuration is received by Manager.

Related links
Manager Modes on page 29

Manager Modes

The menus and options displayed by Manager vary depending on the actions you are performing.
Manager runs in the following modes:

Basic Edition Mode

This is the mode used when a Basic Edition configuration is opened. Basic Mode includes
systems running Partner, Norstar, or Quick Mode. For information on administering a Basic Edition
system, see the IP Office Basic Edition Manager.

Security Configuration Mode
Manager can be used to edit the security settings of IP Office systems.
Standard Mode Configuration Mode

This is the mode used when a Standard Mode configuration is opened. Standard Mode includes
systems running Standard, Preferred, or Advanced Edition.

Server Edition Configuration Mode
This is the mode used when an IP Office Server Edition network configuration is opened.
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Small Community Network Management

Manager supports loading the combined configurations from systems in a Small Community
Network.

IP Office Shell Server Mode

The IP Office Shell Server is a single installation of selected IP Office applications running on
Linux. You can use Manager to administer an IP Office Shell Server.

Embedded File Management

For systems with a memory card installed, Manager can be used to view and manage the files
stored on the card. Embedded File Management can be accessed by selecting File | Advanced |
Embedded File Management.

Upgrade Wizard
The Upgrade Wizard is a component of Manager used to upgrade the firmware run by the system.

Related links
Overview on page 29
Security Configuration Mode on page 30
Standard Mode Configuration Mode on page 31
Server Edition Configuration Mode on page 33
Shell Server Mode on page 34
Backward Compatibility on page 35

Security Configuration Mode

When Manager is in Security Mode, the screen elements shown are available.
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Manager Modes
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Related links
Manager Modes on page 29

Standard Mode Configuration Mode

When Manager is in configuration mode, the screen elements shown are available. Some of these

elements can be customized, moved and hidden.
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Manager Configuration Mode Screen Elements

1 Title Bar
In addition to the application name, when configuration settings are loaded from a system, the
title bar displays the user name used to load the settings and the operator view applied.
2 Menu Bar
The options available with the drop down menus provided here change according to whether
Manager has a set of configuration or security settings loaded or not.
3 Main Toolbar
This toolbar provides icon shortcuts to the most frequently required configuration setting actions.
4 Navigation Pane
This pane shows icons for the different types of record that the configuration can contain. Each
type is followed by the number of records of that type already in the configuration. Selecting an
icon displays the matching records in the group pane and navigation toolbar.
5 Group Pane
This pane lists all the records that match the type selected in the navigation pane or navigation
toolbar. The list can be sorted by clicking on column heading. Selecting a record in this pane
displays its details in the details pane.
6 Details Pane
Table continues...
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This pane shows the configuration settings for a particular record within the configuration. The
record is selected using the navigation toolbar or using the navigation pane and group pane.

Navigation Toolbar

This toolbar provides a set of drop downs which can be used to navigate to particular records in
the configuration settings. The selected options in the navigation pane, the group pane and the
details pane are synchronized with the navigation toolbar and vice versa. This toolbar is
particularly useful if you want to work with the group pane and or navigation pane hidden in order
to maximize the display space for the details pane.

Error Pane

This pane shows errors and warnings about the configuration settings. Selecting an item here
loads the corresponding record into the details pane.

Status Bar This bar display messages about communications between Manager and systems. It
also displays the security level of the communications by the use of a padlock icon.

Related links

Manager Modes on page 29

Server Edition Configuration Mode

When the configuration from a Server Edition solution is loaded into Manager, Manager switches
to Server Edition mode operation.
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Related links
Manager Modes on page 29

Shell Server Mode

An |P Office Shell Server is a single installation of selected IP Office applications running on Linux.
You can use Manager to configure and administer a Shell Server. Application Servers and Unified
Communications Modules (UCM) run on an IP Office Shell Server.

Since a Shell Server does not provide telephony, when you open a Shell Server configuration in
Manager, all telephony functions are disabled. The following Manager functions are supported for
Shell Servers:

» Discovery
* Initial configuration utility.
» System status.

* Load, edit and save security settings.
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Manager Modes

* Load, edit, and save the configuration.

» Erase configuration and security settings.
» Audit trail display.

» Web Control.

For more information on the management of an IP Office Shell Server, see Installing and
Maintaining Avaya IP Office™ Platform Application Server and Installing Avaya IP Office™
Platform Unified Communications Module.

Related links
Manager Modes on page 29

Backward Compatibility

Manager is part of the IP Office Admin Suite of programs. The Manager application can be used to
manage configurations from systems running earlier software releases. Manager adjusts the
settings and fields that it shows to match the core software level of the system.

Manager is able display systems with software levels it does not support in the Select IP Office
discovery menu, however those systems are indicated as not supported.

Backwards compatibility is only supported for General Availability releases of IP Office software. It
is not supported for private builds.

Note that this document describes the current release. If you are running an earlier software
release, obtain the Manager document for the specific release from the Avaya support site.

Related links
Manager Modes on page 29

July 2017 Administering Avaya IP Office™ Platform with Manager 35

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Administering Avaya IP Office™ Platform with Manager

Chapter 3: Getting Started

Related links
PC requirements on page 36
Installing Manager on page 37
Starting Manager on page 38
Opening a Configuration on page 39
Changing the Manager Language on page 42

PC requirements

Supported Operating Systems
« Windows 7 (32/64 bit)
* Windows 8.1 (32/64 bit)
« Windows 10 (32/64 bit)
» Server 2008 R2 (32/64 bit)
» Server 2012 R2 (64 bit)

© Note:

IP Office Manager supports Windows only with the display font size set to 100%.
Minimum PC Requirements

IP Office System RAM Available Minimum free | Processor Network size
System (minimum or memory hard disk (similar or supported
higher) required for space higher)
Manager
operations
Standard Mode |4 GB 2GB 6 GB Intel® Core™ i3 | Not applicable.

or equivalent, 2
GHz minimum

Server Edition | 4 GB (32 bit 2GB 6 GB Intel® Core™ i3 | Up to 32 nodes
0S) or equivalent, 2
GHz minimum

Table continues...
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Installing Manager

IP Office System RAM Available Minimum free | Processor Network size
System (minimum or memory hard disk (similar or supported
higher) required for space higher)
Manager
operations
Server Edition | 8 GB (64 bit 4GB 6 GB Intel® Core™ i5 | Up to 150
0S) or equivalent, 2 | nodes
GHz minimum

Applications

If not already present, the .NET Framework 4.0 application is installed with Manager.

Ports

For information on port usage see the IP Office Port Matrix document on the Avaya support site at
https://support.avaya.com/helpcenter/getGenericDetails?detailld=C201082074362003

Related links
Getting Started on page 36

Installing Manager

Manager is a component of the IP Office Admin suite of applications. This suite is supplied on the
Software DVD (Disk 1). Alternatively, the IP Office Admin Suite can be downloaded from Avaya's

support website http://support.avaya.com.

In addition to Manager, the Admin suite includes options to install the following applications:

» System Monitor This is a tool for system installers and maintainers. Interpreting the
information output by System Monitor requires detailed data and telecoms knowledge.

» System Status Application This is a Java application that can be used to monitor the status
of the system such as extension, trunks and other resources. It displays current alarms and

most recent historical alarms.

© Note:

This installation process will install Windows .NET2 if not already present. The installation
of .NET2 may require some systems to restart and the installation process to then be

restarted.

Procedure

1. If installing from the Admin DVD, insert the DVD and when the page is displayed click on

the link for the Admin suite.

This will open a file windows showing the installation files for the suite. Locate and double-

click on the setup.exe file.

2. Select the language you want to use for the installation process.
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Getting Started

This does not affect the language used by Manager when it is run. Click Next >.

. If an upgrade menu appears, it indicates that a previous installation has been detected.

Select Yes to upgrade the existing installed applications.

. If required select the destination to which the applications should be installed.

We recommend that you accept the default destination. Click Next >.

. The next screen is used to select which applications in the suite should be installed.

Clicking on each will display a description of the application. Click on the - next to each
application to change the installation selection. When you have selected the installations
required, click Next >.

. The applications selected are now ready to be installed.

Click Next >.

. Following installation, you will be prompted whether you want to run Manager.

Selecting Yes runs Manager.

. On some versions of Windows, you may be required to restart the PC.

Allow this to happen if required.

Related links

Getting Started on page 36

Starting Manager

No name or password is required to start Manager. A name and password is only required when
connecting with a system.

When started, by default Manager will attempt to discover any systems on the network. If it finds
any it will display a list from which you can select the system required.

1. Select Start and then Programs or All Programs depending on the version of Windows.

Select the IP Office program group.

to run.

whether it finds any systems.

« If Manager finds multiple systems, the Select IP Office window displays a list of those

2. gelect Manager. If a Windows Security Alert appears select Unblock to allow Manager
3. By default Manager will scan the network for any systems. What appears next depends on
systems from which you can select the one whose configuration you want to edit. If you want

to open a configuration go to Opening a Configuration. If you don't want to load a
configuration click on Cancel.

« If it finds a single system, it will attempt to open the configuration of that system by displaying
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Opening a Configuration

* If no systems are found or you cancel the steps above, the Manager simplified view is
displayed.

Use the simplified view to select one of the following action.
* Create an Offline Configuration
» Open a Configuration from a System
» Read a Configuration from a File

Related links
Getting Started on page 36

Opening a Configuration

The initial IP address ranges in which Manager searches for systems is set through the File |
Preferences | Discovery. By default, Manager scans the local network of the Manager PC.

1. Start Manager. If Manager is already started and a configuration is open in it, that
configuration must be closed first.

If Manager is set to Auto Connect on start up, it will scan for systems automatically and
either display the list of systems discovered or automatically start login to the only system
discovered.

Otherwise, select File | Open Configuration.
2. The Select IP Office window opens, listing those systems that responded.

* If Server Edition systems are detected, they are grouped together. By default the
configuration of those systems cannot be opened using Manager in Advanced View
mode and the configuration of a Primary Server can only be opened if the Open with
Server Edition Manager option is also selected.

* If Manager has been set with SCN Discovery enabled, systems in a Small Community
Network are grouped together. The checkbox next to the network name can be used to
load the configurations of all the configurations into Small Community Network
management mode.

* If the system required was not found, the Unit/Broadcast Address used for the search
can be changed. Either enter an address or use the drop-down to select a previously
used address. Then click Refreshto perform a new search.

* A list of known systems can be stored using Known System Discovery.
» Manager can be configured to search using DNS names.

» Systems found but not supported by the version of Manager being used will be listed as
Not Supported.
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* If the system detected is running software other than from its primary folder, a 4}
warning icon will be shown next to it. The configuration can still be opened but only as a
read-only file.

3. When you have located the system required, check the box next to the system and click
OK.

If the system selected is a Server Edition system and Manager is not running in Server
Edition mode, an Open with Server Edition Manager checkbox is shown and pre-
selected. Clicking OK will switch Manager to its Server Edition mode before loading the
configuration.

4. The system name and password request is displayed. Enter the required details and click
OK.

The name and password used must match a service user account configured within the
system's security settings.

5. Additional messages will inform you about the success or failure of opening the
configuration from the system.

The method of connection, secure or insecure, attempted by Manager is set the
applications Secure Communications preferences setting.

* When Secure Communications is set to On, a 4 padlock icon is displayed at all times
in the lower right Manager status field.

* New installations of Manager default to having Secure Communications enabled. This
means Manager by default attempts to use secure communications when opening a
configuration.

» For Server Edition systems, Manager will always attempt to use secure communications
regardless of the Secure Communications setting.

* If no response to the use of secure communication is received after 5 seconds, Manager
will offer to fallback to using unsecured communications.

6. Following a successful log in, the configuration is opened in Manager. The menus and
options displayed will depend on the type of system configuration loaded.
Related links
Getting Started on page 36
Login messages on page 40

Login messages

While attempting to login to a system, various messages may be displayed.
Configuration Not Loaded Messages
Access Denied

Displayed as the cause if the service user name/password were incorrect, or the service user has
insufficient rights to read the configuration. The Retry option can be used to log in again but
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multiple rejections in a 10 minute period may trigger events, such as locking the user account, set
by the Password Reject Limit and Password Reject Action options in the systems security
settings.

Failed to communicate with system

Displayed as the cause if the network link fails, or the secure communication mode is incorrect (for
example Manager is set to unsecured, but the system is set to secure only).

Account Locked

The account of the service user name and password being used is locked. This can be caused by
a number of actions, for example too many incorrect password attempts, passing a fixed expiry
date, etc. The account lock may be temporary (10 minutes) or permanent until manually unlocked.
An account can be enabled again through the system's security settings.

Additional Messages
Your service user account will expire in X days

Indicates that an Account Expiry date has been set on the system service user account and that
date is approaching. Someone with access to the system's security settings will be required
unlock the account and set a new expiry date.

Your password will expire in X days. Do you wish to change it now?

Indicates that password ageing has been configured in the system's security settings. If your
password expires, someone with access to the system's security settings will be required to unlock
the account.

Change password

Through the system's security settings, a service user account can be required to change their
password when logging in. The menu provides fields for entering the old password and new
password.

Contact Information Check - This configuration is under special control

This message displays if a Manager user with administrator rights has entered their contact
information into the configuration. For example to indicate that they do not want the configuration
altered while a possible problem is being diagnosed. The options available are:

» Cancel Select this option to close the configuration without making any changes.

» Set configuration alteration flag Select this option if the configuration is being opened
because some urgent maintenance action. When the configuration is next opened, the fact
that it has been altered will be indicated on the System | System tab.

» Delete Contact Information Select this option to take the system out of special control.

» Leave contact information and flags unchanged (Administrators only) This option is
only available to service users logging in with administrator rights.

Related links
Opening a Configuration on page 39
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Changing the Manager Language

About this task

The Manager application can run in multiple languages. By default it tries to use the best match to
the PC's regional location settings, otherwise it will use UK English.

The process below can be used to run Manager in one of its supported languages. However it
does not change the language used for help file content.

Procedure

1. Create a Windows shortcut to the Manager application .exe file. By default this file is
located in C:\Program Files\Avaya\lP Office\Manager\Manager.exe.

2. Right-click on the shortcut and select Properties.
3. The Target field can be used to specify the locale setting that Manager should use.

For example, for Italian the Target should have -locale:it-IT added to the end. For
example: "C:\Program Files\Avaya\lP Office\Manager\Manager.exe" -locale:it-IT.

4. Click OK.

5. Manager should now run in the selected language when launched using the updated
shortcut.

Example

Table 2: Manager Locales

Manager Language Shortcut Locale Setting
Brazilian Portuguese locale:pt-Br
Chinese (Simplified) -locale:zh-Hans
French -locale:fr-FR
German -locale:de-DE
Italian -locale:it-IT
Mexican Spanish -locale:es-MX
Russian -locale:ru-RU
US English -locale:en-US
Related links

Getting Started on page 36
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Chapter 4: Menu Bar Commands

The commands available through the Manager's menu bar change according to the mode in which

Manager is running. Commands may also be grayed out if not currently applicable. For some

commands, an arrow symbol indicates that there are sub-commands from which a selection can be

made.

The following sections outline the functions of each command. The Edit and Help menus are not

included.

Related links
File Menu on page 43
View Menu on page 74
Tools Menu on page 75
Security Mode Menus on page 81
Embedded File Management Menus on page 82

File Menu

Related links
Menu Bar Commands on page 43
File > Open Configuration on page 44
File > Close Configuration on page 44
File > Save Configuration on page 44
File > Save Configuration As on page 46
File > Change Working Directory on page 46
File > Preferences on page 47
File > Offline on page 56
File > Advanced on page 57
File > Backup/Restore on page 73
File > Import/Export on page 73
File > Exit on page 74
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File > Open Configuration

This command displays the Select IP Office window used to receive a systems configuration
settings.

The same action is performed by the 2. icon in the Main Toolbar.

The Select IP Office menu is also used for other actions such as reboot and sending a
configuration. If the unit required is not found, the Unit/Broadcast Address can be changed and
then Refresh clicked. To change the TCP addresses scanned, select File | Preferences |
Discovery and enter the required addresses in the IP Search Criteria.

Known Units is not available unless configured

Related links
File Menu on page 43

File > Close Configuration

This command closes the currently loaded configuration without saving it.

Related links
File Menu on page 43

File > Save Configuration

The File > Save Configuration command saves the amended configuration.
If the configuration has been received from a system, the Send Config menu is displayed.
If the configuration file has been opened offline or created from new, the file is saved to disk only.

Related links
File Menu on page 43
Saving Server Edition Configuration Changes on page 44

Saving Server Edition Configuration Changes

After making configuration changes using Manager, the process of saving the changes performs
several actions:

» The configurations are validated for consistency.

* For those systems for which configuration changes have been made, the new configuration is
sent to that system.

Manager defaults to rebooting those systems where a reboot is necessary for the configuration
changes to come into effect.
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File Menu

A time stamped copy of the new configuration is also stored on the Primary Server server.

* For a new Secondary Server or expansion system added to the network configuration using
the create off-line configuration option, the offline file is stored, allowing the new system to be
configured even though not yet physically present.

* When opening the configuration from a network, if the timestamp of the stored copy differs
from that of the actual system configuration, Manager will prompt for which configuration it
should load for editing.

Saving Configuration Changes

1. Click I in the main toolbar or select File | Save Configuration from the menu bar.

2. The menu displayed only shows details for those systems where the system configuration
has been changed and needs to be sent back to the system.

+ Select By default all systems with configuration changes are selected. If you want to exclude
a system from having its configuration updated, either deselect it or cancel the whole
process.

+ Change Mode If Manager thinks the changes made to the configuration settings are
mergeable, it will select Merge by default, otherwise it will select Inmediate.

* Merge Send the configuration settings without rebooting the system. This mode should only
be used with settings that are mergeable. Refer to Mergeable Settings.

* Immediate Send the configuration and then reboot the system.

* When Free Send the configuration and reboot the system when there are no calls in
progress. This mode can be combined with the Incoming Call Barring and Outgoing Call
Barring options.

+ Store Offline It is possible to add a reference for a Server Edition Secondary or for a Server
Edition Expansion System to create a configuration file for that system even though it is not
physically present. Store Offline saves that configuration on the Server Edition Primary in its
file store. The same file is retrieved from there until such time as the physical server is
present at which time you are prompted whether to use the stored file or the actual servers
current configuration.

* Timed The same as When Free but waits for a specific time after which it then wait for there
to be no calls in progress. The time is specified by the Reboot Time. This mode can be
combined with the Incoming Call Barring and Outgoing Call Barring options.

* Reboot Time This setting is used when the reboot mode Timed is selected. It sets the time
for the system reboot. If the time is after midnight, the system's normal daily backup is
canceled.

* Incoming Call Barring This setting can be used when the reboot mode When Free or
Timed is selected. It bars the receiving of any new calls.

* Outgoing Call Barring This setting can be used when the reboot mode When Free or
Timed is selected. It bars the making of any new calls.

Click OK. The progress of the sending of each configuration is displayed.

Related links
File > Save Configuration on page 44
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File > Save Configuration As

The File > Save Configuration As command allows you to save a configuration a file on the
Manager computer. Note that dynamic configuration data, for example hunt groups advertised
from other systems in a network, are not included in a configuration file saved onto PC and then
reopened.

The command displays the Save As window. Select the drive and directory. and then enter the
new file name. Once you have entered the file name, the Save Configuration File window opens,
where you have the option to encrypt the file by entering a password. Leave the password blank if
you do not want to encrypt the file.

© Important:
Encrypted configuration files can only be opened with Manager 9.1 or later. In earlier versions
of Manager, the file will open but it is empty.

Configurations saved onto the PC in this way can be reopened using the L% icon or the File >
Offline > Open File command. If the file has been encrypted, you must enter the password.

When Manager is running in Server Edition mode, the Save command operates differently.
Multiple files are saved, one . cfg file for each server in the network plus a single . cfi file for the
whole network.

The .cfi file can be used with the File > Offline > Open File Set command to open the whole set
of files in a single action.

Related links
File Menu on page 43

File > Change Working Directory
These settings allow you to change the default locations where Manager looks for and saves files.

These fields set the default location where Manager will look for and save files.

Directory Description
Working Directory (.cfg Sets the directory into which Manager saves . cfg files. By default this is the
files) Manager application's program directory.

° Note:

On Windows 7 systems, the default folder for Manager .cfg files is C:
\Program Files (x86)\Avaya\lP Office\Manager. On some Windows 7
systems, the file is saved to the user's profile folder at C:\Users
\<user_name>\AppData\Local\VirtualStore\Program Files (x86)\Avaya\lP
Office\Manager. You must turn on Show hidden files to access this folder.
Alternatively, you can set the working directory to an alternate location.

Table continues...
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File Menu

Directory

Description

Binary Directory (.bin files)

Sets the directory in which the Manager upgrade wizard, HTTP, TFTP and
BOOTP functions look for firmware files requested by phones and other
hardware components. That includes .bin file, . scr files and . txt files. By
default this is the Manager application's program directory.

© Tip:
In the Upgrade Wizard, right-clicking and selecting Change Directory also
changes this setting.

A Warning:

Historically, by default the Working Directory and Binary Directory are
the same. This is deprecated as it potentially allows remote TFTP/HTTP file
access to the folder containing copies of configuration files. Therefore it is
recommended that either of the folders is changed to an alternate location.

Known Units File

Sets the file and directory into which Manager can record details of the systems
it has discovered. Once a file location has been specified, a Known Units button
becomes available on the discovery menu used for loading system configuration.
Pressing that button displays the known units file as a list from which the
required system can be selected. It also allows sorting of the list and records to
be removed.

Related links
File Menu on page 43

File > Preferences

This command displays a window for configuring various aspects of Manager's operation. The
window is divided into a number of tabs.

Related links
File Menu on page 43

File > Preferences > Preferences on page 47

File > Preferences > Directories on page 50

File > Preferences > Discovery on page 51
File > Preferences > Visual Preferences on page 52

File > Preferences > Security on page 52

File > Preferences > Validation on page 55

File > Preferences > Preferences

This tab is accessed through File | Preferences and then selecting the Preferences tab.
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Setting

Description

Edit Services Base TCP
Port:

Default = Off

This field shows or hides the base communication port settings.

Service Base TCP Port

Default = 50804.

Access to the configuration and security settings on a system requires Manager
to send its requests to specific ports. This setting allows the TCP Base Port used
by Manager to be set to match the TCP Base Port setting of the system. The
system's TCP Base Port is set through its security settings.

Service Base HTTP Port

Default = 80.

Access to the HTTP server on a system requires Manager to send its requests
to specific ports. This setting allows the HTTP Base Port used by Manager to be
set to match the HTTP Base Port setting of the system. The system’s HTTP
Base Port is set through its security settings.

Enable Time Server

Default = On.

This setting allows Manager to respond to RFC868 Time requests from systems.
It will provide the system with both the UTC time value and the local time value
of the PC on which it is running.

Enable BootP and TFTP
Servers

Default = Off.

This setting allows Manager to respond to BOOTP request from systems for
which it also has a matching BOOTP record. It also allows Manager to respond
to TFTP requests for files.

Auto Connect on start up

Default = On

If on, when Manager is started it will automatically launch the Select IP Office
menu and display any discovered systems. If only one system is discovered,
Manager will automatically display the login request for that system or load its
configuration if the security settings are default.

Set Simplified View as
default

Default = Off

If on, the Manager will start in simplified view mode if no configuration is loaded.

Default to Standard Mode

Default = Off

If on, when a configuration from a new or defaulted system running in Basic
mode is loaded, Manager will automatically convert the configuration to
Standard mode. Sending the configuration back to the system will restart it in
Standard mode. Only select this option if the only systems you expect to install
are Standard systems.

This setting does not affect existing systems with non-default configurations.

Use Remote Access

Default = Off.

If selected, access to all the configurations of a multi-site network is allowed via
remote access to the primary server on the multi-site network. When selected,
an additional Use Remote Access check box option is displayed on the Select
IP Office menu when the Open with Server Edition Manager check box option
is selected or if Manager is already running in Server Edition mode.
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Setting

Description

° Note:

To enable remote access, you must first configure an SSL VPN service
between each Server Edition system and the Avaya VPN Gateway (AVG).
For information, see Deploying Avaya IP Office™ Platform SSL VPN
Services.

Consolidate Solution to
Primary Settings

This setting is used by Manager when in Server Edition mode.
If Consolidate Network to Primary Settings is selected:

» Entry and administration of consolidated records is performed only at the
solution level except for the Emergency ARS and Fallback System field
settings of location records.

» Those records are then automatically replicated in the configurations of all the
systems in the solution but, except for locations, are still only visible and
editable at the solution level.

» When the configurations are loaded or when this setting is changed to become
selected, if any inconsistency between records are found, a Consolidation
Report is displayed. This report allows selection of whether to update the
system to match the primary or to update the primary to match.

SE Central Access

Default = Off. Applies to Server Edition systems only.

If On, all Server Edition systems in the network obtain their configuration data
from a central location on the Primary Server. As a result, the display of
configuration changes is delayed until a synchronization process runs. The
synchronization process runs every 40 seconds. If the configuration change
requires a system restart, a refreshed configuration display is delayed until 40
seconds after system restart.

This setting can be used to drive configuration changes into expansion systems
when the expansion systems are not reachable through Manager and the only
accessible system is the Primary Server.

0 Important:

When adding a new system to the solution, if the Manager setting File >
Preferences > Preferences > SE Central Access is set to On, an IP
Office Line is not configured from the new system to the Server Edition
Primary Server. The status of the new system is Offline. You must
configure an IP Office Line from the new system to the Server Edition
Primary Server.

° Note:

When SE Central Access is set to On, you cannot open configurations
with a release number of 9.0.x or earlier. To open older configurations, set
SE Central Access to Off.

When Manager is in Server Edition mode and SE Central Access is set to On,
the following File > Advanced menu options are not available:

» System Shutdown
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Setting

Description

* Memory Card Command

In addition to the above, when Manager is in Server Edition mode and SE
Central Access is set to On and no configuration is open, the following File >
Advanced menu options are not available:

* Erase Configuration (Default)

* Reboot

» System Shutdown

» Erase Security Settings (Default)

* Memory Card Command

SE Central Access Port

Default = 7070.

When SE Central Access is set to On, the port used for routing HTTPS
requests for configuration synchronization.

Related links

File > Preferences on page 47

File > Preferences > Directories

These settings allow you to change the default locations where Manager looks for and saves files.

These fields set the default location where Manager will look for and save files.

Directory

Description

Working Directory (.cfg
files)

Sets the directory into which Manager saves . cfqg files. By default this is the
Manager application's program directory.

o Note:

On Windows 7 systems, the default folder for Manager .cfg files is C:
\Program Files (x86)\Avaya\lP Office\Manager. On some Windows 7
systems, the file is saved to the user's profile folder at C:\Users
\<user_name>\AppData\Local\VirtualStore\Program Files (x86)\Avaya\lP
Office\Manager. You must turn on Show hidden files to access this folder.
Alternatively, you can set the working directory to an alternate location.

Binary Directory (.bin files)

Sets the directory in which the Manager upgrade wizard, HTTP, TFTP and
BOOTP functions look for firmware files requested by phones and other
hardware components. That includes .bin file, . scr files and . txt files. By
default this is the Manager application's program directory.

0 Tip:
In the Upgrade Wizard, right-clicking and selecting Change Directory also
changes this setting.
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Directory

Description

A Warning:

Historically, by default the Working Directory and Binary Directory are
the same. This is deprecated as it potentially allows remote TFTP/HTTP file
access to the folder containing copies of configuration files. Therefore it is
recommended that either of the folders is changed to an alternate location.

Known Units File

Sets the file and directory into which Manager can record details of the systems
it has discovered. Once a file location has been specified, a Known Units button
becomes available on the discovery menu used for loading system configuration.
Pressing that button displays the known units file as a list from which the
required system can be selected. It also allows sorting of the list and records to
be removed.

Related links

File > Preferences on page 47

File > Preferences > Discovery

These settings affect the Select IP Office menu used by Manager to discovery systems.

Setting Description
TCP and HTTP Default = On.
Discovery

This setting controls whether Manager uses TCP to discover systems. The addresses
used for TCP discovery are set through the IP Search Criteria field below.

NIC IP/NIC Subnet

This area is for information only. It shows the IP address settings of the LAN network
interface cards (NIC) in the PC running Manager. Double-click on a particular NIC to
add the address range it is part of to the IP Search Criteria. Note that if the address of
any of the Manager PC's NIC cards is changed, the Manager application should be
closed and restarted.

IP Search Criteria

This section is used to enter TCP addresses to be used for the TCP discovery
process. Individual addresses can be entered separated by semi-colons, for example
135.164.180.170; 135.164.180.175. Address ranges can be specified using dashes,
for example 135.64.180.170 - 135.64.180.175.

UDP Discovery

Default = On

This settings controls whether Manager uses UDP to discover systems.

Enter Broadcast IP
Address

Default = 255.255.255.255

The broadcast IP address range that Manager should used during UDP discovery.
Since UDP broadcast is not routable, it will not locate systems that are on different
subnets from the Manager PC unless a specific address is entered.

Use DNS Selecting this option allows Manager to use DNS name (or IP address) lookup to
locate a system. Note that this overrides the use of the TCP Discovery and UDP
Discovery options above. This option requires the system |IP address to be assigned
as a name on the users DNS server. When selected, the Unit/Discovery Address
Table continues...
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Setting

Description

field on the Select IP Office window is replaced by a Enter Unit DNS Name or IP
Address field.

SCN Discovery

If enabled, when discovering systems, the list of discovered systems will group
systems in the same Small Community Network and allow them to be loaded as a
single configuration. At least one of the systems in the Small Community Network
must be running Release 6.0 or higher software. See Configuring Small Community
Networking on page 744. This does not override the need for each system in the
Small Community Network to also be reachable by the TCP Discovery and or UDP
Discovery settings above and accessible by the router settings at the Manager
location.

Related links

File > Preferences on page 47

File > Preferences > Visual Preferences

Setting Description
Icon size Sets the size for the icons in the navigation pane between Small, Medium or Large.
Multiline Tabs Default = Off.
In the details pane, for record types with more than two tabs, Manager can either use
% * buttons to scroll the tabs horizontally or arrange the tabs into multiple rows. This
setting allows selection of which method Manager uses.
Related links

File > Preferences on page 47

File > Preferences > Security

Additional configuration information

For additional configuration information, see Security Administration on page 139. Also see Avaya
IP Office™ Platform Security Guidelines.

Configuration settings

Controls the various security settings of Manager. To control the security settings of the system,
see the information on Security mode.

All settings, except Secure Communications, can only be changed when a configuration has
been opened using a user name and password with Administrator rights or security administration

rights.
Setting Description
Request Login on Default = On
Save By default a valid user name and password is required to receive a configuration
from a system and also to send that same configuration back to the system.
Deselecting this setting allows Manager to send the configuration back without
Table continues. ..
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Setting

Description

having to renter user name and password details. This does not apply to a
configuration that has been saved on PC and then reopened. This setting can
only be changed when a configuration has been opened using a user name and
password with Administrator rights or security administration rights.

Close Configuration/
Security Settings
After Send

Default = On.

When selected, the open configuration file or security settings are closed after
being sent back to the system. This is the normal default. This setting does not
affect multi-site network modes of Manager which always close the configuration
after saving.

Before disabling this setting, you should recall that the configuration held by a
running system can be changed by actions other than Manager, for example
changes made by users through their phone. Keeping a configuration open in
Manager for longer than necessary increases the chances that that copy of the
configuration differs from the current configuration of the running system and will
overwrite those changes when sent back to the system.

Save Configuration
File After Load

Default = Off.

When selected, a copy of the configuration is saved to Manager's working
directory. The file is named using the system name and the suffix .cfg. This
setting can only be changed when a configuration has been opened using a user
name and password with Administrator rights or security administration rights.

Backup Files on
Send

Default = Off.

If selected, whenever a copy of a configuration is sent to a system, a backup
copy is saved in Manager's working directory. The file is saved using the system
name, date and a version number followed by the Backup File Extension as set
below. This setting can only be changed when a configuration has been opened
using a user name and password with Administrator rights or security
administration rights.

Backup File
Extension

Default = .BAK

Sets the file extension to use for backup copies of system configurations
generated by the Backup Files on Send option above.

Number of Backup
Files to keep

Default = Unlimited.

This option allows the number of backup files kept for each system to be limited.
If set to a value other then Unlimited, when that limit would be exceeded, the file
with the oldest backup file is deleted.

Enable Application

Default = On.

Id!e Timer (5 When enabled, no keyboard or mouse activity for 5 minutes will cause the
minutes) o .
Manager to grey out the application and re-request the current service user
password. This setting can only be changed when a configuration has been
opened using a user name and password with Administrator rights or security
administration rights.
Secure Default = On
Communications
Table continues...
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Setting

Description

When selected, any service communication from Manager to the system uses the
TLS protocol. This will use the ports set for secure configuration and secure
security access. It also requires the configuration and or security service within
the system's security configuration settings to have been set to support secure
access. Depending on the level of that secure access selected, it may be
necessary for the Manager Certificate Checks below to be configured to match
those expected by the system for configuration and or security service.

* When Secure Communications is set to On, a 4 padlock icon is displayed at
all times in the lower right Manager status field.

» For Server Edition systems, Manager will always attempt to use secure
communications regardless of the Secure Communications setting.

* If no response to the use of secure communication is received after 5 seconds,
Manager will offer to fallback to using unsecured communications.

Manager Certificate
Checks

When the Secure Communications option above is used, Manager will process
and check the certificate received from the system. This setting can only be
changed when a configuration has been opened using a user name and
password with Administrator rights or security administration rights. The options
are:

» Low: Any certificate sent by the system is accepted.

* Medium: Any certificate sent by the system is accepted if it has previously
been previously saved in the Windows' certificate store. If the certificate has not
been previously saved, the user has the option to review and either accept or
reject the certificate.

» High: Any certificate sent by the system is accepted if it has previously been
previously saved in the Windows' certificate store. Any other certificate cause a
log in failure.

Certificate Offered to
IP Office

Default = none Specifies the certificate used to identify Manager when the
Secure Communications option is used and the system requests a certificate.
Use the Set button to change the selected certificate. Any certificate selected
must have an associated private key held within the store:

» Select from Current User certificate store - Display certificates currently in the
currently logged-in user store.

» Select from Local Machine certificate store.

* Remove Selection — do not offer a Manager certificate.

Security — Registry Settings

A Warning:

Avaya accept no liability for any issues arising from the editing of a PC'’s registry settings. If
you are in any doubt about how to perform this process you should not proceed. It is your
responsibility to ensure that the registry is correctly backed up before any changes are made.
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© Note:

Before manually editing any registry entry, the following Microsoft support articles should be
read:

* http://support.microsoft.com/kb/256986

* http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/
regedit _permit_key.mspx

Manager stores it's security preferences in the Windows Registry. The following key affects
manager security operation; it's values may only be changed by a configuration or security
administrator:

HKEY CURRENT USER\Software\Avaya\IP400\Manager\Security\

In order to prevent circumvention by manual editing of the Windows Registry, Regedt32.exe, the
native registry editor, allows an operator user (with Full Control permissions) to edit permissions
on a per key basis.

To prevent a user from manually editing the security preferences, the HKEY USERS\User GUID
\Software\Avaya\IP400\Manager\Security key permission should be set to ‘Read’ only
for that user. Ensure that all child object permissions are replaced as well by using the ‘Advanced’

button.

To allows the security policy of all local PC users to be fixed, a set of values in the key

HKEY CURRENT USER\Software\Avaya\IP400\Manager\Security\ may be created. This
is tested and used in preference to any value found under HKEY CURRENT USER\Software
\Avaya\IP400\Manager\Security\.

This key is not created by the manager application.

Related links

File > Preferences on page 47

File > Preferences > Validation

By default Manager validates the whole configuration when it is loaded and individual fields
whenever they are edited. This tab allows selection of when automatic validation should be
applied to configuration files loaded into Manager.

Setting

Description

Validate configuration
on open

Automatically validate configuration files when they are opened in Manager.

Validate configuration
on edit

Validate the whole configuration when OK is clicked after editing a record. For large
configurations, disabling this option removes the delay caused by validating the
configuration after every edit.

Prompt for
configuration
validation on save or
send

If selected, when saving or sending a configuration, a prompt is displayed asking
whether the configuration should be validated. If validation is selected and error are
found, the send or save process is canceled. This option is disabled if Validate
configuration on edit is selected.

Related links

File > Preferences on page 47
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File > Offline

Related links
File Menu on page 43
File > Offline > Create New Config on page 56
File > Offline > Open File on page 56
File > Offline > Open File Set on page 56
File > Offline > Send Config on page 56
File > Offline > Receive Config on page 57

File > Offline > Create New Config
Used to create an offline configuration.

This command starts a dialog that allows you to create a default offline configuration by specifying
the system locales, the type of control unit and expansion modules and the trunk cards fitted. The

same action is performed by the = icon in the Main Toolbar.
Related links

File > Offline on page 56
File > Offline > Open File

This command allows a configuration file stored on PC to be opened in Manager.
Related links

File > Offline on page 56

File > Offline > Open File Set

This command is only available when manager is running in Server Edition mode. It can be used
to load a set of files previously saved offline using the File > Save Configuration As command.

When selected, browse to the location of the saved . cfi file and associated . cfg files and select
the .cfi file.

Related links
File > Offline on page 56

File > Offline > Send Config

This command is used to send an offline configuration to a system.

A Warning:

After this command is completed, the system is rebooted. This will end all calls and services in
progress.

After sending the configuration, you should receive the configuration back from the system and
note any new validation errors shown by Manager. For example, if using Embedded Voicemail,
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some sets of prompt languages may need to be updated to match the new configurations locale
setting using the Add/Display VM Locales option.

Related links
File > Offline on page 56

File > Offline > Receive Config

This command displays the Select IP Office menu used to receive a systems configuration
settings.

Once the configuration has been received, you are prompted to save it on the PC.

Related links
File > Offline on page 56

File > Advanced
Related links
File Menu on page 43
File > Advanced > Erase Configuration on page 57
File > Advanced > Reboot on page 58
File > Advanced > System Shutdown on page 58
File > Advanced > Upgrade on page 59
File > Advanced > Change Mode on page 62
File > Advanced > Audit Trail on page 62
File > Advanced > Security Settings on page 63
File > Advanced > Erase Security Settings (Default) on page 63
File > Advanced > Embedded File Management on page 64
File > Advanced > Format IP Office SD Card on page 64
File > Advanced > Recreate |P Office SD Card on page 65
File > Advanced > Memory Card Command on page 67
File > Advanced > Launch Voicemail Pro on page 67
File > Advanced > System Status on page 67
File > Advanced > LVM Greeting Utility on page 67
File > Advanced > Generate WebLM ID on page 68
File > Advanced > Initial Configuration on page 68
File > Advanced > Add/Display VM Locals on page 72

File > Advanced > Erase Configuration

This command returns the configuration settings of a system back to their default values. It does
not affect the system's security settings or audit trail record.
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When this command is used, the Select IP Office menu is displayed. Once a system is selected,
a valid configuration user name and password are required to complete the action.

IP500 V2 systems using IP Office A-Law or IP Office U-Law System SD cards will default to
Quick mode. Loading the configuration will switch Manager to simplified view. To change the
system back to operating in Standard mode, use either of the following methods:

* Change Mode

This will change the operating mode of the system and create a default configuration
appropriate to that mode.

Related links
File > Advanced on page 57

File > Advanced > Reboot

When this command is used, the Select IP Office window is displayed. Once a system is
selected, a valid user name and password are required. The type of reboot can then be selected
in the Reboot window.

When the reboot occurs can be selected as follows:
* Immediate Send the configuration and then reboot the system.

* When Free Send the configuration and reboot the system when there are no calls in
progress. This mode can be combined with the Call Barring options.

* Timed The same as When Free but waits for a specific time after which it then wait for there
to be no calls in progress. The time is specified by the Reboot Time. This mode can be
combined with the Call Barring options.

Reboot Time This setting is used when the reboot mode Timed is selected. It sets the time
for the reboot. If the time is after midnight, the system's normal daily backup is canceled.

Call Barring These settings can be used when the reboot mode When Free is selected. They bar
the sending or receiving of any new calls.

Related links
File > Advanced on page 57

File > Advanced > System Shutdown

This command can be used to shutdown systems. The shut down can be either indefinite or for a
set period of time after which the system will reboot. For Linux based telephone systems, the
shutdown command is applied to the telephony service on the server and not to the whole sever.
In that case, if the system is shutdown indefinitely, it can be restarted using the server's web
control pages to either restart the service or to restart the whole server.

A Warning:

A shutdown must always be used to switch off the system. Simply removing the power cord or
switching off the power input may cause the loss of configuration data.
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This is not a polite shutdown, any user calls and services in operation will be stopped. Once
shutdown, the system cannot be used to make or receive any calls until restarted.

The shutdown process takes up to a minute to complete. When shutting down a system with a
Unified Communications Module installed, the shutdown can take up to 3 minutes while the card

safely closes all open files and closes down its operating system. During this period the module's
LED 1 remains green.

When shutdown, the LEDs shown on the system are as follows. Do not remove power from the
system or remove any of the memory cards until the system is in this state:

» LED1 on each IP500 base card installed will also flash red rapidly plus LED 9 if a trunk
daughter card is fitted to the base card.

» The CPU LED on the rear of the system will flash red rapidly.

* The System SD and Optional SD memory card LEDs on the rear of the system are
extinguished.

To restart a system when shutdown indefinitely, or to restart a system before the timed restart,
switch power to the system off and on again.

Once you have selected the system from the Select IP Office window, the System Shutdown
Mode window opens. Select the type of shutdown required:

« If a Timed shutdown is selected, the system will reboot after the set time has elapsed.

* If Indefinite is used, the system can only be restarted by having its power switched off and
then on again. For Linux based telephone systems, the telephony service must be restarted
through the server's web control pages.

Related links
File > Advanced on page 57

File > Advanced > Upgrade
© Note:

This command is not used with Linux based systems. Linux systems are updated through the
server's webcontrol menus.

This command starts the Upgrade Wizard tool. The Upgrade Wizard is used to compare the
software level of the control unit and modules within systems against the software level of the .bin

binary files Manager has available. The Upgrade Wizard can then be used to select which units to
upgrade.

A Warning:

* Incorrect use of the upgrade command can halt system operation and render units in the
system unusable. You must refer to the Technical Bulletins for a specific release for full
details of performing software upgrades to that release. There may be additional steps
required such as defaulting the security settings.
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» Performing any other actions on a system during an upgrade or closing the upgrade
wizard and Manager during an upgrade may render systems unusable.

* During an upgrade the system may restrict calls and services. It will reboot and
disconnect all current calls and services.

» The Validate option must remain selected wherever possible. Use of unvalidated
upgrades is subject to a number of conditions outlined in the IP Office Installation Manual
and Technical Bulletins.

The list area shows details of systems found by the Upgrade Wizard and the software currently
held by those systems. The check boxes are used to select which units should be upgraded.
Upgrading will require entry of a valid name and password for the selected system.

Column Description

Name The name of the system as set in its configuration (System | System | Name) .

IP Address The IP address of the system.

Type The type of system and the names of the various firmware files used by external
expansion systems supported by the system type.

Version Details the current software each unit in the systems is running.

Edition Indicates the operation mode of the system.

Licensed Indicates the highest value software upgrade license present in the system's

configuration. The IP Office Release that is supported by that license is also
indicated in brackets.

Required License Indicates the software upgrade license required for the current level of software
the system is running. The IP Office Release that is supported by that license is
also indicated in brackets.

It does not refer to the software upgrade license required for the level of software
which is available for upgrade. The system must include a license for the specific
level of software it is required to run.

For IP500 V2 systems, a value of 255 indicates that the control unit is still in its
initial 90 days where it can be upgraded to a higher level without requiring an
upgrade license.

Available Shows the version of the matching firmware files that Manager has available (a —
indicates no file available) in its current working directory. Upgrading to a release
higher than that supported by the current Licensed level will leave the system
unable to support any functions until the appropriate upgrade license is added to
the system configuration.

The Upgrade Wizard includes a number of check boxes that can be used to include other actions
as part of the upgrade process:

e Validate

» The Validate option should remain selected wherever possible. When selected, the upgrade
process is divided as follows: transfer new software, confirm transfer, delete old software,
restart with new software. If Validate is not selected, the old software is deleted before the
new software is transferred.
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Backup System Files

For any IP500 V2 systems being upgraded, the Backup system files option will cause the
system to backup its memory card files as part of the upgrade.

Upload System File

For any IP500 V2 system being upgraded, the Upload system files option will upload
various files:

- It copies the binary files for the system control unit and possible external expansion
modules.

- It copies the firmware files used by phones supported by the system.
- It copies the files for Web Manager.

- For systems configured to run Embedded Voicemail, the Embedded Voicemail prompts for
those supported languages set as the system locale, user locales, incoming call route
locales and short code locales are upgraded.

» Restart IP Phones For Manager 8.1 and higher the Restart IP Phones option can be used.
This will cause those phone to load any upgrade phone firmware included in the system
upgrade (if using the system's memory card as their firmware file source).
Related links
File > Advanced on page 57

Searching for Systems

The default address used by the Upgrade Wizard is the address shown in the Manager title bar,
which is selected through File | Preferences. If the unit required is not found, the address used can
be changed.

Procedure
1. Enter or select the required address in the Unit/Broadcast Address field.
2. Click Refreshto perform a new search.
Changing the .bin File Directory

The directory in which the Upgrade Wizard looks for .bin files is set through Manager's Binary
Directory setting. This can be changed using Files | Change Working Directory or File |
Preferences | Directories.

Use this procedure to change it directly from the Upgrade Wizard.
Procedure
1. Right-click on the list area.
2. Select Select Directory.
3. Browse to and highlight the folder containing the .bin files. Click OK.
4.

The list in the Available column will be updated to show the .bin files in the selected
directory that match units or modules listed.

July 2017 Administering Avaya IP Office™ Platform with Manager 61

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Administering Avaya IP Office™ Platform with Manager

Menu Bar Commands

File > Advanced > Change Mode

This command can be used to change the operating mode of an IP500 V2 system from Basic
Edition to either standard IP Office or Server Edition expansion. To convert an existing system to
Basic Edition mode, use the default configuration options.

© Important:

Using this command will default the configuration. Therefore ensure that you have a backup
copy of the configuration before using this command in case it is necessary to return to the
previous mode.

Do not use this command if the Default to Standard Mode option is enabled in the IP Office
Manager preferences. Disable the option first.

Note that if the system includes components not supported by the mode to which it is switched,
they will not work in the new mode. For example, ETR cards which are only supported in Basic
Edition.

In order to use this command, the system security settings must be at their default settings. The
current setting can be defaulted using the Erase Security Settings (Default) command.

After a mode change, the system restarts. If the system does not restart, the most likely cause is
that the systems security settings were not at their default settings.

Related links
File > Advanced on page 57

File > Advanced > Audit Trail

The audit trail lists the last 16 actions performed on the system from which the configuration
loaded into Manager was received. It includes actions by service users such as sending a
configuration back, reboots, upgrades and defaulting the system.

Audit trail events can be output to a Syslog server through the system's System | System Events
settings.

The last failed action is always recorded and shown in red. It is kept even if there have been 16
subsequent successful actions.

The Audit Trail is part of the system configuration file received from the system. If the configuration
is kept open between send and reboot operations (ie. if Close Configuration/Security Setting After
Send is not selected), the Audit Trail will not show details of those operations. It will only show
details of those operations if the configuration is closed and then a new copy of the configuration
is received from the system.

Audit Details

When a specific access event is selected from the list, the following information is shown in the
Audit Details section:

* The Security User shows the service user name used for the access action.

» The Date and Time of Access indicate the local system time when the recorded event
occurred.
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* The PC Login is the computer name of the PC used for the access.

* The PC IP Address and PC MAC Address are the IP address and MAC address of the PC
used for access.

» The Access Type details the type of action that was performed.

* The Outcome shows the system's response to the access. The outcome Success
(Warning) refers to the sending of a configuration that contains fields marked as errors or
warnings by Manager's validation function. Success (Clean) refers to the sending of a
configuration that does not contain any validation errors or warnings.

Items Changed

The Items Changed area summarizes the changes contained in a sent configuration. Where
changes to a single record of a particular type are made, the ltem Name field lists the individual
record changed. Where changes are made to several records of the same type, the Item Name
field displays Multiple items.

Related links
File > Advanced on page 57

File > Advanced > Security Settings

This command is used to switch the Manager application to security mode. In that mode, Manager
is used to edit the security settings of a system.

Related links
File > Advanced on page 57

File > Advanced > Erase Security Settings (Default)

This command returns the security settings of a system back to their default values. This action
does not affect the system's configuration or audit trail record. When this command is used, the
Select IP Office menu is displayed. Once a system is selected, a valid security user name and
password are required to complete the action.

The system's security settings are returned to their defaults as indicated in the Security Mode
chapter.

Note that any security certificates stored and being used by the system are deleted. Any services
currently using those certificates are disconnected and disabled until the appropriate certificates
are added back to the system's security configuration. That includes SSL VPN connections being
used to perform system maintenance.

The name and password used for this command are those required for security configuration
access which are different from those used for normal configuration access.

For IP500 V2 control units, if the security settings cannot be defaulted using this command, they
can be defaulted using a DTE cable connection to the system. Refer to the IP Office Installation
manual for details.

A Warning:
Service Disruption.
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Whilst defaulting the security settings does not require a system reboot, it may cause service
disruption for several minutes while the system generates a new default security certificate.

Related links
File > Advanced on page 57

File > Advanced > Embedded File Management

For control units with a memory card installed, the contents of the card can be viewed using
Manager. This view can also be used to add and remove files from the card. This may be useful
when the memory card is being used to store Music on Hold or IP phone firmware files.

» For non-Linux systems, the folders accessed using embedded file management are those on
the SD cards installed in the control unit.

* For Linux based systems, the folder path displays as disk in the embedded file manager.
That path maps onto /opt/ipoffice on the server.

Related links
File > Advanced on page 57

File > Advanced > Format IP Office SD Card

This command allows suitable SD cards to be formatted by the Manager PC. The system supports
SD cards with the following format: SDHC minimum 4GB FAT32 format (Single partition, SDHC,
class2+, FAT32, SPI & SD bus). Non-Avaya supplied cards of the same format can be used a
system's Optional SD slot for additional actions such as backup.

A Warning:

» Do not re-purpose a Enterprise Branch SD card for use with any other IP Office mode.
Doing so may damage the SD card and make it unusable for your Enterprise Branch
system.

 All File Will Be Erased Note that this action will erase any existing files and folders on
the card. If the requirement is just to update the card, use Recreate IP Office SD Card
without reformatting. Once a card has been formatted, the folders and files required for
operation can be loaded onto the card from the Manager PC using the Recreate IP Office
SD Card command.

» Avaya supplied SD cards should not be formatted using any other method than the
format commands within Manager and System Status Application. Formatting the cards
using any other method will remove the feature key used for system licensing from the
card.

Related links
File > Advanced on page 57
Formating the SD card on page 65
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Formating the SD card
Procedure

1. Insert the SD card into a reader slot on the Manager computer.
2. Using Manager, select File | Advanced | Format IP Office SD Card.
3. Select the type of card.

This selection just sets the card label shown when viewing the card details. It does not
affect the actual formatting. Select the label that matches the file set you will be placing on
the card.

+ IP Office A-Law A system fitted with this type of card will default to A-Law telephony.
+ IP Office U-Law A system fitted with this type of card will default to U-Law telephony.

» Enerprise Branch Use this option for an SD card intended to be used with an IP Office
system running in Enterprise Branch Mode. There is a separate SD card for Enterprise
Branch. The Enterprise Branch SD card can only be used for Enterprise Branch
operation and cannot be used to change modes to IP Office. You also cannot use or
change an IP Office SD card for use with an Enterprise Branch system.

A Warning:
Do not re-purpose a Enerprise Branch card for use with any other IP Office mode.

Doing so may damage the SD card and make it unusable for your Enterprise Branch
system.

4. Browse to the card location and click OK.

5. The status bar at the bottom of Manager will display the progress of the formatting
process.

6. When the formatting is complete, you can use the Recreate IP Office SD Card command to
load the system folders and files onto the card from the Manager PC.

Related links
File > Advanced > Format IP Office SD Card on page 64

File > Advanced > Recreate IP Office SD Card

This command can be used with the System SD cards used by IP500 V2 control units. It allows
Manager to copy all the files and folders used by a system when starting onto the card that has
been place into the card slot of the PC running Manager. It updates the card with the version of
those files installed with the Manager application. It includes the binary files for the system,
external expansion modules and phones. The command also copies all language prompt sets
used by Embedded Voicemail.

If the card contains dynamic system files such as SMDR records, they are temporarily backed up
by Manager and then restored after the card is recreated. For the card to be used in a system's
System SD slot the card must be Avaya SD Feature Key card. The card must be correctly
formatted, however a reformat of an existing working card is not necessary before using recreate
to update the card contents.
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The source for the files copied to the SD card are the sub-folders of the \Memory Cards folder
under Manager's Working Directory (normally C: \Program Files\Avaya\IPOffice
\Manager). However, if the Working Directory is changed to a location without an appropriate set
of \Memory Cards sub-folders, the required set of files will not be copied onto the SD card.

Related links
File > Advanced on page 57
Recreating the IP Office SD Card on page 66

Recreating the IP Office SD Card
About this task

© Note:

This process can take up to 20 minutes depending on the PC. Once started, the process
should not be interrupted.

Procedure
1. Insert the SD card into a reader slot on the Manager computer.
2. Using Manager, select File | Advanced | Recreate IP Office SD Card.
3. Select the type of system for which the card is intended.

This selection will affect how the system operates when defaulted with this card present in
its System SD card slot.

+ IP Office A-Law A system fitted with this type of card will default to A-Law telephony.
« |P Office U-Law A system fitted with this type of card will default to U-Law telephony.

» Enterprise Branch Use this option for an SD card intended to be used with an IP Office
system running in Enterprise Branch mode. There is a separate SD card for IP Office.
The Enterprise Branch SD card can only be used for IP Office operation and cannot be
used tochange modes to IP Office. You also cannot use or change an IP Office SD card
for use withan Enterprise Branch system.

A Warning:

Do not re-purpose a Enterprise Branch SD card for use with any other IP Office
mode. Doing so may damage the SD card and make it unusable for your Enterprise
Branch system.

4. Browse to the card location and click OK.

5. For all systems, these files are necessary if you want to go through the process of on-
boarding registration.

6. Manager will start creating folders on the SD card and copying the required files into those
folders.

7. Do not remove the card until the process is completed and Manager displays a message
that the process has been completed.
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Related links
File > Advanced > Recreate |P Office SD Card on page 65

File > Advanced > Memory Card Command

These commands are used with the memory cards installed in IP500 V2 control units.
Shutdown
This command can be used to shutdown the operation of IP500 V2 unit memory cards.

This action or a system shutdown must be performed before a memory card is removed from the
unit. Removing a memory card while the system is running may cause file corruption. Card
services can be restarted by either reinserting the card or using the Start Up command.

Shutting down the memory card will disable all services provided by the card including Embedded
Voicemail if being used. Features licensed by the memory card will continue to operate for up to 2
hours.

Start Up

This command can be used to restart operation of an IP500 V2 memory card that has been shut
down. >The command will start the Select IP Office discovery process for selection of the system.

Related links
File > Advanced on page 57

File > Advanced > Launch Voicemail Pro
If the Voicemail Pro client is installed on the same PC as Manager, this link can be used to launch

. y—
the Voicemail Pro client. This can also be done by clicking on the [ icon in the Manager toolbar.

Related links
File > Advanced on page 57

File > Advanced > System Status

System Status is an application that can be used to monitor and report on the status of a system.

This is a separate application from Manager but if installed on the same PC, it can be started
using the File | Advanced | System Status link within Manager. Use of the application requires a
service user name and password configured on the system for System Status Access within the
system's security settings.

Related links
File > Advanced on page 57

File > Advanced > LVM Greeting Utility

This command launches a utility that can be used to convert .wav files to the formats used by
Embedded Voicemail (c11). The source file must be in the standard format used for all system
applications: PCM, 8kHz 16-bit, mono.
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The resulting named greeting files can then be transferred to the Embedded Voicemail memory
card and selected as auto attendant greetings. That is done using the Recording Name field on
the Auto Attendant | Auto Attendant tab. The same named greeting file can be used in several
auto attendants.

The utility can be run separately using the file LVMGreeting.exe found in the LVMGreeting sub-
folder of the Manager application.

© Note:

The LVM Greeting Utility option is not selectable (grayed out) when Voicemail Pro is selected
as the system's voicemail type.

Related links
File > Advanced on page 57

File > Advanced > Generate WebLM ID

This menu is only used for Linux based systems. Any system being upgrading from pre-Release
10 ADI licenses must be migrated to PLDS licenses before upgrading. This is done using the files
created by the license migration tool. However, that tool assumes that the system will also be the
licence host. If instead the system is going to use PLDS license hosted by a WebLM server, the
system's web license server host ID is required in addition to the files created by the license
migration tool. The Generate WebLM ID tool provides that additional ID.

To generate the server’s Web License Server Host ID:

1. Click File | Advanced | Generate WebLM ID. The menu displayed varies depending on
whether the server is virtualized or not.
2. Enter the details of the server. For a virtualized server, the UUID can be obtained as
follows:
» Using the command line command: dmidecode -s system-uuid
e From the uuid.bios line of the virtual machines vmx file.

* From the VSphere client. See http://www-01.ibm.com/support/docview.wss?
uid=swg21682150. .

3. Click Generate.

Related links
File > Advanced on page 57

File > Advanced > Initial Configuration

© Note:

The Initial Configuration utility changes the security settings. Therefore, the user running the
utility must have security read/write rights.

Standard Mode Initial Configuration

The Initial Configuration menu is displayed for all new or fully defaulted IP500 V2 systems. It
allows the required operating mode for the system to be selected.
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For a system that you want to run in Essential Edition, Preferred Edition or Advanced Edition
modes, select IP Office Standard Mode.

For an IP500 V2 system to run in Standard Mode, its configuration must include an Essential
Edition license. A Standard Mode system without this license will not allow any telephony
functions.

For a system that is being installed as an expansion server for a Server Edition solution, select
Server Edition Expansion.

Server Edition Initial Configuration

On a Standard Mode system, use the Initial Confguration option to convert the existing system
configuration into a Server Edition system configuration. It will effectively default the configuration
and reload it in Manager in Server Edition mode. Once Server Edition Expansion is selected as
the System Type, the Initial Configuration menu is displayed. If Server Edition Expansion is
selected in that menu, following selection of the various menu options, the system is rebooted as a
Expansion System (V2) for a Server Edition network.

For systems being configured for operation in a Server Edition solution, the Initial Configuration
menu is used to set or confirm a range of settings. The field shown and accessible in the form
depend on the selected System Type.

Once the menu is completed and Save is clicked, the values entered are written into the system
configuration and the system is restarted. The menu is also displayed when creating an offline
configuration for a Server Editionsystem. The configuration of an existing non-Server Edition
system can be converted to a Server Edition configuration, invoking this menu, using the File |
Advanced | Initial Configuration menu option.

System Type Indicate the type of sever role the system will perform.

Retain Configuration Data This option is shown for IP500 V2 units being converted to become
Expansion System (V2)s in a Server Edition solution.

If left unselected, the default, the existing configuration of the system is defaulted as per a
standard Server Edition expansion system.

If selected, the existing configuration is retained. However, some elements of that configuration
may be invalid or ignored in a Server Edition solution. It is the installers responsibility to ensure
that the final configuration is valid for use in the solution. For more information on IP500 V2
conversion, see Deploying Avaya IP Office™ Platform Server Edition.

Option Description

Hosted The option to select when deploying IP Office in a hosted environment. Selecting this
Deployment option sets HTTP directory to HTTPS. The default is unchecked.

System Name A name to identify this system. This is typically used to identify the configuration by the

location or customer's company name. Some features such as Gatekeeper require the
system to have a name. This field is case sensitive and within any network of systems
must be unique. Do not use <, >, |, \0, :;, %, ?, . or /.

Locale This setting sets default telephony and language settings based on the selection. It also
sets various external line settings and so must be set correctly to ensure correct
operation of the system. See Avaya IP Office™ Platform Locale Settings. For individual

Table continues...
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Option

Description

users the system settings can be overridden through their own locale setting (User | User
| Locale).

Services Device ID

Set a Device ID for the system. This ID is displayed on the Solution View and System
Inventory pages and on the System | System tab in the configuration. The value can be
changed using the Device ID field on the System | System Events | Configuration tab. If
an SSL VPN is configured, , Avaya recommends that the Device ID match an SSL VPN
service Account Name. Each SSL VPN service account name has an associated SSL
VPN tunnel IP address. Having the displayed Device ID match an SSL VPN service
account name helps identify a particular SSL VPN tunnel IP address to use for remotely
managing IP Office.

LAN Interface

This IP Address, IP Mask, Gateway and DHCP Mode settings can be set for the systems
two LANs, LAN1 and LAN2. These radio buttons are used to switch between displaying
the LAN1 details or the LANZ2 details.

IP Address

LAN1 Default = 192.168.42.1. LAN2 Default = 192.168.43.1.

This is the IP address of the Control Unit on LAN1. If the control unit is also acting as a
DHCP server on the LAN, this address is the starting address for the DHCP address
range.

IP Mask

Default = 255.255.255.0. This is the IP subnet mask used with the IP address.

Gateway

The address of the default gateway for routing traffic not in the same subnet address
range of the IP Address/IP Mask set above. A default IP Route for this address is added
to the systems configuration.

DHCP Mode:

Default = Server.
This controls the control unit's DHCP mode for the LAN. When doing DHCP:

* LAN devices are allocated addresses from the bottom of the available address range
upwards.

* Dial In users are allocated addresses from the top of the available range downwards.

* If the control unit is acting as a DHCP server on LAN1 and LAN2, Dial in users are
allocated their address from the LAN1 pool of addresses first.

» Server When this option is selected, the system will act as a DHCP Server on this LAN,
allocating address to other devices on the network and to PPP Dial in users.

» Disabled When this option is selected, the system will not use DHCP. It will not act as a
DHCP server and it will not request an IP address from a DHCP server on this LAN.

+ Dial In When this option is selected, the system will allocate DHCP addresses to PPP
Dial In users only. On systems using DHCP pools, only addresses from a pool on the
same subnet as the system's own LAN address will be used.

» Client When this option is selected, the system will request its IP Address and IP Mask
from a DHCP server on the LAN.

Server Edition
Primary Server

The IP address of the Primary Server. This address is used to add an IP line to the
Primary Server to the configuration.

Server Edition
Secondary Server

The IP address of the Secondary Server. This address is used to add an IP line to the
Secondary Server to the configuration.
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Option

Description

DNS Server

This is the IP address of a DNS Server. If this field is left blank, the system uses its own
address as the DNS server for DHCP client and forwards DNS requests to the service
provider when Request DNS is selected in the service being used (Service | IP).

Enterprise Branch Initial Configuration

The Initial Installation utility provides a default configuration and security settings that minimize
initial installation activities and maximize security. The system must be configured with the default
settings before the system can be administered by System Manager. This utility is used for new
installations and after an upgrade to enable System Manager administration of the IP Office.

1.
2.
3.

Select File > Advanced > Launch Initial Installation Utility.
In the System Name field, enter the appropriate system name.

For the WAN Interface, select LAN1 or LANZ2. If you select LAN1, the DHCP Mode is
disabled.

4. In the IP Address field, enter the appropriate IP address.

In the IP Mask field, enter the appropriate IP mask.

. In the Gateway field, enter the appropriate gateway. Manager will create an IP route using

this gateway with the selected WAN as the destination.

In the DHCP Mode section, if you selected LAN1, select the appropriate DHCP option. If
you selected LAN2, DHCP Mode is disabled.

Select the Under Centralized Management? check box if you want the IP Office system
to be managed by System Manager.

If you selected the Under Centralized Management? check box, a number of additional
fields are shown, configure these additional fields as appropriate:

* SMGR Address - the IP address of the server running System Manager
* SNMP Community

* SNMP Device ID

* Trap Community

+ SCEP Domain Certificate Name

* Certificate Enroliment (SCEP) Password

Select Save.

When you run the Initial Installation Utility, the Initial Installation utility also configures the following:

» System Status Interface (SSA) service security level — Unsecure only

+ Configuration service security level —Secure, Medium

» Security Administration service security level — Secure, Medium

* OAMP Web Services service security level — Secure, Low (if locally administered)

« OAMP Web Services service security level — Secure, High (if administered by System
Manager)
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» Admin Client Certificate checks:-- High (if administered by System Manager)
» SCEP client active (if administered by System Manager)
» SCEP server IP address from SMGR IP address (if administered by System Manager)
» Legacy Program Code — Active (if locally administered)
If the system is administered by System Manager, the following is automatically configured:
* SNMP enabled
* SNMP trap destination 1 from System Manager IP address
» All SNMP traps active
* WebLM client active
* WebLM service address from System Manager IP address
* Remove all default extension users, leaving “NoUser” and “RemoteManager”

Related links
File > Advanced on page 57

File > Advanced > Add/Display VM Locals

This option is only displayed displayed when the configuration from an IP500 V2 systems with its
Voicemail Type set to Embedded Voicemail is received in Manager. It is not shown for off-line
configuration or configurations loaded from a PC file.

Selecting this option displays a list of the Embedded Voicemail prompt languages. Those
languages already present on the System SD card or not supported are greyed out. Additional
languages can be selected and then uploaded from Manager to the system.

When editing the system configuration in Manager, if the locale language selected for the system,
a user, a short code or an incoming call route is not already present on the System SD card,
Manager will display an error. Add/Display VM locales can then be used to upload the prompts
for the required language in order to correct the error.

You can reload languages that are already installed on the System SD card. For example, you
may want to reload the languages if new prompts have been added in a maintenance release. To
reload existing languages, upgrade the system (File | Advanced | Upgrade) with the Upload
System Files option checked. You can also choose Upload System Files from the Embedded File
Management utility (File | Advanced | Embedded File Management).

The Recreate IP Office SD Card command can be used to locally load all available languages
onto an SD card.

Related links
File > Advanced on page 57
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File > Backup/Restore

Backup Binaries and Configurations

This command copies all configuration files (.cfg) and software binary files (.bin) stored in
Manager's working directory to a selected folder.

Restore Binaries and Configurations

This command copies all configuration files (.cfg) and software files (.bin) stored in a selected
folder to the Manager's working directory.

Related links
File Menu on page 43

File > Import/Export

Export

This command allows you to export the selected parts of the configuration to either a set of CSV
text files (.csv) or a single binary file (.exp).

The display shows those exportable record types for which the configuration contains records. The
File Type and the Save In path can be selected at the base. The default location used is sub-
directory of the Manager application directory based on system name of the currently loaded
system.

Manager imports and exports CSV files using UTF8 character encoding which uses a double byte
to support characters with diacritic marks such as a. Other applications such as Excel, depending
on the user PC settings, may use different single-byte encoding which will cause such characters
to be removed. Care should be taken to ensure that any tool used to create or edit a CSV
supports all the characters expected and is compatible with UTF8.

Import

This command allows you to import configuration settings. Two formats are supported. Binary files
(.exp) are settings previously exported from a system using File | Import /Export | Export. CSV text
files (.csv) can also be exported from a system or can be created using a plain text editor.

For the selected File Type and the Look In path, the window displays the file or files found. The
default location used is sub-directory of the Manager application directory based on system name
of the currently loaded system.

Manager imports and exports CSV files using UTF8 character encoding which uses a double byte
to support characters with diacritic marks such as a. Other applications such as Excel, depending
on the user PC settings, may use different single-byte encoding which will cause such characters
to be removed. Care should be taken to ensure that any tool used to create or edit a CSV
supports all the characters expected and is compatible with UTF8.

Related links
File Menu on page 43
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File > Exit
The File | Exit command exits the Manager application.

Related links
File Menu on page 43

View Menu

View > Toolbars

Allows selection of which toolbars should be shown or hidden in configuration mode. A tick mark is
displayed next to the name of those toolbars that are currently shown.

View > Navigation Pane

Shows or hides the Navigation Pane. A tick mark appears next to the command when the pane is
shown.

View > Group Pane

Shows or hides the Group Pane. A tick mark appears next to the command when the pane is
shown.

View > Details Pane

Sets the location of the Details Pane when the Group Pane is also shown. The Details Pane can
be placed either below or to the right of the Group Pane.

View > Error Pane

Shows or hides the Error Pane. A tick mark appears next to the command when the pane is
shown.

View > Advance View

Causes Manager to switch from its simplified view to advanced view mode. Manager automatically
switches to advanced view mode if a Standard Edition configuration is loaded.

View > Simplified View

If Manager has no configuration loaded, this command switches it from advanced view to
simplified view.

View > TFTP Log

This command displays the TFTP Log window. This window shows TFTP traffic between Manager
and devices that uses TFTP to send and receive files. For example, the TFTP Log below shows
an Avaya IP phone requesting and then being sent its software files.

Related links
Menu Bar Commands on page 43
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Tools Menu
Related links
Menu Bar Commands on page 43
Tools > Extension Renumber on page 75
Tools > Line Renumber on page 75
Tools > Connect To on page 76
Tools > Export > User on page 76
Tools > SCN Service User Management on page 77
Tools > Busy on Held Validation on page 77
Tools > MSN Configuration on page 78
Tools > Print Button Labels on page 78
Tools > Import Templates on page 79
File > Advanced > Generate WebLM ID on page 79
Tools > License Migration on page 80

Tools > Extension Renumber

This command allows the extension numbering of user extensions to be changed. The existing
extension number range to be adjusted can be specified followed by the new start point for the
range after renumbering.

The command does not alter the extension number used for hunt groups but does adjust the
extension numbers of hunt group members.

Related links
Tools Menu on page 75

Tools > Line Renumber

On external trunks Line appearance ID numbers can be assigned to each channel supported in
order to allow that channel or line to be associated with a Line Appearance button on phones that
support button programming. By default all lines are automatically numbered from 701 upwards
when added to the system. This command allows the lines to be renumbered from a different
starting point.

Related links
Tools Menu on page 75
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Tools > Connect To

This option can be used to create H.323 IP line connections between two systems in a multi-site

network, one being the system with its configuration currently loaded in Manager, the other being
selected from a discovery dialog. This option is not available for Server Edition mode.

© Important:

This process will require the systems to be rebooted.

Procedure

1.

o &~ e DN

6.

With the configuration of the first system received from that system and displayed in
Manager, clicking on 2 or Tools | Connect To

A discovery menu is displayed and will list any other systems discovered.
Select the system to which connection is required.
Enter the login name and password for configuration access to that system.

Manager will switch to Small Community Network management mode, displaying the
configuration of both systems.

Click I to save the new configuration back to each system.

Related links
Tools Menu on page 75

Tools > Export > User

This tool is used for systems being migrated to a enterprise environment managed from Avaya
System Manager. Refer to the “Migrating an IP Office or B5800 Branch Gateway to an IP Office
Enterprise Branch” manual for full details of the process. If you want to export a list of users and
extension numbers for other purposes use File > Import/Export.

When performing such a migration, users are not automatically created in System Manager. The

existing users must be exported to an XML file and then that file must be imported into System
Manager.

This feature allows you to export all or selected users users from the current configuration to an
XML file. The default filename is <SystemName>_Users.xml.

The Domain Name field is added to the user names as part of the user identity in the XML file.

Related links
Tools Menu on page 75
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Tools > SCN Service User Management

When managing multiple systems, it may be useful to create a common user name and password
on all the systems for configuration access. This tool can be used to create a new service user
account, SCN_Admin, for configuration access.

This tool is also available within a Server Edition network for administration of the Administrator
account.

This process requires you to have a user name and password for security configuration access to
each of the systems.

Procedure
1. The Select IP Office menu displays the list of discovered systems.
2. Select the systems for which you want to create a common configuration account.
Click OK.
3. A user name and password for security configuration access to each system is requested.

Enter the values and click OK. If the same values can be used for all systems enter those
values, select Use above credentials for all remaining, selected IPOs. If each system

requires a different security user names and password, deselect Use above credentials

for all remaining, selected IPOs.

4. The systems will be listed and whether they already have an SCN_Admin account is
shown.

5. To create the SCN_Admin account on each system and set the password for those
account click on Create Service User.

6. Enter the common password and click OK.
7. The password can be changed in future using the Change Password option.
8. Click Close.

Related links
Tools Menu on page 75

Tools > Busy on Held Validation

Busy on Held is a user feature where, when the user has a call on hold, the system indicate the
user as being busy to any further calls.

The use of Busy on Held in conjunction with multiple call appearance buttons is deprecated. This
command can be used to identify those users who have multiple call appearance buttons and for
whom Busy on Held is currently set.
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When run, it shows a list of the users affected and if selected their Busy on Held setting will be
switched off.

Related links
Tools Menu on page 75

Tools > MSN Configuration

Used to populate the Incoming Call Route table with a range of MSN or DID numbers.

Setting Description
MSN/DID The first number in the set of MSN numbers for which you have subscribed.
© Note:

If you require to find an exact match between the MSN numbers and the
destination numbers, enter a minus (-) sign before the first MSN number.

Destination Where incoming calls with matching digits should be routed. The drop-down list
contains the extensions and groups on the system.

Line Group ID Specifies the incoming line group ID of the trunks to which the DID routing is
applied.

Presentation Digits | Set to match the number of digits from the MSN/DID number that the central
office exchange will actually present to the system.

Range How many MSN or DID number routes to create in sequence using the selected
MSN/DID and Destination as start points. Only routing to user extensions is
supported when creating a range of records.

Related links
Tools Menu on page 75

Tools > Print Button Labels

This option is only enabled if a version of DESI software is also installed on the same PC as
Manager. It can then be used when a system configuration is loaded in Manager.

DESI software can be obtained from the Avaya support web site (http://support.avaya.com) or
from DESI (http//www.desi.com). Currently, though all users are shown, only ETR, M Series, T-
Series, 1400 and 1600 phones are supported by DESI templates.

The text used on the labels:

* If a text label has been added in the user's Button Programming settings, that text label is
passed to the DESI application.

* Note that the DESI application cannot import non-ASCII characters and may render them
incorrectly.

July 2017 Administering Avaya IP Office™ Platform with Manager

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Administering Avaya IP Office™ Platform with Manager

Tools Menu

» Manager will display a warning if it estimates that the user's current text for some buttons
may exceed the label space of the phone type.

* If no text label has been set, the default label for the action currently assigned to the button is
passed to the DESI application.

» Once the labels are shown in the DESI application, the label text can be changed.
1. Load the configuration of the system for which you want to print button labels.
2. Select Tools and then Print Button Labels.

* Name/Extn These are the user name and extension number details of the users in the
system configuration currently loaded in Manager.

* Phone Type This field shows the type of phone, if known, that the user is currently
associated with. The drop down can be used to change the selection if required.

» Expansion Modules If the phone type supports additional button modules, this drop down
can be used to select the type and number of button modules.

* Print Extn This check box is used to select whether the phone button details should be
included in the output passed to the DESI software.

* Print BM1/Print BM2/Print BM3 These check boxes are used to select whether button
module button details should be included in the output passed to the DESI software. These
button will only be selectable if the user's Expansion Modules is set to the number of button
modules.

Click Print via DESIto transfer the information to the DESI application. Within DESI, edit the labels
as required and then print the labels.

Related links
Tools Menu on page 75

Tools > Import Templates

Manager can be used to import and use templates. See Working with Templates on page 547.

Templates are stored in a default location. This command can be used to select a folder containing
other template files and copy those files into the correct default folder.

Related links
Tools Menu on page 75

File > Advanced > Generate WebLM ID

This menu is only used for Server Edition systems. Any system being upgrading from pre-Release
10 ADI licenses must be migrated to PLDS licenses before upgrading. This is done using the files
created by the license migration tool. However, that tool assumes that the system will also be the
licence host. If instead the system is going to use PLDS licenses hosted by a WebLM server, the
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system's web license server host ID is required in addition to the files created by the license
migration tool. This tool generates that additional ID.

To generate the server’s Web License Server Host ID:

1. Click File > Advanced > Generate WebLM ID. The menu displayed varies depending you
indicate the server is virtualized or not.

2. Enter the details of the server:
» UUID: For a virtualized server, the UUID can be obtained as follows:
- Using the command line command: dmidecode -s system-uuid
- From the uuid.bios line of the virtual machines vmx file.

- From the VSphere client, see http://www-01.ibm.com/support/docview.wss?
uid=swg21682150.

3. Click Generate.
4. The system’s host ID is displayed. Copy and paste this value to a text file.

Related links
Tools Menu on page 75

Tools > License Migration

IP Office release 10 and higher supports only the Product Licensing and Delivery System (PLDS)
to manage license files. If you are upgrading from a previous release, you must migrate all of your
pre-R10 licenses (ADI, PLDS, mix of ADI/PLDS, virtual) to R10 PLDS licenses. The license
migration tool extracts all the licensing information from an IP Office system and saves it to a file.
This file can then be used prepare a software upgrade quote in the Avaya One Source
Configurator in order to obtain the required new PLDS R10 licenses.

For Server Edition deployments, the License Migration tool collects licensing information from
every node in the solution.

For a step by step procedure, see Migrating Licenses to PLDS on page 528.
Notes

* Ensure all licenses are loaded on the system before using the license migration tool to
extract the licensing information. For Server Edition deployments, ensure all nodes are online
in order to capture the current view of systems in the solution. This step must be completed
before preparing your R10 software upgrade quote in the the Avaya One Source
Configurator.

* License migration is supported on all IP Office modes, release 6.0 and higher.

* The license migration tool can only be used with an online configuration. The Tools >
License Migration option is disabled for offline configurations.

* The license migration tool is not available on UCM and Application servers. When you run
the license migration tool on a Server Edition server, the tool collects licensing information
from every node in the solution.
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» The generated file can be read but must not be edited. License migration will fail if the file has
been edited.

© Note:

The License Migration Tool is not used for the upgrade of an SMGR WebLM license used in
certain pre-R10 Enterprise Branch deployments. For more information see the Avaya One
Source Configurator.
Related links
Tools Menu on page 75

Security Mode Menus

These commands are available when the Manager is in security configuration mode.
Security Settings > File > Open Security Settings

Displays the Select IP Office menu to select and load a system's security settings. This requires
entry of a user name and password with rights to access security settings of the selected system.

This behavior changes when configuration settings have already be received from a system using
a service user name and password that also has security access rights for that system. In that
case, the system's security settings are automatically loaded without requiring name and
password entry.

Security Settings > File > Close Security Settings

Close the currently open set of security settings received from a system without saving those
settings.

Security Settings > File > Save Security Settings

Send edited security settings back to the system. Requires re-entry of a service user name and
password with access rights for security settings.

Security Settings > File > Reset Security Settings

Reset the security settings of the selected system to defaults. Requires entry of a service user
name and password with access rights for resetting the security settings. This option is not usable
while a set of security configuration settings is loaded.

The command File | Advanced | Erase Security Settings (Default) performs the same action
from Manager configuration mode.

Security Settings > File > Preferences

Displays a window for configuring various aspects of Manager's operation. The window is divided
into a number of tabs.

For a description of the Preferences options, see File > Preferences.
Security Settings > File > Configuration
Returns Manager to configuration mode.
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Security Settings > File > Exit
This command closes Manager.

Related links
Menu Bar Commands on page 43

Embedded File Management Menus

For control units with a memory card installed, the contents of the card can be viewed using
Manager. This view can also be used to add and remove files from the card. This may be useful
when the memory card is being used to store Music on Hold or IP phone firmware files.

» For non-Linux systems, the folders accessed using embedded file management are those on
the SD cards installed in the control unit.

* For Linux based systems, the folder path displays as disk in the embedded file manager.
That path maps onto /opt/ipoffice on the server.

Embedded Voicemail Files

When viewing the memory card, the files related to Embedded Voicemail are visible, however
these files are greyed out (ie. cannot be deleted, downloaded or overwritten).

* Mailbox greetings and messages are shown as . c1p files.

* The language prompts for Embedded Voicemail functions are stored in separate language
sub-folders of lvmail. These are .c11 files.

* Named prompt files for use by Embedded Voicemail auto attendants are stored in the
1lvmail\AAG folder and use the same .c11 or . c23 file formats as the language prompts.
These files can be created from standard .wav files before being downloaded to the memory
card by using the LVM Greeting Utility.

Avaya IP Phone Files

The memory card can be used as the source of files requested by IP Phones when rebooting. For
phones using system DHCP, once the files are loaded onto the card, the TFTP Server IP Address
and HTTP Server IP Address on the System | System tab must be set to match the system's LAN
address.

Viewing a Memory Card

When Advanced | Embedded File Management is selected, the Manager will go through normal
system discovery but will only allow selection of systems which can support a memory card. When
a system is selected, a valid service user name and password for configuration access to that
system is requested. If the system selected does not have a memory card installed, the files view
remains blank and the message TFTP:Received TFTP Error "Not Found" appears in Manager's
status bar.

Changing the Files View
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The type of display used in the Files pane can be changed by selecting from the View menu in
the toolbar.

Open File Settings

Select a system and display the contents of its memory cards if any are present and in use.
Close File Settings

Close the current memory card contents listing without exiting embedded file management mode.
Refresh File Settings

This command can be used to request a file update from the system.

Upload File

This command can be used to select and upload a file to the memory card in the system.
Upload System Files

This command is available with IP500 V2 systems. When this command is selected, Manager will
upload the software files for operation to the System SD card.

A Warning:
After this command is completed, the system is rebooted. This will end all calls and services in
progress.
* It copies the binary files for the system control unit and possible external expansion modules.
* It copies the firmware files used by phones supported by the system.

* For systems configured to run Embedded Voicemail, the Embedded Voicemail prompts for
those supported languages set as the system locale, user locales, incoming call route locales
and short code locales are upgraded. In addition the English language prompts are upgraded
as follows: IP Office A-Law/Norstar SD Cards - UK English, IP Office U Law/PARTNER SD
Cards - US English.

Backup System Files

This command is available with IP500 V2 systems. When selected, Manager copies the folders
and files from the System SD card's /primary folder to its /backup folder. Any matching files
and folders already present are overwritten. This action can be included as part of the system's
automatic daily backup process (System | System | Automatic Backup).

Restore System Files

This command is available with IP500 V2 systems. When selected, Manager copies the folders
and files from the System SD card's /backup folder to its /primary folder. Any matching files
and folders already present are overwritten.

A Warning:

After this command is completed, the system is rebooted. This will end all calls and services in
progress.

Upgrade Binaries

This command is available for IP500 V2 systems that have a system SD card and Optional SD
card installed.
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When this command is selected, all files except config.cfg and keys. txt files in the Optional SD
card's \primary folder are copied to the System SD card.
A Warning:

After this command is completed, the system is rebooted. This will end all calls and services in
progress.

Upgrade Configuration

This command is available for IP500 V2 systems that have a system SD card and Optional SD
card installed.

When this command is selected, any config.cfg and keys. txt files in the Optional SD card's
\primary folder are copied to the System SD card.
A Warning:

After this command is completed, the system is rebooted. This will end all calls and services in
progress.

Upload Phone Files

This command is available for IP500 V2 control units. When this command is selected, Manager
copies the software files relating to phone firmware to the memory card. For IP500 V2 control
units, use Upload System Files.

Copy System Card

This command is available for IP500 V2 systems that have an Optional SD card installed in
addition to the mandatory System SD card. When this command is selected, the system will copy
the folders and files on its System SD card to the Optional SD card. Any matching files and
folders already present on the Optional SD card are overwritten.

This process takes at least 90 minutes and can take longer.
Configuration

This command will exit Embedded File Management and return Manager to configuration editing
mode.

Related links
Menu Bar Commands on page 43
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Chapter 5: Manager User Interface

This section of the documentation covers the operation of Manager when being used to edit the
configuration of a system running in Standard Mode. Much of it is also applicable for when also
editing the configuration of systems running in Server Edition mode. Additional Server Edition Mode
functions are detailed in the next chapter.

Related links
Title Bar on page 85
Toolbars on page 85
The Navigation Pane on page 87
The Group Pane on page 88
The Details Pane on page 90
The Error Pane on page 92
The Status Bar on page 94

Title Bar

The Manager title bar shows the following information.
* The Manager application version.
* The system name of the system from which the currently loaded configuration was received.
* The software level of the system's control unit.

» The service user name used to receive the configuration and that user's associated operator
rights.

Related links
Manager User Interface on page 85

Toolbars

Manager displays the following toolbars:

* Main Toolbar
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» Navigation Toolbar
* Details Toolbar

Related links
Manager User Interface on page 85

The Main Toolbar

The Main toolbar is displayed at the top of the Manager window, just below the menu bar. This
toolbar is also available when Manager is in security mode. However many of the controls will not
function in security mode.

P82 [ BLBLEL D oo 2

2 Open Configuration from a System Advertises to the address currently shown in the Manager's
title bar for any available systems. A list of responding systems is then displayed. When a system
is selected from this list, a valid user name and password must be entered. Equivalent to File |
Open Configuration.

% Open Configuration File Open a configuration file stored on a PC. The button can be clicked to
display a browse window. Alternatively the adjacent = arrow can be used to drop-down a list of the
last 4 previously opened configuration files. Equivalent to File | Offline | Open File.

i save Configuration File The action of this icon depends on whether the currently loaded
configuration settings were received from a system or opened from a file stored on PC. If the
former applies, the menu sending the configuration back to the system is displayed. In the latter
case, the file changes are saved to the original file. Equivalent to File | Save Configuration.

4] Collapse All Groups Causes all = symbols in the navigation pane to be collapsed to # symbols.
=2 Show/Hide the Navigation Pane
] Show/Hide the Group Pane

I\ Show/Hide the Error Pane

+ Validate Configuration Runs a validation on all the currently loaded configuration settings. The
results appear in the error pane. By default the configuration is automatically validated when
loaded and changes are validated when made, however the validation preferences can be
changed through File | Preferences | Validation.

== Create New Configuration Runs a series of dialogs that create a new configuration from
scratch.

< Connect To For a standalone system, start the process of adding it to a multi-site network. Not
available in Server Edition mode.

Tf Voicemail Pro Client Launch the Voicemail Pro client if also installed on the Manager PC.
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Server Edition Solution View Switch to the solution view. This option is only shown when
Manager is running in Server Edition mode.

The Navigation Toolbar

This toolbar provides drop down lists which can be used to navigate to particular records in the
configuration settings. The selected options in the navigation pane, group pane and the details
pane are synchronized with the navigation toolbar and vice versa. This toolbar is particularly
useful if you want to work with the group pane and or navigation pane hidden in order to maximize
the display space for the details pane.

|*| ser * BRogers:Z06 - J

This toolbar is not available when Manager is in security mode.

The Details Toolbar

This toolbar is shown in the top-right of the details pane. The options within the toolbar may vary
or be greyed out depending on the actions allowed for a particular configuration record.

T SR

Cr Create a New Record The » arrow is used to select the record type to be created. For
example; when adding an extension clicking ~ may allow selection of a VolP Extension or IP
DECT Extension.

v’|c:|:=~

= Export as Template Save the current record as a tempate. The template can then be used to
create new records.

¥ Delete Current Record Delete the currently displayed record.

+" Validate Current Record By default records are validated when opened and when edited. This
is set through the Manager application's validation settings.

< > Previous Record/Next Record Click < or > at the top-right to move to the previous or next
record.

The Navigation Pane

This pane shows icons for the different types of record that the configuration can contain. Each
type is followed by the number of records of that type already in the configuration. When Manager
is used in security mode, this pane is also used by Manager in security mode to display records
for security settings.
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Selecting an icon displays the matching records in the group pane, navigation toolbar and details
pane. Note that Manager is used to configure different types of system. Therefore the icons shown
may vary depending on the type of system you are configuring. For descriptions of the different
icons refer to Configuration Settings.

The information in the pane also depends on whether the group pane is visible or not. If the group
pane is visible, the navigation pane just shows icons for accessing which types of records should
be shown in the group pane. The group pane can then be used to select which of those records is
currently shown in the details pane. If the group pane is not visible, the navigation pane shows
icons for each type of records and under those icons for each individual record. The navigation
pane can then be used to select which of those records is currently shown in the details pane.

Related links
Manager User Interface on page 85

Expanding and Collapsing the Navigation Tree

Where = or = icons appear in the pane, they allow the structure to be expanded or collapsed.
When the group pane is hidden, ® and = icons are shown for each record type and allow the
record type to be expanded to display all the existing records of that type.

The 4l icon in the main toolbar can also be used to collapse all the expanded record types shown
in the navigation pane.

The Group Pane

This pane lists all the records that match the type selected in the navigation pane or navigation
toolbar. The list can be sorted by clicking on a column heading. Selecting a record in this pane
displays its details in the details pane.

The icons used in the pane may vary according to the state of the record. For example, some of
the users shown in this example have been configured for hot desking. This pane is also used by
Manager in security mode to display records for security settings.

Related links
Manager User Interface on page 85

Sorting the List
About this task

The records shown in the group pane can be sorted using any of the columns displayed.
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The Group Pane

Procedure
1. To sort the list using the details in a particular column, click on the column header.

2. Clicking on the same column header again reverses the sort order.

Customizing the Columns Displayed

About this task

For each record type, which details are shown in the group pane can be customized. Also the
order of the column can be adjusted.

Procedure
1. Right-click on the pane and select Customize Columns.

2. To add a column, selects its name in the left-hand Available Columns list and click >>to
move it to the right-hand Selected Columns list.

3. To remove a column, select its name in the right-hand Selected Columns list and click <<
to move it to the left-hand Available Columns list.

4. To change the order of the Selected Columns, click on a column name and use the * and
V controls.

5. Click OK.

Changing the Column Widths

About this task
Procedure

1. In the column headers, place the cursor over the border between two columns.

2. When the cursor changes to a double headed arrow with a bar through it, click and hold
the cursor.

3. Drag the border to the required position and release the cursor.

Adding a New Record
About this task
The group pane can be used to add a new record of the type currently displayed.
Right-click on the pane and select New.

Ar» arrow symbol next to New indicates that you can select a particular type of new record to
create. Click the arrow and select an option from the list.
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Procedure

1. Use the details pane to configure the new record.

2. Click OKin the details pane.

Deleting an Record

About this task
Procedure

1. Select the record to be deleted by clicking on it.

2. Right-click on the pane and select Delete.

Validating an Record

About this task
Procedure

1. Select the record to be validated by clicking on it.

2. Right-click on the pane and select Validate.

Show in Groups
About this task

This command groups the items shown in the group pane. The grouping method will vary

depending on the record type being listed. For example, short codes are grouped based on short

code feature type such as all forwarding short codes together.

Procedure

Right-click on the pane and select Show In Groups.

The Details Pane

Whenever a selection is made through the group pane or the navigation toolbar, the settings for

the matching record are shown in the details pane. This pane is also used by Manager in security

mode to display records for security settings.

The details are grouped into tabs. The tabs available may vary depending on what particular type

of record is being viewed.
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The Details Pane

Individual settings may also be grayed out. This indicates that they are either for information only
or that they cannot be used until another setting is enabled.

The top-left icon indicates the following:

Locked Indicates that you can view the settings but
cannot change them.

W
W —
W —

Editable Indicates that you can change the settings
if required.

=

Changed Indicates that the settings have been
changed since the tab was opened. Click OK to
save the changes or Cancel to undo.

Various icons may appear adjacent to settings:

::_I

Locked Setting The setting cannot be changed
through this tab. This icon appears on user settings
where the user is associated with User Rights that
controls the setting.

Information Indicates a value which does not have
to be set but may be useful if set.

Warning A warning indicates a configuration setting
value that is not typical and may indicate
misconfiguration.

Error An error indicates a configuration setting
value that is not supported by the system. Such
settings may cause the system to not operate as
expected.

Related links

Manager User Interface on page 85
Managing Records on page 91

July 2017

Managing Records

Procedure
1. Edit a record

a. The method of entering a record varies as different fields may use different methods.
For example text record boxes or drop down lists.

b. By default when changes are made, they are validated once another field is selected.

See File | Preferences | Validation.

c. Click on OK at the base of the details pane to accept the changes or click on Cancel

to undo the changes.
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2. Add a record.

a. Click = at the top-right of the details pane.

b. Select the type of record required. For example, with extensions you can select from
H.323 Extension or SIP Extension.

3. Delete a record.
Click * at the top-right of the details pane.
4. Validate a record.
Click « at the top-right of the details pane.
5. Move to the previous or next record.
Click <or > at the top-right to move to the previous or next record.
6. Select a new tab.

a. To view the detail stored on a particular tab, click on the name of that tab.

b. |f the tab required is not shown, use the "¢ * controls if shown on the right to scroll
through the available tabs. The tabs available may vary depending on what particular
type of record is being viewed.

Related links
The Details Pane on page 90

The Error Pane

Validation is a process where Manager checks configuration records for errors or for values for
which it regards as requiring a warning. The results of this checking are shown by icons next to
the field that caused the error or warning, All errors and warnings are also listed in the Error Pane.

By default validation is performed automatically whenever a configuration file is opened and when
any field is edited. However, if required, the use of automatic validation can be controlled through
the settings on the File | Preference | Validation tab.

Icons

The icons used for errors and warnings are as follows. These are shown in the error pane and
also next to the related field in the details pane. In the details pane, the error or warning
description is shown when the cursor is hovered over the icon.

& Error An error indicates a configuration setting value that is not supported by the system. Such
settings are likely to cause the system to not operate as expected.

i Warning A warning indicates a configuration setting value that is not typical and may indicate
misconfiguration.

L Information Typically indicates a setting which may be useful to set.
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The Error Pane

Related links
Manager User Interface on page 85

Altering the Automatic Validation Settings
About this task

The settings for automatic validation are adjustable.
Procedure
1. Select File | Preferences.
2. Select the Validation tab.
Select the options required.
+ Validate configuration on open Automatically validate configuration files when they

are opened in Manager.

+ Validate configuration on edit Validate the whole configuration when OK is clicked
after editing a record. For large configurations, disabling this option removes the delay
caused by validating the configuration after every edit.

* Prompt for configuration validation on save or send If selected, when saving or
sending a configuration, a prompt is displayed asking whether the configuration should
be validated. If validation is selected and error are found, the send or save process is
canceled. This option is disabled if Validate configuration on edit is selected.

3. Click OK.

Revalidating Configuration Settings
About this task

If necessary, you can force a validation check of the whole configuration or of the current record
shown in the details pane.

Procedure
1. To validate the whole configuration, click + in the main toolbar.

2. For a particular record, click « in the details pane.

Viewing an Error or Warning
About this task

Procedure
1. Clicking on an error or warning in the error pane will load the matching record tab into the
details pane.
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2. The < and > can be used to move to the next error or warning in the error pane.

The Status Bar

The status bar at the base of the Manager screen is used to display icons and messages about
communications between Manager and systems. If the Manager is also acting as a BOOTP and
TFTP server it will also show BOOTP and TFTP messages.

A padlock icon is displayed whenever the Manager communications settings are set to secure.
This indicates all attempted configuration and security settings exchanged will be attempted over a
secure TLS link:

Status bar messages display information about communications the Manager application receives.
Some typical status bar messages are listed below.

Ready

This message is normally seen when Manager has just started and no configuration has been
received.

Received BOOTP request for 001125465ab2, unable to process

Manager is acting as a BOOTP server. It has received a BOOTP request that does not match a
system listed in its BOOTP records. The cause may be a device or application, other than an IP
Office, that also uses BOOTP.

TFTP: Received TFTP Error "NotFound" from 192.168.42.1

An attempt to receive settings from or send settings to the system failed. The most probable cause
is @ name or password error.

TFTP: Received 17408 bytes for Marks_Test

Manager has received configuration settings from the named system using TFTP.
Sent 100% of C:\Program Files\Avaya\lP Office\Manager\b10d01b2_3.bin
Manager has sent the indicated file in response to a BOOTP request.

Related links
Manager User Interface on page 85

Configuring the Interface

The Manager configuration settings interface can be customized in a number of ways. These
changes are remembered the next time Manager is started.
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Related links
Manager User Interface on page 85

Resizing the Manager Window
About this task
When the Manager window is not maximized or minimized, it size can be adjusted.
Procedure
1. Place the cursor over the edge of the current window.
2. When the cursor changes to a double-headed arrow, click and hold the cursor.

3. Drag the edge to the required position and then release the cursor.

Moving the Border Between the Panes

About this task

The border between the visible panes can be adjusted. Note that this is a proportional rather than
exact position. If the whole window size is altered, the border position may also move.

Procedure
1. Place the cursor over the border between two panes.

2. When the cursor changes to a double headed arrow with a bar through it, click and hold
the cursor.

3. Drag the border to the required position and release the cursor.

Showing or Hiding Toolbars
About this task
The different toolbars can be hidden if not required.
Procedure
1. Select View and then Toolbars.
Those toolbars currently shown are indicated by a tick mark.

2. To show or hide a toolbar, click on its name.

July 2017 Administering Avaya IP Office™ Platform with Manager 95

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Administering Avaya IP Office™ Platform with Manager

Manager User Interface

Moving Toolbars
About this task

The position of the Manager toolbars can be moved. Note that when moving a toolbar, the other

toolbars and panes may adjust their size or position to ensure that all the toolbar icons remain
visible.

Procedure
1. Place the cursor over the end of the toolbar.
2. When the cursor changes to a four-way arrow, click and hold the cursor.

3. Move the toolbar to the required position and release the cursor.

Showing or Hiding Panes
About this task

The details pane cannot be hidden. The navigation pane, group pane and error pane can be
shown or hidden. To do this use either of the following methods.

From the main toolbar, use the following icons:
* & Hide/Show Navigation Pane.
* &l Hide/Show Group Pane.

1\ Hide/Show Error Pane.

or
Procedure
1. Select View.
Those panes currently shown are indicated by a tick mark.

2. To show or hide a pane, click on its name.

Changing the Position of the Details Pane
About this task

When the group pane is visible, the details pane is shown either below it or to its right. This
position can be adjusted.

Procedure

1. Select View and then Details Pane.
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2. The current position setting is indicated by a tick mark.

3. To select a position, click on it.

Changing the Size of Configuration Icons
About this task
The size of the icons used on the navigation pane and details pane can be adjusted.
Procedure
1. Select File and then Preferences.
2. Select the Visual Preferences tab.

3. Select the required icon size from Small, Medium or Large.
4. Click OK.

Changing Tab Display
About this task

For records with more than two tabs, you can select whether Manager should use '* * controls or
arrange the tabs as multiple rows when necessary.

Procedure
1. Select Files | Preferences | Visual Preferences.
2. Select Multiline Tabs.
3. Click OK.
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Chapter 6: Working with the Server Edition
Manager User Interface

Related links

Server Edition Solution View on page 98

System Inventories on page 101

Default Settings on page 101

Record Consolidation on page 102

Telephone Features Supported Across Server Edition and SCN Networks on page 103

Server Edition Solution View

When the configuration of a Server Edition solution is loaded into Manager, Manager starts with
the Server Edition Solution View menu. This menu includes the system inventory of the servers,

links for launching various functions and a summary table of the servers and the links between the
servers.

Displaying the Server Edition Solution View

Manager normally starts with the Server Edition Solution View when the configuration for a Server

Edition network is loaded. However, if required, to return to the solution view do one of the
following.

* Click on the | Server EditionSolution View icon in the toolbar.
* Click on the =37 Solution icon in the navigation pane.
Interpreting and Using the Network Table

The table at the bottom of the solution view give a quick overview of all the servers and whether
their configuration was loaded into Manager.

Description This column describes the type of server being detailed by the row. It also includes a

status indicator for the configuration file that Manager has loaded for the server.

Green - Configuration Loaded The configuration of the server has been
successfully retrieved and can be edited in Manager.

Table continues...
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* = Yellow - Offline Configuration Loaded The configuration loaded is an offline
configuration. This will appear for a server that has been added to the solution
when the physical server is not currently connected on the network and Create
Offline Configuration was selected. The offline configuration file is stored on and
retrieved from the primary server until it can be replaced by or replace the actual
server configuration.

* ¥ Red - Configuration Not Loaded There is no configuration for the system
loaded even though the solution configuration includes an entry for the server. This
will appear for a server that has been added to the network when the physical
server is not currently connected on the network and Create Offline
Configuration was not selected. If may also appear if the server is currently not
contactable.

* ® Grey - No Connection This icon is used in conjunctions with the others to
indicate that there is no current connection to the server. For example:

+ In conjunction with a green icon, it indicates that the server for which a
configuration has been loaded cannot be detected on the network. This may be a
temporary issue caused by that particular server rebooting following a
configuration change.

* In conjunction with a red icon, it indicates that the server for which a configuration
has not been loaded has now been detected on the network. Saving and reloading
the solution configuration may resolve the issue.

Name This is the server name as taken from its configuration file. Offline is shown if no
configuration file is available.

Address The IP address of the server. This is the address that is used when Manager
attempts to retrieve the servers configuration when loading the solution
configuration.

Primary Link This value indicates the configuration settings of the H.323 IP trunk between the

primary server and the server indicated by the row. It should state Bothway. If it
states anything other, that indicates a mismatch in H.323 IP trunk configuration
between the system and the primary server. To correct this, right-click on the row
and select Connect to Primary.

Secondary Link

This column is only shown after a secondary server has been added to the
configuration of the solution. The value indicates the configuration settings of the H.
323 IP trunk between the secondary server and the server indicated by the row. It
should state Bothway. If it states anything other, that indicates a mismatch in H.323
IP trunk configuration between the system and the secondary server. To correct this,
right-click on the row and select Connect to Secondary.

Users Configured

This column summarizes the number of users (other than NoUser) configured on
the server. A total for the whole network is shown in the Solution row.

Extensions Configured

This column summarizes the number of extensions configured on the server. A total
for the whole network is shown in the Solution row.

Right-clicking on a server in the table may present a number of action. The actions available vary
with the current state of the network configuration.

* Remove Remove the server from the solution configuration.
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» Connect to Primary Repair the configuration of the H.323 IP trunks between the server and
the primary server.

* Connect to Secondary Repair the configuration of the H.323 IP trunks between the server
and the secondary server.

» Create Offline Configuration Create an offline configuration file for a server for which no
actual configuration has been loaded. The Offline Configuration menu will be displayed
followed by the Initial Configuration menu for the server type. The offline configuration file is
saved on the primary server.

Open...

The right side of the solution view contains links to open the following tools.
» Configuration
» System Status

* Voicemail Administration

Resiliency Administration

On-boarding

IP Office Web Manager
* Help

Set All Nodes to Select

Use this command to implement Select licensing in a IP Office Server Edition Solution. All
systems in the solution must use the same licensing type.

Set All Nodes License Source

All systems in the Server Edition solution must use the same license source. The license source is
defined by the configuration setting License | License | License Source. Use this setting to set
all nodes to use the same license source.

Add...
Add a Server Edition Secondary Server or an Server Edition Expansion System.

When you add a system, IP Office Lines connecting the new system are configured with default
settings.

0 Important:

If the Manager setting File > Preferences > Preferences > SE Central Access is set to On,
an |IP Office Line is not configured from the new system to the Server Edition Primary Server.
The status of the new system is Offline. You must configure an IP Office Line from the new
system to the Server Edition Primary Server.

Related links
Working with the Server Edition Manager User Interface on page 98
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System Inventories

Manager can be used to display a system inventory for any of the servers in the Server Edition
solution. The system inventory is a quick summary of key settings and information about the
server. It can also display an overview system inventory for the whole Server Edition solution.

Displaying a Server's System Inventory

The method for displaying the system inventory depends on what is currently being displayed by
Manager.

In the Server Edition Solution View, using the table at the bottom of the menu, click on the server
for which you want to display the system inventory. Click on Network for the inventory of the
Server Edition network.

or

In the navigation pane, click on the £=<7 icon of the server for which you want to display the system
inventory. Click on the =<7 Network icon for the inventory of the Server Edition network.

Related links
Working with the Server Edition Manager User Interface on page 98

Default Settings

Most of the defaults for systems in a Server Edition solution match those of individual IP Office
systems as detailed in the Configuration Settings section. The table lists some differences.

All auto-create extension and auto-create user settings for IP devices are set to off.

Settings Primary Server Secondary Server Expansion System
System Time Hidden. Time taken SNTP from the primary server.
Settings from host server.
Voicemail Voicemail Pro Centralized Voicemail to the primary server
Alarms Syslog relay all alarms | Syslog relay all alarms to the primary server.

to the local host.

IP Address Specified during initial configuration menu.

Lines Physical - - Auto-created
IP Lines H.323 line to the H.323 line to the H.323 line to the
secondary and each primary and each primary and to the
expansion system. expansion system. secondary if present.
Backup to secondary. Backup to primary. No backup.
Extension Physical - - Auto-created but no
base extension setting.

Table continues...
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Settings Primary Server Secondary Server Expansion System
IP None None None

User None None None

Hunt Group None Not allowed Not allowed

Incoming Call Route None Replicated from primary.

Directory Stored on the primary | Configured to obtain system directory from the

primary server.
User Rights None Replicated from primary.
ARS 50:Main Short code to Short code to primary | Short code to primary
secondary and to secondary if
present.
Related links

Working with the Server Edition Manager User Interface on page 98

Record Consolidation

By default, to maintain the configurations of the systems in a Server Edition solution in synch,
certain types of configuration records are consolidated. That is, they are replicated in the individual
configuration of each system in the network. Consolidation is applied to:

* Short Code System short codes only.
» Time Profile

» Account Code

* User Rights

* Location Though consolidated, the Emergency ARS and Fallback System field settings of
each location are configured separately at individual system level.

* Incoming Call Route For release 9.1 and higher, record consolidation is no longer applied to
Incoming Call Routes.

In Web Manager, consolidated records are shown at the top the Solutions page, under Solution
Objects. In Manager, operation of record consolidation is controlled by the File > Preferences >
Preferences setting Consolidate Solution to Primary Settings. By default that setting is
selected. The setting has the following effects.

If Consolidate Network to Primary Settings is selected:

» Entry and administration of consolidated records is performed only at the solution level
except for the Emergency ARS and Fallback System field settings of location records.

» Those records are then automatically replicated in the configurations of all the systems in the
solution but, except for locations, are still only visible and editable at the solution level.

* When the configurations are loaded or when this setting is changed to become selected, if
any inconsistency between records are found, a Consolidation Report is displayed. This
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report allows selection of whether to update the system to match the primary or to update the
primary to match.

If Consolidate Network to Primary Settings is not selected:

» Entry and administration of consolidated records can be performed at both the solution and
individual system levels.

* Records entered and edited at the solution level are automatically replicated in the
configurations of all the systems in the solution. Each record displays a label on the record
indicating that it is a record that is shared across the solution.

* If a shared record is edited at the individual system level, that copy of the record is no longer
shared with the other systems. It will not be updated by any changes to the solution level
version of the same record.

* No consolidation checking for inconsistencies is done when the configurations are loaded.

Related links
Working with the Server Edition Manager User Interface on page 98

Telephone Features Supported Across Server Edition and
SCN Networks

Each system running IP Office in a multi-site network acts as a self-contained IP Office telephone
system. In addition to the remote systems sharing knowledge of user and hunt group extension
numbers, the following additional telephony features are supported between systems in a multi-
site network. Features not listed are not supported across the multi-site network.

« Absence Text

» Advertised Hunt Groups Hunt groups set to advertised can be dialed by users on other
systems

» Anti-tromboning Calls routed across the multi-site network and back to the originating
system are turned back into internal calls on the originating system only.

» Break Out Dialing

» Call Park / Unpark Call

 Call Pick-up Extension

» Call Tagging

» Callback When Free

» Centralized Call Log

» Centralized Personal Directory
» Conference

* Distributed Hunt Groups
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Distributed Voicemail Server Support When using Vociemail Pro, each system can support
its own Voicemail Pro server.

Enable ARS / Disable ARS

Extension Dialing Each system automatically learns the user extension numbers available
on other systems and routes calls to those numbers.

Resiliency Options

Fax Relay

Follow Me Here / Follow Me To

Forwarding

Hold Held calls are signalled across the network.
Internal Twining

Intrusion Features

Mobile Call Control Licensed mobile call control users who remote hot desk to another
system take their licensed status with them.

Music On Hold Source Selection

Remote Hot Desking

Set Hunt Group Out of Service / Clear Hunt Group Out of Service
Transfer Calls can be transferred to network extensions.

User DSS/BLF Monitoring of user status only. The ability to use additional features such as
call pickup via a USER button will differ depending on whether the monitored user is local or
remote. Indication of new voicemail messages provided by SoftConsole user speed dial icon
is not supported.

User Profile Resilence When a user hot desks to another system, they retain their Profile
settings and rights.

Related links
Working with the Server Edition Manager User Interface on page 98

Configuring Small Community Networking on page 744
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Chapter 7: Security Administration

The security settings are stored on the system and are separate from the system's configuration
settings. To change a system's security settings, Manager must first be switched to security mode
by selecting File | Advanced | Security Settings from the menu bar.

Security settings can only be loaded directly from a system. These settings cannot be saved as a
file on the local PC, nor do they appear as a temporary file at any time. You can optionally secure
the link between the system and Manager for configuration and security settings exchanges. By

default Manager and the system will always attempt to use the original, unsecured link.

Administration security is achieved using a number of optional cryptographic elements:
» Access control to prevent unauthorized use.
» Encryption to guarantee data remains private.
* Message Authentication ensures data has not been tampered with.
* |dentity assures the source of the data.

Related links
Service Users on page 105
Access Control on page 112
Encryption on page 112
Message Authentication on page 113
Certificates on page 114
Implementing Security on page 115
SRTP on page 117

Service Users

Access to system settings is controlled by Service Users and Rights Groups stored in the
control unit's security settings. These are stored separately from the system's configuration
settings. All actions involving communications between Manager and the system require a service
user name and password. That service user must be a member of a Rights Group with
permissions to perform the required action.

Security Administrator: The security administrator can access the system's security settings
and the account cannot be removed or disabled.
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In addition a further security setting can force this account to have exclusive security rights,
preventing another Service Users from security settings access.

Service Users: Each service user has a name, a password and is a member of one or more
Rights Groups. The accounts may be in one of a number of states, including enabled, disabled,
locked out and enforced password change.

IP Office supports a maximum of 64 Service Users.

Rights Groups: The Rights Groups to which a service user belongs determine what actions they
can perform. It can be thought of as a role, but has much more flexibility. Actions available to
Rights Groups include configuration, security actions and maintenance actions. Where a service
user has been configured as a member of more than one Rights Group, they combine the
functions available in the separate Rights Groups.

IP Office supports a maximum of 32 Rights Groups.

Application Roles: In addition to rights of IP Office service access, Rights Groups can also
contain ‘Roles’ for IP Office Manager and Web Manager; the settings of these roles determine
what rights of access the Service User has within that application. It allows more granularity of
access control within that application than the basic service access rights. For example the IP
Office configuration service has two basic rights of access: Read All and Write All. However the
Manager Operator roles can further constrain what can be written, viewed or edited.

Example Rights Assignment

h . . .
. . Operator Rights e Configuration
@ Service User X<—>( @ Rights Group &) «—E=52cs £ Somnyraten — i Sohine
-

Administrator riEhls k
Service User Y-=-=—> &Rights Group B Reboot 2 = External . Voicemail
u - Voicemail Pro 9 ﬁz.,_ Service ? Settings

0 Service User Z Administrator -

_|: &Rights Group C
Security &% Security — . Security

S #5. Administration ;
Administrator & Service Settings

In the above illustration:

» Service user X can read and write the configuration. However they can only edit Operator
settings and can only make changes that can be merged.

» Service user Y can read and write the configuration, edit all settings and make changes that
require reboots or merges. They can also access the Voicemail Pro settings.

» Service user Z can read and write the configuration, edit all settings and make changes that
require reboots. They can also access the security and the Voicemail Pro settings.

* The Security Administrator can only access the security settings.
Changing Administrative Users and Rights Groups

IP Office Manager and Web Manager allow modification of Service Users and Rights Groups.
Prior to any change, the following should be considered:

» A Server Edition or multi-site IP500 V2 deployment must have consistent Service Users and
Rights Groups. IP Office Manager and Web Manager have synchronization tools to assist.
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« All changes must follow security best practices such as password policy and minimal rights of
access.

Security Settings on Upgrade

When the IP Office system is upgraded and new rights groups or services added, existing users
will only be granted the new rights if the Service Users’ accounts are at default. This prevents
unexpected changes of rights on upgrade. If access to these new rights or services are required,
they must be added manually after the upgrade process has been completed.

Related links
Security Administration on page 105
Default Service Users and Rights Groups on page 107

Default Service Users and Rights Groups

Security Administrator Account
The following Security Administrator account is present on first startup and security settings reset.

Name Default Usage Rights Group Notes
Account Membership
Status
Security Enabled, This is the default security | Implied all Cannot be removed or
administration account. security rights disabled
Force
password Has all rights to all security
change management and
maintenance services

Service User Accounts
The following Service User accounts are present on first start-up and security settings reset.

Name Default Usage Rights Group Notes
Account Membership
Status

Administrator Enabled, This is the default account | Administrator, Should not be removed or
Force used for system System Status, | disabled

configuration using the IP Business Partner
Office and Web Manager
applications, including one-
X Portal/Voicemail Pro
administration.

password Should not be renamed

change

Has all rights to all
management and
maintenance services
including security settings.

Table continues...
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Name Default Usage Rights Group Notes
Account Membership
Status
EnhTcpaService Enabled This account is used for TCPA Group Although not enforced, the
one-X Portal for IP Office password should be
connections to the system. change as soon as possible
in both IP Office and one-X
Portal
Enable only when one-X
Portal deployed
IPDECTService Disabled This account is used for IPDECT Group Enable only when DECT
DECT R4 system R4 deployed and
provisioning provisioning mode active
BranchAdmin Disabled This account is used for SMGR Admin Enable only when SMGR
System Manager (SMGR) deployed; will be enabled
access in a branch when the Initial
deployment Configuration Utility (ICU)
run and SMGR
administration selected.
Must not be renamed
BusinessPartner | Disabled Similar access rights to Business Partner | Should be removed/
Administrator and can be disabled unless required
used as a separate
account for Business
Partners
Maintainer Disabled Maintenance account Maintainer Should be removed/
without edit configuration or disabled unless required
security access.
Can be used for Manager
(read-only), Web Manager
(read-only), System Status
Application (SSA), Backup/
Restore, System Monitor,
Upgrade

Rights Groups

The following Rights Groups are present on first start-up and security settings reset.

Name Usage

User

Rights Group

Notes

Administrator
Group

Allows full access to the IP
Office Manager application
to configure the system.

No security or maintenance
access

Administrator
permitted

All IP Office Manager operations are
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Name

Usage

Rights Group
User

Notes

Manager Group

Allows limited access to the
IP Office Manager
application to configure the
system.

All IP Office Manager operations
permitted except:

* Delete Short Code
* View LAN2 Settings

Operator Group

Allows limited access to the
IP Office Manager
application to configure the
system.

All IP Office Manager operations
permitted except:

* New object creations
» View LAN2 Settings
» Delete Directory

* Delete ICR

System Status
Group

Allows limited access to the
SSA and Sys Monitor
applications.

Administrator

Sys Monitor access right only checked
when using service users with Sys
Monitor

TCPA Group

This group is used by the
one-X Portal for IP Office
application.

EnhTcpaService

IPDECT Group

This group is used by the
DECT R4 master base
station to extract DECT
settings from IP Office.

IPDECTService

SMGR Admin

This group is used by
SMGR to configure IP
Office.

BranchAdmin

Do not change the access rights

Security Admin

Allows access to security
settings only

Backup Admin

Allows access to all backup
and restore services only,
including one-X Portal

Upgrade Admin

Allows access to the
upgrade service

Allows upgrade of both IP Office
applications and operating system

System Admin

Allows configuration of IP
Office, one-X Portal and
Voicemail Pro

Maint Admin Allows configuration of IP - Typically used for maintenance
Office, one-X Portal and personnel
Voicemail Pro along with
backup, restore and
upgrade
Table continues...
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Name

Usage

Rights Group Notes

User

Business Partner

Full access to all
configuration, security and
maintenance services.

Administrator,
BusinessPartner

Customer Admin

Web Management , one-X
Portal and Voicemail Pro
administration

- No IP Office manager access

Maintainer

Allows configuration view
only, along with SSA, Sys
Monitor backup, restore and
upgrade

Typically used for maintenance
personnel with no need for
configuration changes

Rights Group Assignment

Service Access Right Rights Group
¢ 1 = Administrator ¢ 5=TCPA Group
CIRUE + 6 = IPDECT Group
* 2 =Manager Group | 7 = SMGR Admin
e 3 = Operator Group
* 4 = System Status
Group
1 2 3 4 5 6 7
Configuration Read all configuration | « S S
Write all configuration | « o+ o+
Merge configuration o o o
Default configuration o o o
Reboot/Shutdown o o o
immediately
Reboot when free o o o
Reboot at time of day
Security Admin Read all security
settings
Write all security
settings
Reset all security
settings
Write own service user
password
System Status System Status Access o
Read all configuration o
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Service Users

Service Access Right Rights Group
¢ 1 = Administrator ¢ 5=TCPA Group

Group * 6 = IPDECT Group
e 7=SMGR Admin

e 2 = Manager Group
e 3 = Operator Group

e 4 = System Status
Group

1 2 3 4 5 6 7

i

System Control
Sys Monitor o

Enhanced TSPI Enhanced TSPI o
Access

HTTP DECT R4 Provisioning o
Web Services Security Read Al
Security Write All

Security Write Own
Password

Config Read All
Config Write All
Backup

i

i

Restore

LS L L L

Upgrade

External Voicemail Pro Basic

Voicemail Pro Standard

Voicemail Pro o
Administrator

One-X Portal
Administrator

one-X Portal Super
User

Web Control
Administrator

Web Control Security
WebRTC Administrator

Related links
Service Users on page 105
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Access Control

Access to configuration, security settings and SSA is controlled by the use of service users,
passwords and Rights Groups. All actions involving communications between the Manager user
and the system require a service user name and password. That service user must be a member
of a Rights Group configured to perform the required action.

£ service User x-4—e €% Rights Group &) Elperrjltn:-r Riights » o Configuration lﬂI:l:un_figlural:il:un
FIgE  ervice S ettings
ﬂ Service User Y #——% " €8 Rights Group B ) # Adminiztrator Rights
Reboat Trai
ﬂ Service Uzer 2
..ﬂ} Rightz Group C 41 .
>  # Security " Security

ﬂ SE':L_‘"_t-'" N Administration Settings
Adriniztrator S ervice

:'] Adit

In the example illustrated above:

+ Service user X can read and write the configuration. However they can only edit Operator
settings and can only make changes that can be merged.

+ Service user Y can read and write the configuration, edit all settings and make changes that
require reboots.

+ Service user Z can read and write the configuration, edit all settings and make changes that
require reboots. They can also access the security settings.

» The Security Administrator can only access the security settings.

Granular access to configuration objects group in Web Manager

Using IP Office Manager, administrators can allow or restrict Service Users from accessing
configuration objects in IP Office Web Manager. Administrators can provide Read or Write access
to configuration depending on the role of Service User. If a Service User does not have read or
write access to a Configuration object, the objects do not appear on the interface when the
Service User logs in to IP Office Web Manager. When a Service user logs in to IP Office Web
Manager, system does a check on the Rights group provisioned for the Service User and shows
those menus that are enabled for the Rights group.

Related links

Security Administration on page 105

Encryption

Encryption ensures that all data sent by either the system or Manager cannot be ‘read’ by anyone
else, even another copy of Manager. Encryption is the application of a complex mathematical
process at the originating end, and a reverse process at the receiving end. The process at each
end uses the same ‘key’ to encrypt and decrypt the data:
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Message Authentication

Any data sent may be optionally encrypted using a number of well known and cryptographically
secure algorithms:

Algorithm Effective key size (bits) Use

DES-40 40 Not supported.
DES-56 56 Not supported.
3DES 112 ‘Minimal’ security.
RC4-128 128 ‘Acceptable’ security.
AES-128 128 ‘Strong’ security.
AES-256 256 ‘Strong’ security.

In general the larger the key size, the more secure the encryption. However smaller key sizes
usually incur less processing. The system supports encryption using the Transport Layer Security
(TLS) v1.0 protocol. In addition, many cryptographic components of the TLS module have been
FIPS 140-2 certified, indicating the accuracy of implementation.

Related links
Security Administration on page 105

Message Authentication

Message authentication ensures that all data sent by either the system or Manager cannot be
tempered with (or substituted) by anyone else without detection. This involves the originator of the
data producing a signature (termed a hash) of the data sent, and sending that as well. The
receiver gets the data and the signature and check both match.
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L]

?

Any data sent may be optionally authenticated using a number of well known and
cryptographically secure algorithms:

Algorithm Effective hash size (bits) Use

MD5 128 Not recommended.
SHA-1 160 ‘Acceptable’ security.
SHA-2 224, 256, 384, 512 ‘Strong’ security

In general the larger the hash size, the more secure the signature. However smaller hash sizes

usually incur less processing.

IP Office supports message authentication using the Transport Layer Security (TLS) 1.0, 1.1, and
1.2 protocol. In addition, many cryptographic components of the TLS module have been FIPS
140-2 certified, indicating the accuracy of implementation.

Related links

Security Administration on page 105

Certificates

Public key cryptography is one of the ways to maintain a trustworthy networking environment. A
public key certificate (also known as a digital certificate or identity certificate) is an electronic
document used to prove ownership of a public key. The certificate includes information about the

key, information about its owner's identity, and the digital signature of an entity that has verified the
certificate's contents are correct. If the signature is valid, and the person examining the certificate
trusts the signer, then they know they can use that key to communicate with its owner.

For more information, see Certificate Management on page 529.

Related links

Security Administration on page 105
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Implementing Security

Implementing Security

IP Office can be made a very secure. However, only a certain number of features are active by
default in order to ease the initial installation. If all Manager and system security settings are left at
default, no security mechanisms are active, other than the use of default service user names and
passwords. In addition, all legacy interfaces are active, and all configuration and security data is
sent unencrypted. Therefore, it is necessary to implement the configuration options listed here.
Additional setting may be necessary to further secure the individual deployment. Avaya is
presenting this information for guidance only; the customer is responsible for ensuring their
system is secure.

To improve IP Office security in practice, two main mechanisms are used:
+ Activation of IP Office security features.
» Reduction of exposure to external or internal attack.

Minimum Security

A minimum security scenario could be where configuration data is open, but the security settings
are constrained: Any individual with the correct service user name and password can access the
configuration from any PC installation of Manager, no logging of access: Passwords can be
simple, and will never age.

» Change all default passwords of all service users and Security Administrator.
» Set the system Security Administration service security level to Secure, Low.
» Set the system service user Password Reject Action to None.
+ Set the system Client Certificate Checks level to None (default).
+ Set the system Minimum Password Complexity to Low (default).
» Set the system Previous Password Limit to zero (default).
» Set the system Password Change Period to zero (default).
+ Set the system Account Idle Time to zero (default).
 Set certificate check level to low in Manager Security Preferences (default).
In addition, any PC installation of Manager can manage any IP Office.
Medium Security

A medium security scenario could be where both configuration and security settings are
constrained and a level of logging is required: Any individual with the correct service user name
and password can access the configuration from any PC installation of Manager: Passwords
cannot be simple, and will age.

* Change all default passwords of all service users and Security Administrator

+ Set the system Security Administration service security level to Secure, Medium.

» Set the system Configuration service security level to Secure, Medium.

» Set the system service user Password Reject Action to Log to Audit Trail (default).
+ Set the system Client Certificate Checks level to None (default).
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+ Set the system Minimum Password Complexity to Medium.

» Set the system Previous Password Limit to non zero.

» Set the system Password Change Period to non zero.

» Set the system Account Idle Time to zero (default).

* Disable all the system Unsecured Interfaces.

« Set certificate check level to low in Manager Security Preferences (default).
Maximum Security

A maximum security scenario could be where both configuration and security settings are
constrained and a full level of logging is required: Certified individuals with the correct service user
name and password can access the configuration from specific PC installations of Manager:
Passwords cannot be simple, and will age: Manager can managed specific systems.

» Change all default passwords of all service users and Security Administrator
» Set the system Security Administration service security level to Secure, High.
» Set the system Configuration service security level to Secure, High.

» Set the system service user Password Reject Action to Log and Disable Account.
» Set the system Client Certificate Checks level to High.

» Set the system Minimum Password Complexity to High.

 Set the system Minimum Password Length to >8.

+ Set the system Previous Password Limit to non zero (>5).

+ Set the system Password Change Period to non zero.

» Set the system Account Idle Time to non zero.

» Set the system Session ID Cache to zero.

« Install valid, 1024 bits+, non self signed certificates (+private key) in all IP Office server
certificates, derived from a trusted certificate authority.

* Install the corresponding trusted CA certificate in each of the Manager’s windows certificate
stores.

+ Install valid, 1024 bits+, non self signed certificate (+ private key) in all Manager Certificate
Stores.

* Install the corresponding certificates in all the system Certificate Stores of all permissible
Manager entities, and the trusted CA certificate.

* Disable all the system Unsecured Interfaces.
» Set Manager Certificate Checks level to high in Manager Security Preferences.
+ Set Certificate offered to the system in Manager Security Preferences.

The above essentially locks the systems and corresponding Managers together. Only recognized
(by strong certificate) entities may communicate successfully on the service interfaces. All
services use strong encryption and message authentication.

The use of intermediate CA certificates can be used to overcome the limit of 6 maximum
certificates in each system Certificate Store.
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Related links
Security Administration on page 105

SRTP

Secure Real-Time Transport Protocol (SRTP) refers to the application of additional encryption and
or authentication to VolIP calls (SIP and H.323). SRTP can be applied between telephones,
between ends of an IP trunk or in various other combinations.

IP Office supports:
* Individual configuration for RTP and RTCP authentication and encryption
* HMAC SHA1 as the authentication algorithm
* AES-CM as the encryption algorithm
+ 80 (default) or 32 bit authentication tag
* Master key length of 128 bits
» Master salt length of 112 bits.

Configuring the use of SRTP at the system level is done on the System | VoIP Security tab using
the Media Security setting. The options are:

- Best Effort
* Disabled (default)
+ Enforced

When enabling SRTP on the system, the recommended setting is Best Effort. In this scenario, IP
Office uses SRTP if supported by the other end, and otherwise uses RTP. If the Enforced setting
is used, and SRTP is not supported by the other end, the call is not established.

The system level setting can be overridden at the trunk or extension level. This can be used for
special cases where the trunk or extension setting must be different from the system settings.

If the system level setting is Enforced, and devices that do not support SRTP are connected to
the system, their extension level configuration must be Disabled or calls will fail. This extra
configuration would typically not be required if the system level setting is Best Effort.

SRTP is supported on SIP Lines, SM Lines, and IP Office Lines. SRTP is not supported on H.323
IP trunks.

Encrypted RTCP

IP Office supports unencrypted RTCP by default. This default is compatible with most Avaya
endpoints which do not currently support encrypted RTCP. To the extent possible, any type of
endpoint using SRTP with IP Office should use unencrypted RTCP for consistency with other
endpoints to allow for direct media.

IP Office supports RTCP encryption as a configurable option. In addition to system level
configuration, it can be turned on at the trunk and extension level. Therefore, RTCP encryption
can be configured as an exception for an entity which only supports encrypted RTCP. In such case

July 2017 Administering Avaya IP Office™ Platform with Manager 117

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Administering Avaya IP Office™ Platform with Manager

Security Administration

there will be no direct media SRTP between that entity and one that does not support encrypted
RTCP, and IP Office will relay the SRTP media.

Authentication

Authentication can be applied to both the voice part of calls (the RTP stream) and or to the control
signal associated with the call (the RTCP stream). By default, IP Office supports RTP encryption,
RTP authentication, RTCP authentication. Authentication is applied after encryption so that
packets can be authenticated at the remote end without having to be decrypted first.

* The method used for the initial exchange of authentication keys during call setup depends on
whether the call is using SIP or H.323. The IP Office system uses SDESC for SIP calls and
H235.8 for H.323 calls.

* SRTP is only supported when using an addition method such as TLS or a VPN tunnel to
establish a secure data path before call setup.

» A replay attack is when someone intercepts packets and then attempts to use them to for a
denial-of-service or to gain unauthorized access. Replay protection records the sequence of
packets already received. If a packed has been received previously, it is ignored. If packets
arrive outside a specified sequence range, the security device rejects them. All packets in a
stream (RTP and RTCP) have a sequential index number, however packets may not be
received in sequential order. SRTP protects against replay attacks by using a moving replay
window containing the index numbers of the last 64 authenticated packets received or
expected. Any packet received that has an index older than the current window is ignored.
Only packets with an index ahead of the window or inside the window but not already
received are accepted. Separate replay protection is used for the RTP and the RTCP
streams.

* Rekeying is the sending of new authentication keys at intervals during an secure call. This
option is not supported by the IP Office system which just sends authentication keys at the
start of the call.

SRTP sessions can use direct media between the devices or can be relayed via the IP Office
system. In some scenarios the IP Office system can be one end of the SRTP part of a call that
then continues to a non-SRTP destination.

If both the call originator and target require SRTP: A direct media is made if supported, using
SRTP. If direct media is not supported, the call is relayed via the IP Office system. In either case
SRTP parameters are negotiated end to end with the IP Office system translating and forwarding
them from one end to other end if necessary.

If only the originator or target requires SRTP: A non-direct media call is setup with with SRTP
negotiated between the IP Office system and the party which requires SRTP.

Emergency Calls

Emergency calls from an extension are not blocked even if SRTP is required but cannot be
established.

Calls using SRTP do not use any special indication on the user's telephone. Normal call functions
(conference, transfer, etc) remain available to the user. SRTP alarms and details of when SRTP is
being used are shown by the System Status Application and System Monitor.

Related links
Security Administration on page 105
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Chapter 8: Editing IP Office Security
Settings in Manager

The following conditions apply when editing the IP Office security settings.
 Editing of security settings may only be done online to a system.
No offline saving or editing is allowed for security purposes.
* No errors in the security settings are allowed to persist.
This prevents the system becoming inaccessible through operator error.

» Sets of changes to security objects may be made without the need for the OK button to be
selected every time.

This allows a coordinated set of changes to be accepted or canceled by the operator.

Loading Security Settings

About this task

The address ranges in which Manager searches for systems are set through the Manager
preferences (File | Preferences | Discovery). The security mechanism used for security settings
transfer between Manager and a system are set through the Secure Communications attribute of
Manager preferences (File | Preferences | Security).

If not already done, switch Manager to security mode by selecting File | Advanced | Security
Settings.

© Note:

If the system's configuration settings have already been loaded using a service user name
and Password that also has security access, then the security settings are automatically
loaded when Manager is switched to security mode.

Procedure

T already in security mode, click 2. in the main toolbar or select File | Open Security

Settings from the menu bar.
2. The Select IP Office window appears, listing those systems that responded.

The list can be sorted by clicking on the column names.
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3. If the system required was not found, the address used for the search can be changed.

Enter or select the required address in the Unit/Broadcast Address field and then click
Refresh to perform a new search.

4. When the system required is located, check the box next to the system and click OK.
5. The user name and password request for the system is then displayed.

Enter the required details and click OK. By default this is a different user name and
password from those that can be used for configuration access.

6. If the security settings are received successfully, they appear within Manager.

« If the service user name/password is incorrect, or the service user has insufficient rights
to read the security settings, "Access Denied" is displayed.

* If the network link fails, or the secure communication mode is incorrect (for example
Manager is set to unsecured, but the system is set to secure only), "Failed to
communicate with IP Office" is displayed.

Saving Security Settings

About this task
Procedure

1. Click i in the Main Toolbar or select File | Save Security Settings from the menu bar.
These options are only available when some change has been made.

2. The user name and password request for the system is then displayed.

Enter the required details and click OK. By default this is a different user name and
password from those that can be used for configuration access.

Resetting a System's Security Settings

About this task
Procedure

1. Select File | Reset Security Settings (if in security mode), or File | Advanced | Erase
Security Settings (if in configuration mode).

2. The Select IP Office window appears, listing those systems that responded.
The list can be sorted by clicking on the column names.
3. When the system required is located, check the box next to the system and click OK.

4. The user name and password request for the system is then displayed.
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Enter the required details and click OK. By default this is a different user name and
password from those that can be used for configuration access.

5. Manager will indicate if the security settings are reset successfully.
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Chapter 9: Security Mode Field
Descriptions

The Manager Security Mode is used to load and edit the security settings of a system. How the
controls operate is similar to Manager in configuration mode.

To switch to Security Mode, select File | Advanced | Security Settings.
To switch back to Configuration Mode, select File | Configuration.

Security Mode Screen Elements

Table 3: Toolbar icons

Icon Action

2 Get the Security Settings

= Save the Security Settings

-] Not Used in security mode

2] Show/Hide the Navigation Pane
_:| Show/Hide the Group Pane

A\ Not used in security mode

' Not used in security mode

Security Settings Pane: This pane is used to select the type of security records that should be
displayed in the group pane or details pane.

g" General Defines general security controls for the system. When selected, the settings are
displayed in the details pane.

L]
=

=2’ System Defines security settings for the system such as application access. When
selected, the settings are displayed in the details pane.

@ Services Secure services supported by the system. Currently these are access to security
settings and access to configuration settings.

% Rights Groups Create groups with different access rights. When selected, the existing
Rights Groups are displayed in the group pane.
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a@ Service Users Sets the name and password for an administrator. Also allows selection of
the Rights Groups to which the user belongs. When selected, the existing service users are
displayed in the group pane.

Group Pane: This pane is used to display the existing Right Groups or Service Users when those
options are selected in the security settings pane.

Details Pane: This pane shows the settings selected in the security settings pane or the group

pane.

Status Bar: This bar display messages about communications between Manager and systems. It
also displays the security level of the communications by the use of a padlock icon.

Related links

General Security Settings on page 123

System on page 127
Security Services Settings on page 135

Rights Groups on page 137
Service Users on page 143

General Security Settings

Related links

Security Mode Field Descriptions on page 122
General on page 123

General

Field

| Description

Security Administrator

The Security Administrator is a special service user who does not belong to any Rights Groups. The Security
Administrator is able to access the system's security settings but cannot access its configuration settings. By
default they are the only service user able to access to the security settings.

Unique Security
Administrator

Default = Off

When selected, only the Security Administrator is able to access the system's security
settings. When this is selected, the security options for Rights Groups are disabled.
When not selected, the ability to access security settings can also be assigned to Rights
Groups.

Name: Default = 'security'. Range = 6 to 31 characters.
The name for the Security Administrator.
Password Default = 'securitypwd'. Range = 8 to 31 characters.
Table continues. ..
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Security Mode Field Descriptions

Field

Description

The password for the Security Administrator. In order to change the Security
Administrator password, the current password must be known.

Minimum Password
Complexity

Default = Medium.

The password complexity requirements for the Security Administrator. This setting is
active for attempted password changes on both Security Manager and the system. The
options are:

Low:
Any password characters may be used without constraint.
Medium:

The password characters used must include characters from at least 2 of the 'code
point sets' listed below. For example a mix of lower case and upper case. In addition, 3
or more consecutive identical characters of any type is not allowed.

High:

The password characters used must include characters from at least 3 of the 'code
point sets' listed below. For example a mix of lower case, upper case and numbers. In
addition, 3 or more consecutive identical characters of any type is not allowed.

Code Point Sets:

* Lower case alphabetic characters.
* Upper case alphabetical character.
* Numeric characters.

» Non-alphanumeric characters, for example # or *.

Previous Password
Limit (Entries)

Default = 4. Range = 0 (Off) to 10 records.

The number of previous password to check for duplicates against when changing the
password. When set to 0, no checking of previous passwords takes place. This setting
is active for attempted password changes on both Security Manager and the system.

Service User Details

These settings control service user names and password/account policies. This setting is active for attempted
password changes on all administration interfaces.

Minimum Name
Length

Default = 6, Range 1 to 31 characters.

This field sets the minimum name length for service user names.

Minimum Password
Length

Default = 8, Range 1 to 31 characters. This field sets the minimum password length for
service user passwords.

Password Reject
Limit

Default = 3, Range 0 to 255 failures.

Sets how many times an invalid name or password is allowed within a 10 minute period
before the Password Reject Action is performed. Selecting 0 indicates never perform
the Password Reject Action.
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Field

Description

Password Reject
Action

Default = Log and Temporary Disable.

The action performed when a user reaches the Password Reject Limit. The options
are:

* No Action

* Log to Audit Trail Log to Audit Trail creates a record indicating the service user
account name and time of last failure.

* Log and Disable Account:. Log and Disable Account creates an audit trail record
and additionally permanently disables the service user account. This account can only
be enabled using the Security Manager Service User settings.

* Log and Temporary Disable: Log and Temporary Disable creates an audit trail
record and additionally temporarily disables the service user account for 60 seconds.
This account can only be enabled using the Security Manager Service User settings.

Minimum Password
Complexity

Default = Medium.

The password complexity requirements for the Security Administrator. This setting is
active for attempted password changes on both Security Manager and the system. The
options are:

Low:
Any password characters may be used without constraint.
Medium:

The password characters used must include characters from at least 2 of the 'code
point sets' listed below. For example a mix of lower case and upper case. In addition, 3
or more consecutive identical characters of any type is not allowed.

High:

The password characters used must include characters from at least 3 of the 'code
point sets' listed below. For example a mix of lower case, upper case and numbers. In
addition, 3 or more consecutive identical characters of any type is not allowed.

Code Point Sets:

» Lower case alphabetic characters.
» Upper case alphabetical character.
* Numeric characters.

» Non-alphanumeric characters, for example # or *.

Previous Password
Limit (Entries)

Default = 4. Range = 0 (Off) to 10 records.

The number of previous password to check for duplicates against when changing the
password. When set to 0, no checking of previous passwords takes place. This setting
is active for attempted password changes on both Security Manager and the system.

Password Change
Period

Default = 0 (Off). Range 0 to 999 days.

Sets how many days a newly changed password is valid. Selecting 0 indicates any
password is valid forever. This setting is active for password changes through this form
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Field

Description

or prompted by Manager. Note that the user must be a member of a Rights Group that
has the Security Administration option Write own service user password enabled. If
this timer expires, the service user account is locked. The account may only be re-
enabled using the Service User Settings. To prompt the user a number of days before
the account is locked set a Expiry Reminder Time (see below).

Whenever this setting is changed and the OK button is clicked, the Security Manager
recalculates all existing service user password timers.

Account Idle Time

Default = 0 (Off). Range 0 to 999 days.

Sets how many days a service user account may be inactive before it becomes
disabled. Selecting 0 indicates an account may be idle forever. If this timer expires, the
service user account is permanently disabled. The account may only be re-enabled
using the Service User Settings. The idle timer is reset whenever a service user
successfully logs in.

Whenever this setting is changed and the OK button is clicked, the Security Manager
recalculates all existing service user idle timers.

Expiry Reminder
Time

Default = 10. Range 0 (Off) to 999 days.

Sets the period before password or account expiry during which a reminder indication if
the service user logs in. Selecting 0 prevents any reminders. Reminders are sent, for
password expiry due to the Password Change Period (above) or due to the Account
Expiry date (see Service User Settings on page 143) — whichever is the sooner.
Currently Manager displays reminders but System Status does not.

IP Office User Details

These settings control IP Office user password/account policies.

Password
Enforcement

Default = On.

When enabled, password settings are enforced. When disabled, password
requirements are not enforced and the remaining settings are not editable

Minimum Password
Length

Default = 8, Range 1 to 31 characters.

This field sets the minimum password length for user passwords

Minimum Password

Default = Medium.

Complexity The password complexity requirements for the Security Administrator. This setting is
active for attempted password changes on both Security Manager and the system. The
options are:

Low:

Any password characters may be used without constraint.

Medium:

The password characters used must include characters from at least 2 of the 'code

point sets' listed below. For example a mix of lower case and upper case. In addition, 3

or more consecutive identical characters of any type is not allowed.

High:

Table continues...
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Field

Description

The password characters used must include characters from at least 3 of the 'code
point sets' listed below. For example a mix of lower case, upper case and numbers. In
addition, 3 or more consecutive identical characters of any type is not allowed.

Code Point Sets:

» Lower case alphabetic characters.
» Upper case alphabetical character.
* Numeric characters.

» Non-alphanumeric characters, for example # or *.

Password Reject
Limit

Default = 5, Range 0 to 255 failures.

Sets how many times an invalid name or password is allowed within a 10 minute period
before the Password Reject Action is performed. Selecting 0 indicates never perform
the Password Reject Action.

Password Reject
Action

Default = Log and Temporary Disable. The action performed when a user reaches the
Password Reject Limit. The options are:

* No Action

* Log to Audit Trail Log to Audit Trail creates a record indicating the user account
name and time of last failure.

* Log and Disable Account Log and Disable Account creates an audit trail record and
additionally permanently disables the user account. The account can be enabled
using the Account Status field on the User | User page.

* Log and Temporary Disable Log and Temporary Disable creates an audit trail record
and additionally temporarily disables the user account for 60 seconds. The account
can be enabled using the Account Status field on the User | User page.

Related links

General Security Settings on page 123

System

Related links

Security Mode Field Descriptions on page 122

System Details on page 128

Unsecured Interfaces on page 129

Certificates on page 130
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System Details

Field

| Description

Base Configuration

Services Base TCP
Port

Default = 50804. Range = 49152 to 65526.

This is the base TCP port for services provided by the system. It sets the ports on which
the system listens for requests to access those services, using its LAN1 IP address.
Each service uses a port offset from the base port value. If this value is changed from
its default, the Manager application must be set to the same Base TCP Port through its
Services Base TCP Port setting (File | Preferences).

For information on port usage see the IP Office Port Matrix document on the Avaya
support site at https://support.avaya.com/helpcenter/getGenericDetails?
detailld=C201082074362003

Maximum Service
Users

Default = 64.

This is a fixed value for indication purposes only. This value is the maximum number of
service users that can be stored in a system's security settings

Maximum Rights
Groups

Default = 32.

This is a fixed value for indication purposes only. This value is the maximum number of
Rights Groups that can be stored in a system's security settings.

System Discovery

System discovery is the processes used by applications to locate and list available systems. The IP Office can
be disabled from responding to this process if required. If this is done, access to the IP Office requires its
specific IP address to be used.

TCP Discovery
Active

Default = On.

Selecting TCP Discovery Active allows the system to respond to those requests.

UDP Discovery
Active

Default = On.

Selecting UDP Discovery Active allows the system to respond to those requests.

Security

These settings cover the per-system security aspects, primarily TLS settings.

Session ID Cache

Default = 10 hours, Range 0 to 100 hours.

This sets how long a TLS session ID is retained by the system. If retained, the session
ID may be used to quickly restart TLS communications between the system and a re-
connecting application. When set to 0, no caching takes place and each TLS
connection must be renegotiated.

HTTP Challenge
Timeout (Seconds)

Default = 10.

For HTTP/HTTPS connection attempts, this field sets the timeout for connection
validation responses.
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System

Field

Description

RFC2617 Session
Cache (Minutes)

Default = 10.

For HTTP/HTTPS sessions, this field sets the allowed duration for successful logins as
per RFC2617.

HTTP Ports

These settings set the ports for web based configuration access to the system.
HTTP Port Default = 80.

HTTPS Port Default = 443.

Web Services Port

Default =8443.

WebSocket Proxy

These settings are applicable to WebSocket communication over IP Office lines.

Enabled

Default = On.

When set to On , Web Manager uses the proxy server to communicate between the
Server Edition Primaryserver and other nodes.

When set to Off, the WebSocket proxy is disabled. Any IP Office line WebSocket
communication over an HTTP session is closed with “404 NotFound”.

Enforce Secure

Default = On.
Applicable only when the Enabled check box is On.
When set to On, any proxy communication over IP Office line Websocket uses HTTPS.

When set to Off, any HTTPS communication over IP Office line Websocket is disallowed
and the session is closed with “403 Forbidden”.

Related links

System on page 127

Unsecured Interfaces

These features relate to applications that access the system configuration settings using older
security methods.

Field

Description

System Password

Default = 'password'. Range = 0 to 31 characters.

The system password is used by Manager to upgrade IP Office IP500 V2 systems. Also
used for Monitor when the Monitor password setting is blank.

Voicemail Password

Default = Blank. Range = 0 to 31 characters.

This password is required if a matching password is also set through the Voicemail Pro
client application. Typically no password is set.

Monitor Password

Default = Blank. Range = 0 to 31 characters.
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Field

Description

This password, if set, is used by the System Monitor application. If this password is not
set, those applications use the system password. If changing this password with no
previous password set, enter the system password as the old password.

Use Service User

Default = Off.

Skl Set to On to enable log in to the System Monitor application using the service user
credentials.

Applications These check boxes control which actions the system will support for legacy

Controls applications. Different combinations are used by the different applications. A summary

of the applications affected by changes is listed in the Application Support list.
» TFTP Server: Default = On.

» TFTP Directory Read: Default = Off.

* TFTP Voicemail: Default = Off.

* Program Code: Default = On.

* DevLink: Default = On.

» TAPI/DevLink3: Default = Off.

« HTTP Directory Read: Default = On. Allow the system's current directory records to
be accessed using HTTP.

* HTTP Directory Write: Default = On. Allow HTTP import to be used to place
temporary directory records into the directory.

Application Support

This panel is shown for information only. It indicates the effect on various applications of
the Application Controls selections.

Related links

System on page 127

Certificates

Additional Configuration Information

For additional information on certificates, see Certificate Management on page 529.

Services between the system and applications may, depending on the settings of the service
being used for the connection, require the exchange of security certificates. The system can either
generate its own certificate or certificates provided from a trusted source can be loaded.

A Warning:

The process of 'on-boarding' (see Deploying Avaya IP Office™ Platform SSL VPN Services)
automatically adds a certificate for the SSL VPN to the system's security settings when the on-
boarding file is uploaded to the system. Care should be taken not to delete such certificates
except when advised by Avaya.
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Configuration Settings

Field Description
Identity Certificate:

The Identity Certificate is an X.509v3 certificate that identifies the system to a connecting another device using
TLS, for example a PC running IP Office Manager set to Secure Communications.

By default, the system's provides its own self-generated certificate, automatically generated when the system is
first installed. Alternatively, a certificate from another source can be uploaded to the system if required.

The system’s certificate is advertised (used) by Services which have their Service Security Level set to a value
other than Unsecure Only.

Offer Certificate Default = On.

This is a fixed value for indication purposes only. This sets whether the system will offer
a certificate in the TLS exchange when the IP Office is acting as a TLS server, which
occurs when accessing a secured service.

Offer ID Certificate Default = Off.
Chain

When set to On, this setting instructs IP Office to advertise a chain of certificates in the
TLS session establishment. The chain of certificates is built starting with the identity
certificate and adding to the chain all certificates it can find in the IP Office Trusted
Certificate Store based on the Common Name found in the "Issued By" Subject
Distinguished Name field in each of the certificates in the chain. If the Root CA
certificate is found in the IP Office Trusted Certificate Store, it will be included in the
chain of certificates. A maximum of six certificates are supported in the advertised chain
of certificates.

Issued to Default = IP Office identity certificate.

Common name of issuer in the certificate.

Set This option can is used to load a certificate and associated private key. The certificate
and key must be a matching pair.

IP Office supports certificates with RSA key sizes of 1024, 2048 and 4096 bits. The use
of RSA key size 4096 may impact system performance. The recommended key size is
2048.

IP Office supports signature algorithms of SHA-1, SHA-256, SHA-384, and SHA-512.
Using signature size larger than SHA-256 may impact system performance. The
recommended signature algorithm is SHA-256.

The source may be:

» Current User Certificate Store.

* Local Machine Certificate Store.

* File in the PKCS#12 (.pfx) format

+ Pasted from clipboard in PEM format, including header and footer text.

This method must be used for PEM (.cer) and password protected PEM (.cer) files.
The identity certificate requires both the certificate and private key. The .cer format
does not contain the private key. For these file types select Paste from clipboard and

Table continues...

July 2017 Administering Avaya IP Office™ Platform with Manager 131

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Administering Avaya IP Office™ Platform with Manager

Security Mode Field Descriptions

Field Description
then copy the certificate text and private key text into the Certificate Text Capture
window.
Using a file as the certificate source:
In Manager, when using the file option, the imported "p12" "pfx" or "cer" file for setting
the identity certificate can only contain the private key and identity certificate data. It
cannot contain additional Intermediate CA certificates or the Root CA certificate. The
Intermediate CA certificates or the Root CA certificate must be imported separately in
the IP Office Trusted Certificate Store.
This does not apply to Web Manager.
© Note:
Web Manager does not accept the file of type "cer" with extension ".cer". This file
type can only be used in Manager.
View This command displays details of the current identity certificate. The certificate source,
details and valid dates are displayed.
The certificate view menu can also be used to install the certificate (but not its private
key) into the viewing PC’s local certificate store for use by the PC for secure connection
to the system or to export the certificate from the PC.
Regenerate This command deletes the current identity certificate and generates a new self-signed
certificate.
0 Important:
Regenerating the certificate can take up to a minute during which system
performance may be impacted. Therefore it is recommended to only perform this
action during a maintenance window. The regeneration takes places after saving
the changes to security settings.
Clicking Regenerate opens the Regenerate Certificate window where you are prompted
to enter the following information:
 Signature: Default = SHA256/RSA2048.
This setting configures both the signature algorithm and the RSA key length to use
when generating the IP Office identity certificate. The options are:
- SHA256/RSA2048
- SHA1/RSA1024
If any other combinations are needed, the Security Administrator will need to
construct the IP Office identity certificate outside of Manager and use the Set action to
install it.
* Default Subject Name: Default = System generated value.
Specifies a common name for the subject of this certificate. The subject is the end-
entity or system that owns the certificate (public key). Example:
ipoffice-0123456789AB.avaya.com.
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System

Field

Description

If the field is blank, a system generated subject name is used.
» Subject Alternative Name(s): Default = System generated value.

The Subject Alternative Name (SAN) field allows a list of alternate names to be bound
to the subject of the certificate.

The input field will allow the user to enter multiple Subject Alternate Names, each
separated by the comma “,” character. Each SAN consists of a PREFIX, followed by
the colon “:” character, followed by VALUE. The list of allowed PREFIX strings are
“‘DNS”, “URI”, “IP”, “SRV”, and “email”. The VALUE can be any text character except
the comma. (The comma is reserved as a field separator.) The input field has a
maximum size limit of 511 characters.

Example: ”"DNS: ipoffice-0123456789AB.avaya.com, IP:
192.168.137.29, URI:http://avaya example url.com/,
email:jack@my email server.com”

Supported Subject Alternative Name types include: a DNS Name, a Uniform
Resource Identifier, an IP Address, an SRV record, or an electronic mail address.
Although a PREFIX must be specified to select the type of name, no validation is
performed on the value.

If this field is blank, a system generated subject alternative name field value is used.

Certificate Expiry
Warning Days

Default = 60, Range = 30 to 180

IP Office Manager can display a warning when a system’s security certificate is due to
expire. This setting is used to set the trigger for certificate warnings.

Use Different
Identity Certificate
for Telephony

Default = Off.

When not enabled, all secure telephony communications use the system’s default
identity certificate and settings.

When enabled, secure telephony communications use a separate identity certificate.
The certificate to use if uploaded to the system’s certificate store using the Set button.

Received Certificate
Checks
(Management
Interface)

Default = None.

This setting is used for administration connections to the system by applications such as
Manager. When the Service Security Level of the service being used is set to High, a
certificate is requested by the system. The received certificate is tested as follows:

* None: No extra checks are made (The certificate must be in date).
» Low: Certificate minimum key size 1024 bits, in date.
* Medium: Certificate minimum key size 1024 bits, in date, match to store.

* High: Certificate minimum key size 2048 bits, in date, match to store, no self signed,
no reflected, chain validation.

Received Certificate
Checks (Telephony
Endpoints)

Default = None.

This setting is used with IP telephony endpoints connecting to the system.
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Field

Description

This setting is used by IP Office to validate the identity certificate offered by the other
end of TLS connection. IP Office does not support mutual authentication for SIP phones
(an identity certificate is not installed in all SIP phones). Therefore, IP Office does not
require a client certificate from a SIP phone, only SIP/SM trunks.

The received certificate is tested as follows:

* None: No extra checks are made (The certificate must be in date).

» Low: Certificate minimum key size 1024 bits, in date.

* Medium: Certificate minimum key size 1024 bits, in date, match to store.

* High: Certificate minimum key size 2048 bits, in date, match to store, no self signed,
no reflected, chain validation.

Trusted Certificate Store

This section displays a list of the certificates held in the system’s trusted certificate store.

Installed Default = A set of fixed Avaya provided Intermediate CA or Root CA certificates.

CORMIELE The certificate store contains a set of trusted certificates used to evaluate received
client certificates. Up to 25 X.509v3 certificates may be installed.

Add Add a trusted certificate. The source may be:

* Current User Certificate Store.
» Local Machine Certificate Store.
* File in one of the following formats:
- PEM (.cer)
- password protected PEM (.cer)
- DER (.cer)
- password protected DER (.cer)
+ Pasted from clipboard in PEM format, including header and footer text.
This method must be used for PKCS#12 (.pfx) files. The PKCS#12 (.pfx) format
contains a private key and a trusted certificate cannot contain a private key. For this
file type, select Paste from clipboard and then copy the certificate text into the
Certificate Text Capture window.
IP Office supports certificates with RSA key sizes of 1024, 2048 and 4096 bits. The use
of RSA key size 4096 may impact system performance. The recommended key size is
2048.
IP Office supports signature algorithms of SHA-1, SHA-256, SHA-384, and SHA-512.
Using signature size larger than SHA-256 may impact system performance. The
recommended signature algorithm is SHA-256.

View View the currently selected certificate. The certificate (not the private key) may also be
installed into the local PC certificate store for export or later use when running the
manager in secured mode.

Delete Delete the currently selected certificate.

July 2017 Administering Avaya IP Office™ Platform with Manager 134

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Administering Avaya IP Office™ Platform with Manager

Security Services Settings

SCEP Settings

The Simple Certificate Enrollment Protocol is a protocol intended to ease the issuing of certificates in a network
where numerous devices are using certificates. Rather than having to individually administer the certificate
being used by each device, the devices can be configured to request a certificate using SCEP.

These settings are relevant for IP Office Branch deployments.

These settings are not used in IP Office Standard mode.

Active

Default = Off.

Request Interval
(seconds)

Default = 120 seconds. Range = 5 to 3600 seconds.

SCEP Server IP/
Name

Default = Blank.

SCEP Server Port

Default = 80 for HTTP and 443 for HTTPS.

SCEP URI

Default = /ejbca/publicweb/apply/scep/pkiclient.exe

SCEP Password

Default = Blank.

Related links

System on page 127

Security Services Settings

This tab shows details of the services that the system runs to which service users can

communicate.

Field Description
Name The name of the service. This is a fixed value for indication purposes only.
Host System This field shows the system's name. This is a fixed value for indication purposes only.

Service Port

This is the port on which the system listens for attempts to access the service. The
routing of traffic to this port may need to be enabled on firewalls and network devices
between the service users and the system. The base port (TCP or HTTP) for each
service is offset by a fixed amount from the ports set in System Settings.

For information on port usage see the IP Office Port Matrix document on the Avaya
support site at https://support.avaya.com/helpcenter/getGenericDetails?
detailld=C201082074362003

Service Security
Level

Sets the minimum security level the service will support. See File | Preferences |
Security for the corresponding Manager application setting, which must be changed to
match the appropriate service access security settings.
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Field Description

A Warning:
If the system does not already have an X509 security certificate, selecting a setting

other than Unsecure Only will cause the system to stop responding for a period
(less than a minute) while the system generates its own unique security certificate.

The options are:

* Unsecure Only This option allows only unsecured access to the service. The service's
secure TCP port, if any, is disabled. This or disabled are the only options supported for
the System Status Interface and Enhanced TSPI services.

» Unsecure + Secure This option allows both unsecured and secure (Low) access. In
addition, TLS connections are accepted without encryption, just authentication.

» Secure, Low This option allows secure access to that service using TLS, and
demands weak (for example DES_40 + MD5) encryption and authentication or higher.
The service's unsecured TCP port is disabled.

» Secure, Medium This option allows secure access to that service using TLS, and
demands moderate (for example DES_56 + SHA-1) encryption and authentication or
higher. The service's unsecured TCP port is disabled.

» Secure, High This option allows secure access to that service using TLS and
demands strong (for example 3DES + SHA-1) encryption and authentication, or higher.
In addition, a certificate is required from the client (usually Manager). See System
Details | Client Certificate Checks for tests made on the received certificate. The
service's unsecured TCP port is disabled.

 Disabled This option is available for the System Status Interface and Enhanced TSPI
services. If selected, access to the service is disabled.

Service Access For Server Edition systems, it is defaulted to Server Edition Manager. When set to
Source Server Edition Manager, the system can only be configured using Manager in its Server
Edition mode. When set to Unrestricted, the system can be configure using Manager in
its normal Simplified View or Advanced View modes.

A Warning:

Opening the configuration of a Server Edition system in Manager running in any
mode other than Server Edition mode should be avoided unless absolutely
necessary for system recovery. Even in that case, Manager will not allow
renumbering, changes to the voicemail type and changes to H.323 lines.

For systems centrally managed using SMGR , it is defaulted to Avaya Aura System
Manager. When set to Avaya Aura System Manager, the system can only be
configured using SMGR in Branch Mode. When set to Unrestricted, the system can be
configured using Manager in its normal Simplified View or Advanced View modes.

Related links
Security Mode Field Descriptions on page 122
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Rights Groups

Rights Groups

Related links

Security Mode Field Descriptions on page 122

Group Details on page 137

Configuration on page 137
Security Administration on page 139

System Status on page 139
Telephony APIs on page 140

HTTP on page 140
Web Services on page 140
External on page 142

Group Details
This tab sets the name of the Rights Group.

Field Description
Name : Range = Up to 31 characters
The name for the Rights Group should be unique. The maximum number of rights groups
is 32.
Related links

Rights Groups on page 137

Configuration

This tab sets the configuration settings access for service user's who are members of this Rights

Group.

Field

Description

IP Office Service
Rights

This setting controls what action on the system can be performed by members of the

Rights Group.

Manager This setting controls what types of configuration records Manager will allow members of the
Operator Rights | Rights Group to viewed and what actions they can perform with those types of records.
Operator View/Edit/ New/Delete Configuration Record
Types
Administrator All View, edit create and delete
all configuration records.
Manager View View all except WAN Port.
Table continues...
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Field Description
Edit Extension, User, Hunt
New Group, Short Code, Service,
RAS, Incoming Call Route,
Directory, Time Profile,
Firewall Profile, IP Route,
Least Cost Route, Account
Code, ARS.
Delete As edit except Short Code.
Operator View View all except WAN Port.
Edit Extension, User, Hunt
Group, Short Code, Service,
RAS, Incoming Call Route,
Time Profile, Firewall Profile,
IP Route, Least Cost Route,
Account Code, License,
ARS.
New None.
Delete Delete Incoming Call Route
and Directory.
User & Group Edit View User and Hunt Group
Edit records only.
New None
Delete
User & Group Admin All User and Hunt Group
records only.
Dir & Account Admin All Directory and Account Code
records only.
Time & Attendant Admin All Time Profile and Auto
Attendant records only.
ICR & User Rights Admin | All Incoming Call Route and
User Rights records only.
Read Only View View all configuration
records.
Edit None.
New
Delete
Related links

Rights Groups on page 137
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Security Administration

This tab sets the security settings access for Service user's who are members of this Rights
Group. These settings are ignored and greyed out if a Unique Security Administrator has been
enabled in General Settings.

Field

SDescription

Read all security
settings

Members of the Rights Group can view the system's security settings.

Write all security
settings

Members of the Rights Group can edit and return changes to the system's security
settings.

Reset all security
settings

If selected, members of the Rights Group can reset the security settings to default values.

Write own service
user password

If selected, members of the Rights Group can change their own password when requested
to do so by the system. That request may be the result of a Password Change Period,
Force new password or Account Expiry. The new password change is requested
automatically at login time.

Related links

Rights Groups on page 137

System Status

This tab sets whether members of the group can access the system using the System Status
Application (SSA).

configuration

Field Description

System Status If selected, members of the Rights Group can view the system's current status and
Access resources using the System Status Application (SSA).

Read all The System Status application includes tools to take a snapshot of the system for use by

Avaya for diagnostics. That snapshot can include a full copy of the system's configuration
settings. This setting must be enabled for the SSA user to include a copy of the
configuration in the snapshot.

System Control

If enabled, the SSA user is able to use SSA to initiate system shutdowns and memory
card shutdown/restarts.

SysMonitor If enabled, members of the Rights Group can use the System Monitor application to
Access perform detailed diagnosis of system problems.
Related links

Rights Groups on page 137
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Telephony APIs
Field Description
Enhanced TSPI If selected, applications in this rights group are able to use the system's Enhanced
Access TSPI interface. This interface is currently used by the one-X Portal application server
for its connection to the system.
DevLink3 If selected, applications in this rights group are able to use the system's DevLink3
interface.
This is a TCP based interface that streams real time call events (Delta3 records) and
is the recommended replacement to the existing DevLink windows based DLL. A new
Rights Group with a user name and password is required for external applications to
connect via the DevLink3 interface.
Location API If selected, applications in this rights group are able to use the system's Location API
interface.
Related links

Rights Groups on page 137

HTTP
This tab sets the HTTP services supported for members of the group.
Field Description
DECT R4 This service is used to allow the system to configure the DECT R4 master base
Provisioning station and to respond to handsets subscribing to the DECT R4 system. It requires

both the system and DECT R4 master base station to be configured to enable
provisioning. For full details refer to the DECT R4 Installation Manual.

Related links
Rights Groups on page 137

Web Services

These settings are used by users in rights groups using web services to configure and manage
the system. These are currently not used on Standard Mode systems

IP Office Service Rights

Field Description
Security Read All | If selected, the rights group members can view system security settings.
Security Write All | If selected, the rights group members can change system security settings.
Table continues...
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Field

Description

Security Write
Own Password

If selected, members of the Rights Group can change their own password when
requested to do so by the system. That request may be the result of a Password Change
Period, Force new password or Account Expiry. The new password change is requested
automatically at login time.

Config Read All

If selected, the rights group members can view system configuration settings

Config Write All

If selected, the rights group members can change system configuration settings.

Backup If selected, the rights group members can initiate the system backup process.

Restore If selected, the rights group members can initiate the system restore process.

Upgrade If selected, the rights group members can initiate the system upgrade process.
Web Manager Rights

Field Description

File Manager

If selected, the rights group members are assigned Read only access to embedded file
management configuration settings in Web Manager by default.

Service
Commands

If selected, the rights group members are assigned Read only access to Service
Commands configuration settings in Web Manager by default.

Users, Extensions

If selected, the rights group members are assigned Read only access to Users and
Extension configuration settings in Web Manager by default.

Groups, Auto
Attendant (For
Standard Edition
only)

If selected, the rights group members are assigned Read only access to Groups, Auto
Attendant configuration settings in Web Manager by default.

Incoming Call
Routes, Alternate
Route Selection,

If selected, the rights group members are assigned Read only access to Incoming Call
Routes, Alternate Route Selection, and Short Codes configuration settings in Web
Manage by default.

Short Codes

System, If selected, the rights group members are assigned Read only access to on System,

Locations, time Locations, Time Profiles, and Licensing configuration settings in Web Manager by default.

Profiles and

Licensing

Lines If selected, the rights group members are assigned Read only access to Lines
configuration settings in Web Manager by default.

‘Directory, If selected, the rights group members are assigned Read only access to Directory,

Authorization
codes, Account
Codes

Authorization Codes, and Account Codes configuration settings in Web Manager by
default.

IP Routes, WAN
Ports, Firewall
Profiles, RAS,
Services, Tunnel
(Applicable for

If selected, the rights group members are assigned Read only access to IP Routes, WAN
Portas, Firewall Profiles, RAS Services Users and Extension configuration settings in
Web Manager by default.

IP500)
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Field Description
User Rights If selected, the rights group members are assigned Read only access to Users
configuration settings in Web Manager by default.
Related links

Rights Groups on page 137

External

These settings are used by users in rights groups for external components using web services to
configure and manage the system.

IP Office Service Rights

Field

Description

Voicemail Pro
Basic

If selected, the rights group members can read the configuration and perform backup,
restore, and upgrade.

Voicemail Pro
Standard

If selected, the rights group members can update the configuration and perform backup,
restore, and upgrade.

Voicemail Pro
Administrator

If selected, the rights group members can update the configuration and security settings.

one-X Portal
Administrator

If selected, the rights group members can update the configuration and security settings.
Does not include backup and restore.

one-X Portal If selected, the rights group members can perform backup and restore.
Super User

Web Control If selected, the rights group members can update the configuration settings.
Administrator

Web Control If selected, the rights group members can update the security settings.
Security

WebRTC Gateway
Administrator

If selected, the rights group members can update the configuration settings.

Media Manager
Administrator

If selected, the rights group members can update Media Manager configurations and
settings. The rights group members can also access all archived recordings.

Media Manager
Standard

If selected, the rights group members can have read-only access to Media Manager
configurations and access to the recordings.

Reporter
Administrator

If selected, the rights group members can have configuration access to Integrated Contact
Reporter.

Web Manager
Rights

These rights are used with web service access to systems such as IP Office Web
Manager.

Related links

Rights Groups on page 137
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Service Users

Service Users

These settings are displayed when Service Users is selected in the navigation pane and a
particular service user is selected in the group pane.

The maximum number of service users is 64.

Field

Description

Name:

Range = Up to 31 characters. Sets the service user's name.

The minimum name length is controlled through General settings.

° Note:

If changing the user name and/or password of the current service user used to load
the security settings, after saving the changes Manager should be closed. Not
closing Manager will cause error warnings when attempting to send any further
changes.

Password:

Range = Up to 31 characters. Sets the service user's password.

To change the current password click Change. Enter and confirm the new password. Note
that an error will be indicated if the password being entered does not meet the password
rules set through General settings.

To clear the cache of previous password details used by the password rules setting, click
Clear Cache. For example, if the rule restricting the reuse of old passwords has been
enabled, clearing the cache allows a previous password to be used again.

Account Status

Default = Enabled.

Displays the current service user account status (correct at the time of reading from the
system). The options are:

+ Enabled This status is the normal non-error state of a service user account. This setting
can be selected manually to re-enable an account that has been disabled or locked.
Note that re-enabling a locked account will reset all timers relating to the account such
as Account Idle Time.

* Force New Password This status can be selected manually. The service user is then
required to change the account password when they next log in. Until a password
change is successful, no service access is allowed. Note that the user must be a
member of a Rights Group that has the Security Administration option Write own
service user password enabled.

+ Disabled This status prevents all service access. This setting can be selected manually.
The account can be enabled manually by setting the Account Status back to Enabled.

Account Expiry

Default = <None> (No Expiry).
Not applicable to Web Manager.

This option can be used to set a calendar date after which the account will become
locked. The actual expiry time is 23:59:59 on the selected day. To prompt the user a
number of days before the expiry date, set an Expiry Reminder Time on the security
General Settings tab.
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Field Description
Rights Group The check boxes are used to set the Rights Groups to which the user belongs. The
Membership user's rights will be a combination of the rights assigned to the groups to which they
belong.
Related links

Security Mode Field Descriptions on page 122
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Chapter 10: Editing Configuration Settings

IP500 V2 Operation

Before editing the system's configuration settings, it is important to understand how those settings
are stored and used by the system.

The control unit holds copies of its configuration in both its internal non-volatile and RAM memory. A
copy is also held on the System SD card (IP500 V2).

The copies in non-volatile memory and System SD card, are retained even if power to the control
unit is removed. During power up, the system loads the configuration file stored on the System SD
card into its RAM memory. Other systems load the configuration stored in non-volatile memory into
RAM memory. The copy in RAM memory is then used to control the system's operation.

If the system encounters a problem using the configuration file in its System SD card's /primary
folder, it attempt to use the copy in its non-volatile memory. For fully details of the IP500 V2 boot
process and SD card usage refer to the IP Office Installation Manual.

Users actions such as changing their forward destinations or mailbox passcode are written to the
configuration in RAM memory.

Changes made using Manager are written to the configuration in non-volatile memory and then
copied into the RAM memory and System SD.

Between 00:00 and 00:30, a daily backup occurs which copies the configuration in the system's
operation RAM memory back into its non-volatile memory and, on IP500 V2 system's, the System
SD card.On IP500 V2 system, the contents of the system memory cards /primary folder can then
also be automatically copied to the /backup folder by enabling System | System | Automatic
Backup.

When the system is shutdown using the correct shutdown method, the configuration in RAM
memory is copied to the non-volatile memory and System SD card.
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Control Unit

Memory RAM Memory

Lser Changes

mmemenennes —p|_Hard Reboot

' _ Daily Backup Current

| M running systern | ——0m 1

| configuration.

: [ Soft Reboot g —

| Mergeable

P - lterms Only J=zer Changes
Manaoer

Feceive

Send ahd Merge Configuration

Send and Rehoot =

Using Manager
When using Manager to edit the configuration settings, the following need to be remembered:

* Manager receives the current configuration settings from RAM memory. Therefore the
configuration it receives includes any changes made by users up to that time. However it will
not contain any subsequent changes made by users.

* When sending the configuration settings back to the system, Manager allows two choices,
reboot or merge.

* Reboot sends the configuration to the system's non-volatile memory along with an instruction
to reboot. Following the reboot, the new configuration in non-volatile memory is copied to the
RAM memory and used.

» Merge sends the configuration to the system's non-volatile memory without rebooting. The
system then copies those changes that are mergeable into the RAM memory. A key point here
is that not all configuration settings are mergeable.

As a result of the above, it is important to bear the follow scenarios in mind:

» Changes made by users after a configuration is received by Manager may be lost when the
configuration is sent back from Manager. Therefore it is preferable to always edit a recently
received copy of the configuration rather than one that has been open for a period of time.

* If a merge is attempted with non-mergeable changes, those items will be written to the non-
volatile memory but will not be copied to RAM memory. If a daily backup occurs, they will then
be overwritten by the RAM. If a power loss reboot occurs, they will be written to RAM memory.

Related links
Mergeable Settings on page 147
Configuration Size on page 156
Setting the Discovery Addresses on page 158
Known System Discovery on page 159
Opening a Configuration from a System on page 161
Opening a Configuration Stored on PC on page 164
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Creating New Records on page 164

Creating an Offline Configuration on page 166
Importing and Exporting Settings on page 167
Copying and Pasting on page 170

Saving a Configuration onto PC on page 171
Sending a Configuration on page 171

Erasing the Configuration on page 174
Default Settings on page 174

Mergeable Settings

Mergeable Settings

The table below shows the configuration records for which changes can be merged and those that
require a system reboot. The Send Configuration menu shown when sending a configuration to
the system automatically indicates when the configuration is mergeable.

Configuration Setting Mergeable | Notes

System | System Yes These settings are mergeable with the exception of
Locale and Favor RIP Routes over Static Routes.
Changing these settings requires a reboot of the
system.

System | LAN | LAN Settings No

System | LAN | VoIP No The following settings are mergeabile:

» Auto-create Extn
* Auto-create User

H.323 Signalling over TLS

Remote Call Signalling Port

Enable RTCP Monitoring on Port 5005

RTCP collector IP address for phones

Scope
Initial keepalives
Periodic timeout
VLAN

1100 Voice VLAN Site Specific Option Number
(SSON)

* 1100 Voice VLAN IDs

The remaining settings are not mergeable. Changes to
these settings will require a reboot of the system.
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Configuration Setting Mergeable | Notes

System | LAN | Network No

Topology

System | LAN | DHCP Pools Yes These settings are mergeable. However, the following

actions require a merge with service disruption.

» Changing the Start Address, Subnet Mask or
Default Router value for an existing DHCP Pool of
addresses.

» Decreasing Pool Size for an existing DHCP Pool of
addresses.

+ Deleting an existing DHCP Pool of addresses.

When these actions are performed, the DHCP (Server
or Dialln) is re-initialized which triggers a reboot of the
Avaya DHCP Clients (H.323 and SIP) in order to force
the Avaya DHCP clients to renew their IP address lease
and apply the new settings. For the remaining Avaya
and non-Avaya DHCP clients, you must manually reboot
the devices in order to force the IP Addresses lease
renewal. Otherwise, the devices continue to use the
allocated IP addresses until the IP addresses lease time
out expires. IP address lease time out is set to three
days.

Note that IP Office supports phone reboot only for E129
and B179 SIP phone models.

System | DNS No
System | Voicemail Yes These settings are mergeable with the exception of
Voicemail Type and Voicemail IP Address. Changes
to these settings requires a reboot of the system.
System | Telephony | Yes Changes to Companding LAW and Media Connection
Telephony Preservation require a reboot.
System | Telephony | Park and | Yes
Page
System | Telephony | Tones Yes » Changes to Disconnect Tone requires a reboot.
e LU » Changes to Busy Tone Detection requires a reboot.
 Deleting any of the hold music Alternate Sources
requires a reboot.
System | Telephony | Ring Yes
Tones
System | Telephony | SM Yes
System | Telephony | Call Log | Yes
System | Telephony | TUI Yes
Table continues...
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Configuration Setting Mergeable | Notes

System | Directory Services | | Yes

LDAP

System | Directory Services | | Yes

HTTP

System | System Events | No

Configuration

System | System Events | No

Alarms

System | SMTP No

System | SMDR Yes

System | VCM Yes

System | CCR Yes

System | Codecs Yes

System | VolP No

System | VoIP Security Yes

System | Dialer Yes Changes to the Operation field or to the Trunk Range /
IP Office table require a reboot.
It is recommended that you do not change the
mergeable settings while the system is in use.

System | Contact Center Yes

Line | Analog Line | Line Yes These settings are mergeable with the exception of the

Settings Network Type setting. Changes to this setting will
require a reboot of the system.

Line | Analog Line | Analog No The Allow Analog Trunk to Trunk Connect setting is

Options mergeable. The remaining settings are not mergeable.
Changes to these settings will require a reboot of the
system.

Line | BRI Line No The following settings are not mergeable. Changes to
these settings will require a reboot of the system.
* Line Sub Type
* Network Type
* TEI
+ Add 'Not-end-to-end ISDN' Information Element
* Progress Replacement
+ Clock Quality
* Force Number Plan to ISDN
Decreasing the Number of Channels setting requires a
a “merge with service disruption”. When the
configuration file is sent to the system, active calls on
the deleted channels are cleared.

Table continues...
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Configuration Setting

Mergeable | Notes

The remaining settings are mergeable.

Line | BRI Line | Channels

Yes

Line | E1 PRI Line

* Line Sub Type

* Network Type

* TEI

+ Channel Allocation
* CRC Checking

» Clock Quality

* Progress Replacement

* Force Number Plan to ISDN
* Line Signalling

the deleted channels are cleared.

The remaining settings are mergeable.

No The following settings are not mergeable. Changes to
these settings require a system reboot.

* Add 'Not-end-to-end ISDN' Information Element

Decreasing the Number of Channels setting requires a
a “merge with service disruption”. When the
configuration file is sent to the system, active calls on

Line | E1 Short Codes

Yes

Line | E1 PRI Channels

No The following settings are mergeable:

+ Admin (ETSI CHI)
* Incoming Group ID (ETSI CHI)
» Outgoing Group ID (ETSI CHI)

» Line Appearance ID (ETSI, ETSI CHI)

The remaining settings are not mergeable. Changes to
these settings require a system reboot.

Line | E1-R2 Options

No Changing the Admin setting is mergeable.

The remaining settings are not mergeable. Changes to
these settings will require a reboot of the system.

Line | E1-R2 Channels

No The following settings are mergeable:
* Incoming Group ID

» Outgoing Group ID

* Admin
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Configuration Setting

Mergeable

Notes

The remaining settings are not mergeable. Changes to
these settings require a system reboot.

Line | E1-R2 MFC Group

No

Line | E1-R2 Advanced

No

Line | US T1 Line

No

The following settings are mergeable:
* Admin
* Prefix

The remaining settings are not mergeable. Changes to
these settings require a system reboot.

Line | T1 Channels

No

The following settings are mergeable:
* Incoming Group ID

» Outgoing Group ID

* Line Appearance ID

* Admin

The remaining settings are not mergeable. Changes to
these settings require a system reboot.

Line | T1 ISDN Line

No

The following settings are mergeable:
* Prefix

» Send Redirecting Number

* Admin

» Send original calling party for forwarded and
twinning calls

 Originator number for forwarded and twinning
calls

The remaining settings are not mergeable. Changes to
these settings require a system reboot.

Line | T1 ISDN Channels

No

The following settings are mergeable:
* Incoming Group ID

* Outgoing Group ID

* Line Appearance ID

* Admin

The remaining settings are not mergeable. Changes to
these settings require a system reboot.

Line | T1 ISDN TNS

No

Line | T1 ISDN Special

No

Line | T1 ISDN Call by Call

No
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Configuration Setting Mergeable | Notes

Line | H.323 Line | VoIP Line Yes

Line | H.323 Line | Short No For line subtypes ETSI, ETSI CHI, QSIG A, and QSIG

Codes B, these settings are mergeable. Changes to these
settings do not require a reboot of the system.

Line | H.323 Line | VoIP Yes

Settings

Line | IP DECT Line | Line Yes When creating an IP DECT line, these settings are

Line | IP DECT Line | Gatewa Yes mergeable. You can also remove an IP DECT line

- | - I 4 without rebooting. Changing an IP DECT line that has

Line | IP DECT Line | VoIP Yes been imported into the configuration is not mergeable.

Line | SIP Line | SIP Line Yes These settings are mergeable with the exception of the
Line Number setting. Changing the Line Number
setting requires a “merge with service disruption”. When
the configuration file is sent to the system, the SIP trunk
is restarted and all calls on the line are dropped.
Deleting a SIP line requires a “merge with service
disruption”.

Line | SIP Line | Transport Yes Changing these settings requires a “merge with service
disruption”. When the configuration file is sent to the
system, the SIP trunk is restarted.

Note that ITSP Proxy Address and Calls Route via
Registrar are mergeable.

Deleting a SIP line requires a “merge with service
disruption”.

Line | SIP Line | SIP URI Yes These settings are mergeable, with the following
exceptions.

* Registration

* |ldentity Header

These settings require a “merge with service disruption”.
When the configuration file is sent to the system, the
SIP trunk is restarted and all calls on the line are
dropped.

Line | SIP Line | VoIP Yes

Line | SIP Line | T38 Fax Yes

Line | SIP Line | SIP Yes

Credentials

Line | SIP Line | SIP Advanced | Yes These settings are mergable, with the exception of the

Media Connection Preservation setting. Changing the
Media Connection Preservation setting requires a
“merge with service disruption”. When the configuration
file is sent to the system, the SIP trunk is restarted and
all calls on the line are dropped.
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Configuration Setting Mergeable | Notes

Line | SIP Line | Engineering Yes

Line | SIP DECT Line | SIP No

DECT Base

Line | SIP DECT Line | VoIP No

Line | SM Line | Session Yes Changing the In Service setting to Disabled (out of

Manager service) requires a system reboot. However, changing
the In Service setting to Enabled is mergeable.
Configuration changes made while the line is out of
service are also mergeable.

Line | SM Line | VolP Yes

Line | SM Line | T38 Fax Yes

Line | IP Office Line | Line No

Line | IP Office Line | Short No For line subtypes ETSI, ETSI CHI, QSIG A, and QSIG

Codes B, these settings are mergeable. Changes to these
settings do not require a reboot of the system.

Line | IP Office Line | VoIP Yes For line subtypes ETSI, ETSI CHI, QSIG A, and QSIG

Settings B, these settings are mergeable. Changes to these

settings do not require a reboot of the system.

Line | IP Office Line | T38 Fax | Yes

Control Unit | Unit No

Extension | Extn Yes Mergeable except Base Extension and Caller Display
Type.

Extension | Analog Extension | | No

Analog

Extension | H323 Extension | No

VolP

Extension | SIP Extension | No

VolP

Extension | SIP Extension | Yes

T38 Fax

Extension | IP DECT Extension | Yes These settings are mergeable with the exception of the

Reserve License setting. Changing the Reserve
License settings requires a reboot of the system.

Extension | SIP DECT Base No

User | User Yes
User | Voicemail Yes
User | DND Yes
User | Short Codes Yes
User | Source Numbers Yes
Table continues...
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Configuration Setting Mergeable | Notes
User | Telephony | Call Yes
Settings
User | Telephony | Supervisor | Yes
Settings
User | Telephony | Multi-line Yes
Options
User | Telephony | Call Log Yes
User | Telephony | TUI Yes
User | Forwarding Yes
User | Dial In Yes
User | Voice Recording Yes
User | Button Programming Yes
User | Menu Programming | Yes
Hunt Group
User | Menu Programming | Yes
4400/6400
User | Mobility Yes
User | Group Membership Yes
User | Announcements Yes
User | SIP Yes
User | Personal Directory Yes
User | Web Self Administration | Yes
Group | Group Yes
Group | Queuing Yes
Group | Overflow Yes
Group | Fallback Yes
Group | Voicemail Yes
Group | Voice Recording Yes
Group | Announcements Yes
Group | SIP Yes
Short Code | Short Code Yes
Service | Service Yes
Service | Bandwidth Yes
Service | IP Yes
Service | Autoconnect Yes
Service | Quota Yes
Service | PPP Yes
Table continues. ..
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Configuration Setting Mergeable | Notes

Service | Fallback Yes

Service | Dial In Yes

SSL VPN Service | Service Yes

SSL VPN Service | Session Yes

SSL VPN Service | NAPT Yes

SSL VPN Service | Fallback Yes

RAS | RAS Yes

RAS | PPP Yes

Incoming Call Route | Yes

Standard

Incoming Call Route | Voice Yes

Recording

Incoming Call Route | Yes

Destinations

WAN Port | WAN Port No

WAN Port | Frame Relay No

WAN Port | DLCIs No

WAN Port | Advanced No

Directory | Directory Entry Yes

Time Profile | Time Profile Yes

Firewall Profile | Standard Yes

Firewall Profile | Custom Yes

Firewall Profile | Static NAT Yes

IP Route | IP Route Yes

IP Route | RIP Dynamic Yes

Routing

Account Code | Account Code | Yes

Account Code | Voice Yes

Recording

License | License Yes

License | Remote Server No The Reserved Licenses setting is mergeable. The
remaining settings are not mergeable. Changes to these
settings requires a reboot of the system.

Tunnel | Tunnel (L2TP) No

Tunnel | Main (IPSec) No

Tunnel | IKE Policies (IPSec) No

Tunnel | IKE Policies (IPSec) No

Table continues...
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Configuration Setting Mergeable | Notes
Auto Attendant | Auto Yes

Attendant

Auto Attendant | Actions Yes

Authorization Codes Yes

User Rights | User Yes

User Rights | Short Codes Yes

User Rights | Button Yes

Programming

User Rights | Telephony | Call | Yes
Settings

User Rights | Telephony | Yes
Supervisor Settings

User Rights | Telephony | Yes
Multi-line Options

User Rights | Telephony | Call | Yes

Log

User Rights | User Rights Yes
Membership

User Rights | Voicemail Yes
User Rights | Forwarding Yes
ARS | ARS Yes
RAS Location Request Yes
Location Yes

Related links

Editing Configuration Settings on page 145

Configuration Size

The maximum size of the configuration file that can be loaded into an IP500 V2 control unit is 2.0
MB.

When you attempt to save a configuration that is too large, you will be prompted and the save is
canceled.

During normal operation, additional configuration records can be added to the configuration
without using Manager (for example call log records and directory records made from phones). If,
during the overnight backup to flash memory, the configuration if found to be too large, records will
be removed until the configuration is sufficiently small to be backed up. The recordsremoved are
call log records, system directory records and then personal directory in that order. Note that those
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records will still exist in the configuration running the system in its RAM memory, however if the
system is restarted they will disappear as the configuration is reloaded from the Flash memory.

Figures for all individual records in the configuration cannot be given as they vary. The list below
gives typical values, in bytes, for common records:

Physical Extension: 70.
IP Extension: 70.

User: 170.

User Short Code: 40.
DSS Button: 20.

Hunt Group: 100.

Hunt Group member: 10.
System Short Code: 10.
Normal Service: 220.
Intranet Service: 240.
WAN Service: 400.

RAS Service: 110.
Incoming Call Route: 30.
WAN Port (PPP): 70.
WAN Port (FR): 120.
Directory Record: 70.
Time Profile: 40.

Time Profile Record: 20.
Firewall Profile: 40.
Custom Firewall Record: 80.
IP Route (Static): 30.
License Key: 40.
Account Code: 40.
Logical LAN: 60.

Tunnel (L2TP): 200.
Tunnel (IPSec): 110.

Related links
Editing Configuration Settings on page 145
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Setting the Discovery Addresses

By default, when 2 or File | Open configuration is selected, Manager's Select IP Office window
opens. It performs a UDP broadcast to the address 255.255.255.255. This broadcast will only
locate systems that are on the same network subnet as the PC running Manager.

For systems not located on the same subnet as the Manager PC, the following options are
supported.

Specific Addressing The Unit/Broadcast Address shown on the Select IP Office menu can be
changed to the specific IP address of the required system. A single address is routable and so can
be used to discover a system on another subnet.

TCP Discovery Address Ranges A set of TCP addresses and address ranges can be specified
for use by the Select IP Office discovery process.

Known System Discovery Manager can write the details of systems it discovers to a file. The list
of systems in that file can then be used for access to those systems.

DNS Lookup Manager can be configured to locate systems using DNS name lookup. This
requires the systems on a customer network to be added as names on the customer's DNS server
and the Manager PC to be configured to use that server for DNS name resolution. The use of
DNS is configured through File | Preferences | Discovery.

Changing the Initial Discovery Settings The Discovery tab of the Preferences menu can be
used to set the UDP and TCP addresses used by the discovery process run by the Select IP
Office menu.

1. Select File | Preferences menu.
2. Select the Discovery tab.

TCP Discovery: Default = On. This setting controls whether Manager uses TCP to discover
systems. The addresses used for TCP discovery are set through the IP Search Criteria field
below.

NIC IP/NIC Subnet This area is for information only. It shows the IP address settings of the LAN
network interface cards (NIC) in the PC running Manager. Double-click on a particular NIC to add
the address range it is part of to the IP Search Criteria. Note that if the address of any of the
Manager PC's NIC cards is changed, the Manager application should be closed and restarted.

IP Search Criteria This section is used to enter TCP addresses to be used for the TCP discovery
process. Individual addresses can be entered separated by semi-colons, for example
135.164.180.170; 135.164.180.175. Address ranges can be specified using dashes, for example
135.64.180.170 - 135.64.180.175.

UDP Discovery: Default = On This settings controls whether Manager uses UDP to discover
systems.

Enter Broadcast IP Address: Default = 255.255.255.255 The broadcast IP address range that
Manager should use during UDP discovery. Since UDP broadcast is not routable, it will not locate
systems that are on different subnets from the Manager PC unless a specific address is entered.
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Use DNS: Selecting this option allows Manager to use DNS name (or IP address) lookup to
locate a system. Note that this overrides the use of the TCP Discovery and UDP Discovery
options above. This option requires the system IP address to be assigned as a name on the users
DNS server. When selected, the Unit/Discovery Address field on the Select IP Office dialogue is
replaced by a Enter Unit DNS Name or IP Address field.

SCN Discovery: If enabled, when discovering systems, the list of discovered systems will group
systems in the same Small Community Network and allow them to be loaded as a single
configuration. At least one of the systems in the Small Community Network must be running
Release 6.0 or higher software. See Configuring Small Community Networking on page 744. This
does not override the need for each system in the Small Community Network to also be reachable
by the TCP Discovery and or UDP Discovery settings above and accessible by the router
settings at the Manager location.

Related links
Editing Configuration Settings on page 145

Known System Discovery

The Select IP Office menu normally displays systems discovered by Manager using either UDP
broadcast and or TCP requests. Manager can be configured to also record details of discovered
units and then display a list of those previously discovered (‘known') systems.

Related links
Editing Configuration Settings on page 145

Configuring Manager for Known System Discovery

About this task

Use of known systems discovery is not enabled by default. The Manager must be configured for
the feature with a file location to which it can store and retrieve known system details.

Procedure

1. Select File | Change Working Directory.
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Yworking Directom [Lofg files)
|E:"~F'ru:ugram Fileghbyapahl P Officeb anager |

Binary Directorny [.bin filez)
|E:'xF'ru:ugram Filez'\dwapahl P Officehid anager |

Known Units File

|E:"\F'r|:|gram Filez'\dywapahl P Officettdanagertknownl PO cav |

2. In the Known Units File field, enter the directory path and file name for a CSV file into
which Manager can write details of the systems it discovers.

If the file specified does not exist it will be created by Manager.
3. Click OK.

Using Known System Discovery

About this task
Procedure

1. When the Select IP Office screen is displayed click on Known Units.

Known [P Dffice Systems

Fiter | IF |
SyztemMame kaCAddress SystemTope  |PAddress Softwaret erzion
k 00007026704 | 1P 500 132168441 | 4.0(51101)
Site & D0e007026fac | 1P 500 132168421 | 4.0(51101)
Site C 0000701 26f: | IP 403 192168461 | 3.2117)
*

[ k. H Cancel ][ Help ]

2. The screen displays the list of systems previously discovered and stored in the CSV file.
3. To select an control unit, highlight the row containing unit data and click OK.
The selected unit will appear in the Select IP Office window.
4. To filter displayed units, type the first few characters of the unit name in the Filter field.
Any unit whose name does not match the filter will be temporarily hidden.

5. Each discovery appends data to the known unit list.

July 2017 Administering Avaya IP Office™ Platform with Manager 160

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Administering Avaya IP Office™ Platform with Manager

Opening a Configuration from a System

It is possible that details of some records in the list may be out of date. Right clicking on
the leftmost (grey) column of any row will bring up a floating menu offering the options of
Refresh and Delete.

6. A new record may be manually added without having to access the system first through
normal discovery.

Enter the IP address of the new system in the IP Address column of the blank row shown
with a * and select Refresh from the floating menu. This will update the Known Units file
with data relating to the unit with the specified address.

7. Select Cancel to return to the Select IP Office menu.
Result

© Note:

» The key used by the Known Systems CSYV file is the IP address. The file cannot contain
records for separate systems that use the same IP address for access.

» The file can be made read only. In that case any attempts using Manager to update the
file will be ignored.

Opening a Configuration from a System

The initial IP address ranges in which Manager searches for systems are set through the Manager
preferences (File | Preferences | Discovery). By default it scans the local network of the Manager
PC.

Start Manager. If Manager is already started and a configuration is open in it, that configuration
must be closed first.

* If Manager is set to Auto Connect on start up, it will scan for systems automatically and either
display the list of systems discovered or automatically start login to the only system
discovered.

* Otherwise, click on 2 or select File | Open Configuration.
The Select IP Office window appears, listing those systems that responded.

* If Server Edition systems are detected, they are grouped together. By default the
configuration of those systems cannot be opened using Manager in Advanced View mode
and the configuration of a Primary Server can only be opened if the Open with Server Edition
Manager option is also selected.

* If Manager has been set with SCN Discovery enabled, systems in a Small Community
Network are grouped together. The checkbox next to the network name can be used to load
the configurations of all the configurations into Small Community Network management
mode.
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* If the system required was not found, the Unit/Broadcast Address used for the search can
be changed. Either enter an address or use the drop-down to select a previously used
address. Then click Refresh to perform a new search.

* The address ranges used by Manager for searching can be configured through the File |
Preferences | Discovery tab.

+ A list of known systems can be stored and used.

* Manager can be configured to search using DNS names. See the setting File | Preferences
Discovery | Use DNS

» Systems found but not supported by the version of Manager being used will be listed as Not
Supported.

* If the system detected is running software other than from its primary folder, a Y warning
icon will be shown next to it. The configuration can still be opened but only as a read-only file.

When you have located the system required, check the box next to the system and click OK.

If the system selected is a Server Editionsystem and Manager is not running in Server Edition
mode, an Open with Server Edition Manager checkbox is shown and pre-selected. Clicking OK
will switch Manager to its Server Edition mode before loading the configuration.

The system name and password request is displayed. Enter the required details and click OK.

The name and password used must match a service user account configured within the system's
security settings.

Additional messages will inform you about the success or failure of opening the configuration from
the system.

The method of connection, secure or insecure, attempted by Manager is set the applications
Secure Communications preferences setting.

* When Secure Communications is set to On, a H padlock icon is displayed at all times in the
lower right Manager status field.

* New installations of Manager default to having Secure Communications enabled. This
means Manager by default attempts to use secure communications when opening a
configuration.

» For Server Edition systems, Manager will always attempt to use secure communications
regardless of the Secure Communications setting.

* If no response to the use of secure communication is received after 5 seconds, Manager will
offer to fallback to using unsecured communications.

Following a successful log in, the configuration is opened in Manager. The menus and options
displayed will depend on the type of system configuration loaded.

Login Messages
While attempting to login to a system, various additional messages may be displayed.

Configuration Not Loaded Messages
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Access Denied This is displayed as the cause if the service user name/password were incorrect,
or the service user has insufficient rights to read the configuration. The Retry option can be used
to log in again but multiple rejections in a 10 minute period may trigger events, such as locking the
user account, set by the Password Reject Limit and Password Reject Action options in the
systems security settings.

Failed to communicate with system This is displayed as the cause if the network link fails, or
the secure communication mode is incorrect (for example Manager is set to unsecured, but the
system is set to secure only).

Account Locked The account of the service user name and password being used is locked. This
can be caused by a number of actions, for example too many incorrect password attempts,
passing a fixed expiry date, etc. The account lock may be temporary (10 minutes) or permanent
until manually unlocked. An account can be enabled again through the system's security settings.

Additional Messages

Your service user account will expire in X days This message indicates that an Account Expiry
date has been set on the system service user account and that date is approaching. Someone
with access to the system's security settings will be required to set a new expiry date.

Your password will expire in X days. Do you wish to change it now? This message indicates
that password ageing has been configured in the system's security settings. If your password
expires, someone with access to the system's security settings will be required to unlock the
account.

Change password Through the system's security settings, a service user account can be
required to change their password when logging in. The menu provides fields for entering the old
password and new password.

Contact Information Check - This configuration is under special control This message will
appear if a Manager user with administrator rights has entered their contact information into the
configuration. For example to indicate that they do not want the configuration altered while a
possible problem is being diagnosed. The options available are:

Retain | Replace | Cancel This message appears when it is detected that the configuration of one
of the systems in a Server Editionnetwork has previously been edited directly rather than via
access to the primary system. Select Replace to replace the system’s update configuration with
the copy already held by the primary server. Select Retain to keep the already updated
configuration.

Cancel Select this option to close the configuration without making any changes.

Set configuration alteration flag Select this option if the configuration is being opened because
some urgent maintenance action. When the configuration is next opened, the fact that it has been
altered will be indicated on the System | System tab.

Delete Contact Information Select this option to take the system out of special control.

Leave contact information and flags unchanged (Administrators only) This option is only
available to service users logging in with administrator rights.
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Related links
Editing Configuration Settings on page 145

Opening a Configuration Stored on PC
About this task

A configuration file previously saved on the PC can be reopened in Manager. This method of
access does not require entry of a service user name and password. All parts of the configuration
are visible.

Use either of the following processes to load a saved configuration file:
Procedure

1. Click % the main toolbar or select File | Offline | Open File from the menu bar. If the files

is one that has previously been opened offline, click the = symbol next to (% in the main
toolbar

2. An Open configuration file window appears.
Use this to browse to the required configuration file.
3. Select the file and click Open.

Related links
Editing Configuration Settings on page 145

Creating New Records

There are a number of ways in which you can add new records to the configuration currently
loaded in Manager.

Related links
Editing Configuration Settings on page 145

Adding a New Record Using the Details Pane

About this task
Procedure

1. Use the navigation pane, groups pane or navigation toolbar, select an existing record of
the type required.

2. Click & at the top-right of the details pane.
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3. Select the type of record required.
For example, with extensions you can select from H.323 Extension or SIP Extension.

4. Complete the settings for the new record and click OK.

Adding a New Record Using the Group Pane

About this task
Procedure

1. Using the navigation pane or navigation toolbar, select the type of record required.

2. Right-click on the group pane and select ] New.
3. If alist is displayed, select the specific type of record required.
4

. Complete the settings for the new record and click OK.

Adding a New Record Using the Navigation Pane

About this task
Procedure

1. Inthe navigation pane, right-click on the type of record required and select _1 New.
2. If alist is displayed, select the specific type of record required.

3. Complete the settings for the new record and click OK.

Other record creation methods

About this task
Procedure

1. Import records

New records can be created for users, hunt groups, short codes and directory entries by
importing files. See Importing and Exporting Settings on page 167.

2. Automatically create records
There are scenarios where new records are automatically added to the configuration:

+ Certain default records are added to the configuration when a new system is started or
when a system configuration is erased.

* New records for extensions and lines are automatically added to match the hardware
present when a system is started or rebooted.
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* For telephones connected via IP links (H.323, SIP and DECT), the system can be
configured to automatically create extension and or user records to match the
telephone.

3. Use templates to create records

Manager supports a number of methods by which new records can be created from
templates. See Working with Templates on page 547.

Creating an Offline Configuration
About this task

Manager can be used to create a new configuration without connecting to a system. This allows
the creation of a configuration prior to installation of the real system and so can be used to speed
up the installation process.

The configuration created must match the physical equipment in the system into which the
configuration will be loaded. Doing otherwise may cause the system to reset and experience other
problems.

The Create Configuration tool includes all control units, external expansion modules and trunk
cards supported. It is your responsibility to confirm what equipment is supported in your locale.

Creating a New Configuration
Procedure

1. Close or save any configuration currently open.

2. Click == in the main toolbar or select File | Offline | Create New Config.

3. You should set the Configuration, Locale, Extension Number Length and System Unit
first.

Changing any of these after you start selecting other system hardware will reset the
hardware selections.

4. Select the type of Configuration you want to create.

The other options available will change depending on the selection. If the menu has been
started from Manager running in Server Edition mode, the only option is Server Edition
Edition.

5. Select the Locale for the system.
This defines a range of features such as default telephony settings.
6. The Extension Number Length setting value can be None or 3 to 15.

If a value is selected, all default extension, user and hunt group extension numbers
created by Manager will be that length. In addition Manager will display a warning if an
extension number of a different length is entered when editing the configuration.
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10.
1.

12.

13.
14.

Importing and Exporting Settings

. Select the type of System Unit.

Select the hardware components for the system. For a Server Edition system this is only
necessary if a Expansion System (V2) is selected as the System Units option.

Select the additional cards to include in the control unit.

The number and type of cards selectable will depend on the control unit type.

Select the external expansion modules to also include in the system.

Click OK.

For non-Server Edition systems, the configuration is created and loaded into Manager.

For Server Edition systems, the Initial Configuration menu for the selected type of system
unit is displayed. Complete the menu and click Save.

Once this configuration has been edited as required it can be saved on the PC or sent to a
system.

To Save a Configuration File on the PC Use File | Save Configuration.

To Send the Configuration to a System If the system which you want to use the
configuration is available, use File | Offline | Send Configuration to send the configuration
to it.

A Warning:

This action will cause the system to reboot and will disconnect all current calls and
service.

» Ensure that you have a copy of the systems existing configuration before overwriting it
with the off-line configuration.

+ After sending the configuration, you should receive the configuration back from the
system and note any new validation errors shown by Manager. For example, if using
Embedded Voicemail, some sets of prompt languages may need to be updated to match
the new configurations locale setting using the Add/Display VM Locales option.

Related links
Editing Configuration Settings on page 145

Importing and Exporting Settings

Manager can import configuration settings created elsewhere. This can be useful when setting up
a new system or sharing common settings such as a directory between systems.

The system supports LDAP (System | Directory Services | LDAP) for automatic importation of
directory records (LDAP Version 2).

The system also supports HTTP (System | Directory Services | HTTP) for automatic importation
of directory records.
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© Note:

You can also manage configuration settings using templates. See Working with Templates on
page 547.

Settings are imported and exported in the following formats:

 Binary Files (.exp) These are non-editable files. During import and export it is possible to
select what types of records should be included in the file. During import the whole file is
imported.

+ Comma Separated Variable Text Files (.csv) These are plain text files. In addition to being
exported from a system these files can be created and edited using programs such as
WordPad or Excel.

When opening a .csv file in Excel it will alter the way some data is displayed, automatically
changing the display format of dates and long numbers such as phone numbers.

UTF-8 Character Encoding Manager imports and exports CSV files using UTF-8 character
encoding which uses a multiple bytes to support characters with diacritic marks such as a. Other
applications, such as Excel, may, depending on the user PC settings, use different encoding which
will cause such characters to be removed or corrupted. Care should be taken to ensure that any
tool used to create or edit the CSV supports all the characters expected and uses UTF-8 format.

* Importing into Manager from Excel From Excel save the file as a .csv. This file will use
ANSI character encoding. Open the file in Notepad and use the Save As option to rename
the file and select UTF-8 encoding. Import the UTF-8 version of the file into Manager.

« Exporting from Manager into Excel Do not double-click on the file exported from Manager.
Start Excel and use File | Open to select the file. Excel will recognize that the file uses UTF-8
encoding and will start its text file importation wizard. Follow the wizard instructions and
select comma as the field delimiter.

CSV File Formats

The format is CSV using commas as field separator, no text delimiters and no header row. The
simplest way to check the required format for a CSV file prior to import, is to export and a file from
an existing system configuration.

File Name Fields in Order

Configuration Proprietary format. Note that this does not contain all configuration
fields.

License The License option is only available for export and only for ADI licenses
present on the system.

Short Code Code, Telephone Number, Feature.

User Name, Extension, User Rights, Email Address, Full Name, Password,
VoiceMail Code, Login Code, UserTemplate, ExtensionTemplate.

Directory Name, Number, Speed Dial.

Group Name, Extension, Group, Hunt, Rotary, Longest Waiting, Queuing On,

Voicemail On, Broadcast, Voicemail Email.
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© Note:

Group: Apart from Name, Extension and Voicemail Email, the fields use a 1 or 0 value for on
or off.

The format of the system CSV is too complex to be described. It is a full export of all the system's
configuration settings. This file format should only be used for export and import between systems
and not for any offline editing.

Using the CSV Configurator spreadsheet

You can use the CSV Configurator spreadsheet to create or modify multiple configuration entries.
The CSV Configurator spreadsheet is available in the Manager application folder. By default,
Manager is installed under C: \Program Files or C:\Program Files (x86) on Windows 7.

The remaining path and file name is .. .\Avaya\IP Office\Manager\IP Office User
CSV Configurator.xlsm.

Follow the procedure below to export configuration settings. You can then use the exported files
with the CSV Configurator spreadsheet. Follow the instructions in the spreadsheet.

Related links
Editing Configuration Settings on page 145

Exporting Settings

About this task
Procedure

1. Select File | Import/Export... from the menu bar.
2. Select Export.
3. Select the type of file.
The list of exportable record types will change to match the file type.
4. Select the types of items that should be exported.
5. Use the Save In path to select the location for the exported files.

The default location used is a subfolder in the Manager application directory based on
system name of the currently loaded system. For example, .. .\Avaya\IP Office
\Manager\System 1.

6. Click OK.

Importing Settings

Importing settings will overwrite any existing records that match a record being imported
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Procedure
1. Select File | Import/Export... from the menu bar.
2. Select Import.
3. Select the type of file.

The list of items will change to match the type of file selected and whether a matching file
or files is found in the current file path.

4. Use Look In to adjust the file path.

The default location used is a subfolder in the Manager application directory based on
system name of the currently loaded system. For example, .. .\Avaya\IP Office
\Manager\System 1.

5. Select the types of items that should be imported.
6. Click OK.

Copying and Pasting

Manager supports the normal Windows methods of cutting, copying, pasting and deleting records
and settings. These can be accessed through the Edit menu in the menu bar or using the
standard Windows keyboard shortcuts for those actions. They can also be accessed by selecting
a record or text field and then right-clicking.

Copy and paste can be used with the navigation and group panes to create a new record with the
same settings as the original. The copy will be renamed as Copy of ... to avoid conflicting with the
original.

When using copy and paste between individual settings fields, whether on the same record or a
different record, care should be taken to ensure that the fields use the same type of data. Similarly
copying a record in the navigation or group pane and then pasting it into the details pane will
prompt Manager to paste the copied records data into the first field of the current record in the
details pane. As a general rule, cut and paste actions should be used with the same pane and
within similar record types.

For users and user rights, a number of controls have been provided to copy settings between a
user and a user right or vice versa. See Configuring User Rights on page 614.

Related links
Editing Configuration Settings on page 145
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Saving a Configuration onto PC

The system configuration settings shown within Manager can be saved as a .cfg file on the
Manager PC. These files can be used as backups or sent to other persons to aid problem
diagnostics. Note however that an offline configuration file does not include the Audit Trail records
for the system.

Automatically Saving Sent Configurations

By default, Manager creates a file copy of the configuration before it is sent to the system. This
copy is stored in Manager's Working Directory using the system name and .cfg. This behavior is
controlled by the Backup File on Send (File | Preferences | Security) option.

The number of backups of each systems configuration can be limited to a set number of the most
recent copies.

Saving a Configuration Received from a System
Select File | Save Configuration as from the menu bar.

Saving a Configuration opened on the PC

Click = in the main toolbar or select File | Save Configuration from the menu bar.

Related links
Editing Configuration Settings on page 145

Sending a Configuration

The current configuration settings open within Manager can be sent to the system. The method
depends on whether Manager is being used to edit the configuration of a single system or a
network of systems.

Sending an Individual System Configuration

The first steps of this process depend on whether you are sending a configuration received from
the system or sending one opened offline/created new.

° A Configuration Opened from a System Click il in the main toolbar or select File | Save
Configuration from the menu bar.

* A Configuration Created Offline or Opened from a PC File Select File | Offline | Send
Config from the menu bar.

The Send Configuration menu is displayed.

Configuration Reboot Mode If Manager thinks the changes made to the configuration settings
are mergeable, it will select Merge by default, otherwise it will select Inmediate.

* Merge Send the configuration settings without rebooting the system. This mode should only
be used with settings that are mergeable. Refer to Mergeable Settings.
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* Immediate Send the configuration and then reboot the system.

* When Free Send the configuration and reboot the system when there are no calls in
progress. This mode can be combined with the Call Barring options.

* Timed The same as When Free but waits for a specific time after which it then wait for there
to be no calls in progress. The time is specified by the Reboot Time. This mode can be
combined with the Call Barring options.

* Reboot Time This setting is used when the reboot mode Timed is selected. It sets the time
for the system reboot. If the time is after midnight, the system's normal daily backup is
canceled.

» Call Barring These settings can be used when the reboot mode When Free or Timed is
selected. They bar the sending or receiving of any new calls.

Click OK. A service user name and password may be requested.
* If the service user name or password used do not valid, "Access Denied" is displayed.

* If the service user name used does not have rights to send a configuration or to request a
reboot or merge, "Insufficient service user rights" is displayed.

« If the service user name used does not have operator rights to make the changes that have
been made to the configuration, "Insufficient operator rights. Operator cannot modify
XXXX records" is displayed.

* The warning will appear if the configuration being sent contain any errors indicated by a X
icon in the error pane. The configuration can still be sent by selected Yes.

* The message Failed to save the configuration data. (Internal error) may indicate that the
IP500 V2 system has booted using software other than that in its System SD card's primary
folder.

Sending Multiple Configurations

When Manager is running in Server Edition mode or SCN Management mode, it loads multiple
configurations at the same time.

1. Click l= in the main toolbar or select File | Save Configuration from the menu bar.

2. The menu displayed only shows details for those systems where the system configuration
has been changed and needs to be sent back to the system.
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il send Multiple Configurations o ] |
Select | IP Office Change Mode RebootTime IBr:;::irrl;l;ng £ g:r?:;ng £ g;::s Progress
» 00016CE3BS63 | Merge v|los:0 r r Q9
¥ |systemC Merge j 08:20 Il | B 0%
¥ |systemD Merge j 08:20 r r a 0%
¥ |systemE Merge v|los:0 - i N 0%

Help

+ Select By default all systems with configuration changes are selected. If you want to exclude

a system from having its configuration updated, either deselect it or cancel the whole

process.

» Change Mode If Manager thinks the changes made to the configuration settings are

mergeable, it will select Merge by default, otherwise it will select Inmediate.

* Merge Send the configuration settings without rebooting the system. This mode should only

be used with settings that are mergeable. Refer to Mergeable Settings.

* Immediate Send the configuration and then reboot the system.

* When Free Send the configuration and reboot the system when there are no calls in

progress. This mode can be combined with the Incoming Call Barring and Outgoing Call
Barring options.

+ Store Offline It is possible to add a reference for a Server Edition Secondary or for a Server
Edition Expansion System to create a configuration file for that system even though it is not
physically present. Store Offline saves that configuration on the Server Edition Primary in its

file store. The same file is retrieved from there until such time as the physical server is

present at which time you are prompted whether to use the stored file or the actual servers
current configuration.

» Timed The same as When Free but waits for a specific time after which it then wait for there
to be no calls in progress. The time is specified by the Reboot Time. This mode can be
combined with the Incoming Call Barring and Outgoing Call Barring options.

* Reboot Time This setting is used when the reboot mode Timed is selected. It sets the time

for the system reboot. If the time is after midnight, the system's normal daily backup is

canceled.

* Incoming Call Barring This setting can be used when the reboot mode When Free or

Timed is selected. It bars the receiving of any new calls.

» Outgoing Call Barring This setting can be used when the reboot mode When Free or
Timed is selected. It bars the making of any new calls.

Click OK. The progress of the sending of each configuration is displayed.

Related links

Editing Configuration Settings on page 145
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Erasing the Configuration
About this task

The system configuration settings can be erased. During this process, the system is rebooted and
starts with a set of default settings. This process does not erase the security settings of the
system.

Erasing the Configuration

Procedure
1. Select File | Advanced | Erase Configuration (Default).
2. Enter a valid user name and password.
3. The system will be rebooted.

Related links
Editing Configuration Settings on page 145

Default Settings

The following applies to new systems and those defaulted using the Erase Configuration
command. They also apply to IP500 V2 control units defaulted using the reset button on the rear
of the unit (refer to the Installation manual for details of using the reset button).

Mode

IP500 V2 control units can operate in a number of modes. The initial mode is determined by the
type of System SD card fitted and the level of software.

IP Office A-Law: A system fitted with this type of card will default to A-Law telephony.
IP Office U-Law: A system fitted with this type of card will default to U-LAW telephony.

Enterprise Branch: Use this option for an SD card intended to be used with an IP Office system
running in Enterprise Branch Mode. There is a separate SD card for Enterprise Branch. The
Enterprise Branch SD card can only be used for Enterprise Branch operation and cannot be used
to change modes to IP Office. You also cannot use or change an IP Office SD card for use with an
Enterprise Branch system.

A Warning:

Do not re-purpose a Enerprise Branch card for use with any other IP Office mode. Doing so
may damage the SD card and make it unusable for your Enterprise Branch system.

Default Short Codes

For IP500 V2 control units, A-Law or U-Law operation is determined by the Feature Key dongle
installed in the system. Depending on the variant, a default system will use different sets of default
short codes. See the Default System Short Code List on page 777.
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Default Data Settings

When a new or defaulted control unit is switched on, it requests IP address information from a
DHCP Server on the network. This operation will occur whether the LAN cable is plugged in or
not.

If a DHCP server responds within approximately 10 seconds, the control unit defaults to being a
DHCP client and uses the IP address information supplied by the DHCP server.

If no DHCP Server responds, the control unit still defaults to being the DHCP client but assumes
the following default LAN addresses:

» For its LAN1 it allocates the IP address 192.168.42.1 and |IP Mask 255.255.255.0.

* For its LANZ2 if supported, it allocates the IP address 192.168.43.1 and IP Mask
255.255.255.0.

Once a control unit has obtained |IP address and DHCP mode settings, it will retain those settings
even if rebooted without a configuration file present on the System SD card. To fully remove the
existing IP address and DHCP mode setting, the system must be defaulted using Manager.

Default Security Settings

Security settings are held separately from the configuration settings and so are not defaulted by
actions that default the configuration. To return the security settings to their default values the
separate Erase Security Settings command should be used.

Default Standard Mode Telephony Configuration Settings

A hunt group Main is created with extension number 200. The first 16 extensions on the systems
are added to the group.

All physical extensions ports are numbered from extension number 201 upwards. A matching user
record for each extension is also created.

A default incoming call route for all voice calls is created, with the default hunt group Main as its
destination.

A default incoming call route for data calls is created with the default RAS record Dialln as its
destination.

All lines are defaulted to Incoming Group ID and Outgoing Group ID of 0.

Default short codes are created based on whether the system's locale is A-Law or U-Law.
Default Server Edition Telephony Configuration Settings

No users except NoUser.

All extensions are unnumbered.

No default hunt group or incoming calls routes are created.

All auto-create options are off by default.

Related links
Editing Configuration Settings on page 145
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Chapter 11: Configuration Mode Field
Descriptions

This following sections detail the configuration settings for the different record types within the
system. Depending on the type and locale of the system some settings and tabs may be hidden as
they are not applicable. Other settings may be grayed out. This indicates that the setting is either for
information only or that another setting needs to be enabled first.

Related links
Configuration field display on page 177
BOOTP Record on page 180
Operator on page 182
System on page 182
Line on page 250
Control Unit on page 350
Extension on page 351
User on page 368
Group on page 416
Short Code on page 438
Service on page 439
RAS on page 451
Incoming Call Route on page 453
WAN Port on page 462
Directory Entry on page 467
Time Profile on page 468
Firewall Profile on page 470
IP Route on page 474
Account Code on page 477
License on page 479
Tunnel on page 484
Auto Attendant on page 490
Authorization Codes on page 495
User Rights on page 496
ARS on page 505
RAS Location Request on page 509
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Configuration field display

Location on page 510

Configuration field display

The way that the system configuration settings are grouped and displayed in the navigation pane
depends on whether Manager is running in its normal Standard mode or in Server Edition mode.

Related links
Configuration Mode Field Descriptions on page 176
Configuration field display in Standard mode on page 177
Configuration field display in Server Edition mode on page 178

Configuration field display in Standard mode

This order of display of different types of configuration record is used for Standard mode systems.
*=/ System Overall settings for the data and telephony operation of the system.
“’f Line Settings for trunks and trunk channels within the system.
~~" Control Unit Information summary of the system.
& Extension Settings for extension ports.
ﬁ User Settings for each system user. They may or may not be associated with an extension.

m Hunt Group Collections of users to which calls can be directed for answer by any one of those
users.

9% Short Code These are numbers which when dialed trigger specific features or are translated
for external dialing. Short codes can be set at both the system wide level and locally for a
particular system.

9 Service Configuration settings such as user names and passwords needed for connections to
data services such as the Internet.

%, RAS Remote Access Service settings for connecting incoming data calls.

@ Incoming Call Route Records here are used to match incoming call details on external trunks
to destinations on the system.
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% WAN Port Configuration settings for the WAN ports provided on some units.

— Directory External names and numbers. Used for matching names to incoming calls and for
dialing from user applications.

N
j, Time Profile Used to control when various functions are active.
@ Firewall Profile Use to control the types of data traffic that can cross into or out of the system.

IP Route These records are used to determine where data traffic on the system should be
routed.

B Account Code Used for call logging and to control the dialing of certain numbers.

W License License keys are used to enable system features and applications.

W« Tunnel Used to created IPSec and L2TP data tunnels.

@i"} User Rights Provide templates to control the settings applied to associated users.
ﬁ Auto Attendant Used when an Avaya memory card is installed in the control unit.

Y ARS Automatic Route Selection is used by to control outgoing external calls.

% Authorization Codes Authorization codes are similar to account codes. However, unlike
account codes which are usable by any user, each authorization code is only usable by a specific
user or users associated with a specific set of user rights.

Related links
Configuration field display on page 177

Configuration field display in Server Edition mode

When Manager is being used in Server Edition mode, the navigation pane works in the same way
as normal. However, the different types of configuration records are ordered and grouped
differently. This reflects the fact that some types of record are automatically shared across all
systems in the network.

Solution settings

The first 8 types are records have special behaviors that are different from normal records stored
in the configurations of individual systems in the network.
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ﬁ User These records show settings for system users. Each user may or may not be associated
with an extension. All the users configured on all systems are grouped here to allow easy
configuration access. The individual user records are still stored in the configuration of the
particular system on which the user was created and can also be accessed through that system's
configuration settings. New users are created through the User settings of the system that hosts
the user.

% Hunt Group These records are groups of users to which calls can be directed for answering
by any one of those users. Hunt group records are stored in the configuration of the Primary
Server but those hunt groups are advertised for use by all systems in the network.

— Directory External names and numbers. These records are used to match names to incoming
calls and for making calls by name selection from the directory on phones or in applications.
These directory records are stored in the configuration of the Primary Server. By default all other
systems in the network automatically import a copy of the Primary Server system directory at
regular intervals.

By default, the following types of records are all shared and replicated by each system in the
network and cannot be set at an individual system level. That operation can be changed using the
consolidation settings.

9x Short Code These are numbers which when dialed trigger specific features or are translated
for external dialing. These short codes are common to all systems in the network.

e Incoming Call Route Records set here are used to match incoming call details on external
trunks to destinations. These incoming call routes are shared by all systems in the network.

V)
f, Time Profile Used to control when various functions are active. The time profiles set here are
shared by all systems in the network.

88 Account Code Used for call logging and to control the dialing of certain numbers. The account
codes set here are shared by all systems in the network.

%"} User Rights Provide templates to control the settings applied to users associated with a
particular set of user rights. These user rights are shared and replicated on all systems in the
network.

Individual system settings

In addition to the settings above, a range of other types of record can be configured for each
individual system in the network. Visibility and configuration of Short Code, Incoming Call Route,
Time Profile, Account Code and User Rights records is dependent on the consolidation settings
of Manager.

=’ System A system icon is shown for each system in the network. That is, one for the Primary
Server, one for the the Secondary Server if installed and one for each Expansion System (L) and
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Expansion System (V2) systems. Each can be expanded to allow configuration of records that are
particular to that system.

“’{ Line Settings for trunks and trunk channels within the system.

~~" Control Unit Information summary of the system.
£ Extension Settings for extension ports.

ﬁ User Settings for each system user. They may or may not be associated with an
extension.

9% Short Code These are numbers which when dialed trigger specific features or are
translated for external dialing.
&F; Service Configuration settings such as user names and passwords needed for
connections to data services such as the Internet.

‘%@ RAS Remote Access Service settings for connecting incoming data calls.
@ WAN Port Configuration settings for the WAN ports provided on some units.

@ Firewall Profile Use to control the types of data traffic that can cross into or out of the
system.

IP Route These records are used to determine where data traffic on the system should
be routed.

& License License keys are used to enable system features and applications.
W¥ Tunnel Used to created IPSec and L2TP data tunnels.
Y ARS Automatic Route Selection is used by to control outgoing external calls.

% Authorization Codes Authorization codes are similar to account codes. However, unlike
account codes which are usable by any user, each authorization code is only usable by a
specific user or users associated with a specific set of user rights.

Related links
Configuration field display on page 177

BOOTP Record

Navigation: BOOTP | BOOTP Record
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BOOTP Record

The BOOTP settings are used by the Manager application itself. They are not system
configuration settings.

BOOTP is protocol used by devices to request software when restarting. It is used when
upgrading the control unit within a system or when the core software within the control unit has
been erased. When running, Manager can respond to BOOTP requests and, if it finds a matching
BOOTP record for the system, provide the software file indicated by that record.

BOOTP records are not part of a system's configuration settings, they are items saved on the

Manager PC. Normally Manager automatically creates a BOOTP record for each system with

which it has communicated, up to a maximum of 50 records. However BOOTP records can be
added and edited manually when necessary.

Field

Description

File Location

The location from which Manager provides files in response to BOOTP is its binaries
directory. This can be changed using File > Change Working Directory or File >
Preferences > Directories.

This directory is also the directory used by Manager when providing files by TFTP.

Disabling BOOTP

Manager can be disabled from providing BOOTP support for any systems. Select File >
Preferences > Preferences > Enable BOOTP and TFTP Server.

Enabled

Default = Enabled

If unchecked, BOOTP | BOOTP Record support for the matching system from this
Manager PC is disabled.

System Name

This field is not changeable. It shows the system name.

MAC Address

The MAC address of the system. The address can be obtained and or verified in a number
of ways:

* When a system's configuration settings are loaded into Manager, it is shown as the
Serial Number on the Unit form. On defaulted systems, it is also used as the system
name.

« If the system is requesting software, the MAC address is shown as part of the request in
the status bar at the base of the Manager screen.

« If the system can be pinged, it may be possible to obtain its MAC address using the
command arp -a <ip address>.

IP Address

The IP address of the system's LAN1.

Filename

The name of the .bin software file used by that type of control unit. To be transferred to the
system, this file must exist in the Manager applications Working Directory.

Time Offset

: Default = 0.

In addition to performing BOOTP support for systems, the Manager application can also
act as a time server (RFC868). This field sets the offset between the time on the PC
running Manager and the time sent to the system in response to its time requests. The
field is not used if a specific Time Server IP Address is set through the System form in the
system's configuration settings.

Manager can be disabled from acting as an Internet Time (RFC868) server. Select File >
Preferences > Preferences and uncheck Enable time server.
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Related links
Configuration Mode Field Descriptions on page 176

Operator

Operator records are not part of a system's configuration settings. They are used when a pre-
Release 3.2 configuration is loaded to control what parts of a configuration can be edited.

Operator View Edit New Delete Configuration Record
Types

Administrator Yes Yes Yes Yes All configuration records

Manager Yes Yes Yes Yes View all. Other actions

Extension, User, Hunt Group,
Short Code, Service, RAS,
Incoming Call Route,
Directory, Time Profile,
Firewall Profile, IP Route,
Least Cost Routing, Account
Code, ARS.

Operator Yes Yes — — View all configuration
records. Edit all except
System, Line, Control Unit
and Authorization Codes.

If an invalid operator is specified while receiving a configuration from a pre-3.2 system, the
settings will be loaded using the Guest operator. This additional operator allows a read-only view.

Related links
Configuration Mode Field Descriptions on page 176

System

Navigation: System

There is one System record for each system being managed. When managing multi system
Server Edition or Small Community Network deployments, clicking on the System icon for a
particular system displays a system inventory page for that system.
Related links
Configuration Mode Field Descriptions on page 176
System on page 183
LAN1 on page 189
LANZ on page 202
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System

DNS on page 203
Voicemail on page 203

Telephony on page 211
Directory Services on page 226

System Events on page 231
SMTP on page 238
System | SMDR on page 239

VCM on page 240
Integrated Contact Reporter on page 243

VoIP on page 243

VolP Security on page 245
Dialer on page 246

Contact Center on page 248

System

Navigation: System | System

Additional configuration information

For additional information on time settings, see System Date and Time on page 543.

Configuration settings

These settings are mergeable with the exception of Locale and Favor RIP Routes over Static
Routes. Changing these settings requires a reboot of the system.

Field

Description

Name

Default: = System MAC Address.

A name to identify this system. This is typically used to identify the configuration by the
location or customer's company name. Some features such as Gatekeeper require the
system to have a name. This field is case sensitive and within any network of systems
must be unique. Do notuse <, >, |,\0, :;, %, ?, . or/.

Contact
Information

Default = Blank.

This field is only be edited by service user with administrator rights. If Contact Information
is entered, it will set the system under 'special control'.

If the contact information is set using a standalone version of Manager, warnings that
"This configuration is under special control" are given when the configuration is opened
again. This can be used to warn other users of Manager that the system is being
monitored for some specific reason and provide them with contact details of the person
doing that monitoring.

Locale

Sets default telephony and language settings based on the selection. It also sets various
external line settings and so must be set correctly to ensure correct operation of the
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Field Description
system. See Avaya IP Office™ Platform Locale Settings. For individual users, the system
settings can be overridden through their own locale setting Select User | User | Local.
Location Default = None.

Specify a location to associate the system with a physical location. Associating a system
with a location allows emergency services to identify the source of an emergency call.
The drop down list contains all locations that have been defined in the Location page.

Customize Locale Settings

The Customize locale matches the Saudi Arabia locale but with the following additional controls shown below.
For other locales, these are set on System | Telephony | Tones and Music.

Tone Plan

Default = Tone Plan 1

The tone plan control tones and ringing patterns. The options are:
* Tone Plan 1: United States.

* Tone Plan 2: United Kingdom.

» Tone Plan 3: France.

» Tone Plan 4: Germany.

* Tone Plan 5: Spain.

CLI Type

Used to set the CLI detection used for incoming analogue trunks. The options are:
« DTMF

« FSK V23

* FSK BELL202

Device ID

Server Edition Only. Displays the value set for Device ID on the System | System Events
| Configuration tab. If an SSL VPN is configured, Avaya recommends that the Device ID
match an SSL VPN service Account Name. Each SSL VPN service account name has an
associated SSL VPN tunnel IP address. Having the displayed Device ID match an SSL
VPN service account name helps identify a particular SSL VPN tunnel IP address to use
for remotely managing IP Office.

TFTP Server IP
Address

Default = 0.0.0.0 (Disabled).

While running, Manager can act as a TFTP server and provides files from its configured
binaries directory. To set the address to broadcast, use the value 255.255.255.255.

° Note:

The following Manager settings are disabled by default:

» Security Settings | Unsecured Interfaces | Applications Controls | TFTP
Directory Read

* File | Preferences | Preferences | Enable BootP and TFTP Servers

On Server Edition Systems, the default setting on the Primary Server is 0.0.0.0
(disabled). The default setting on Secondary and Expansion servers is the address of the
Primary Server.
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Field

Description

For Avaya IP phones using the system for DHCP, the address set here is used when they
make TFTP requests for software and settings files.

On systems with an Avaya memory card, the LAN1 IP Address can be entered to specify
that memory card as the TFTP file source. The files required for download must be
transferred onto the card using either TFTP from the PC command line (see File Writer
IP Address below) or through Embedded File Management.

1100, 1200, 1600 and 9600 Series IP phones do not support TFTP and require an HTTP
Server IP Address (see below) to be specified.

This address is only used in DHCP responses if the Phone File Server Type is set to
Custom.

HTTP Server IP
Address

Default = 0.0.0.0 (Disabled).

For Avaya IP phones using the system for DHCP, the address set here is used when they
make HTTP requests for software and settings files. The files for download should be
placed in the HTTP server's root directory.

Using the system's own memory card is supported as the source for HTTP files. This is
supported for up to 50 IP phones total. This is done by setting the TFTP Server IP
Address and HTTP Server IP Address to match the system IP address.

HTTP-TFTP Relay is support using Manager as the TFTP server (not supported by Linux
based systems). This is done by setting the TFTP Server IP Address to the address of
the Manager PC and the HTTP Server IP Address to the control unit IP address. This
method is supported for up to 5 IP phones total.

This address is only used in DHCP responses if the Phone File Server Type (see below)
is set to Custom.

Phone File Server
Type

Default = Memory Card (Disk on a Linux system).

For IP (H.323 and SIP) phones using the system as their DHCP server, the DHCP
response can include the address of a file server from which the phone should request
files. The setting of this field controls which address is used in the DHCP response. The
options are:

» Custom: The DHCP response provided to phones it is supporting contains the TFTP
Address from the TFTP Server IP Address above and the HTTP Address from the
HTTP Server IP Address above.

* Memory Card (Disk on a Linux system): The system will respond to file requests from
phones using files on its own memory card. The DHCP response provided to phones it
is supporting contains the LAN address of the system for both TFTP and HTTP
address.

* Manager: The system will forward any H.323 phone file request to the configured
Manager PC IP Address set below. HTTP-TFTP relay is used for HTTP requests. The
DHCP response provided to phones the system is supporting contains the LAN address
of the system for the HTTP Address. This option is not supported for Linux based
systems.

HTTP Redirection

Default = Off.
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Field

Description

Allows for the use of an alternate HTTP file server for the download of large binary files.
This field is available when the Phone File Server Type is set to Memory Card (or Disk
on a Linux system). When this field is set to Phone Binaries, 96x1 H.323 phones
requesting their binary files are redirected to the HTTP server defined in the HTTP Server
IP Address field.

Manager PC IP

Default = 0.0.0.0 (Broadcast).

HTTP Provisioning

QOtisss This address is used when the Phone File Server Type is set to Manager.

Avaya HTTP Default = Off.

Clients Only When selected, the system only responds to HTTP requests from sources it identifies as
another system, an Avaya phone or application.

Enable SoftPhone | Default = Off.

This option must be enabled if the IP Office Video Softphone is being supported.

Use Preferred
Phone Ports

Default = Off

When selected, the system allows users to configure firewalls to block ports 80 and 443 if
alternate mechanism for administration is provided. Phones can use either port 411 or
8411 if supported. Legacy phones that still require 80 and 443 can continue to use those
ports through IP Office HTTP server. Where possible, HTTP requests from phones
received on ports 80 and 443 must result in the phone proceed to use 8411/411,
However, files continue to be served on the ports 80 and 443 to allow functionality of non-
compliant phones. Configuration files served to phones, that are not behind an SBC,
defines 8411 for HTTP and additionally 411 for TLS if the phone supports it and the phone
is remote, or incoming request is already secure.

When cleared, phones can continue to connect through all the four ports. DHCP provided
HTTP IP addresses are served.

Favor RIP Routes
over Static Routes

Default = Off

RIP can be enabled on the system LAN1 and LANZ2 interfaces and on specific Services.
When this setting is on, the RIP route to a destination overrides any static route to the
same destination in the system's IP Routes, regardless of the RIP route's metric. The only
exception is RIP routes with a metric of 16 which are always ignored.

© Note:

If a previously learnt RIP route fails, the system applies a metric of 16 five minutes
after the failure. When off, any RIP route to a destination for which a static route has
been configured is ignored. This option is not supported on Linux based systems.

Automatic Backup

Default = On.

This command is available with IP500 V2 systems. When selected, as part of its daily
backup process, the system automatically copies the folders and files from the System
SD card's /primary folder to its /backup folder. Any matching files and folders already
present in the /backup folder are overwritten.

Provider Default = Not visible. This field is visible only if the system has been branded by addition
of a special license for a specific equipment provider. The branding is fixed, that is it
remains even if the license is subsequently removed. The number shown is a unique
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Field Description
reference to the particular equipment provider for whom the system has been branded.
When branded, the equipment provider's name is displayed on idle phone displays and
other provider related features are enabled.

Time Setting This and the following time/date settings are only shown for IP500 V2 based systems.

Config Source

The time and date settings for Linux based servers are set through the server’s Platform
View menus (Settings | System | Date and Time).

For IP500 V2 systems the time is either set manually, obtained using Time protocol
(RFC868) requests or obtained using Network Time Protocol (RFC958) request. This field
is used to select which method is used and to apply ancillary settings based on the
selected method.

* None, the system to not make any time requests. The system time and date needs to
be set using a phone with System Phone Rights (User | User), see Date and Time.
The system can then automatically apply daylight saving settings to the manually set
time.

» Voicemail Pro/Manager Both the Voicemail Pro service and the Manager program can
act as RFC868 Time servers for the system. Use of other RFC868 server sources is not
supported. They provide both the UTC time value and the local time as set on the PC.
The system makes a request to the specified address following a reboot and every 8
hours afterwards. This option should not be used with a Unified Communication Module
as in that scenario the voicemail server is being hosted by and getting its time from the
IP Office.

* SNTP: Use a list of SNTP servers to obtain the UTC time. The records in the list are
used one at a time in order until there is a response. The system makes a request to
the specified addresses following a reboot and every hour afterwards.

Time Settings — Voicemail Pro/Manager

These settings are shown for IP500 V2 based systems where the Time Setting Config Source has been set to
Voicemail Pro/Manager.

IP Address

Default = 0.0.0.0 (Broadcast) The address to which the RFC868 request is sent. 0.0.0.0
means default operation. In this mode, following a reboot the control unit makes time
requests on its LAN interfaces. It first makes a request to the IP address set and, if it
receives no reply, then makes a broadcast request.

If you are running Manager when the voicemail server starts, voicemail does not start as
a time server. It is therefore recommended that you have no copy of Manager running
when you start or restart the voicemail server. Manager can be disabled from acting as a
RFC868 time server by deselecting the Enable Time Server option (File | Preferences |
Edit | Preferences).

Time Offset

Default = 00:00. This value is not normally set as any time changes, including daylight
saving changes, that occur on the PC will be matched by the system.

Time Settings — None/SNTP

These settings are shown for IP500 V2 based systems where the Time Setting Config Source has been set to

None or SNTP.
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Field Description

Time Server Default = Blank

Address . . . . . .
Displayed when the Time Setting Config Source is set to SNTP. Enter a list of IP
addresses, host names, or fully qualified domain names (FQDN) for the SNTP servers.
Separate each record with a space. The use of broadcast addresses is not supported.
The list is used in order of the records until a response is received.

Time Zone Select a time zone from the list. This sets the default time offset and DST to match the

chosen time zone.

Local Time Offset
from UTC

Default is based on the currently selected time zone.

This setting is used to set the local time difference from the UTC time value provided by
an SNTP server. For example, if the system is 5 hours behind UTC, this field should be
configured with -05:00 to make the adjustment. The time offset can be adjusted in 15
minute increments. If also using the daylight time saving settings below, use this offset to
set the non-DST local time.

Automatic DST

Default is based on the currently selected time zone.

When set to On, the system automatically corrects for daylight saving time (DST)
changes as configured in the Clock Forward/Back Settings below.

Clock Forward/
Back Settings

(Start Date — End
Date (DST Offset))

Default is based on the currently selected time zone.

Click Edit to configure the time and date for DST clock corrections. In the Daylight Time
Settings window, you can configure the following information:

« DST Offset: the number of hours to shift for DST.

* Clock Forward/Back: Select Go Forward to set the date when the clock will move
forward. Select Go Backwards to set the date when the clock will move backward.

* Local Time To Go Forward: The time of day to move the clock forward or backward.

» Date for Clock Forward/Back: Set the year, month and day for moving the clock
forwards and backwards.

Once you click OK, the forward and back dates, plus the DST offset, are displayed using
the format (Start Date — End Date (DST Offset)).

File Writer IP
Address

Default = 0.0.0.0 (Disabled)

This field set the address of the PC allowed to send files to the System SD card installed
in the system using HTTP or TFTP methods other than embedded file management.

* On non-Linux based systems, this field sets the address of the PC allowed to send files
to the memory card using HTTP or TFTP methods other than embedded file
management.

» For Linux based systems it is applied to non-embedded file management access to
the /opt/ipoffice folder on the server.

An address of 255.255.255.255 allows access from any address. If embedded file
management is used, this address is overwritten by the address of the PC using
embedded file management (unless set to 255.255.255.255).

July 2017

Table continues...

Administering Avaya IP Office™ Platform with Manager 188

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Administering Avaya IP Office™ Platform with Manager

System

Field

Description

Dongle Serial
Number

Displayed for pre-Release 10.0 IP500 V2 systems using ADI licensing only. For system’s
using PLDS licensing, see the PLDS Host ID (License | License).

This field is for information only. It shows the serial number of the feature key dongle
against which the system last validated its licenses. Local is shown for a serial port,
Smart Card or System SD feature key plugged directly into the control unit. Remote is
shown for a parallel or USB feature key connected to a feature Key Server PC. The serial
number is printed on the System SD card and prefixed with FK.

System
Identification

Displayed for Linux based systems. This field is for information only.

This is the unique system reference that is used to validate licenses issued for this
particular system. For a physical server this is a unique value based on the server
hardware. For a virtual server this value is based on several factors including the LAN1
and LAN2 IP addresses, the host name and the time zone. If any of those are changed,
the System ID changes and any existing licenses become invalid.

AVPP IP Address

Default = 0.0.0.0 (Disabled)

Where Avaya 3600 Series SpectraLink wireless handsets are being used with the
system, this field is used to specify the IP address of the Avaya Voice Priority Processor
(AVPP)

Related links

System on page 182

LAN1

Navigation: System | LAN1

Used to configure the behavior of the services provided by the system's first LAN interface.

Up to 2 LAN's (LAN1 and LANZ2) can be configured. The control unit has 2 RJ45 Ethernet ports,
marked as LAN and WAN. These form a full-duplex managed layer-3 switch. Within the system
configuration, the physical LAN port is LAN1, the physical WAN port is LAN2.

Configuring both interfaces with the same IP address on the same subnet is not supported.
However, no warning is issued when this configuration is implemented.

Related links

System on page 182

LAN Settings on page 189
VolP on page 191

Network Topology on page 198

DHCP Pools on page 201

LAN Settings

Navigation: System | LAN | LAN Settings

Used to set the general LAN settings for the LAN interface such as the IP address mode.
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Configuration Settings

These settings are not mergeable. Changes to these settings require a reboot of the system.

Field Description
IP Address Default = 192.168.42.1 or DHCP client.
This is the IP address of the Control Unit on LAN1. If the control unit is also acting
as a DHCP server on the LAN, this address is the starting address for the DHCP
address range.
IP Mask Default = 255.255.255.0 or DHCP client.
This is the IP subnet mask used with the IP address.
Primary Trans. IP Default = 0.0.0.0 (Disabled)
Address This setting is only available on control units that support a LAN2. Any incoming IP
packets without a service or session are translated to this address if set.
RIP Mode Default = None.
Routing Information Protocol (RIP) is a method by which network routers can
exchange information about device locations and routes. Routes learnt using RIP
are known as 'dynamic routes'. The system also supports 'static routes' though its
IP Route records. For Server Edition systems this setting is only available on
Expansion System (V2) systems. The options are:
* None: The LAN does not listen to or send RIP messages
 Listen Only (Passive): Listen to RIP-1 and RIP-2 messages in order to learn RIP
routes on the network.
* RIP1: Listen to RIP-1 and RIP-2 messages and send RIP-1 responses as a sub-
network broadcast.
* RIP2 Broadcast (RIP1 Compatibility): Listen to RIP-1 and RIP-2 messages and
send RIP-2 responses as a sub-network broadcast.
» RIP2 Multicast: Listen to RIP-1 and RIP-2 messages and send RIP-2 responses
to the RIP-2 multicast address.
Enable NAT Default = Off
This setting controls whether NAT should be used for IP traffic from LAN1 to LAN2.
This setting should not be used on the same LAN interface as a connected WAN3
expansion module.
Number of DHCP Default = 200 or DHCP client. Range = 1 to 999.
1P ACLIRAEED This defines the number of sequential IP addresses available for DHCP clients.
DHCP Mode Default = DHCP Client.
This controls the control unit's DHCP mode for the LAN. When doing DHCP:
* LAN devices are allocated addresses from the bottom of the available address
range upwards.
« Dial In users are allocated addresses from the top of the available range
downwards.
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Field Description

+ If the control unit is acting as a DHCP server on LAN1 and LAN2, Dial in users
are allocated their address from the LAN1 pool of addresses first.

The options are:

» Server: When this option is selected, the system will act as a DHCP Server on
this LAN, allocating address to other devices on the network and to PPP Dial in
users.

» Disabled When this option is selected, the system will not use DHCP. It will not
act as a DHCP server and it will not request an IP address from a DHCP server
on this LAN.

+ Dial In When this option is selected, the system will allocate DHCP addresses to
PPP Dial In users only. On systems using DHCP pools, only addresses from a
pool on the same subnet as the system's own LAN address will be used.

» Client When this option is selected, the system will request its IP Address and IP
Mask from a DHCP server on the LAN.

° Note:

Do not use this option with a limited time lease line.

» Advanced: The system can be configured with a number of DHCP Pools from
which it can issue IP addresses.

Related links
LAN1 on page 189
VolP
Navigation: System | LAN | VoIP

Additional configuration information

For more information on remote H.323 extensions, see Configuring Remote H.323 Extensions on
page 586.

Configuration settings
Used to set the system defaults for VolP operation on the LAN interface.
The following settings are mergeable:
» Auto-create Extn
* Auto-create User
* H.323 Signalling over TLS
* Remote Call Signalling Port
» Auto-create Extn/User
Enable RTCP Monitoring on Port 5005
RTCP collector IP address for phones
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* Scope

* Initial keepalives

* Periodic timeout

* VLAN

* 1100 Voice VLAN Site Specific Option Number (SSON)
* 1100 Voice VLAN IDs

The remaining settings are not mergeable. Changes to these settings requires a reboot of the

system.

Field

Description

Default = On

H.323 Gatekeeper Enable

This settings enables gatekeeper operation.

Auto-create Extn

Default = Off

The field to set up auto creation of extensions for H.323 phones registering
themselves with the System as their gatekeeper. If selected, the system displays the
Auto Create Extension Password window prompting you to type a Password and
Confirm Password. This password is used for subsequent auto creation of
extensions. A message H.323 Auto-Create Extension option is active
is flashed next to the Auto Create Extension field till the option is cleared. SIP
Extensions use a separate setting, see below. This setting is not supported on
systems configured to use WebLM server licensing.

If using resilience backup to support Avaya IP phones, Auto-create Extn and Auto-
create User should not be left enabled after initial configuration or any subsequent
addition of new extensions and users. Leaving auto-create options enabled on a
system that is a failover target may cause duplicate extension/user records on the
multi-site network under multiple failure scenarios.

For security, any auto-create settings set to On are automatically set to Off after 24
hours.

Auto-create User

Default = Off

When this option is on and H.323 Auto-create Extn is also on, when a new H.323
extension is created a matching user record is also created.

For security, any auto-create settings set to On are automatically set to Off after 24
hours.

H.323 Remote Extn
Enable

Default = Off.

The system can be configured to support remote H.323 extensions in the case where
NAT is used in the connection path. This could be the case where the IP Office is
located behind a corporate NAT/Firewall router and/or the H.323 phone is located
behind residential NAT enable router.

The use of this option and the interaction and configuration of external third party
elements is beyond the scope this help file.
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Field

Description

In the case where the public IP address of the corporate router is unknown, the LAN's
Network Topology settings should be used to configure a STUN Server. Enabling H.
323 Remote Extn Enable allows configuration of the RTP Port number Range
(NAT) settings.

Currently, only 9600 Series phones are supported as H.323 remote extensions.

H.323 Signalling over
TLS

Default = Disabled. For hosted deployments, default = Preferred.

When enabled, TLS is used to secure the registration and call signalling
communication between IP Office and endpoints that support TLS. The H.323 phones
that support TLS are 9608, 9611, 9621, and 964 1running firmware version 6.6 or
higher.

When enabled, certificate information is configured in the 46xxSettings. txt file
on IP Office and automatically downloaded to the phone. When IP Office receives a
request from the phone for an identity certificate, IP Office searches it's trusted
certificate store and finds the root CA that issued it's identity certificate. IP Office then
provides the root CA as an auto-generated certificate file named Root-CA-
XXXXXXXX.pem.

For information on IP Office certificates, see Security Mode | System | Certificates.
The options are:

 Disabled: TLS is not used.

» Preferred: Use TLS when connecting to a phone that supports TLS.

* Enforced: TLS must be used. If the phone does not support TLS, the connection is
rejected.

When set to Enforced, the Remote Call Signalling Port setting is disabled.

If TLS security is enabled (Enforced or Preferred), it is recommended that you
enable a matching level of media security on System | VoIP Security.

Remote Call
Signalling Port

Default = 1720.

This field is available when H.323 Remote Extn Enable is set to On. It specifies the
corporate router's signalling port for remote H.323 phones.

Note that if H.323 signalling over TLS is set to Enforced, this field is greyed out and
the port is fixed to 1300.

SIP Trunks Enable

Default = On.

This settings enables support of SIP trunks. It also requires entry of SIP Trunk
Channels licenses.

Enabling SIP Trunks Enable allows configuration of the RTP Port number Range
(NAT) settings.

SIP Registrar Enable
Default = Off.
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Field

Description

system.

Used to set the system parameters for the system acting as a SIP Registrar to which SIP endpoint devices can
register. Separate SIP registrars can be configured on LAN1 and LAN2. Registration of a SIP endpoint requires
an available IP Endpoints license. SIP endpoints are also still subject to the extension capacity limits of the

Auto-create Extn/User

Default = Off.

The field to set up auto creation of extensions for SIP phones registering themselves
with the SIP registrar. If selected, the system displays the Auto Create Extension
Password window prompting you to type a Password and Confirm Password. This
password is used for subsequent auto creation of extensions. A message SIP
Auto-Create Extension/User option is active is flashed next to the Auto
Create Extension/User field till the option is cleared. This setting is not supported on
systems configured to use WebLM server licensing.

For security, any auto-create settings set to On are automatically set to Off after 24
hours.

° Note:

This setting is not applicable to the Avaya A175 Desktop Video Device with the
Avaya Equinox .

SIP Remote Extn
Enable

Default = Off.

The system can be configured to support remote SIP extensions in the case where
NAT is used in the connection path. This could be the case where the IP Office is
located behind a corporate NAT/Firewall router and/or the SIP phone is located
behind residential NAT enable router.

This option cannot be enabled on both LAN1 and LAN2.

The use of this option and the interaction and configuration of external third party
elements is beyond the scope this help file.

In the case where the public IP address of the corporate router is unknown, the LAN's
Network Topology settings should be used to configure a STUN Server. Enabling SIP
Remote Extn Enable allows configuration of:

» the Remote UDP Port, Remote TCP Port, Remote TLS Port settings
+ the Port Number Range (NAT) settings

Currently, only Avaya Equinox” for Windows, Avaya Equinox” for iOS, one-X Mobile
iOS and one-X Mobile Android SIP clients are supported as SIP remote extensions.

SIP Domain Name

Default = Blank

This value is used by SIP endpoints for registration with the system. If left blank,
registration uses the LAN IP address. The entry should match the domain suffix part
of the SIP Registrar FQDN below, for example, example. com.

° Note:

For Avaya SIP telephones supported for resilience, the SIP Domain Name must
be common to all systems providing resilience.
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Field

Description

SIP Registrar FQDN

Default = Blank

This is the SIP registrar fully qualified domain name, for example,
serverl.example.com, to which the SIP endpoint should send its registration
request. This address must be resolvable by DNS to the IP address of the IP Office
system or to the IP address, such as that of an Avaya SBCE, through which the SIP
endpoints reach the IP Office system.

Layer 4 Protocol

Default = TCP and UDP. This field is used to select which protocols are supported for
SIP connections: TCP, UDP, or TLS.

* UDP Port: Default = 5060. The port to use for SIP UDP support if UDP is selected
as the Layer 4 Protocol above.

* TCP Port: Default = 5060. The port to use for SIP TCP support if TCP is selected
as the Layer 4 Protocol above.

* TLS Port: Default = 5061. The port to use for SIP TLS support.

* Remote UDP Port: Default = 5060. The port to use for SIP UDP support if UDP is
selected as the Layer 4 Protocol for remote SIP extension.

* Remote TCP Port: Default = 5060. The port to use for SIP TCP support if TCP is
selected as the Layer 4 Protocol for remote SIP extension.

* Remote TLS Port: Default = 5061. The port to use for SIP TLS support if TLS is
selected as the Layer 4 Protocol for remote SIP extension.

° Note:

The E129 phone does not support UDP. In IP Office release 10 and higher, UDP
support has been removed from the configuration file sent to the phone. For the
E129 phone, you must enable TCP.

Challenge Expiry Time
(secs)

Default = 10.

The challenge expiry time is used during SIP extension registration. When a device
registers, the system SIP Registrar will send a challenge back to the device and waits
for an appropriate response. If the response is not received within this timeout the
registration is failed.

RTP

Port Number Range

For each VoIP call, a receive port for incoming Real Time Protocol (RTP) traffic is
selected from a defined range of possible ports, using the even numbers in that
range. The Real Time Control Protocol (RTCP) traffic for the same call uses the RTP
port number plus 1, that is the odd numbers. For control units and Avaya H.323 IP
phones, the default port range used is 49152 to 53246. On some installations, it may
be a requirement to change or restrict the port range used. It is recommended that
only port numbers between 49152 and 65535 are used, that being the range defined
by the Internet Assigned Numbers Authority (IANA) for dynamic usage.

0 Important:

The minimum and maximum settings of the port range should only be adjusted
after careful consideration of the customer network configuration and existing
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Description

port usage. For pre-Release 8.1 systems, the gap between the minimum and
maximum port values must be at least 1024. For Release 8.1 and higher, the
gap between the minimum and maximum port values must be at least 254.

Port Range (minimum)

IP500 V2 default = 46750. Range = 46750 to 50750.
Linux default = 40750. Range = 40750 to 50750

This sets the lower limit for the RTP port numbers used by the system.

Port Range
(maximum)

IP500 V2 default = 50750. Range = 46750 to 50750.
Linux default = 50750. Range = 47000 to 50750
This sets the upper limit for the RTP port numbers used by the system.

Port Number Range (NAT)

These settings are available when either H.323 Remote Extn Enable, SIP Trunks Enable, or SIP Remote
Extn Enable is set to On.

This option is not supported if System | LAN | Network Topology | Firewall/NAT Type is set to Symmetric
Firewall or Open Internet.

Port Range (minimum)

IP500 V2 default = 46750. Range = 46750 to 50750.
Linux default = 40750. Range = 40750 to 50750

This sets the lower limit for the RTP port numbers used by the system.

Port Range
(maximum)

IP500 V2 default = 50750. Range = 46750 to 50750.
Linux default = 50750. Range = 40750 to 50750
This sets the upper limit for the RTP port numbers used by the system.

Enable RTCP Monitor
On Port 5005

Default = On.

For 1600, 4600, 5600 and 9600 Series H.323 phones, the system can collect VolP
QoS (Quality of Service) data from the phones. For other phones, including non-IP
phones, it can collect QoS data for calls if they use a VCM channel. The QoS data
collected by the system is displayed by the System Status Application.

This setting is mergeable. However it only affects H.323 phones when the register
with the system. therefore any change to this setting requires H.323 phones that have
already been registered to be rebooted. Avaya H.323 phones can be remotely
rebooted using the System Status Application.

The QoS data collected includes: RTP IP Address, Codec, Connection Type, Round
Trip Delay, Receive Jitter, Receive Packet Loss.

This setting is not the same as the RTCPMON option within Avaya H.323 phone
settings. The system does not support the RTCPMON option.

RTCP Collector IP
address for phones

Default = Blank.

This setting defines an alternate destination for the RTCP Monitor data described in
the Enable RTCP Monitor On Port 5005 field above. This enables you to send the
data collected to a third party QoS monitoring application.
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Field Description
The Enable RTCP Monitor On Port 5005 must be turned Off to enable this field.

Changes to this setting requires a reboot of the phones.

Keepalives

These settings are used to facilitate NAT traversal of RTP/RTCP packets and are applicable to all RTP/RTCP
session on the network interface. You should enable these settings on interfaces connected to NAT devices if
you are using SIP trunks and/or H323 and SIP remote workers.

Scope Default = Disabled

Select whether the sending of keepalive packets should be disabled or sent for RTP
or for both RTP and RTCP.

Periodic timeout Default = 0 (Off). Range = 0 to 180 seconds.

Sets how long the system will wait before sending a keepalive if no other packets of
the select SCOPE are seen.

Initial keepalives Default = Disabled.

If enabled, keepalives can also been sent during the initial connection setup.

DiffServ Settings

When transporting voice over low speed links it is possible for normal data packets (1500 byte packets) to
prevent or delay voice packets (typically 67 or 31 bytes) from getting across the link. This can cause
unacceptable speech quality. Therefore it is important that all traffic routers and switches in a network to have
some form of Quality of Service mechanism (QoS). QoS routers are essential to ensure low speech latency and
to maintain sufficient audible quality.

The system applies the DiffServ settings to outgoing traffic on any SIP lines which have Line | SIP Line |
Transport | Use Network Topology Info set to match the LAN interface.

The system supports the DiffServ (RFC2474) QoS mechanism. This uses a Type of Service (ToS) field in the IP
packet header.

The hex and decimal entry fields for the following values are linked, the hex value being equal to the decimal
multiplied by 4.

DSCP (Hex) Default = B8 (Hex)/46 (decimal). Range = 00 to FF (Hex)/0 to 63 (decimal)

The DiffServ Code Point (DSCP) setting applied to VolIP calls. By default, the same
setting is used for audio and video. If desired, you can configure separate values for

audio and video. For correct operation, especially over WAN links, the same value
should be set at both ends.

Video DSCP (Hex) Default = B8 (Hex)/46 (decimal). Range = 00 to FF (Hex)/0 to 63 (decimal)

The DiffServ Code Point (DSCP) setting applied to video VoIP calls. For correct
operation, especially over WAN links, the same value should be set at both ends.

DSCP Mask (Hex) Default = FC (Hex)/63 (decimal). Range = 00 to FF (Hex)/0 to 63 (decimal)
Allows a mask to be applied to packets for the DSCP value.
SIG DSCP (Hex) Default = 88 (Hex)/34 (decimal). Range = 00 to FF (Hex)/0 to 63 (decimal)

This setting is used to prioritize VolIP call signaling.
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Field

Description

DHCP Settings

Primary Site Specific
Option Number

Default = 176. Range = 128 to 254.
A site specific option number (SSON) is used as part of DHCP to request additional

information. is the defau use eries an eries
(4600/5600) inf tion. 176 is the default SSON used by 4600 Seri d 5600 Series IP
phones.
Secondary Site Default = 242. Range = 128 to 254.
IEENE e Similar to the primary SSON. 242 is the default SSON used by 1600 and 9600 Series
Number (1600/9600) . : . .
IP phones requesting installation settings via DHCP.
VLAN Default = Not present. This option is applied to H.323 phones using the system for

DHCP support. If set to Disabled, the L2Q value indicated to phones in the DHCP
response is 2 (disabled). If set to Not Present, no L2Q value is included in the DHCP
response.

1100 Voice VLAN Site
Specific Option
Number (SSON)

Default = 232.

This is the SSON used for responses to 1100/1200 Series phones using the system
for DHCP.

1100 Voice VLAN IDs

Default = Blank.

For 1100/1200 phone being supported by DHCP, this field sets the VLAN ID that
should be provided if necessary. Multiple IDs (up to 10) can be added, each
separated by a + sign.

Related links

LAN1 on page 189

Network Topology

Navigation: System | LAN | Network Topology

STUN (Simple Traversal of UDP through NAT) is a mechanism used with overcome the effect of
NAT firewalls. The network address translation (NAT) action performed by this type of firewall can
have negative effects on VolIP calls.

Test packets are sent by the system to the address of the external STUN server, those packets
crossing the firewall in the process. The STUN server replies and includes copies of the packets it
received in the reply. By comparing the packet sent and received, it is possible for the system to
determine the type of NAT firewall and to modify future packets to overcome the effects of the

firewall.

These settings are used for SIP trunk connections from the LAN, H.323 and SIP remote
extensions. For further details of system SIP operation refer to the SIP Line section. The use of
STUN is unnecessary if the SIP ITSP uses a Session Border Controller (SBC). Use of SIP
requires entry of SIP Trunk Channels licenses.

The following fields can be completed either manually or the system can attempt to automatically
discover the appropriate values. To complete the fields automatically, only the STUN Server IP
Address is required. STUN operation is then tested by clicking Run STUN. If successful the
remaining fields are filled with the results.
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Configuration Settings

These settings are not mergeable. Changes to these settings require a reboot of the system.

Field Description

STUN Server IP Default = Blank

Address Enter the IP address or fully qualified domain name (FQDN) of the SIP ITSP's STUN
server. The system will send basic SIP messages to this destination and from data
inserted into the replies can try to determine the type NAT changes being applied by
any firewall between it and the ITSP.

STUN Port Default = 3478.

Defines the port to which STUN requests are sent if STUN is used.

Firewall/NAT Type

Default = Unknown
The settings here reflect different types of network firewalls. The options are:
* Blocking Firewall

« Symmetric Firewall: SIP packets are unchanged but ports need to be opened
and kept open with keep-alives. If this type of NAT is detected or manually
selected, a warning ‘Communication is not possible unless the STUN server is
supported on same IP address as the ITSP’ will be displayed as part of the
manager validation.

* Open Internet: No action required. If this mode is selected, settings obtained by
STUN lookups are ignored. The IP address used is that of the system LAN
interface.

+ Symmetric NAT: A symmetric NAT is one where all requests from the same
internal IP address and port, to a specific destination IP address and port, are
mapped to the same external IP address and port. If the same host sends a
packet with the same source address and port, but to a different destination, a
different mapping is used. Furthermore, only the external host that receives a
packet can send a UDP packet back to the internal host. SIP Packets need to be
mapped but STUN will not provide the correct information unless the IP address
on the STUN server is the same as the ITSP Host. If this type of NAT/Firewall is
detected or manually selected, a warning ‘Communication is not possible unless
the STUN server is supported on same IP address as the ITSP’ will be displayed
as part of the manager validation.

* Full Cone NAT: A full cone NAT is one where all requests from the same internal
IP address and port are mapped to the same external IP address and port.
Furthermore, any external host can send a packet to the internal host, by sending
a packet to the mapped external address. SIP packets need to be mapped to NAT
address and Port; any Host in the internet can call in on the open port, that is the
local info in the SDP will apply to multiple ITSP Hosts. No warning will be
displayed for this type of NAT because the system has sufficient information to
make the connection).

» Restricted Cone NAT: A restricted cone NAT is one where all requests from the
same internal IP address and port are mapped to the same external IP address
and port. Unlike a full cone NAT, an external host (with IP address X) can send a
packet to the internal host only if the internal host had previously sent a packet to
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Description

IP address X. SIP packets needs to be mapped. Responses from hosts are
restricted to those that a packet has been sent to. So if multiple ITSP hosts are to
be supported, a keep alive will need to be sent to each host. If this type of NAT/
Firewall is detected or manually selected, no warning will be displayed for this type
of NAT.

» Port Restricted Cone NAT: A port restricted cone NAT is like a restricted cone
NAT, but the restriction includes port numbers. Specifically, an external host can
send a packet, with source IP address X and source port P, to the internal host
only if the internal host had previously sent a packet to IP address X and port P.
SIP packets needs to be mapped. Keep-alives must be sent to all ports that will be
the source of a packet for each ITSP host IP address. If this type of NAT/Firewall
is detected or manually selected, no warning will be displayed for this type of NAT.
However, some Port Restricted NAT's have been found to be more symmetric in
behavior, creating a separate binding for each opened Port, if this is the case the
manager will display a warning ‘Communication is not possible unless the STUN
server is supported on same IP address as the ITSP’ as part of the manager
validation.

« Static Port Block: Use the RTP Port Number Range specified on the VolIP tab
without STUN translation. Those ports must be fixed as open on any NAT firewall
involved

* One-To-One NAT: This setting supports IP Office cloud deployments where the
Primary server is behind a NAT that performs IP address translation but not port
mappings. All required ports must be open on the NAT.

When set to One-To-One NAT, the following configuration settings are applied and
cannot be edited.

- The LAN | Network Topology | Public Port values are set to 0.

- LAN | VoIP | SIP Registrar Enable remote protocol port values are set to equal
their corresponding local protocol port values.

- The LAN | VoIP | RTP | Port Number Range (NAT) Minimum and Maximum
values are set to equal the corresponding Port Number Range values.

¢ Unknown

Binding Refresh Time
(seconds)

Default = 0 (Never). Range = 0 to 3600 seconds.

Having established which TCP/UDP port number to use, through either automatic or
manual configuration, the system can send recurring ‘SIP OPTIONS requests’ to the
remote proxy terminating the trunk. Those requests will keep the port open through
the firewall. Requests are sent every x seconds as configured by this field.

© Note:

If a binding refresh time has not been set you may experience problems
receiving inbound SIP calls as they are unable to get through the Firewall. In
these circumstances make sure that this value has been configured.

Public IP Address

Default = 0.0.0.0 This value is either entered manually or discovered by the Run
STUN process. If no address is set, the system LAN1 address is used.
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Field Description

Public Port Default =0
The public port value for UDP, TCP, and TLS. For each protocol, this value is either
entered manually or discovered by the Run STUN process.

Run STUN This button tests STUN operation between the system LAN and the STUN Server IP

Address set above. If successful the results are used to automatically fill the
remaining fields with appropriate values discovered by the system. Before using Run
STUN the SIP trunk must be configured.

When this option is used, a L information icon is shown against the fields to
indicate that the values were automatically discovered rather than manually entered.

Run STUN on startup

Default = Off

This option is used in conjunction with values automatically discovered using Run
STUN. When selected, the system will rerun STUN discovery whenever the system
is rebooted or connection failure to the SIP server occurs.

Related links

LAN1 on page 189

DHCP Pools

Navigation: System | LAN | DHCP Pools

DHCP pools allows for the configuration of of IP address pools for allocation by the system when
acting as a DHCP server. On an IP500 V2 system, you can configure up to 8 pools. On Server
Edition Linux systems, you can configure up to 64 pools.

By default the DHCP settings (IP Address, IP Mask and Number of DHCP IP Addresses) set on
the LAN Settings tab are reflected by the first pool here. For support of PPP Dial In address
requests, at least one of the pools must be on the same subnet as the system's LAN. Only
addresses from a pool on the same subnet as the system's own LAN address will be used for PPP

Dial In.

These settings are mergeable. However, the following actions require a merge with service

disruption:

* Changing the Start Address, Subnet Mask or Default Router value for an existing DHCP
Pool of addresses.

* Decreasing Pool Size for an existing DHCP Pool of addresses.

* Deleting an existing DHCP Pool of addresses.

When these actions are performed, the DHCP (Server or Dialln) is re-initialized which triggers a
reboot of the Avaya DHCP Clients (H.323 and SIP) in order to force the Avaya DHCP clients to
renew their IP address lease and apply the new settings. For the remaining Avaya and non-Avaya
DHCP clients, you must manually reboot the devices in order to force the IP Addresses lease
renewal. Otherwise, the devices continue to use the allocated IP addresses until the IP addresses
lease time out expires. IP address lease time out is set to three days.

The DHCP server re-initialization causes a reboot of all Avaya DHCP clients and not only of the
DHCP clients that have obtained an IP Address within the modified DHCP Pool IP range. Note
that IP Office supports phone reboot only for E129 and B179 SIP phone models.
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Description

Apply to Avaya
IP Phones Only

Default = Off.

When set to On, the DHCP addresses are only used for requests from Avaya IP
phones. Other devices connected to the system LAN will have to use static
addresses or obtain their address from another DHCP server.

In addition to the above control, Avaya IP phones will only complete DHCP against a
DHCP server configured to supports a Site Specific Option Number (SSON) that
matches that set on the phone. The SSON numbers supported by the system DHCP
are set on the VoIP sub-tab.

Once set to On and the configuration has been merged, you must manually reboot
the non-Avaya DHCP Client devices in order to force IP addresses lease renewal and
to make the settings new values effective. Otherwise the non-Avaya DHCP Client
devices will continue to use the allocated IP addresses until the IP addresses lease
time out expires. IP address lease time out is set to three days.

DHCP Pool

Up to 8 pools can be added. The first pool matches the IP Address, IP Mask and
Number of DHCP IP Addresses on the LAN Settings sub-tab. When adding or editing
pools, Manager will attempt to warn about overlaps and conflicts between pools. The
options are:

» Start Address Sets the first address in the pool.

» Subnet Mask: Default = 255.255.255.0 Sets the subnet mask for addresses issued
from the pool.

» Default Router: Default = 0.0.0.0 For pools issuing IP addresses on the same
subnet as the system LAN's, 0.0.0.0 instructs the system to determined the actual
default router address to issue by matching the IP address/subnet mask being
issued in the IP Routing table. This matches the default behaviour used by systems
without multiple pools. For pools issuing addresses not on the same subnet as the
system LAN's, the default router should be set to the correct value for devices on
that subnet.

* Pool Size: Default = 0 Set the number of DHCP client addresses available in the
pool.

Related links

LAN1 on page 189

LAN2

Navigation: System | LAN2

These settings used to configure the system's second LAN interface. The fields available for LAN2
are the same as for LAN1 except for the following additional field.

These settings are not mergeable. Changes to these settings will require a reboot of the system.

Field Description
Firewall Default = <None> (No firewall)
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Field Description
Allows the selection of a system firewall to be applied to traffic routed from LAN2 to
LAN1.
Related links

System on page 182

DNS

Navigation: System | DNS

DNS is a mechanism through which the URL's requested by users, such as www.avaya.com, are
resolved into IP addresses. These requests are sent to a Domain Name Server (DNS) server,
which converts the URL to an IP address. Typically the internet service provider (ISP) will specify
the address of the DNS server their customers should use.

WINS (Windows Internet Name Service) is a similar mechanism used within a Windows network
to convert PC and server names to IP addresses via a WINS server.

If the system is acting as a DHCP server, in addition to providing clients with their own IP address

settings it can also provide them with their DNS and WINS settings if requested by the client.

These settings are not mergeable. Changes to these settings require a reboot of the system.

Related links
System on page 182

Voicemail

Navigation: System | Voicemail
Additional configuration information

For information on configuring Voicemail Pro resiliency, see Server Edition Resiliency on
page 687.

Configuration settings

The following settings are used to set the system's voicemail server type and location. Fields are
enabled or grayed out as appropriate to the selected voicemail type. Refer to the appropriate
voicemail installation manual for full details.

These settings are mergeable with the exception of Voicemail Type and Voicemail IP Address.
Changes to these settings requires a reboot of the system.

Field Description

Voicemail Type Defaults: Non-Server Edition = Embedded Voicemail, Primary Server = Voicemail Pro,

Server Edition Secondary Server with independent voicemail or for Outbound Contact
Express = Voicemail Pro, Server Edition Others: Centralized Voicemail.
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Field

Description

Sets the type of voicemail system being used. The options are:

None: No voicemail operation.

Analogue Trunk MWI: Select this option to support receiving a message waiting
indicator (MWI) signal from analog trunks terminating on the ATM4U-V2 card. MWI
is a telephone feature that turns on a visual indicator on a telephone when there are
recorded messages.

Avaya Aura Messaging: Select this option if you want to configure the system to
use Avaya Aura Messaging as the central voicemail system. If you choose this
option, you are still able to use Embedded Voicemail or Voicemail Pro at each
branch to provide auto-attendant operation and announcements for waiting calls.
When selected, access to voicemail is routed via an SM line to the numbers
specified in the AAM Number field. The optional AAM PSTN Number can be
configured for use when the SM Line is not in service.

For a setup where the voicemail box numbers configured on Avaya Aura Messaging
or Modular Messaging are same as the caller's DID, the short code to route the
PSTN call should be such that the caller-id is withheld ( "W" in the telephone-
number of the shortcode ). This is to make sure that, during rainy day - the voicemail
system does not automatically go to the voicemail box of the caller based on the
caller id.

Call Pilot: Select this option if you want to configure the system to use CallPilot over
SIP as the central voicemail system. If you choose this option, you are still able to
use Embedded Voicemail or VVoicemail Pro at each branch to provide auto-
attendant operation and announcements for waiting calls. When selected, access to
voicemail is routed via SM line to the numbers specified in the CallPilot Number
field.

° Note:

The CallPilot PSTN Number field and associated Enable Voicemail
Instructions Using DTMF check box are not supported. IP Office cannot
access the CallPilot system over the PSTN when the Session Manager line is
down.

© Note:

Users can access their CallPilot voicemail by dialing the Voicemail Collect short
code. Access to CallPilot voicemail from Auto Attendant cannot be enabled by
setting a Normal Transfer action to point to the Voicemail Collect short code. If
desired, it can be enabled by setting a Normal Transfer action to point to the
CallPilot number.

Centralized Voicemail Select this option when using a Voicemail Pro system
installed and licensed on another system in a multi-site network. The outgoing line
group of the H.323 IP line connection to the system with the Voicemail Pro should
be entered as the Voicemail Destination. In a Server Edition network this option is
used on the Secondary Server and expansion systems to indicate that they use the
Primary Server for as their voicemail server.
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Field

Description

* Distributed Voicemail: This option can be used when additional Voicemail Pro
voicemail servers are installed in a multi-site network and configured to exchange
messages with the central voicemail server using email. This option is used if this
system should use one of the additional servers for its voicemail services rather
than the central sever. When selected, the Voicemail Destination field is used for
the outgoing H.323 IP line to the central system and the Voicemail IP Address is
used for the IP address of the distributed voicemail server the system should use.
This option is not supported by Server Edition systems.

* Embedded Voicemail On systems with an Avaya memory card, select this option to
run Embedded Voicemail which stores messages and prompts on the memory card.
It also supports internal Auto Attendant configuration through the system
configuration. The IP500 V2 supports 2 simultaneous Embedded Voicemail calls by
default but can be licensed for up to 6. The licensed limit applies to total number of
callers leaving messages, collecting messages and or using an auto attendant. This
option is not supported by Server Edition systems.

» Group Voicemail This option is used to support third-party voicemail systems
attached by extension ports in the group specified as the Voicemail Destination.
This option is not supported by Server Edition systems.

* Modular Messaging over SIP Select this option if you want to configure the system
to use Modular Messaging over SIP as the central voicemail system. If you choose
this option, you are still able to use Embedded Voicemail or Voicemail Pro at each
branch to provide auto-attendant operation and announcements for waiting calls.
When selected, access to voicemail is routed via an SM line to the numbers
specified in the MM Number field. The optional MM PSTN Number can be
configured for use when the SM Line is not in service.

° Note:

Embedded Voicemail and Voicemail Pro are available only in Distributed
branch deployments. They are not available when there are centralized users
configured for a IP Officee system that is deployed as either a Centralized
branch or a mixed branch.

The Embedded Voicemail option uses the Essential Edition and the Additional
Voicemail Ports licenses to control the number of ports that can be used. These
licenses are also used to control the number of ports on systems where Embedded
Voicemail is configured to provide local Auto Attendant and announcements while
the selected option for voicemail is one of the central voicemail options through the
Session Manager (i.e. Avaya Aura Messaging, Modular Messaging, or CallPilot).

Similarly, the Voicemail Pro option uses the Preferred Edition and the Incremental
Voicemail Ports licenses to control the number of ports that can be used. These
licenses are also used to control the number of ports on systems where Voicemail
Pro is configured to provide local Call Flow processing while the selected option for
voicemail is Avaya Aura Messaging, Modular Messaging or CallPilot.

- When the system routes a call to the voicemail server it indicates the locale for
which matching prompts should be provided if available. The locale sent to the
voicemail server by the system is determined as show below. If the required set of
prompts is not available, the voicemail will fallback to another appropriate
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Field

Description

language and finally to English (refer to the appropriate voicemail installation
manual for details).

- Short Code Locale: The short code locale, if set, is used if the call is routed to
voicemail using the short code.

- Incoming Call Route Locale: The incoming call route locale, if set, is used if
caller is external.

- User Locale: The user locale, if set, is used if the caller is internal.

- System Locale: If no user or incoming call route locale is set, the system locale is
used unless overridden by a short code locale.

- Systems using Embedded Voicemail, if the required set of upgraded language
prompts to match the locale is not present on the system SD card, Manager will
display an error. The required prompt set can be uploaded from Manager using
the Add/Display VM Locales option.

* Remote Audix Voicemail: Select this option if using a remote Avaya Intuity Audix
or MultiMessage voicemail system. Requires entry of an Audix Voicemail license in
Licenses. This option is not supported by Server Edition systems.

Voicemail Pro Select this option when using Voicemail Pro. The IP address of the
PC being used should be set as the Voicemail IP Address. In a Server Edition
network this option is used on the Primary Server. It can also be used on the
Secondary Server if the Secondary server is connected to its own voice mail server
or if the Secondary Server is part of an Outbound Contact Express deployment. Use
of Voicemail Pro requires licenses for the number of simultaneous calls to be
supported. Licenses are not required for an Outbound Contact Express deployment.

Voicemail Mode: Default = IP Office Mode. Embedded Voicemail on IP500 V2
systems can use either IP Office Mode or Intuity Mode key presses for mailbox
functions. End users should be provided with the appropriate mailbox user guide for
the mode selected. You can switch between modes without losing user data, such
as passwords, greetings, or messages.

The following user guides are available from the Avaya support web site:

« |IP Office Essential Edition - Embedded Voicemail User Guide (Intuity Mode)

+ |P Office Essential Edition - Embedded Voicemail User Guide (IP Office Mode)
+ |P Office Voicemail Pro Mailbox User Guide (Intuity Mode)

+ IP Office Voicemail Pro Mailbox User Guide (IP Office Mode)

Add/Display VM
Locales

For new IP500 V2 SD cards and cards recreated using Manager, the following
Embedded Voicemail languages set are placed onto cards by default. Using this
option displays the list of languages that can be uploaded from Manager. Those
languages already present or not supported are greyed out. If a locale is selected for
the system, a user, a short code or an incoming call route which is not present on the
SD card, Manager will display an error. This command can be used to upload the
required language prompts to correct the error.
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Field

Description

Voicemail Destination

Defaults: Non-Server Edition = Blank, Server Edition = IP trunk connection to the
Primary Server.

* When the Voicemail Type is set to Remote Audix Voicemail, Centralized
Voicemail or Distributed Voicemail, this setting is used to enter the outgoing line
group of the line configured for connection to the phone system hosting the central
voicemail server.

* When the Voicemail Type is set to Group Voicemail, this setting is used to specify
the group whose user extensions are connected to the 3rd party voicemail system.

* When the Voicemail Type is set to Analogue Trunk MWI, this setting is used to
specify the phone number of the message center. All analogue trunks configured for
Analogue Trunk MWI must have the same destination.

Voicemail IP Address

Defaults: Non-Server Edition = 255.255.255.255, Primary Server = Primary Server |P
Address.

This setting is used when the Voicemail Type is set to Voicemail Pro or Distributed
Voicemail. It is the IP address of the PC running the voicemail server that the system
should use for its voicemail services. If set as 255.255.255.255, the control unit
broadcasts on the LAN for a response from a voicemail server. If set to a specific IP
address, the system connects only to the voicemail server running at that address. If
the system is fitted with an Unified Communication Module hosting Voicemail Pro, the
field should be set to 169.254.0.2.

Backup Voicemail IP
Address

Defaults: Primary Server = Secondary Server IP Address, All others = 0.0.0.0 (Off).
This option is supported with Voicemail Pro.

An additional voicemail server can be setup but left unused. If contact to the voicemail
server specified by the Voicemail IP Address is lost, responsibility for voicemail
services is temporarily transferred to this backup server address.

Phone-context

Default = Blank.
Available when CallPilot is selected as the Voicemail Type.

The appropriate string, for example CDP or UDP, according to the CS 1000 network
dial plan configuration for the CallPilot mailbox. IP Office includes this string, along
with the redirecting extension number, in the History-Info header of the SIP message
that it sends to leave voicemail on CallPilot. The information in the History-Info header
identifies the CallPilot mailbox to which the voicemail is sent. For more information
about CS 1000 dial plans, see the CS 1000 documentation.

Audix UDP

Available if the voicemail type Remote Audix Voicemail is selected. Needs to be
completed with a four digit number from the Universal Dial Plan of the Avaya
Communication Manager system.

Voicemail Channel
Reservation

These settings allow the channels between the system and Voicemail Pro to be
reserved for particular functions. Unreserved channels can be used for any function
but reserved channels cannot be used for any function other than that indicated.
These settings are not available unless the configuration includes validated licenses
for the total number of voicemail channels.
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Field

Description

Note that the voicemail server also restricts the maximum number of channels that
can be used for some services that would be taken from the Unreserved Channels
pool.

Alarms and callbacks are each limited to up to 2 (IP500 V2) or 5 (Server Edition)
channels at any time. Outcalling and conference invites are each limited to up to 5
(IP500 V2) or 12 (Server Edition) channels at any time.

* Unreserved Channels: This setting cannot be changed and by default will show the
total number of licensed voicemail channels. This number will decrease as channels
are reserved for the following functions.

» Mailbox Access: Default = 0 This setting sets the number of channels reserved for
users accessing mailboxes to collect messages.

+ Auto-Attendant:: Default = 0 This setting sets the number of channels reserved for
users directed to Voicemail Pro short code and module start points.

* Voice Recording: Default = 0 This setting sets the number of channels reserved for
voice recording other than mandatory voice recording (see below). If no channels
are available recording does not occur though recording progress may be indicated.

+ Mandatory Voice Recording: Default = 0 This setting sets the number of channels
reserved for mandatory voice recording. When no channels are available for a call
set to mandatory recording, the call is barred and the caller hears busy tone.

* Announcements: Default = 0 This setting sets the number of channels reserved for
announcements. When no channels are available calls continue without
announcements.

Maximum Record
Time

Default = 120 seconds. Range = 30 to 180 seconds. This field is only available when
Embedded Voicemail is selected as the Voicemail Type. The value sets the
maximum record time for messages and prompts.

Messages Button
Goes to Visual Voice

Default = On.

Visual Voice allows phone users to check their voicemail mailboxes and perform
action such as play, delete and forward messages through menus displayed on their
phone. By default, on phones with a MESSAGES button, the navigation is via spoken
prompts. This option allows that to be replaced by Visual Voice on phones that
support Visual Voice menus. For further details see the button action Visual Voice on
page 1021 .

Outcalling Control

Default = Off (Outcalling allowed).

This setting is used to enable or disable system wide outcalling on Embedded
Voicemail and Voicemail Pro. When selected, all outcalling and configuration of
outcalling is disabled. For Voicemail Pro, outcalling can also be disabled at the
individual user mailbox level using the Voicemail Pro client.

DTMF Breakout

differ.

Allows system defaults to be set. These are then applied to all user mailboxes unless the users own settings
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Field | Description

The Park & Page feature is supported when the system voicemail type is configured as Embedded Voicemail
or Voicemail Pro. Park & Page is also supported on systems where Avaya Aura Messaging, Modular
Messaging over SIP, or CallPilot (for IP Office Aura Edition with CS 1000 deployments) is configured as the
central voice mail system and the local Embedded Voicemail or Voicemail Pro provides auto attendant
operation. The Park & Page feature allows a call to be parked while a page is made to a hunt group or
extension. This feature can be configured for Breakout DTMF 0, Breakout DTMF 2, or Breakout DTMF 3.

Reception/Breakout The number to which a caller is transferred if they press Owhile listening to the
(DTMF 0) mailbox greeting rather than leaving a message (*0 on Embedded Voicemail in IP
Office Mode).

For voicemail systems set to Intuity emulation mode, the mailbox owner can also
access this option when collecting their messages by dialing *0.

If the mailbox has been reached through a Voicemail Pro call flow containing a Leave
Mail action, the option provided when 0 is pressed are:

 For IP Office mode, the call follows the Leave Mail action's Failure or Success
results connections depending on whether the caller pressed 0 before or after the
record tone.

+ For Intuity mode, pressing 0 always follows the Reception/Breakout (DTMF 0)
setting.

* When Park & Page is selected for a DTFM breakout, the following drop-down boxes
appear:

- Paging Number: Displays a list of hunt groups and users (extensions). Select a
hunt group or extension to configure this option.

- Retries: The range is 0 to 5. The default setting is 0.

- Retry TimeoutProvided in the format M:SS (minute:seconds). The range can be
set in 15-second increments. The minimum setting is 15 seconds and the
maximum setting is 5 minutes. The default setting is 15 seconds

Breakout (DTMF 2) The number to which a caller is transferred if they press 2while listening to the
mailbox greeting rather than leaving a message (*2 on Embedded Voicemail in IP
Office Mode).

Breakout (DTMF 3) The number to which a caller is transferred if they press 3while listening to the
mailbox greeting rather than leaving a message (*3 on Embedded Voicemail in IP
Office Mode).

Voicemail Code Complexity
Defines the requirements for the voicemail code.

For IP Office systems that have Voicemail Type set to Centralized, the Voicemail Code Complexity settings
must be the same as the IP Office system that is connected to Voicemail Pro.

Enforcement Default = On.

When on, a user PIN is required. The enforcement is not forced during upgrade but
after checking, it can not be cleared.
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Field

Description

Minimum Length

Default = 6. Maximum 31 digits. Older configurations can continue to have 4 digits
with a maximum of 20 digits.

Complexity

Default = On.

When on, the following complexity rules are enforced.

» The user extension number cannot be used.

* A PIN consisting of repeated digits is not allowed (111111).

* A PIN consisting of a sequence, forward or reverse, is not allowed (123456,
564321).

The number of users having invalid Voicemail Code complexity is highlighted below
this field in red colored text.

Call Recording

server.

These setting relate to call recording. Call recording is only supported when using a Voicemail Pro voicemail

Auto Restart Paused
Recording (secs)

Default = 15 seconds. Range = Never or 5 to 999 seconds.

If recording, manual or automatic, of a call is halted using a Pause Recording button,
this timer determines when recording is restarted if the button is not pressed again.

Hide Auto Recording

Default = On (USA)/Off (Rest of World)

During call recording by Voicemail Pro, some Avaya phones display REC or similar to
show that the call is being recorded. When on, hide auto recording suppresses this
recording indication.

SIP Settings

For Enterprise Branch deployments, these settings are used for calls made or
received on a SIP line where any of the line’s SIP URI fields are set to use internal
data. For Embedded Voicemail and Voicemail Pro, for calls made or received on a SIP
line where any of the line's SIP URI fields are set to Use Internal Data, that data is
taken from these settings. These options are shown if the system has SIP trunks and
is set to use Embedded Voicemail, Voicemail Lite/Pro, Centralized Voicemail or
Distributed Voicemail.

SIP Name

Default = Blank on Voicemail tab/Extension number on other tabs.

The value from this field is used when the From field of the SIP URI being used for a
SIP call is set to Use Internal Data.

SIP Display Name
(Alias)

Default = Blank on Voicemail tab/Name on other tabs.

The value from this field is used when the Display Name field of the SIP URI being
used for a SIP call is set to Use Internal Data

Contact Default = Blank on Voicemail tab/Extension number on other tabs. The value from this
field is used when the Contact field of the SIP URI being used for a SIP call is set to
Use Internal Data.

Anonymous Default = On on Voicemail tab/Off on other tabs. If the From field in the SIP URI is set
to Use Internal Data, selecting this option inserts Anonymous into that field rather
than the SIP Name set above.
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Voicemail Language Prompts

When the system routes a call to the voicemail server it indicates the locale for which matching
prompts should be provided if available. The locale sent to the voicemail server by the system is
determined as show below. If the required set of prompts is not available, the voicemail will
fallback to another appropriate language and finally to English (refer to the appropriate voicemail
installation manual for details).

« Short Code Locale: The short code locale, if set, is used if the call is routed to voicemail
using the short code.

* Incoming Call Route Locale: The incoming call route locale, if set, is used if caller is
external.

» User Locale: The user locale, if set, is used if the caller is internal.

» System Locale: If no user or incoming call route locale is set, the system locale is used
unless overridden by a short code locale.

Systems using Embedded Voicemail, if the required set of upgraded language prompts to match
the locale is not present on the system SD card, Manager will display an error. The required
prompt set can be uploaded from Manager using the Add/Display VM Locales option.

Related links
System on page 182

Telephony

Used to set the default telephony operation of the system. Some settings shown here can be
overridden for individual users through their User | Telephony tab. The settings are splitinto a
number of sub-tabs.
Related links
System on page 182
Telephony on page 211
Park and Page on page 218
Tones and Music on page 219
Ring Tones on page 222
SM on page 223
Call Log on page 225
TUl on page 226

Telephony
Navigation: System | Telephony

Additional configuration information

» The Directory Overrides Barring setting allows you to control barred numbers. For additional
configuration information, see Call Barring on page 609.

* The Inhibit Off-Switch Forward/Transfer stops any user from transferring or forwarding
calls externally. For additional information, see Off-Switch Transfer Restrictions on page 677.
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* For additional information regarding the Media Connection Preservation setting, see Media
Connection Preservation on page 589.

 For additional information on ring tones, see Ring Tones on page 566.
Configuration Settings

Used to configure a wide range of general purpose telephony settings for the whole system.

These settings are mergeable with the exception of Companding LAW and Media Connection
Preservation. Changes to these settings requires a reboot of the system.

Field

| Description

Analog Extensions

These settings apply only to analog extension ports provided by the system. For Server Edition this field is only
available on Expansion System (V2) systems

Default Outside Call
Sequence

Default = Normal

This setting is only used with analog extensions. It sets the ringing pattern used for
incoming external calls. For details of the ring types see System | Telephony | Ring
Tones.

This setting can be overridden by a user's User | Telephony | Call Settings setting.
Note that changing the pattern may cause fax and modem device extensions to not
recognize and answer calls.

Default Inside Call
Sequence

Default = Ring Type 1

This setting is only used with analog extensions. It sets the ringing pattern used for
incoming internal calls. For details of the ring types see System | Telephony | Ring
Tones. This setting can be overridden by a user's User | Telephony | Call Settings
setting.

Default Ring Back
Sequence

Default = Ring Type 2

This setting is only used with analog extensions. It sets the ringing pattern used for
ringback calls such as hold return, park return, voicemail ringback, and Ring Back
when Free. For details of the ring types see System | Telephony | Ring Tones.

This setting can be overridden by a user's User | Telephony | Call Settings setting.

Restrict Analog
Extension Ringer
Voltage

Default = Off.

Supported on IP500 V2 systems only. If selected, the ring voltage on analogue
extension ports on the system is limited to a maximum of 40V Peak-Peak. Also
when selected, the message waiting indication (MWI) settings for analog extension
are limited to Line Reversal A, Line Reversal B or None. Any analog extension
already set to another MWI setting is forced to Line Reversal A.

Dial Delay Time (secs)

Default = 4 (USA/Japan) or 1 (ROW). Range = 1 to 30 seconds.

This setting sets the time the system waits following a dialed digit before it starts
looking for a short code match. In situations where there are potential short codes
matches but not exact match, it also sets the delay following the dialing of a digit
before dialing complete is assumed.

Dial Delay Count

Default = 0 digits (USA/Japan) or 4 digits (ROW). Range = 0 to 30 digits.
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Field

Description

This setting sets the number of digits dialed after which the system starts looking for
a short code match regardless of the Dial Delay Time.

Default No Answer
Time (secs)

Default = 15 seconds. Range = 6 to 99999 seconds.

This setting controls the amount of time before an alerting call is considered as
unanswered. How the call is treated when this time expires depends on the call type.

For calls to a user, the call follows the user's Forward on No Answer settings if
enabled. If no forward is set, the call will go to voicemail if available or else
continues to ring. This timer is also used to control the duration of call forwarding if
the forward destination does not answer. It also controls the duration of ringback call
alerting. This setting is overridden by the User | Telephony | Call Settings | No
Answer Time setting for a particular user if different.

For calls to hunt groups, this setting controls the time before the call is presented to
the next available hunt group member. This setting is overridden by the Hunt Group
| Hunt Group | No Answer Time setting for a particular hunt group if different.

Hold Timeout (secs)

Default = Locale specific. Range = 0 (Off) to 99999 seconds.

This setting controls how long calls remain on hold before recalling to the user who
held the call. Note that the recall only occurs if the user has no other connected call.
Recalled calls will continue ringing and do not follow forwards or go to voicemail.

Park Timeout (secs)

Default = Locale specific. Range 0 (Off) to 99999 seconds.

This setting controls how long calls remain parked before recalling to the user who
parked the call. Note that the recall only occurs if the user has no other connected
call. Recalled calls will continue ringing and do not follow forwards or go to
voicemail.

Ring Delay

Default = 5 seconds. Range = 0 to 98 seconds. This setting is used when any of the
user's programmed appearance buttons is set to Delayed ringing. Calls received on
that button will initially only alert visually. Audible alerting will only occur after the ring
delay has expired. This setting can be overridden by a ring delay set for an
individual user (User | Telephony | Multi-line Options | Ring Delay).

Call Priority Promotion
Time (secs)

Default = Disabled. Range = Disabled, 10 to 999 seconds.

When calls are queued for a hunt group, higher priority calls are placed ahead of
lower priority calls, with calls of the same priority sort by time in queue. External calls
are assigned a priority (1-Low, 2-Medium or 3-High) by the Incoming Call Route
that routed the call. Internal calls are assigned a priority of 1-Low. This option can
be used to increase the priority of a call each time it has remained queued for longer
than this value. The calls priority is increased by 1 each time until it reaches 3-High.

In situations where calls are queued, high priority calls are placed before calls of a
lower priority. This has a number of effects:

» Mixing calls of different priority is not recommended for destinations where
Voicemail Pro is being used to provided queue ETA and queue position messages
to callers since those values will no longer be accurate when a higher priority call
is placed into the queue. Note also that Voicemail Pro will not allow a value
already announced to an existing caller to increase.
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Field

Description

« If the addition of a higher priority call causes the queue length to exceed the hunt
group's Queue Length Limit, the limit is temporarily raised by 1. This means that
calls already queued are not rerouted by the addition of a higher priority call into
the queue.

Default Currency

Default = Locale specific.

This setting is used with ISDN Advice of Charge (AOC) services. Note that changing
the currency clears all call costs stored by the system except those already logged
through SMDR. The currency is displayed in the system SMDR output.

Default Name Priority

Default = Favor Trunk.

For SIP trunks, the caller name displayed on an extension can either be that
supplied by the trunk or one obtained by checking for a number match in the
extension user's personal directory and the system directory. This setting determines
which method is used by default. For each SIP line, this setting can be overridden by
the line's own Name Priority setting if required. Select one of the following options:

« Favor Trunk: Display the name provided by the trunk. For example, the trunk may
be configured to provide the calling number or the name of the caller. The system
should display the caller information as it is provided by the trunk. If the trunk does
not provide a name, the system uses the Favor Directory method.

» Favor Directory: Search for a number match in the extension user's personal
directory and then in the system directory. The first match is used and overrides
the name provided by the SIP line. If no match is found, the name provided by the
line, if any, is used.

Media Connection
Preservation

Default = Enabled.

When enabled, attempts to maintain established calls despite brief network failures.
Call handling features are no longer available when a call is in a preserved state.
When enabled, Media Connection Preservation applies to SCN links and Avaya H.
323 phones that support connection preservation.

Phone Failback

Default = Automatic.

Applies to H.323 phones that support resiliency. The options are:
* Automatic

* Manual

Phones are permitted to failover to the secondary gatekeeper when the IP Office
Line link to the primary gatekeeper is down.

When set to Automatic, if a phone’s primary gatekeeper has been up for more than
10 minutes, the system causes the phone to failback if the phone is not in use. If the
phone is in use, the system will reattempt failback 10 seconds after the phone
ceases to be in use.

When set to Manual, phones remain in failover until manually restarted or re-
registered, after which the phone attempts to fail back.
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Field

Description

° Note:

Manual failback is not supported on SIP phones.

Login Code Complexity

Defines the requirements for the login code.

Enforcement

Default = On.

When on, a user PIN is required.

Minimum Length

Default = 6. Maximum 15 digits.

The number of users with login codes less than six digits is displayed below the field
in red colored text.

Complexity

Default = On.

When on, the following complexity rules are enforced.

» The user extension number cannot be used.

» A PIN consisting of repeated digits is not allowed (111111).

* A PIN consisting of forward or backward sequence are not allowed. Examples:
123456, 654321.

The number of users with invalid Code Complexity is highlighted below the field in
red colored text.

Send RTCP to an RTCP
Collector

When the check box is selected, system RTCP reporting is enabled. For IP Office
Release 10.0 and higher, in addition to having the individual phones send RTCP call
quality reports, the system can also send RTCP reports for calls.

Server Address

This Sets the address of the third-party QoS monitoring application to which the
system sends RTCP reports.

UDP Port Number

The destination port. The default for this filed is 5005.

RTCP reporting interval
(secs)

This setting sets the time interval at which the system sends RTCP reports.

Companding Law

These settings should not normally be changed from their defaults. They should only
be used where 4400 Series phones (ULAW) are installed on systems which have A-
Law digital trunks.

A-Law or U-Law> PCM (Pulse Code Modulation) is a method for encoding voice as
data. In telephony, two methods of PCM encoding are widely used, A-Law and U-
Law (also called Mu-Law or y-Law). Typically U-Law is used in North America and a
few other locations while A-Law is used elsewhere. As well as setting the correct
PCM encoding for the region, the A-Law or U-Law setting of a system when it is first
started affects a wide range of regional defaults relating to line settings and other
values.

For IP500 V2 systems, the encoding default is set by the type of Feature Key
installed when the system is first started. The cards are either specifically A-Law or
U-Law.
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Field Description

DSS Status Default = Off
This setting affects Avaya display phones with programmable buttons. It controls
whether pressing a DSS key set to another user who has a call ringing will display
details of the caller. When off, no caller information is displayed.

Auto Hold Default = On (Off for the United States locale).

Used for users with multiple appearance buttons. When on, if a user presses
another appearance button during a call, their current call is placed on hold. When
off, if a users presses another appearance button during a call, their current call is
disconnected.

Show Account Code

Default = On This setting controls the display and listing of system account codes.

* When on: When entering account codes through a phone, the account code digits
are shown while being dialed.

* When off: When entering account codes through a phone, the account code digits
are replaced by s characters on the display.

Inhibit Off-Switch
Forward/Transfer

Default = On

When enabled, this setting stops any user from transferring or forwarding calls
externally.

Restrict Network
Interconnect

Default = Off.

When this option is enabled, each trunk is provided with a Network Type option that
can be configured as either Public or Private. The system will not allow calls on a
public trunk to be connected to a private trunk and vice versa, returning number
unobtainable indication instead.

Due to the nature of this feature, its use is not recommended on systems also using
any of the following other system features: multi-site networks, VPNremote,
application telecommuter mode.

Include location
specific information

Default = Off.

When set to On, this setting is available in the trunk configuration settings when
Network Type is set to Private.

Set to On if the PBX on the other end of the trunk is toll compliant.

Drop External Only
Impromptu Conference

Default = On.

If selected, when the last remaining internal user in a conference exits the
conference, the conference is ended, regardless of whether it contains any external
callers.

If not selected, the conference is automatically ended when the last internal party or
trunk that supports reliable disconnect exits the conference. The Inhibit Off-Switch
Forward/Transfer option above is no longer applied to conference calls.

Visually Differentiate

Default = Off.

S el This setting is applied to the lamp flashing rate used for bridged appearance and call
coverage appearance buttons on 1400, 1600 and 9600 Series phones and on their
Table continues...
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Field

Description

button modules. When selected, external calls alerting on those buttons will use a
slow flash (200ms on/50ms off). If not selected or if the call is internal, normal
flashing (500ms on/500ms off) is used.

Unsupervised Analog
Trunk Disconnect
Handling

Default = Off.

When using analog trunks, various methods are used for trunk supervision, ie. to
detect when the far end of the trunk has disconnected and so disconnect the local
end of the call. Depending on the locale, the system uses Disconnect Clear
signalling and or Busy Tone Detection. This setting should only be enabled if it is
know that the analog trunks do not provide disconnect clear signalling or reliable
busy tone. For Server Edition this field is only available on Expansion System (V2)
systems. When enabled:

+ Disconnect Clear signalling detection is disabled. Busy tone detection remains on.

» Unsupervised transfers and trunk-to-trunk transfers of analog trunk calls are not
allowed. The Allow Analog Trunk to Trunk Connect setting on analog trunks
(Line | Analog Options) is disabled.

+ If Voicemail Pro is being used for external call transfers, Supervised Transfer
actions should be used in call flows rather than Transfer actions.

+ All systems in the network must have this setting set to match each other.

High Quality
Conferencing

Default = On.

Supports the use of the G.722 codec. IP lines and extensions using G.722 are
provided with wide band audio. If High Quality Conferencing is enabled, when
several wide band audio devices are in the same conference, the system will ensure
that the audio between them remains wide band, even if the conference also
contains other lines and devices using narrow band audio (analog devices, digital
devices and IP devices using codecs other than G.722).

Digital/Analogue Auto
Create User

Default = On. (IP500 V2 only. Default = Off for Server Edition/On for others)

When enabled, an associated user is created for each digital/analogue extension
created. Digital/analogue extension creation occurs on initial start up, reset of
configuration, or addition of new digital/analogue expansion units or plug-in
modules.

Directory Overrides
Barring

Default = On.

When enabled, barred numbers are not barred if the dialed number is in the External
Directory.

Advertize Callee State
To Internal Callers

Default = Off.

When enabled, for phones on the same IP Office network (internal phones),
additional status information is communicated to the calling party.

Not supported for SIP endpoints.

* When calling another internal phone and the called phone is set to Do Not Disturb
or on another call, the calling phone displays “Do Not Disturb” or “On Another Call”
rather than “Number Busy”.
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Field

Description

+ On 95xx and 96xx phones, if a line appearance is programmed on a button on
phone A and that line is in use on phone B, then phone A displays the name of the
current user of the line along with the line number.

« If a line appearance on a phone is in use elsewhere in the system and another
extension unsuccessfully attempts to seize that line, the phone displays “In
Use:<name>" where <name> is the name of the user currently using the line.

Internal Ring on

Default = Off.

UEIET? When enabled, the transfer enquiry calls ring with internal ring tone even if the call
that is being transferred is an external call. If the user transferring the call completes
the call when the call is ringing, the ring tone played to the target changes to the ring
tone appropriate for the call being transferred.

This feature is supported on phone series: 1400, 9500, 1600, 9600, and analog
phones.
This feature is not supported on SIP and H.323 DECT phones.

Related links

Telephony on page 211

Park and Page

Navigation: System | Telephony | Park and Page

The Park and Page tab allows for simple configuration of the of the short code and the
programmable button for the park and page function.

These settings are mergeable. Changes to these settings do not require a reboot of the system.

Field

Description

Central Park Range

Default = Blank. Range = nX to nnnnnnnXX The park slot ID range definition,
where n is a digit sequence from 1 to 9999999 and X represents a park slot
value from 0 to 99. The Central Park Range cannot exceed 9 characters total
length.

Examples:

» 1X defines range 10-19

+ 3XX defines range 300-399

+ 9876543XX defines range 987654300-987654399

Page Target Group Default = Blank. The list of paging group targets that are presented on supported
List phones if the Page action is requested after the Call Park.
On some phones, only the first three groups can be presented as Page options
(via the Softkeys on the phone). On phones that support scrolling lists, a larger
list of possible Page targets can be presented.
Related links

Telephony on page 211
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Tones and Music

System

Navigation: System | Telephony | Tones and Music

Additional configuration information

For additional information on configuring hold music, see Music On Hold on page 567.

Configuration settings

Used to configure the various tones and music on hold sources used by the system.

The settings are mergable with the exception of Disconnect Tone and Busy Tone Detection.
Changes to these settings requires a reboot of the system.

Deleting any of the hold music Alternate Sources requires a reboot.

Field

Description

Conferencing Tone

Default = Entry & Exit Tones.
This settings controls how conference tones are used. The options are:

» Entry & Exit Tones: Asingle tone is heard when a new party joins a conference and
double-tone is heard when a party leaves the conference.

* Repeating ToneA conference tone is heard every 10 seconds by all conference
parties.

Note that no conference tones are played in a conference initiated by an Outbound
Contact Express agent.

Disconnect Tone

Default = Default (Use locale setting).

For digital and IP phones, when the system detects that the far end of a call has
disconnected, it can make the near end either go idle or play disconnect tone. By
default, the chosen behavior depends on the system locale. This field can be used to
override the locale's default action and force either disconnect tone or go idle. The
options are:

» Default: Use the system locale specific action for disconnected calls.
» On: Play disconnect tone when far end disconnection is detected.

« Off: Go idle when far end disconnection is detected.

Busy Tone Detection

Default = Off. Enables or disables the use of busy tone detection for call clearing. This
is a system wide setting.

CLI Type

This field is used to set the CLI detection used for incoming analogue trunks. Note that
the CLI Type field is shown for locales other than Customize. For the Customize
locale, it is set through the System | System form. The options are:

« DTMF

* FSK V23
 FSK BELL202
Local Dial Tone Default = On
Table continues. ..
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Field

Description

For all normal operation this setting should be left enabled as it allows the system to
provide dial tone to users (essential for MSN working).

Local Busy Tone

Default = Off

This setting should only be used when the local exchange gives a busy signal via Q.
931 but does not provide busy tone.

Beep on Listen

Default = On

This setting controls whether call parties hear a repeating tone when their call is
monitored by another party using the Call Listen feature.

A Warning:
The use of features to listen to a call without the other call parties being aware of
that monitoring may be subject to local laws and regulations. Before enabling the
feature you must ensure that you have complied with all applicable local laws
and regulations. Failure to do so may result in severe penalties.

GSM Silence
Suppression

Default = Off.

This setting should only be selected if voice quality problems are experienced with
calls to voicemail or while recording calls. When on, the system signals silence by
generating silence data packets in periods when the voicemail system is not playing
prompts. Note that use of this option may cause some timeout routing options in
voicemail to no longer work.

Analogue Trunk VAD

Default = Off.

Select this option to enable Voice Activity Detection (VAD) for analog trunks
terminating on the ATM4U-V2 card. VAD functionality provides a Call Answer signal
triggered by voice activity. This signal can be used for:

* Mobile Twinning

+ SMDR

+ Call Forwarding

+ Call Display

* Mobile Call Control

» Transfer Ringing Call
* TAPI

* Trunk to Trunk Call

Busy Tone Detection

Default = System Frequency (Tone defined by system locale) Allows configuration of
the system's busy tone detection settings on lines that do not provide reliable
disconnect signalling. In that case, the system will use tone disconnect clearing to
disconnect such lines after 6 seconds of continuous tone. The default tone (frequency
and on/off cadence) detection used is defined by the system locale. The settings
should not be adjusted unless advised by Avaya Technical Support. Changes to this
setting require a reboot rather than a merge when the new configuration is sent to the
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Field Description
system. .For Server Edition this field is only available on Expansion System (V2)
systems.

Hold Music

This section is used to define the source for the system's music on hold source. You must ensure that any MOH
source you use complies with copyright, performing rights and other local and national legal requirements.

Server Edition deployments support centralized music on hold, where the Primary Server streams music to the
Secondary Server and all expansion servers.

The WAV file properties must be:

+ PCM

+ 8kHz 16-bit

* mono

» maximum length 90 seconds (30 seconds on non-IP500 V2 systems, 600 seconds on Linux based systems)

If the file downloaded is in the incorrect format, it will be discarded from memory after the download.

A Caution:

Copying files in the incorrect format directly into the opt/ipoffice/system/primary directory can
disable the music on hold function.

The first WAV file, for the system source, must be called HoldMusic.wav. Alternate source WAV files:
» can be up to 27 IA5 characters

+ cannot contain spaces

+ any extension is allowed

* case sensitive
System Source Default = WAV File.

Selects the default hold music source for most uses of music on hold. Note that
changes to the System Source requires a reboot. The options are:

* WAV: Use the WAV file HoldMusic.wav. This file is loaded via TFTP.
Note that on Linux systems, the file name is case sensitive.

* WAV (restart): Identical to WAV except that for each new listener, the file plays from
the beginning.

Not supported on IP500 V2 systems. Cannot be used as a centralized source.

« External: Applicable to IP500 V2 systems. Use the audio source connected to the
back of the control unit.

» Tone: The use of a double beep tone (425Hz, 02./0.2/0.2/3.4 seconds on/off) can be
selected as the system source. The hold music tone is automatically used if the
system source is set to WAV File but the HoldMusic.wav file has not yet been
successfully downloaded.
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Field Description

Alternate Sources This is just a summary, for more details see Alternate Source on page 569. The
available options depends on the system type. On IP500 V2 systems, up to 3
additional sources can be specified. On Linux systems, up to 31 alternate sources can
be specified. Note that adding and changing a source can be done using a merge but
deleting a source requires a reboot.

* Number: Assigned automatically by the system.

» Name: Up to 31 characters This field is used to associate a name with the alternate
source. That name is then used in the Hold Music Source field on Incoming Call
Routes and Hunt Groups.

» Source: Up to 31 characters. Defines the source for the music on hold.

The options are listed below with a brief description. For more information, see
Alternate Source on page 569.

- WAV: To specify a wav file, enter WAV: followed by the file name. Playback
resumes from where it left off the last time.

- XTN: Any analog extension. Not applicable to Linux systems.

- WAVRST: To specify a wav file, enter WAVRST: followed by the file name.
Playback is started every time from the beginning. Not applicable to IP500 V2
systems.

- WAVDIR: Multiple WAV file source. The WAV files must be stored in the
directory /disk/tones/mohwavdir (file manager access) or /opt/ipoffice/
tones/mohwavdir/ (SSH access). Playback resumes from where it left off the
last time. Not applicable to IP500 V2 systems.

- WAVDIRRST: As per WAVDIR above, however playback is always started from
the beginning. Not applicable to IP500 V2 systems.

- USB: Supports multiple USB inputs. Enter USB: <number>. Not applicable to
IP500 V2 systems.

- LINE: In Server Edition networks, setting the Secondary Server and Expansion
Server Alternate Source to Line allows the server to receive streamed audio
from a source on the Primary Server. On the Secondary Server and Expansion
Server, enter Line: x, ywhere x is the line number to the Primary Server and y is
the MOH source number on the Primary Server.

Related links
Telephony on page 211
Ring Tones
Navigation: System | Telephony | Ring Tones

Additional configuration information
For additional ring tone configuration information, see Ring Tones. on page 566
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Configuration settings

Used to configure distinct ring tones for groups and incoming call routes. Ring Tone configuration
is only supported on 1400 series and 9500 series phones.

These settings are mergeable. Changes to these settings do not require a reboot of the system.

Field Description
Available Ring In this table, the Number, Name, and Source values are system supplied. The
Tones Name value is used to create a ring tone plan.

Ring Tone Plan

Use this table to specify available ring tones. Ring tones in this table can be
applied to hunt groups and incoming call routes and by short codes.

* Number: System supplied.

The Number can be used in a short code by adding r(x) to the Telephone
Number field, where x = 1 to 8 and specifies which ring tone plan to use.

+ Name: A descriptive name for where this ring tone is used. For example, the
name of a hunt group. Each name in the table must be unique. Once configured
in this table, ring tone names can be selected from the Ring Tone Override field
at:

- Group | Group
- Incoming Call Route | Standard

Ring Tone Override is supported on 1400 and 9500 series phones.

* Ring Tone: The list of ring tone names from the Available Ring Tones table.

Related links

Telephony on page 211

SM

Navigation: System | Telephony | SM

Used to configure settings that apply to both SM lines.

These settings are not mergeable. Changes to these settings require a reboot of the system.

Field

Description

Short Form Dialing
Length

Default = 0. Range = 0 to 14.

This number specifies the short-form dialing length for all Centralized users and
Groups. Configuration of this field allows IP Office to treat the last N digits (where
N is the number entered in this field) of each Centralized user’s extension number
as an alias to that user’s extension number. For example, if a Centralized user’s
extension number is 5381111 and the Short Form Dialing Length is 4, the system
will match calls to 1111 with this extension. When 1111 is dialed by another user
on the system, entered from the autoattendant, or comes from the ICR, then in
sunny-day that call will be sent to Session Manager with the number converted to
5381111 and in rainy-day it will target the extension 5381111 locally.
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Field

Description

Branch Prefix

Default = Blank. Maximum range = 15 digits.

This number is used to identify the IP Office system within the Avaya Aura®
network. The branch prefix of each IP Office system must be unique and must not
overlap. For example 85, 861 and 862 are okay, but 86 and 861 overlap. On calls
routed via an SM Line, the branch prefix is added to the caller's extension number.
You have the option to leave the Branch Prefix field blank. If you do not configure
the branch prefix, the IP Officeuser extensions must be defined with the full
enterprise number.

Local Number
Length

Default = Blank (Off). Range = Blank or 3 to 9 in deployments with IP Office users
and blank or 3 to 15 in deployments with only centralized users.

This field sets the default length for extension numbers for extensions, users, and
hunt groups added to the IP Office configuration. Entry of an extension number of
a different length will cause an error warning by Manager.

The number of digits entered in the Branch Prefix field plus the value entered in
the Local Number Length field must not exceed 15 digits. You have the option to
leave the Local Number Length field blank.

Proactive
Monitoring

Default = 60 seconds. Range = 60 seconds to 100000 seconds.

The Enterprise Branch system sends regular SIP OPTIONS messages to the SM
line in order to check the status of line. This setting controls the frequency of the
messages when the SM line is currently in service. Centralized SIP phones use
their own settings.

Monitoring Retries

Default = 1. Range = 0 to 5.

The number of times the Enterprise Branch system retrys sending an OPTIONS
request to Session Manager before the SM Line is marked out-of-service.

Reactive Monitoring

Default 60 seconds. Range = 10 to 3600 seconds.

The Enterprise Branch system sends regular SIP OPTIONS messages to the SM
line in order to check the status of line. This setting controls the frequency of the
messages when the SM line is currently out of service. Centralized SIP phones
use their own settings.

Failback Policy

Default = Auto.

This field allows the administrator to choose between an automatic or manual
failback policy on the IP Office. In deployments with Centralized phones, this field
must be set consistently with the Failback Policy of the phones, which is
configured via the Session Manager global settings in System Manager. The
options are:

+ Auto: IP Office automatically brings the SM Line to ‘In Service’ status as soon
as it detects via the Reactive Monitoring that the Session Manager is reachable

* Manual: When an SM line is in "Out of Service" state, IP Office does not bring it
back to "In Service" status based on automatic detection. IP Office keeps the
SM Line in "Out of Service" state until the administrator manually initiates
Failback of IP Office from Session Manager.
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Related links
Telephony on page 211

Call Log
Navigation: System | Telephony | Call Log

The system can store a centralized call log for users. Each users' centralized call log can contain
up to 30 call records for user calls. When this limit is reached, each new call records replaces the
oldest previous record.

On Avaya phones with a fixed Call Log or History button (1400, 1600, 9500 and 9600 Series),
that button can be used to display the user's centralized call log. The centralized call log is also
used for M-Series and T-Series phone. The user can use the call log to make calls or to store as a
personal speed dial. They can also edit the call log to remove records. The same call log is also
used if the user logs into one-X Portal for IP Office.

The centralized call log moves with the user if they log on and off from different phones. This
includes if they hot desk within a network.

These settings are mergeable. Changes to these settings do not require a reboot of the system.

Field Description

Default Centralized | Default = On.
Call Log On

When selected, each user is defaulted to have the system store a call log of their
calls. This call log is accessible on the phone when the user is using a phone with
a Call Log or History button. The use of centralized call logging can be enabled/
disabled on a per user basis using the setting User | Telephony | Call Log |
Centralized Call Log.

Log Missed Calls Default = Off.
Answered at
Coverage

This setting controls how calls to a user, that are answered by a covering user
should be logged in the centralized call log. This option applies for calls answered
elsewhere (covered) by pickup, call coverage (call coverage buttons or coverage
group), bridged appearance button, user BLF, voicemail, etc.

Setting Targeted User Covering User
Off Nothing Answered Call
On Missed Call Answered Call

Log Missed Hunt Default = Off. By default, hunt group calls are not included in any user's
Group Calls centralized call log unless answered by the user. If this option is selected, a
separate call log is kept for each hunt group of calls that are not answered by
anyone. It includes hunt group calls that go to voicemail.

If missed hunt group calls are also being logged, the system stores up to 10 call
records for each hunt group. When this limit is reached, new call records replace
the oldest record.

Within the user call log settings (User | Telephony | Call Log), the list of hunt
groups allows selection of which hunt groups' missed call records should be
displayed as part of the user's centralized call log.
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Related links
Telephony on page 211
TUI
Navigation: System | Telephony | TUI
Used to configure system wide telephony user interface (TUI) options.
Default phone display options:
Use these settings to define the default phone display when feature menus are disabled. Note that
for new users, the default phone display options are set to the system default values.
Feature menus can be disabled in one of two ways.
» Set System | Telephony | TUI | Features Menu to Off. Set User | Telephony | TUI | User
Setting to Same as System.
* On User | Telephony | TUI, set User Setting to Custom and set Features Menu to Off.
Related links

Telephony on page 211

Directory Services

Navigation: System | Directory Services

Related links

System on page 182
LDAP on page 226
HTTP on page 229

LDAP

Navigation: System | Directory Services | LDAP
Additional configuration information

For additional configuration information, see Centralized System Directory on page 551.
Configuration settings

The system supports LDAP Version 2. LDAP (Lightweight Directory Access Protocol) is a software
protocol for enabling anyone to locate organizations, individuals, and other resources such as files
and devices in a network, whether on the Internet or on a corporate intranet. LDAP is a
"lightweight" (smaller amount of code) version of DAP (Directory Access Protocol), which is part of
X.500, a standard for directory services in a network. LDAP is lighter because in its initial version,
it did not include security features.

The system supports the import of directory records from one system to another using HTTP. That
includes using HTTP to import records that another system has learnt using LDAP. HTTP import,
which is simpler to configure, can be used to relay LDAP records with LDAP configured on just
one system.
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LDAP records can contain several telephone numbers. Each will be treated as a separate
directory record when imported into the system directory.

In a network, a directory tells you where in the network something is located. On TCP/IP networks,
including the Internet, the Domain Name System (DNS) is the directory system used to relate the
domain name to a specific network address. However, you may not know the domain name. LDAP
allows you to search for an individual without knowing where they're located (although additional
information will help with the search).

An LDAP directory is organized in a simple "tree" hierarchy consisting of the following levels:
» The "root" directory (the starting place or the source of the tree), which branches out to
» Countries, each of which branches out to
» Organizations, which branch out to

» Organizational units (divisions, departments, and so forth), which branches out to (includes
an entry for)

* Individuals (which includes people, files, and shared resources such as printers)

An LDAP directory can be distributed among many servers. Each server can have a replicated
version of the total directory that is synchronized periodically. An LDAP server is called a Directory
System Agent (DSA). An LDAP server that receives a request from a user takes responsibility for
the request, passing it to other DSA's as necessary, but ensuring a single coordinated response
for the user.

LDAP Directory Synchronization allows the telephone number Directory held in the Control Unit to
be synchronized with the information on an LDAP server. The feature can be configured to
interoperate with any server that supports LDAP Version 2.

These settings are mergeable. Changes to these settings do not require a reboot of the system.

Field Description
LDAP Enabled Default = Off

This option turns LDAP support on or off. The system uses LDAP Version 2. If the
server being queried is an LDAP Version 3 server, support for LDAP Version 2
requests may need to be enabled on that server (all LDAP Version 3 servers
support LDAP Version 2 but do not necessarily have it enabled by default).

User Name Default = Blank

Enter the user name to authenticate connection with the LDAP database. To
determine the domain-name of a particular Windows 2000 user look on the
"Account" tab of the user's properties under "Active Directory Users and
Computers". Note that this means that the user name required is not necessarily
the same as the name of the Active Directory record. There should be a built-in
account in Active Directory for anonymous Internet access, with prefix "I[USR_"
and suffix server_name (whatever was chosen at the Windows 2000 installation).
Thus, for example, the user name entered is this field might be:
IUSR_CORPSERV@example.com

Password Default = Blank
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Field

Description

Enter the password to be used to authenticate connection with the LDAP
database. Enter the password that has been configured under Active Directory for
the above user. Alternatively an Active Directory object may be made available for
anonymous read access. This is configured on the server as follows.

In "Active Directory Users and Computers" enable "Advanced Features" under the
"View" menu. Open the properties of the object to be published and select the
"Security" tab. Click "Add" and select "ANONYMOUS LOGON?", click "Add", click
"OK", click "Advanced" and select "ANONYMOUS LOGON", click "View/Edit",
change "Apply onto" to "This object and all child objects", click "OK", "OK", "OK".

Once this has been done on the server, any record can be made in the User
Name field in the System configuration form (however this field cannot be left
blank) and the Password field left blank. Other non-Active Directory LDAP servers
may allow totally anonymous access, in which case neither User Name nor
Password need be configured.

Server IP Address

Default = Blank

Enter the IP address of the server storing the database.

Server Port

Default = 389

This setting is used to indicate the listening port on the LDAP server.

Authentication
Method

Default = Simple
Select the authentication method to be used. The options are:
» Simple: clear text authentication

* Kerberos: Not used.

Resync Interval
(secs)

Default = 3600 seconds. Range = 60 to 99999 seconds.

The frequency at which the system should resynchronize the directory with the
server. This value also affects some aspects of the internal operation.

The LDAP search inquiry contains a field specifying a time limit for the search
operation and this is set to 1/16th of the resync interval. So by default a server
should terminate a search request if it has not completed within 225 seconds
(3600/16).

The client end will terminate the LDAP operation if the TCP connection has been
up for more than 1/8th of the resync interval (default 450 seconds). This time is
also the interval at which a change in state of the "LDAP Enabled" configuration
item is checked.

Search Base/Search
Filter

Default = Blank These 2 fields are used together to refine the extraction of
directory records. Basically the Base specifies the point in the tree to start
searching and the Filter specifies which objects under the base are of interest.
The search base is a distinguished name in string form (as defined in RFC1779).

The Filter deals with the attributes of the objects found under the Base and has its
format defined in RFC2254 (except that extensible matching is not supported). If
the Search Filter field is left blank the filter defaults to "(objectClass=*)", this will
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Field

Description

match all objects under the Search Base. The following are some examples
applicable to an Active Directory database.

» To get all the user phone numbers in a domain:
Search Base: cn=users,dc=acme, dc=com
Search Filter: (telephonenumber=*)

+ To restrict the search to a particular Organizational Unit (eg office) and get cell
phone numbers also:

Search Base: ou=holmdel, DC=example, DC=com

Search Filter: (| (telephonenumber=*) (mobile=*))
+ To get the members of distribution list "group1":

Search Base: cn=users,dc=example,dc=com

Search Filter:
(& (memberof=cn=groupl, cn=users, dc=example, dc=com)
(telephonenumber=*))

Number Attributes

: Default = see below

Enter the number attributes the server should return for each record that matches
the Search Base and Search Filter. Other records could be ipPhone,
otherlpPhone, facsimileTelephoneNumber, otherfacsimileTelephone Number,
pager or otherPager. The attribute names are not case sensitive. Other LDAP
servers may use different attributes.

By default the record is
"telephoneNumber,otherTelephone,homePhone=H,otherHomePhone=H,mobile=M
,otherMobile=M", as used by Windows 2000 Server Active Directory for Contacts.

The optional "=string" sub-fields define how that type of number is tagged in the
directory. Thus, for example, a cell phone number would appear in the directory
as: John Birbeck M 7325551234

Related links

Directory Services on page 226

HTTP

Navigation: System | Directory Services | HTTP

Additional configuration information

For additional configuration information, see Centralized System Directory on page 551.

Configuration settings

The system can use HTTP to import the directory records held by another system. Note that
support for HTTP can be disabled. The setting System | System | Avaya HTTP Clients Only can
restrict a system from responding to HTTP requests. The system's Unsecured Interface security
settings also included controls for HTTP access (HTTP Directory Read and HTTP Directory

Write).
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For Server Edition, on Secondary Server, Expansion System (L) and Expansion System (V2)
systems, the HTTP settings are automatically defaulted to obtain the system directory from the
Primary Server.

These settings are mergeable. Changes to these settings do not require a reboot of the system.

Field Description
Directory Type Default = None (No HTTP import)/IP Office SCN on Server Edition.

Set whether HTTP import should be used and the method of importation. The options
are:

* None: Do not use HTTP import.
« IP Office: Import from the system at the IP address set in the Source field.

« |IP Office SCN: Import from a system in a multi-site network. The Source field is used
to select the Outgoing Line ID that matches the H.323 line to the remote system.

Source Default = Blank/9999 on Server Edition.

The form of this field changes according to the Directory Type selection above. For IP
Office this field requires the IP address of the other system. For IP Office SCN, the
outgoing group ID of the IP Office line to the remote system is used.

List Default = All.

This field sets what types of directory record should be imported. The options are:
» All: Import the full set of directory records from the remote system.

» Config Only: Import just directory records that are part of the remote system's
configuration. Note that these will be treated as imported records and will not be added
to the local systems own configuration records.

« LDAP Only: Import just directory records that the remote system has obtained as the
result of its own LDAP import. This allows LDAP directory records to be relayed from
one system to another.

* HTTP Only: Import just directory records that the remote system has obtained as the
result of its own HTTP import. This allows HTTP directory records to be relayed from
one system to another.

URI Default = /system/dir/complete_dir_list?sdial=true

This field is for information only and cannot be adjusted. The path shown changes to
match the List setting above.

Resync Interval Default = 3600 seconds.

(secs) Set how often the system should request an updated import. When a new import is

received, all previously imported records are discarded and the newly imported records
are processed.

HTTPS Enabled Default = On.

Turns HTTPS support on or off for directory record import.
Port Number Default = 443.

The port used for the Directory import.
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Field Description

When HTTPS Enabled is set to On, the default value is 443. When HTTPS Enabled is
set to Off, the default value is 80.

Related links
Directory Services on page 226

System Events

Navigation: System | System Events

The system supports a number of methods by which events occurring on the system can be
reported. These are in addition to the real-time and historical reports available through the System
Status Application (SSA).

Related links
System on page 182

Configuration on page 231
Alarms on page 232
Configuration
Navigation: System | System Events | Configuration
This form is used for general configuration related to system alarms.

Configuration Settings
These settings are not mergeable. Changes to these settings require a reboot of the system.

Field Description
SNMP Agent Configuration
SNMP Enabled Default = Off.

Enables support for SNMP. This option is not required if using SMTP or Syslog.

Community Default = Blank.

(Read-only) The SNMP community name to which the system belongs.

SNMP Port Default = 161. Range = 161, or 1024 to 65535. The port on which the system listens for
SNMP polling.

Device ID This is a text field used to add additional information to alarms. If an SSL VPN is

configured, Avaya recommends that the Device ID match an SSL VPN service Account
Name. Each SSL VPN service account name has an associated SSL VPN tunnel IP
address. Having the displayed Device ID match an SSL VPN service account name helps
identify a particular SSL VPN tunnel IP address to use for remotely managing IP Office.

Contact This is a text field used to add additional information to alarms.
Location This is a text field used to add additional information to alarms.
Table continues...
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Field

Description

QoS Parameters

alarm for the call.

These parameters are used if the setting System | LAN1 | VoIP | Enable RTCP Monitor on Port 5005 is set to
On. They are used as alarm thresholds for the QoS data collected by the system for calls made by Avaya H.323
phones and for phones using VCM channels. If a monitored call exceeds any of the threshold an alarm is sent
to the System Status application. Quality of Service alarms can also be sent from the system using Alarms.

» The alarm occurs at the end of a call. If a call is held or parked and then retrieved, an alarm can occur for
each segment of the call that exceeded a threshold.

* Where a call is between two extensions on the system, it is possible that both extensions will generate an

» An alarm will not be triggered for the QoS parameters recorded during the first 5 seconds of a call.

Round Trip Delay
(msec)

Default = 350.

Less than 160ms is high quality. Less than 350ms is good quality. Any higher delay will be
noticeable by those involved in the call. Note that, depending on the compression codec
being used, some delay stems from the signal processing and cannot be removed: G.711

=40ms, G.723a = 160ms, G.729 = 80ms.

Jitter (msec)

Default =20.

Jitter is a measure of the variance in the time for different voice packets in the same call to
reach the destination. Excessive jitter will become audible as echo.

Packet Loss (%)

Default = 3.0.

Excessive packet loss will be audible as clipped words and may also cause call setup

delays.

Good Quality High Quality
Round Trip Delay < 350ms < 160ms
Jitter <20ms <20ms
Packet Loss <3% <1%

Related links
System Events on page 231

Alarms

Navigation: System | System Events | Alarms
These settings are not mergeable. Changes to these settings require a reboot of the system.

This form is used to configure what can cause alarms to be sent using the different alarm
methods.

» Up to 5 alarm traps can be configured for use with the SNMP settings on the System |
System Events | Configuration tab.

» Up to 3 email alarms can be configured for sending using the systems System | SMTP
settings. The email destination is set as part of the alarm configuration below.

» Up to 2 alarms can be configured for sending to a Syslog destination that is included in the
alarm settings.
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Configuration Settings

Field Description
New Alarm This area is used to show and edit the alarm.
Destination

To use SNMP or Email the appropriate settings must be configured on the Configuration sub-tab. Note that the
Destination type is grayed out if the maximum number of configurable alarms destinations of that type has been
reached. Up to 5 alarm destinations can be configured for SNMP, 3 for SMTP email, and 2 for Syslog

Trap

If selected, the details required in addition to the selected Events are:

» Server Address: Default = Blank. The IP address or fully qualified domain name
(FQDN) of the SNMP server to which trap information is sent.

* Port: Default = 162. Range = 0 to 65535. The SNMP transmit port.

« Community: Default = Blank The SNMP community for the transmitted traps. Must be
matched by the receiving SNMP server.

* Format: Default = IP Office. The options are:
- IP Office SNMP event alarms format in accordance with IP Office.
- SMGR SNMP event alarms format in accordance with SMGR.

Syslog

If selected, the details required in addition to the selected Events are:

» IP Address: Default = Blank. The IP address of the Syslog server to which trap
information is sent.

* Port: Default = 514. Range = 0 to 65535. The Syslog destination port.
* Protocol: Default = UDP. Select UDP or TCP.
* Format: Default = Enterprise. The options are:
- Enterprise Syslog event alarms format in accordance with Enterprise.

- IP Office Syslog event alarms format in accordance with IP Office.

Email

If selected, the details required in addition to the selected Events are:

Email: The destination email address.

Minimum Security
Level

Default = Warnings.

The options are:

» Warnings: All events, from Warnings to Critical, are sent.

* Minor: Minor, major, and critical events are sent. Warnings are not sent.

» Major: Major and critical events are sent. Warnings and minor events will not be sent.

* Critical: Only critical events are sent.

Events Default = None
Sets which types of system events should be collected and sent. The table below lists the
alarms associated with each type of event. Text in italics in the messages is replaced with
the appropriate data. Items in [] brackets are included in the message if appropriate. The
Table continues...
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Field Description
subject line of SMTP email alarms takes the form "System name: IP address - System
Alarm".
Type Events Event State Message
Entity Application Voicemail operation The Voicemail server is now
operational.

Voicemail Failure The Voicemail server is down.

Voicemail Event - storage The Voicemail server storage is

OK OK.

Voicemail Event - storage The Voicemail server storage is

nearly full nearly full.

Voicemail Event - storage | storage full The Voicemail server

full storage is full.

Service Feature license missing Attempt to use a feature for which
no license is installed. License
Type: <name>

All licenses in use The following licenses are all in
use. License Type: <name>

Clock source changed 8kHz clock source changed.
Details will be provided.

Logon failed Logon failure reason will be
provided.

No free channels available | No free channels were available.
Outgoing group ID: <number>

Hold music file failure Failed to load Hold Music source
file.

All resources in use The following system resources
are all in use: <resource type> will
be provided.

OEM card slot error System running secondary
software or error description with
OEM card will be provided.

Network interconnect Details of the network

failure interconnection failure will be
provided.

SIP message too large SIP message Rx error - too large -
ignored.

Contact Flash Change The PC card in name has
Card changed.
Expansion Operational Expansion module name link is up.
Module Failure Expansion module name link is
down.
Table continues...
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Type Events Event State Message

Error Expansion module name link has a
link error.

Change Expansion module name link has
changed.

Trunk Operational Trunk number (name) [on
expansion module number] is now
operational.

Failure Trunk number (name) [on
expansion module number] is
down.

Trunk Trunk seize failure Seize failure: Channel [number] or
Port [number].

Incoming call outgoing Incoming call outgoing trunk:

trunk failure Channel [number] or Port
[number].

CLI not delivered CLI not delivered: Channel
[number] or Port [number].

DDI incomplete DDI incomplete. Expected Number
of digits: .

LOS LOS

0O0S 0O0S

Red Alarm Red Alarm

Blue Alarm Blue Alarm

Yellow Alarm Yellow Alarm

IP connection failure IP connection failure. IP Trunk Line
Number: <number> or Remote end
IP address: <IP address>

Small Community Network | Small Community Network invalid

invalid connection connection. IP trunk line number:
<number> or remote end IP
address: <IP address>

Link Device changed Device changed. Home Extension
Number: .

LDAP server LDAP server communication failure

communication failure

Resource down Link/resource down. Module type,
number and name will be provided.

SMTP server SMTP server communication

communication failure failure

Voicemail Pro connection Voicemail Pro connection failure

failure

Table continues...
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Type Events Event State Message
Dialer connection failure The Dialer connection has been
lost.
VCM Operational VCM module name is now
operational.
Failure VCM module name has failed.
Memory Card Invalid Card
Free Capacity
Generic Generic Non-primary location boot | System running backup software.
alarm
Invalid SD Card Incompatible or Invalid (System or
Optional) SD Card fitted.
Network link failure Network Interface name (ip
address) has been disconnected.
Network link operational Network Interface name (ip
address) has been connected.
System warm start System has been restarted (warm
start).
System cold start System has restarted from power
fail (cold start).
SNMP Invalid community Invalid community specified in
SNMP request.
License License Server | Server Operational The license server is now
operational.
Server failure The license server is no longer
operational.
License Key License Key Failure
Failure
Loopback Loopback Near end line loopback Trunk number (name) [on

expansion module number] is in
near end loopback.

Near end payload loopback

Trunk number (name) [on
expansion module number] is in
near end loopback with payload.

Loopback off

Trunk number (name) [on
expansion module number] has no
loopback.

Phone Change

Phone Change

Phone has been unplugged

The phone with id n has been
removed from extension extension
(unit, port number).

Phone has been plugged in

The phone with type type (id
number) has been plugged in for
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Type Events Event State Message
extension extension (unit, port
number).
Quality of Service | QoS Monitoring | If Enable RTCP Monitor on Port 5005 is selected, any monitored
calls that exceeds the set QoS Parameters causes an alarm.
Syslog Basic Audit Events as written to the system Audit Trail. Available on Syslog
output only.

Extended Audit | Configuration change information. Each message contains one
configuration or security settings object attribute change, and
optionally the previous and new values.

System Monitor | If selected, System monitor traces are packed into Syslog traces.

System Configuration CCR group agent not CCR Group agent not targeted as

targeted it is not an CCR Agent. Group :
<name> Agents: <namef, ..... ,
name n>.

Small Community Network | Small Community Network dial

dial plan conflict plan conflict

No incoming call route for | The following line had no Incoming

call Call Route for a call. Line:
<number> or Line Group ID:
<number>.

Installed hardware failure Installed hardware failure details
will be provided.

System

Shutdown

Running Backup

Emergency Calls | Emergency call successful | Successful Emergency Call |

Emergency call! Location:/ocation
Dialled:dialled number
Called:number sent on the line
CallerlD: ID Usr:user
Extn:extension
Emergency call successful | Failed Emergency Call |

Emergency call! Location:/ocation
Dialled:dialled
numberfailCause:cause Usr:user
Extn: extension

Alarm Types

Note the following.

* Voicemail Pro Storage Alarms: The alarm threshold is adjustable through the Voicemail Pro

client.

+ Embedded Voicemail Storage Alarms: A disk full alarm is generated when the Embedded
Voicemail memory card reaches 90% full. In addition a critical space alarm is generated at
99% full and an OK alarm is generated when the disk space returns to below 90% full.
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* Loopback: This type of alarm is only available for systems with a United States locale.

The list of IP Office alarms is available on the Admin CD in the folder \snmp mibs\IPOffice.

Related links

System Events on page 231

SMTP

Navigation: System | SMTP

These settings are not mergeable. Changes to these settings require a reboot of the system.

Configuration Settings

SMTP can be used as the method of sending system alarms. The email destination is set as part
of the email alarms configured in System | System Events | Alarms.

SMTP can be used with Embedded Voicemail for Voicemail Email. The voicemail destination is set
by the user's Voicemail Email address.

Field Description

Server Address Default = Blank
This field sets the IP address of the SMTP server being used to forward SNMP
alarms sent by email.

Port Default = 25. Range = 0 to 65534.

This field set the destination port on the SMTP server.

Email From Address

Default = Blank

This field set the sender address to be used with mailed alarms. Depending of
the authentication requirements of the SMTP server this may need to be a
valid email address hosted by that server. Otherwise the SMTP email server
may need to be configured to support SMTP relay.

Use STARTTLS

Default = Off. (Release 9.0.3).

Select this field to enable TLS/SSL encryption. Encryption allows voicemail-to-
email integration with hosted email providers that only permit SMTP over a
secure transport.

Server Requires
Authentication

Default = Off

This field should be selected if the SMTP server being used requires
authentication to allow the sending of emails. When selected, the User Name
and Password fields become available

User Name Default = Blank This field sets the user name to be used for SMTP server
authentication.
Password Default = Blank This field sets the password to be used for SMTP server
authentication.
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Field

Description

Use Challenge
Response
Authentication (CRAM-
MD5)

Default = Off. This field should be selected if the SMTP uses CRAM-MD5.

Related links
System on page 182

System | SMDR

Navigation: System | SMDR

Using a specified IP address, the system can send a call record for each completed call.

© Note:

Outbound Contact Express does not generate SMDR records.

These settings are mergeable. Changes to these settings do not require a reboot of the system.

Field

Description

Output

Default = No Output.

Select the type of call record that the system should output via IP. The options
are:

* No Output
« SMDR Only : Send call records using the SMDR settings below.

see the appendix.

SMDR: Station Message Detail Recorder Communications

This fields are available when SMDR is selected as the output. For information on SMDR record details,

IP Address Default = 0.0.0.0 (Listen).
The destination IP address for SMDR records. The address 0.0.0.0 puts the
control unit in listen mode on the specified TCP port. When a connection is
made on that port, all SMDR records in the buffer are provided.

TCP Port Default = 0.

The destination IP port for SMDR records.

Records to Buffer

Default = 500. Range = 10 to 3000.

The system can cache up to 3000 SMDR records if it detects a
communications failure with destination address. If the cache is full, the system
will begin discarding the oldest records for each new record.

Call Splitting for Default = Off.
Diverts
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Field Description

When enabled, for calls forwarded off-switch using an external trunk, the
SMDR produces separate initial call and forwarded call records. This applies
for calls forwarded by forward unconditional, forward on no answer, forward on
busy, DND or mobile twinning. It also applies to calls forwarded off-switch by
an incoming call route. The two sets of records will have the same Call ID. The
call time fields of the forward call record are reset from the moment of
forwarding on the external trunk.

Related links
System on page 182

VCM
Navigation: System | VCM

This form allows adjustment of the operation of any Voice Compression Modules (VCM's) installed
in a control unit.

Calls to and from IP devices can require conversion to the audio codec format being used by the
IP device. For systems this conversion is done by voice compression channels. These support the
common |P audio codecs G.711, G.723 and G.729a. For details of how to add voice compression
resources to a system, refer to the IP Office Installation Manual.

These settings should only be adjusted under the guidance of Avaya support.
These settings are mergeable. Changes to these settings do not require a reboot of the system.
When are Voice Compression Channels Used

IP Device to Non-IP Device: These calls require a voice compression channel for the duration of
the call. If no channel is available, busy indication is returned to the caller.

IP Device to IP Device: Call progress tones (for example dial tone, secondary dial tone, etc) do
not require voice compression channels with the following exceptions:

» Short code confirmation, ARS camp on and account code entry tones require a voice
compression channel.

* Devices using G.723 require a voice compression channel for all tones except call waiting.
When a call is connected:

* If the IP devices use the same audio codec no voice compression channel is used.

« If the devices use differing audio codecs, a voice compression channel is required for each.
Non-IP Device to Non-IP Device: No voice compression channels are required.

Music on Hold: This is provided from the system's TDM bus and therefore requires a voice
compression channel when played to an IP device.

Conference Resources and IP Devices: Conferencing resources are managed by the
conference chip which is on the system's TDM bus. Therefore, a voice compression channel is
required for each IP device involved in a conference. This includes services that use conference
resources such as call listen, intrusion and silent monitoring. They also apply to call recording.
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Page Calls to IP Device: Page calls require 1 voice compression channel per audio codec being
used by any IP devices involved. The system only uses G.729a for page calls, therefore only
requiring one channel but also only supporting pages to G.729a capable devices.

Voicemail Services and IP Devices: Calls to the system voicemail servers are treated as data
calls from the TDM bus. Therefore calls from an IP device to voicemail require a voice
compression channel.

Fax Calls: These are voice calls but with a slightly wider frequency range than spoken voice
calls. The system only supports fax across IP between systems with the Fax Transport option
selected.

SIP Calls:
» SIP Line Call to/from Non-IP Devices: Voice compression channel required.
* Outgoing SIP Line Call from IP Device: No voice compression channel required.

* Incoming SIP Line Call to IP Device: Voice compression channel reserved until call
connected.

T38 Fax Calls: The system supports T38 fax on SIP trunks and SIP extensions. Each T38 fax
call uses a VCM channel.

« Within a multi-site network, an T38 fax call can be converted to a call across across an H.323
line between systems using the Fax Transport Support protocol. This conversion uses 2
VCM channels.

* In order use T38 Fax connection, the Equipment Classification of an analog extension
connected to a fax machine can be set Fax Machine. Additionally, the short code feature
Dial Fax is available.

© Note:

T3 IP devices must be configured to 20ms packet size for the above conditions to apply. If left
configured for 10ms packet size, a voice compression channel is needed for all tones and for
non-direct media calls.

Measuring Channel Usability

The System Status Application can be used to display voice compression channel usage. Within
the Resources section it displays the number of channel in use. It also displays how often there
have been insufficient channels available and the last time such an event occurred.

Field Description
Echo Return Loss Default = 6dB. IP500 VCM, IP500 VCM V2 and IP500 Combination Cards. This
(dB) control allows adjustment of expected echo loss that should be used for the

echo cancellation process.

Echoes are typically generated by impedance mismatches when a signal is
converted from one circuit type to another, most notably from analog to IP. To
resolve this issue, an estimated echo signal can be created from one output and
then subtracted from the input to hopefully remove any echo of the output.

Table continues...
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Field Description
The options are:

- 0dB
+ 3dB
* 6dB

- 9dB

Nonlinear Processor | Default = Adaptive. |
Mode

A low level of comfort noise is required on digital lines during periods where
there would normally be just silence. This is necessary to reassure users that
the call is still connected. These controls allow adjustment of the comfort noise
generated by the nonlinear processor (NLP) component of the VCM. The
options are:

» Adaptive: Adaptive means the comfort noise generated by the NLP will try to
match background noise.

+ Silence: Silence means the NLP will not generate comfort noise at all

» Disabled: Nonlinear processing is not applied, in which case some residual
echo may be heard.

NLP Comfort Noise Default = -9dB.
Attenuation

The options are:
» -3dB
- -6dB
+ -9dB

NLP Comfort Noise Default =-30dB.
Ceiling

The options are:
+ -30dB
» -55dB

Modem

For Fax relay, these settings allow adjustment of the TDM side operation applied to fax calls using VCM

channels.
Tx Level (dB) Default = -9dB. Range = 0 to -13dB.
CD Threshold Default = -43dB, Options = -26dB, -31dB or -43dB.
No Activity Timeout Default = 30 seconds. Range = 10 to 600 seconds.
(secs)

Related links

System on page 182
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System

Integrated Contact Reporter

Navigation: System | Contact Center | Integrated Contact Reporter

Integrated Contact Reporter is a simple Contact Center application that involves five to twenty five
agents and up to five supervisors. The application collects and displays information on the current
status of hunt groups and users that have been configured for Integrated Contact Reporter
operation.

These settings are mergeable. Changes to these settings do not require a reboot of the system.

Field Description

Busy Not Available Reason Codes

Agents who indicate that they are in a 'busy not available' state can be prompt to also indicate the reason
for being in that state. This menu allows descriptions for the possible reasons to be entered. The
descriptions are then used in menus from which the Agent's make selections when setting themselves into
busy not available state and in reports on Agent status.

Code/Reason Rows 1 to 8 can be used to contain descriptions of up to 31 characters each.
Rows 0 and 9 are fixed as Unsupported and Busy Not Available.
Default After Call Default = 10. Range = 10 to 999 seconds.

Work Time (seconds) If an agent goes into the After Call Work (ACW) state, either automatically or

manually, this field sets the duration of that state after which it is automatically
cleared. This duration can be overridden by the Agent's own setting (User |
Telephony | Supervisor Settings | After Call Work Time). During ACW state, hunt
group calls are not presented to the user.

Related links
System on page 182

VolP

Navigation: System | VolP

This tab is used to set the codecs available for use with all IP (H.323 and SIP) lines and
extensions and the default order of codec preference.

» Avaya H.323 telephones do not support G.723 and will ignore it if selected.

» For systems with H.323 lines and extensions, one of the G.711 codecs must be selected and
used.

* G.723 and G.729b are not supported by Linux based systems.

* The number of channels provided by an IP500 VCM 32 or IP500 VCM 64 card, up to a
maximum of 32 or 64 respectively, depends on the actual codecs being used. This also
applies to IP500 VCM 32 V2 and IP500 VCM 64 V2 cards. The following table assumes that
all calls using the VCM use the same codec.
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Codec IP500 VCM 32 IP500 VCM 32 | IP500 VCM 64 IP500 VCM 64
V2 V2

G.711 32 64

G.729a 30 60

G.723 22 44

G.722 30 60

Paging from an IP device uses the preferred codec of that device. It is the system administrator's
responsibility to ensure all the target phones in the paging group support that codec.

These settings are not mergeable. Changes to these settings require a reboot of the system.

Field Description
Ignore DTMF Mismatch | Default = On.
For Phones

When set to On, the following settings are visible and configurable:
» Extension | H.323 Extension | VoIP | Requires DTMF
» Extension | SIP Extension | VoIP | Requires DTMF

When set to On, during media checks, the system ignores DTMF checks if the call is
between two VolP phones and the extension setting Requires DTMF is set to Off.
The two phones can be located on different systems in a Server Edition or SCN
deployment.

© Note:

Direct media may still not be possible if other settings, such as codecs, NAT
settings, or security settings, are mismatched.

Allow Direct Media
Within NAT Location

Default = Off.

When set to On, the system allows direct media between devices that reside behind
the same NAT. Devices are behind the same NAT if their public IP addresses are the
same.

° Note:

Direct media may still not be possible if other settings, such as codecs, NAT
settings, or security settings, are mismatched.

The default behavior is to allow direct media between all types of devices (H323 and
SIP remote workers and IP Office Lines behind a NAT). In the case of routers that
have H323 or SIP ALG, it can be desirable to allow direct media only between
certain categories of devices. This can be configured by adding the NoUser Source
Number MEDIA_NAT_DM_INTERNAL. For information, see User | Source
Numbers.

RFC2833 Default

Default = 101. Range = 96 - 127.

Payload This field specifies the default value for RFC2833 dynamic payload negotiation.
Service providers that do not support dynamic payload negotiation may require a
fixed value.

Table continues...
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System

Field

Description

Available Codecs

This list shows the codecs supported by the system and those selected as usable.
Those codecs selected in this list are then available for use in other codec lists
shown in the configuration settings. For example the adjacent Default Selection list
and the individual custom selection list on IP lines and extensions.

A Warning:
Removing a codec from this list automatically removes it from the codec lists of
any individual lines and extensions that are using it.

The supported codecs (in default preference order) are: G.711 A-Law, G.711 U-
Law, G.722, G.729 and G.723.1. The default order for G.711 codecs will vary to
match the system's default companding setting. G.723.1 and G.729b are not
supported on Linux based systems.

Default Codec

By default, all IP (H.323 and SIP) lines and extensions added to the system have

Selection their Codec Selection setting set to System Default. That setting matches the
codec selections made in this list. The buttons between the two lists can be used to
move codecs between the Unused and the Selected parts of the list and to change
the order of the codecs in the selected codecs list.

Related links

System on page 182

VoIP Security

Navigation: System | VoIP Security

Use to set system level media security settings. These settings apply to all lines and extensions
on which SRTP is supported and which have their Media Security settings configured to be Same
as System. Individual lines and extensions have media security settings that can override system

level settings.

Simultaneous SIP extensions that do not have physical extensions in the configuration use the
system security settings.

SM lines and all centralized user extensions must have uniform media security settings.

These settings are not mergeable. Changes to these settings require a reboot of the system.

Field

Description

Media Security

Default = Disabled.

Secure RTP (SRTP) can be used between IP devices to add additional security. These
settings control whether SRTP is used for this system and the settings used for the
SRTP. The options are:

» Same as System: Matches the system setting at System | VolP Security.

» Disabled: Media security is not required. All media sessions (audio, video, and data)
will be enforced to use RTP only.
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Field Description

* Preferred: Media security is preferred. Attempt to use secure media first and if
unsuccessful, fall back to non-secure media.

+ Enforced: Media security is required. All media sessions (audio, video, and data) will
be enforced to use SRTP only.
A Warning:

Selecting Enforced on a line or extension that does not support media security
will result in media setup failures.

If media security is enabled (Enforced or Preferred), it is recommended that you enable
a matching level of security using System | LAN | VoIP | H.323 Signalling over TLS.

Media Security Not displayed if Media Security is set to Disabled. The options are:

Options * Encryptions: Default = RTP This setting allows selection of which parts of a media

session should be protected using encryption. The default is to encrypt just the RTP
stream (the speech).

+ Authentication: Default = RTP and RTCP This setting allows selection of which parts
of the media session should be protected using authentication.

* Replay Protection SRTP Window Size: Default = 64. Currently not adjustable.

* Crypto Suites: Default = SRTP_AES CM_128 SHA1_80. There is also the option to
select SRTP_AES_CM_128_SHA1_32.

Strict SIPS (Enterprise Branch deployments) Default = Off.

This option provides a system-wide configuration for call restrictions based on SIPS URI.

When this option is off, calls are not rejected due to SIPS. A call is sent according to the
configuration of the outgoing trunk or line that it is routed to, regardless of the way the
call came in, even if the call came in as a SIP invite with SIPS URI and is being sent with
a SIP URI onto a non-secure SIP trunk.

When this option is on, an incoming SIP invite with SIPS URI if targeted to a SIP trunk
(SM line or SIP line) is rejected if the target trunk is not configured with SIPS in the URI
Type field.

Related links
System on page 182

Dialer

Navigation: System | Dialer
Use to configure the functions required for an Outbound Contact Express deployment.

These settings are mergeable. However, changes to the Operation field or to the Trunk Range /
IP Office table require a reboot.

It is recommended that you do not change the mergeable settings while the system is in use.
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System

Field

Description

Operation

Default = Off.

On the primary IP Office Server Edition server, set this field to Primary. For all other IP
Office servers, set this field to Child. When set to Off or Child, no other fields are
displayed.

Record Mode

Default = Off

Defines the automatic call recording function on VMPro. The options are:
* Whole Call: The entire call is recorded.

+ Agent Connected: Recording starts once the conversation begins.

« Off

Record Controls

: Default = Full Defines what functions an agent can perform from WebAgent or from the
handset. The options are:

* Full
* Pause
« Off

Record Mode
and Record
Controls

Record Mode and Record Controls are related. The combined configuration settings are
listed below.

Note that stopping and starting the recording creates multiple recording files. Pausing and
resuming the recording keeps the recording in a single file.

Record Mode Record Controls Result

Off Off Calls are not recorded.

Agent Connected Off All calls are always recorded
from the time the agent joins

the call.

Pause All calls are always recorded
but the Agent can pause and

resume recording.

Agent Connected

Full All calls are always recorded
from the time the Agent joins
the call. Agent has full
control on when calls get

recorded.

Agent Connected

Whole Call Off All calls are always recorded
from the time the customer

answers.

Whole Call Pause All calls are always recorded
from the time the customer
answers but the Agent can
pause and resume the

recording.
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Field

Description

Whole Call Full Call recording starts before
the agent is connected. All
calls are always recorded
but the Agent can pause and

resume the recording

Agent Call Back
Time

Default = 60. Range = 30 - 300.

The number of seconds an agent has to make a manual call after a customer hang up.
Used when a customer wants to be called on a different number.

Confirmation
Voice Prompt

Remote Agent Default = Blank. Maximum length = 33.

Display Text . . : L .
Specify the text string displayed on the remote agent extension if that extension supports
displays and the protocol allows it to be transmitted.

Remote Agent Default = Blank. Maximum length = 31.

Specify the Call Flow Entry point name used to play a greeting to the remote agent when
they log in. The actual Entry Point is added as a Modules Entry point using the VMPro
Client. The entry point cannot be added as a short code, user or group entry point.

Remote Agent Default = 0. The first extension number allocated to a remote agent. It must not conflict with
First Extension the existing dialing plan. If the range contains existing user extensions, they are used when
Number assigning extensions to remote users.
Remote Agent Default = 0. Maximum = 500.
Number of . . . .

. The range of extensions starting from the one above. A user is created for every extension.
Extensions

If the field is edited and the number of extensions is reduced, the number of remote agents
that can log in is reduced to the new setting. However, reducing the range does not
automatically delete previously created users. Users can only be deleted manually.

Use Custom Hold
Treatment

Default = unchecked. Defines system behavior when a call is placed on hold. When
unchecked the the system Hold Music setting is used for the system's music on hold
source. When checked, the music on hold source is VMPro.

Record while on
Hold

Default = unchecked. When the Use Custom Hold Treatment box is checked, the Record
while on Hold setting can be enabled. When unchecked, recording is paused when the
call is on hold. When checked, recording continues when the call is on hold.

Trunk Range / IP
Office

The number of trunks used by Outbound Contact Express. The default entry is Trunk
Range: 1-250 for the Primary (Local) server. 250 is the maximum number of trunks
configured on a single server. Use this table to define the number of trunks managed by
the Primary and Secondary systems. The trunk range must match the line numbers used
by the Proactive Contact Dialer. Enter only one range per server.

Related links

System on page 182

Contact Center

Navigation: System | Contact Center
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The Contact Center tab contains the user information required by IP Office to synchronize account
information with an an Avaya Contact Center Select (ACCS) system. The information is
synchronized using the Contact Center Management Application (CCMA). These settings are only
used for the deployment of an ACCS system.

This tab is visible on the Server Edition Primary Server and Standard Mode IP500 V2 systems.

These settings are mergeable. Changes to these settings do not require a reboot of the system.

Field Description
Contact Center Default = None.
Application

The options are:
» Avaya Contact Center Select
» Avaya IP Office Contact Center

* Integrated Contact Reporter

Synchronize to
this System

Default = Off.
When set to On, the CCMA fields below are enabled.

CCMA Address

Default = Blank

Address of the Contact Center Management Application system.

CCMA Username

Default = Blank

User name on the Contact Center Management Application system.

CCMA Password

Default = Blank

Password on the Contact Center Management Application system.

Default After Call

Applicable for Integrated Contact Reporter

UL T Default = 10 seconds, Minimum = 10 seconds, Maximum = 999 seconds
The default time set for After Call Work (ACW). If configured, ACW begins at the end of a
call. Hunt group calls are not sent to the agent during ACW.

Busy Not Applicable for Integrated Contact Reporter

Available Reason
Codes

Default = 2 codes
Maximum = 9 codes

The reasons for 0 and 9 are assigned by default and cannot be modified. You can
configure the rest.

Use the configure icon to add Busy Not Available reasons and assign them to the
available codes.

Related links

System on page 182
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Line

The line settings shown in the system configuration will change according to the types of trunk
cards installed in the control unit or added using external expansion modules.

A Warning:

Changing Trunk Cards Changing the trunk card installed in an control unit will result in line
settings for both the previous trunk card and the currently installed trunk card. In order to
change the trunk card type in a particular card slot, the configuration must be defaulted. This
does not apply if replacing an existing card with one of a higher capacity or fitting a trunk card
into a previously unused slot.

Trunk Incoming Call Routing

Each trunk type can be categorized as either an external trunk or internal trunk. The trunk type
affects how the system routes calls received on that trunk and the routing of calls to the trunk.

External Trunks

Internal Trunks

Trunk Types

Analog trunks

T1 Robbed Bit

E1R2

ISDN BRI (excluding So)
ISDN PRI T1

ISDN PRI E1

SIP

QSIG (T1, E1 or H.323)
BRI So

H.323

SCN

SES

IP Office Line

Incoming Calls Routed by

All incoming calls are routed by
comparison of call details for
matches within the system
Incoming Call Routes.

Line short codes are not used.

Incoming calls are routed by
looking for a match to the
incoming digits in the following
order:

» Extension number.

* Trunk short codes (excluding ?

short code).

» System short codes
(excluding ? short code).

* Trunk ? short code.

» System ? short code.

Line Groups

Each system trunk (or in some cases individual trunk channels) can be configured with an
Incoming Group ID and an Outgoing Group ID. These group IDs are used as follows:

* Incoming Call Routes For incoming calls on external trunks, the Incoming Group ID of the
trunk is one of the factors used to match the call to one of the configured incoming call

routes.
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» Short Codes - Routing Outgoing Calls For dialing which matches a short code set to a Dial
feature, the short codes Line Group ID can indicate either an ARS form or to use a trunk
from set to the same Outgoing Group ID. If the call is routed to an ARS form, the short
codes in the ARS form will specify the trunks to use by matching Outgoing Group ID.

Removing Unused Trunks

In cases where a trunk card is installed but the trunk is not physically connected, it is important to
ensure that the trunk is disabled in the configuration. This can be done on most trunks using by
setting the line's Admin setting to Out of Service.

This is especially important with analog trunks. Failure to do this may cause the system to attempt
to present outgoing calls to that trunk. Similarly, where the number of channels subscribed is less
than those supportable by the trunk type, the unsubscribed channels should be disabled.

Clock Quality

Calls between systems using digital trunks (for example E1, E1R2, T1 PRI and BRI) require an
common clock signal. The system will try to obtain this clock signal from an exchange through one
of its digital trunks. This is done by setting the Clock Quality setting of that Line to Network. If there
are multiple trunks to public exchanges, another trunk can be set as Fallback should the primary
clock signal fail. Other trunks should be set as Unsuitable.
Related links
Configuration Mode Field Descriptions on page 176
Analog Line on page 251
BRI Line on page 259
PRI Trunks on page 264
S0 Line on page 293
H.323 Line on page 296
IP DECT Line on page 301
SIP Line on page 306
SIP DECT Line on page 330
SM Line on page 333
IP Office Line on page 341

Analog Line

Analog trunks can be provided within the systems in the following ways. In all cases the physical
ports are labeled as Analog. For full details of installation refer to the IP Office Installation manual.

Using ICLID: The system can route incoming calls using the ICLID received with the call.
However ICLID is not sent instantaneously. On analog trunks set to Loop Start ICLID, there will be
a short delay while the system waits for any ICLID digits before it can determine where to present
the call.

Line Status: Analog line do not indicate call status other than whether the line is free or in use.
Some system features, for example retrieving unanswered forwards and making twinned calls
make use of the call status indicated by digital lines. This is not possible with analog lines. Once
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an analog line has been seized, the system has to assume that the call is connected and treats it
as having been answered.

Dialing Complete: The majority of North-American telephony services use en-bloc dialing.
Therefore the use of a ; is recommended at the end of all dialing short codes that use an N. This is
also recommended for all dialing where secondary dial tone short codes are being used.

Ground Start: This type of analog trunk is only supported through the Analog Trunk external
expansion module.

Related links
Line on page 250

Line Settings on page 252
Analog Options on page 253

Line Settings
Navigation: Line | Analog Line | Line Settings
Configuration Settings

These settings are mergeable with the exception of the Network Type setting. Changes to this
setting will require a reboot of the system.

Field Description
Line Number This parameter is not configurable, it is allocated by the system.
Card/Module Indicates the card slot or expansion module being used for the trunk device

providing the line. For IP500 V2 control units: 1 to 4 match the slots on the

front of the control unit from left to right. Expansion modules are numbered
from 5 upwards, for example trunks on the module in Expansion Port 1 are
shown as 5.

Port Indicates the port on the Card/Module above to which the configuration
settings relate.

Network Type Default = Public.

This option is available if System | Telephony | Telephony | Restrict
Network Interconnect is enabled. It allows the trunk to be set as either
Public or Private. The system will return number busy indication to any
attempt to connect a call on a Private trunk to a Public trunk or vice versa.
This restriction includes transfers, forwarding and conference calls.

Due to the nature of this feature, its use is not recommended on systems also
using any of the following other system features: multi-site networks,
VPNremote, application telecommuter mode.

Telephone Number Used to remember the external telephone number of this line to assist with
loop-back testing. For information only.

Incoming Group ID Default = 0, Range 0 to 99999. The Incoming Group ID to which a line belongs
is used to match it to incoming call routes in the system configuration. The
matching incoming call route is then used to route incoming calls. The same ID
can be used for multiple lines.
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Field

Description

Outgoing Group ID

Default = 1. Range 0 to 99999.

Short codes that specify a number to dial also specify the line group to be
used. The system will then seize a line with a matching Outgoing Group ID.

In a Server Edition network, the Outgoing Group ID used on a system must
also be unique within the network. The same ID cannot be used in the
configuration of any lines on another server system in the network. For
Standard Edition deployments, the same ID can be used for multiple lines.

Reserved Group ID Numbers:
» 90000 - 99999 Reserved for system use (not enforced).

* 99999 and 99998 In a Server Edition network, reserved for the IP Office
lines to the Primary Server and Secondary Server respectively.

* 99901 to 99930 In a Server Edition network, reserved for the IP Office lines
from the Primary Server to each expansion system in the network.

* 0 In a Server Edition network, the ID 0 cannot be used.

» 98888 For IP Office deployed in an Enterprise Branch environment, reserved
for the SM line.

Outgoing Channels

Default = 1 (not changeable)

Voice Channels

Default = 1 (not changeable)

Prefix

Default = Blank

Enter the number to prefix to all incoming numbers for callback. This is useful if
all users must dial a prefix to access an outside line. The prefix is automatically
placed in front of all incoming numbers so that users can dial the number back.

For outgoing calls: The system does not strip the prefix, therefore any prefixes
not suitable for external line presentation should be stripped using short codes.

Line Appearance ID

Default = Auto-assigned. Range = 2 to 9 digits. Allows a number to be
assigned to the line to identify it. On phones that support call appearance
buttons, a Line Appearance button with the same number will show the status
of the line and can be used to answer calls on the line. The line appearance ID
must be unique and not match any extension number.

Admin Default = In Service.
This field allows a trunk to be taken out of service if required for maintenance
or if the trunk is not connected.
Related links

Analog Line on page 251

Analog Options

Navigation: Line | Analog Line | Analog Options

Covers analog line specific settings. The system wide setting System | Telephony | Tones &
Music | CLI Type is used for to set the incoming CLI detection method for all analogue trunks.
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The Allow Analog Trunk to Trunk Connect setting is mergeable. The remaining settings are not
mergeable. Changes to these settings will require a reboot of the system.

Field Description
Channel Set by the system. Shown for information only.
Trunk Type Default = Loop Start

Sets the analog line type. The options are:

* Ground Start: Ground Start is only supported on trunks provided by the Analog
Trunk 16 expansion module. It requires that the module and the control unit are
grounded. Refer to the IP Office installation manual.

* Loop Start

* Loop Start ICLID: As the system can use ICLID to route incoming calls, on
analog Loop Start ICLID trunks there is a few seconds delay while ICLID is
received before the call routing can be determined.

Signaling Type

Default = DTMF Dialing
Sets the signaling method used on the line. The options are:
+ DTMF Dialing

* Pulse Dialing

Direction

Default = Both Directions

Sets the allowed direction of operation of the line. The options are:
* Incoming

» Outgoing

* Both Directions

Flash Pulse Width

Default = 0. Range = 0 to 2550ms.

Set the time interval for the flash pulse width.

Await Dial Tone

Default = 0. Range = 0 to 25500ms.

Sets how long the system should wait before dialing out.

Echo Cancellation

Default = 16ms.

The echo cancellation should only be adjusted as high as required to remove echo
problems. Setting it to a higher value than necessary can cause other distortions.
Not used with external expansion module trunks. The options are (milliseconds):

. Off
-8
. 16
. 32
. 64
. 128
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Line

Field

Description

Echo Reduction

Default = On. (ATM4Uv2 card only)

Used when impedance matching is not required but echo reduction is.

Mains Hum Filter

Default = Off.

If mains hum interference on the lines is detected or suspected, this settings can be
used to attempt to remove that interference. Useable with ATM16 trunks and IP500
ATMA4U trunks. The options are:

« Off
* 50Hz
* 60Hz

Impedance Set the impedance used for the line. This field is only available for system locales
where the default value can be changed.
The value used for Default is set by the setting System | System | Locale. For
information, see Avaya IP Office™ Platform Locale Settings.
The following values are used for Automatic Impedance Matching: 600+2150nF,
600, 900+2150nF, 900, 220+820||115nF, 370+620||310nF, 270+750||150nF,
320+1050||230nF, 350+1000]|210nF, 800+100(|210nF.

Quiet Line This field is only available for certain system locales (see above). The setting may

be required to compensate for signal loss on long lines.

Digits to break dial tone

Default = 2. Range = Up to 3 digits.

During automatic impedance testing (see below), once the system has seized a
line, it dials this digit or digits to the line. In some cases it may be necessary to use
a different digit or digits. For example, if analog trunk go via another PBX system or
Centrex, it will be necessary to use the external trunk dialing prefix of the remote
system plus another digit, for example 92.

Automatic

Default = Yes. (ATM4Uv2 card only)

When set to Yes, the Default value is used. The value used for Default is set by the
system Locale.

When set to No, the Impedance value can be manually selected from the list of
possible values:

600
900 270+(750R || 150nF) and 275R + (780R || 150nF)
220+(820R || 120nF) and 220R+ (82R || 115nF)
370+(620R || 310nF)

320+(1050R || 230nF)

370+(820R || 110nF)

275+(780R || 115nF)

120+(820R || 110nF)
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Field

Description

350+(1000R || 210nF)
200+(680R || 100nF)
600+2.16uF

900+1pF

900+2.16uF

600+1uF Global Impedance

Automatic Balance
Impedance Match

These controls can be used to test the impedance of a line and to then display the
best match resulting from the test. Testing should be performed with the line
connected but the system otherwise idle. To start testing click Start. The system will
then send a series of signals to the line and monitor the response, repeating this at
each possible impedance setting. Testing can be stopped at any time by clicking
Stop. When testing is complete, Manager will display the best match and ask
whether that match should be used for the line. If Yes is selected, Manager will also
ask whether the match should be applied to all other analog lines provided by the
same analog trunk card or module.

Note that on the Analog Trunk Module (ATM16), there are four control devices, each
supporting four channels. The impedance is set by the control device for all four
channels under its control. Consequently, the impedance match tool only functions
onlines 1, 5,9, and 13.

Before testing, ensure that the following system settings are correctly set:
» System | System | Locale
» System | Telephony | Telephony | Companding Law

If either needs to be changed, make the required change and save the setting to the
system before proceeding with impedance matching.

Due to hardware differences, the impedance matching result will vary slightly
depending on which type of trunk card or expansion module is being used.

Automatic Balance Impedance Matching, Quiet Line and Digits to break dial
tone are available for the Bahrain, Egypt, French Canadian, India, Kuwait, Morocco,
Oman, Pakistan, Qatar, Saudi Arabia, South Africa, Turkey, United Arab Emirates,
United States and Customize locales.

Allow Analog Trunk to
Trunk Connect

Default = Not selected (Off). When not enabled, users cannot transfer or forward
external calls back off-switch using an analog trunk if the call was originally made or
received on another analog trunk. This prevents transfers to trunks that do not
support disconnect clear.

If the setting System | Telephony | Telephony | Unsupervised Analog Trunk
Disconnect Handling is enabled, this setting is greyed out and trunk to trunk
connections to any analog trunks are not allowed.

BCC Default = Not selected [Brazil locale only]
A collect call is a call at the receiver's expense and by his permission. If supported
by the line provider, BCC (Block Collect Call) can be used to bar collect calls.
Table continues. ..
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Line

Field

Description

Secondary Dial Tone

Default = Off

Configures the use of secondary dial tone on analog lines. This is a different
mechanism from secondary dial tone using short codes. This method is used mainly
within the Russian locale. When selected, the options are:

» Await time: Default = 3000ms. Range = 0 to 25500ms. Used when secondary
dial tone (above) is selected. Sets the delay.

+ After n Digits: Default = 1. Range = 0 to 10. Sets where in the dialing string, the
delay for secondary dial tone, should occur.

* Matching Digit: Default =8. Range = 0 to 9. The digit which, when first matched
in the dialing string, will cause secondary dial tone delay.

Long CLI Line

Default = Off

The CLI signal on some analog lines can become degraded and is not then
correctly detected. If you are sure that CLI is being provided but not detected,
selecting this option may resolve the problem.

Modem Enabled

Default = Off

The first analog trunk in a control unit can be set to modem operation (V32 with V42
error correction). This allows the trunk to answer incoming modem calls and be
used for system maintenance. When on, the trunk can only be used for analog
modem calls. The default system short code *9000* can be used to toggle this
setting.

For the IP500 ATM4U-V2 Trunk Card Modem, it is not required to switch the card's
modem port on/off. The trunk card's V32 modem function can be accessed simply
by routing a modem call to the RAS service's extension number. The modem call
does not have to use the first analog trunk, instead the port remains available for
voice calls.

MWI Standard

Default = None.
This setting is only displayed for ATM4U-V2 cards.

When System | Voicemail | Voicemail Type is set to Analogue MWI, change this
setting to Bellcore FSKBellcore FSK.

Pulse Dialing

These settings are used for pulse dialing.

» Mark: Default = 40ms. Range = 0 to 255. Interval when DTMF signal is kept
active during transmission of DTMF signals.

» Space: Default = 60ms. Range = 0 to 255. Interval of silence between DTMF
signal transmissions.

* Inter-Digit Pause: Default = 500ms. Range = 0 to 2550ms. Sets the pause
between digits transmitted to the line.

Ring Detection

These settings are used for ring detection.

* Ring Persistency: Default = Set according to system locale. Range = 0 to
2550ms. The minimum duration of signal required to be recognized.
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Field Description

» Ring Off Maximum: Default = Set according to system locale. Range = 0 to
25500ms. The time required before signaling is regarded as ended.

Disconnect Clear Disconnect clear (also known as 'Line Break' or 'Reliable Disconnect') is a method
used to signal from the line provider that the call has cleared. The system also uses
"Tone Disconnect', which clears an analog call after 6 seconds of continuous tone,
configured through the Busy Tone Detection (System | Telephony | Tones &
Music) settings.

« Enable: Default = On Enables the use of disconnect clear.

* Units: Default = 500ms. Range = 0 to 2550ms. This time must be less than the
actual disconnect time period used by the line provider by at least 150ms.

If the setting System | Telephony | Telephony | Unsupervised Analog Trunk
Disconnect Handling is enabled, this setting is greyed out and disconnect clear
disabled.

DTMF These settings are used for DTMF dialing.

» On: Default = 80ms. Range = 0 to 255ms. The width of the on pulses generated
during DTMF dialing.

» Off: Default = 80ms. Range = 0 to 255ms. The width of the off pulses generated
during DTMF dialing.
BCC Flash Pulse Width | [Brazil locale only] Default = 100 (1000ms). Range = 0 to 255.

Sets the BCC (Block collect call) flash pulse width.

Gains These settings are used to adjust the perceived volume on all calls.

* A | D: Default = 0dB. Range =-10.0dB to +6.0dB in 0.5dB steps. Sets the analog
to digital gain applied to the signal received from the trunk by the system. To
conform with the Receive Objective Loudness Rating at distances greater than
2.7km from the central office, on analog trunks a receive gain of 1.5dB must be
set.

* D | A: Default = 0dB. Range =-10.0dB to +6.0dB in 0.5dB steps. Sets the digital to
analog gain applied to the signal from the system to the trunk.

» Voice Recording: Default = Low Used to adjust the volume level of calls recorded
by voicemail. The ptions are:

- Low
- Medium
- High

Related links
Analog Line on page 251
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Line

BRI Line

BRI trunks are provided by the installation of a BRI trunk card into the control unit. The cards are
available in different variants with either 2 or 4 physical ports. Each port supports 2 B-channels for
calls. For full details of installation refer to the IP Office Installation manual.

Point-to-Point or Multipoint

BRI lines can be used in either Point-to-Point or Point-to-Multipoint mode. Point-to-Point lines are
used when only one device terminates a line in a customer's office. Point-to-Multipoint lines are
used when more than one device may be used on the line at the customer's premises. There are
major benefits in using Point-to-Point lines:-

* The exchange knows when the line/terminal equipment is down/dead, thus it will not offer
calls down that line. If the lines are Point-to-Multipoint, calls are always offered down the line
and fail if there is no response from the terminal equipment. So if you have two Point-to-
Multipoint lines and one is faulty 50% of incoming calls fail.

* You get a green LED on the Control Unit when the line is connected. With Point-to-Multipoint
lines some exchanges will drop layer 1/2 signals when the line is idle for a period.

» The timing clock is locked to the exchange. If layer 1/2 signals disappear on a line then the
Control Unit will switch to another line, however this may result in some audible click when
the switchover occurs.

The system's default Terminal Equipment Identifier (TEI) will normally allow it to work on Point-to-
Point or Point-to-Multipoint lines. However if you intend to connect multiple devices simultaneously
to an BRI line, then the TEI should be set to 127. With a TEI of 127, the control unit will ask the
exchange to allocate a TEI for operation.

© Note:

When connected to some manufactures equipment, which provides an SO interface (BRI), a
defaulted Control Unit will not bring up the ISDN line. Configuring the Control Unit to a TEI of
127 for that line will usually resolve this.

Related links
Line on page 250
BRI Line on page 259
Channels on page 264

BRI Line
Navigation: Line | BRI Line

The following settings are not mergeable. Changes to these settings will require a reboot of the
system.

* Line Sub Type
* Network Type
» TEI
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+ Add 'Not-end-to-end ISDN' Information Element
* Progress Replacement

» Clock Quality

* Force Number Plan to ISDN

Decreasing the Number of Channels setting requires a a “merge with service disruption”. When
the configuration file is sent to the system, active calls on the deleted channels are cleared.

The remaining settings are mergeable.

Field

Description

Card/Module

Indicates the card slot or expansion module being used for the trunk device
providing the line.

For IP500 V2 control units: 1 to 4 match the slots on the front of the control unit
from left to right. Expansion modules are numbered from 5 upwards, for example
trunks on the module in Expansion Port 1 are shown as 5.

Port

Indicates the port on the Card/Module above to which the configuration settings
relate.

Line Number

This parameter is not configurable; it is allocated by the system.

Admin

Default = In Service.

This field allows a trunk to be taken out of service if required for maintenance or if
the trunk is not connected.

Line Sub Type

Default = NTT for Japan/ETSI for other locales.

Select to match the particular line type provided by the line provider. IP500 BRI
daughter cards can be configured for S-Bus (So) operation for connection to ISDN
terminal devices. Note that this requires the addition of terminating resistors at both
the system and remote ends, and the use of a suitable cross-over cable. For full
details refer to the Deploying Avaya IP Office Platform IP500 V2 manual.

Network Type

Default = Public.

This option is available if System | Telephony | Telephony | Restrict Network
Interconnect is enabled. It allows the trunk to be set as either Public or Private.
The system will return number busy indication to any attempt to connect a call on a
Private trunk to a Public trunk or vice versa. This restriction includes transfers,
forwarding and conference calls.

Due to the nature of this feature, its use is not recommended on systems also
using any of the following other system features: multi-site networks, VPNremote,
application telecommuter mode.

Telephone Number

Used to remember the external telephone number of this line to assist with loop-
back testing. For information only.

Incoming Group ID

Default = 0, Range 0 to 99999.

The Incoming Group ID to which a line belongs is used to match it to incoming call
routes in the system configuration. The matching incoming call route is then used
to route incoming calls. The same ID can be used for multiple lines.
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Line

Field

Description

Outgoing Group ID

Default = 1. Range 0 to 99999.

Short codes that specify a number to dial also specify the line group to be used.
The system will then seize a line with a matching Outgoing Group ID.

In a Server Edition network, the Outgoing Group ID used on a system must also
be unique within the network. The same ID cannot be used in the configuration of
any lines on another server system in the network. For Standard Edition
deployments, the same ID can be used for multiple lines.

Reserved Group ID Numbers:
» 90000 - 99999 Reserved for system use (not enforced).

99999 and 99998 In a Server Edition network, reserved for the IP Office lines to
the Primary Server and Secondary Server respectively.

99901 to 99930 In a Server Edition network, reserved for the IP Office lines from
the Primary Server to each expansion system in the network.

* 0 In a Server Edition network, the ID 0 cannot be used.

98888 For IP Office deployed in an Enterprise Branch environment, reserved for
the SM line.

Prefix

Default = Blank. The prefix is used in the following ways:

* For incoming calls: The ISDN messaging tags indicates the call type (National,
International or Unknown). If the call type is unknown, then the number in the
Prefix field is added to the ICLID.

* For outgoing calls: The prefix is not stripped, therefore any prefixes not suitable
for external line presentation should be stripped using short codes.

National Prefix

Default =0

This indicates the digits to be prefixed to a incoming national call. When a number
is presented from ISDN as a "national number" this prefix is added. For example
1923000000 is converted to 01923000000.

International Prefix

Default = 00

This indicates the digits to be prefixed to an incoming international call. When a
number is presented from ISDN as an "international number" this prefix is added.
For example 441923000000 is converted to 00441923000000.

TEI

Default = 0 The Terminal Equipment Identifier. Used to identify each device
connected to a particular ISDN line. For Point-to-Point lines this is 0. It can also be
0 on a Point to Multipoint line, however if multiple devices are sharing a Point-to-
Multipoint line it should be set to 127 which results in the exchange allocating the
TEl's to be used.

Number of Channels

Default = 2. Range = 0 to 2.

Defines the number of operational channels that are available on this line.

Outgoing Channels

Default = 2. Range = 0 to 2.
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Field

Description

This defines the number of channels available, on this line, for outgoing calls. This
should normally be the same as Number of Channels field, but can be reduced to
ensure incoming calls cannot be blocked by outgoing calls.

Voice Channels

Default = 2. Range = 0 to 2.

The number of channels available for voice use.

Data Channels

Default = 2. Range = 0 to 2.

The number of channels available for data use. If left blank, the value is 0.

Clock Quality

Default = Network

Refer to the IP Office Installation Manual for full details. This option sets whether
the system should try to take its clock source for call synchronization and signalling
from this line. Preference should always be given to using the clock source from a
central office exchange if available by setting at least one exchange line to
Network.

« If multiple lines are set as Network, the order in which those lines are used is
described in the IP Office Installation Manual. If additional lines are available,
Fallback can be used to specify a clock source to use should the Network
source not be available.

« Lines from which the clock source should not be taken should be set as
Unsuitable.

* If no clock source is available, the system uses its own internal 8KHz clock
source.

* In scenarios where several systems are network via digital trunk lines, care must
be taken to ensure that all the systems use the same clock source. The current
source being used by a system is reported within the System Status Application.

Add 'Not-end-to-end
ISDN' Information
Element

Default = Never*. Sets whether the optional 'Not end-to-end ISDN' information
element should be added to outgoing calls on the line. The options are Never,
Always or POTS (only if the call was originated by an analog extension). *The
default is Never except for the following locales; for Italy the default is POTS, for
New Zealand the default is Always.

Progress Replacement

Default = None.

Progress messages are defined in the Q.931 ISDN connection control signaling
protocol. Generally, If a progress message is sent, the caller does not get
connected and so typically does not accrue call costs.

Not all ISDN lines support Q.931 Progress messages. Use this setting to configure
alternative signaling to the ISDN line for internally generated Progress messages.
The options are:

 Alerting: Map to Q.931 Alerting. The call is not connected. The caller does not
hear the message and typically does not accrue call costs.

» Connect: Map to Q.931 Connect. The caller hears the message and typically will
accrue call costs.
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Line

Field Description
Supports Partial Default = Off.
Rerouting

Partial rerouting (PR) is an ISDN feature. It is supported on external (non-network
and QSIG) ISDN exchange calls. When an external call is transferred to another
external number, the transfer is performed by the ISDN exchange and the channels
to the system are freed. Use of this service may need to be requested from the line
provider and may incur a charge.

Force Number Plan to
ISDN

Default = Off.

This option is only configurable when Support Partial Rerouting is also enabled.
When selected, the plan/type parameter for Partial Rerouting is changed from
Unknown/Unknown to ISDN/Unknown.

Send Redirecting
Number

Default = Off.

This option can be used on ISDN trunks where the redirecting service is supported
by the trunk provider. Where supported, on twinned calls the caller ID of the original
call is passed through to the twinning destination. This option is only used for
twinned calls.

Support Call Tracing

Default = Off. The system supports the triggering of malicious caller ID (MCID)
tracing at the ISDN exchange. Use of this feature requires liaison with the ISDN
service provider and the appropriate legal authorities to whom the call trace will be
passed. The user will also need to be enabled for call tracing and be provider with
either a short code or programmable button to activate MCID call trace. Refer to
Malicious Call Tracing in the Telephone Features section for full details.

Active CCBS Support

Default = Off.

Call completion to a busy subscriber (CCBS). It allows automatic callback to be
used on outgoing ISDN calls when the destination is busy. This feature can only be
used on point-to-point trunks. Use of this service may need to be requested from
the line provider and may incur a charge.

Passive CCBS

Default = Off.

Cost Per Charging Unit

The information is provided in the form of charge units. This setting is used to enter
the call cost per charging unit set by the line provider. The values are 1/10,000th of
a currency unit. For example if the call cost per unit is £1.07, a value of 10700
should be set on the line. Refer to Advice of Charge.

Send original calling
party for forwarded and
twinning calls

Default = Off.
Use the original calling party ID when forwarding calls or routing twinned calls.

This setting applies to BRI lines with subtype ETSI.

Originator number for
forwarded and twinning
calls

Default = blank.

The number used as the calling party ID when forwarding calls or routing twinned
calls. This field is grayed out when the Send original calling party for forwarded
and twinning calls setting is enabled.

This setting applies to BRI lines with subtype ETSI.

Related links

BRI Line on page 259
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Channels

Navigation: Line | BRI Line | Channels

This tab allows settings for individual channels within the trunk to be adjusted. To edit a channel
either double-click on it or click the channel and then select Edit.

To edit multiple channels at the same time, select the required channels using Ctrl or Shift and
then click Edit. When editing multiple channels, fields that must be unique such as Line
Appearance ID are not shown.

These settings are mergeable. Changes to these settings do not require a system reboot.

Field Description
Line Appearance | Default = Auto-assigned. Range = 2 to 9 digits.
ID Used for configuring Line Appearances with button programming. The line appearance ID
must be unique and not match any extension number. Line appearance is not supported
for trunks set to QSIG operation and is not recommended for trunks be used for DID.
Related links
BRI Line on page 259
PRI Trunks
PRI trunks are provided by the installation of a PRI trunk card into the control unit. avThe IP500
PRI-U trunk card can be configured (see below) to one of those line types. The cards are also
available with either 1 or 2 physical ports. The number of B-channels supported by each physical
port depends on the line type of the card.
* E1: 30 B-channels and 1 D-channel per port.
* T1: 24 B-channels per port.
* US PRI: 23 B-channels and 1 D-channel per port.
* E1-R2: 30 B-channels and 1 D-channel per port.
IP500 PRI-U Trunk Card Line Type
The IP500 PRI-U card can be configured to support either E1, T1 or E1-R2 PRI line types. To
select the line type required, right-click on the line in the group or navigation pane and select
Change Universal PRI Card Line Type.
The control unit supports 8 B-channels on each IP500 PRI-U card fitted. Additional B-channels up
to the full capacity of IP500 PRI-U ports installed require licenses added to the configuration. D-
channels are not affected by licensing.
For ETSI and QSIG trunks, license instances are consumed by the number of calls in progress on
B-channels.
For T1, E1R2 and ETSI CHI trunks, licenses instances are consumed by the channels set as in
service.
Related links
Line on page 250
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Line

E1 Line on page 265
E1 R2 Line on page 273
T1 Line on page 278
T1 PRI Line on page 284

E1 Line
Related links
PRI Trunks on page 264
E1 PRI Line on page 265
E1 Short Codes on page 271
E1 PRI Channels on page 271

E1 PRI Line

Navigation: Line | E1 PRI Line

The following settings are not mergeable. Changes to these settings require a system reboot.
* Line Sub Type
* Network Type
» TEI
* Channel Allocation
* CRC Checking
» Clock Quality
+ Add 'Not-end-to-end ISDN' Information Element
* Progress Replacement
* Force Number Plan to ISDN
* Line Signalling

Decreasing the Number of Channels setting requires a a “merge with service disruption”. When
the configuration file is sent to the system, active calls on the deleted channels are cleared.

The remaining settings are mergeable.

Field Description
Line Number This parameter is not configurable; it is allocated by the system.
Line Sub Type Select to match the particular line type provided by the line provider. The options are:
« ETSI
« ETSI CHI
* QSIGA
*+ QSIGB
Table continues...
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Field

Description

ETSI CHI is used to send the channel allocation ID (CHI) in the call setup signalling.
This is a request to use a particular B-channel rather than use any B-channel
allocated by the central office exchange.

QSIG trunks trunks are not supported on IP500 V2 systems without IP500 Voice
Networking licenses.

Card/Module

Indicates the card slot or expansion module being used for the trunk device providing
the line.

For IP500 V2 control units: 1 to 4 match the slots on the front of the control unit from
left to right. Expansion modules are numbered from 5 upwards, for example trunks
on the module in Expansion Port 1 are shown as 5.

Port Indicates the port on the Card/Module above to which the configuration settings
relate.
Network Type Default = Public.

This option is available if System | Telephony | Telephony | Restrict Network
Interconnect is enabled. It allows the trunk to be set as either Public or Private.
The system will return number busy indication to any attempt to connect a call on a
Private trunk to a Public trunk or vice versa. This restriction includes transfers,
forwarding and conference calls.

Due to the nature of this feature, its use is not recommended on systems also using
any of the following other system features: multi-site networks, VPNremote,
application telecommuter mode.

Telephone Number

Used to remember the external telephone number of this line to assist with loop-back
testing. For information only.

Channel Allocation

Default = 30|1.

For lines set to ETSI CHI, this option allows the system to select the default order in
which channels should be used for outgoing calls. Typically this is set as the opposite
of the default order in which the central office exchange uses channels for incoming
calls.

For lines set to the Line Sub Type of ETSI CHI, the Incoming Group ID is set as
part of the individual channel settings.

Incoming Group ID

Default = 0, Range 0 to 99999.

The Incoming Group ID to which a line belongs is used to match it to incoming call
routes in the system configuration. The matching incoming call route is then used to
route incoming calls. The same ID can be used for multiple lines.

Outgoing Group ID

Default = 1. Range 0 to 99999.

Short codes that specify a number to dial also specify the line group to be used. The
system will then seize a line with a matching Outgoing Group ID.

In a Server Edition network, the Outgoing Group ID used on a system must also be
unique within the network. The same ID cannot be used in the configuration of any
lines on another server system in the network. For Standard Edition deployments,
the same ID can be used for multiple lines.
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Line

Field

Description

Reserved Group ID Numbers:
* 90000 - 99999 Reserved for system use (not enforced).

99999 and 99998 In a Server Edition network, reserved for the IP Office lines to
the Primary Server and Secondary Server respectively.

99901 to 99930 In a Server Edition network, reserved for the IP Office lines from
the Primary Server to each expansion system in the network.

0 In a Server Edition network, the ID 0 cannot be used.

98888 For IP Office deployed in an Enterprise Branch environment, reserved for
the SM line.

Prefix

Default = Blank.
The prefix is used in the following ways:

» For incoming calls The ISDN messaging tags indicates the call type (National,
International or Unknown). If the call type is unknown, then the number in the
Prefix field is added to the ICLID.

* For outgoing calls The prefix is not stripped, therefore any prefixes not suitable
for external line presentation should be stripped using short codes.

National Prefix

Default =0

This indicates the digits to be prefixed to a incoming national call. When a number is
presented from ISDN as a "national number" this prefix is added. For example
1923000000 is converted to 01923000000.

International Prefix

Default = 00

This indicates the digits to be prefixed to an incoming international call. When a
number is presented from ISDN as an "international number" this prefix is added. For
example 441923000000 is converted to 00441923000000.

TEI

Default =0 The

Terminal Equipment Identifier. Used to identify each Control Unit connected to a
particular ISDN line. For Point to Point lines this is typically (always) 0. It can also be
0 on a Point to Multi-Point line, however if multiple devices are sharing a Point to
Multi-Point line it should be set to 127 which results in the exchange deciding on the
TEl's to be used.

Number of Channels

Defines the number of operational channels that are available on this line. Up to 30
for E1 PRI, 23 for T1 PRI.

Outgoing Channels

This defines the number of channels available, on this line, for outgoing calls. This
should normally be the same as Number of Channels field, but can be reduced to
ensure incoming calls cannot be blocked by outgoing calls. Only available when the
Line Sub Type is set to ETSI.

Voice Channels

The number of channels available for voice use. Only available when the Line Sub
Type is set to ETSI.

Data Channels

The number of channels available for data use. Only available when the Line Sub
Type is set to ETSI.
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Field

Description

CRC Checking

Default = On
Switches CRC on or off.

Line Signalling

Default = CPE This option is not used for lines where the Line SubType is set to
QSIG. Select either CPE (customer premises equipment) or CO (central office). The
CO feature is intended to be used primarily as a testing aid. It allows PRI lines to be
tested in a back-to-back configuration, using crossover cables.

The CO feature operates on this line type by modifying the way in which incoming
calls are disconnected for system configuration in Brazil and Argentina. In these
locales, the CO setting uses Forced-Release instead of Clear-Back to disconnect
incoming calls. The Brazilian Double-Seizure mechanism, used to police Collect
calls, is also disabled in CO mode.

Clock Quality

Default = Network

Refer to the IP Office Installation Manual for full details. This option sets whether the
system should try to take its clock source for call synchronization and signalling from
this line. Preference should always be given to using the clock source from a central
office exchange if available by setting at least one exchange line to Network.

* If multiple lines are set as Network, the order in which those lines are used is
described in the IP Office Installation Manual. If additional lines are available,
Fallback can be used to specify a clock source to use should the Network source
not be available.

« Lines from which the clock source should not be taken should be set as
Unsuitable.

* If no clock source is available, the system uses its own internal 8KHz clock source.

* In scenarios where several systems are network via digital trunk lines, care must
be taken to ensure that all the systems use the same clock source. The current
source being used by a system is reported within the System Status Application.

Add 'Not-end-to-end
ISDN' Information
Element

Default = Never

Sets whether the optional 'Not end-to-end ISDN' information element should be
added to outgoing calls on the line. The options are:

* Never
* Always
* POTS(only if the call was originated by an analog extension).

The default is Never except for the following locales; for Italy the default is POTS, for
New Zealand the default is Always.

Progress Replacement

Default = None.

Progress messages are defined in the Q.931 ISDN connection control signaling
protocol. Generally, If a progress message is sent, the caller does not get connected
and so typically does not accrue call costs.
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Line

Field

Description

Not all ISDN lines support Q.931 Progress messages. Use this setting to configure
alternative signaling to the ISDN line for internally generated Progress messages.
The options are:

+ Alerting: Map to Q.931 Alerting. The call is not connected. The caller does not
hear the message and typically does not accrue call costs.

» Connect: Map to Q.931 Connect. The caller hears the message and typically will
accrue call costs.

Supports Partial
Rerouting

Default = Off.

Partial rerouting (PR) is an ISDN feature. It is supported on external (non-network
and QSIG) ISDN exchange calls. When an external call is transferred to another
external number, the transfer is performed by the ISDN exchange and the channels
to the system are freed. Use of this service may need to be requested from the line
provider and may incur a charge.

Force Number Plan to
ISDN

Default = Off.

This option is only configurable when Support Partial Rerouting is also enabled.
When selected, the plan/type parameter for Partial Rerouting is changed from
Unknown/Unknown to ISDN/Unknown.

Send Redirecting
Number

Default = Off.

This option can be used on ISDN trunks where the redirecting service is supported
by the trunk provider. Where supported, on twinned calls the caller ID of the original
call is passed through to the twinning destination. This option is only used for
twinned calls.

Support Call Tracing

Default = Off.

The system supports the triggering of malicious caller ID (MCID) tracing at the ISDN
exchange. Use of this feature requires liaison with the ISDN service provider and the
appropriate legal authorities to whom the call trace will be passed. The user will also
need to be enabled for call tracing and be provider with either a short code or
programmable button to activate MCID call trace. Refer to Malicious Call Tracing in
the Telephone Features section for full details.

Active CCBS Support

Default = Off.

Call completion to a busy subscriber (CCBS). It allows automatic callback to be used
on outgoing ISDN calls when the destination is busy. This feature can only be used
on point-to-point trunks. Use of this service may need to be requested from the line
provider and may incur a charge.

Passive CCBS

Default = Off.

Cost Per Charging Unit

Advice of charge (AOC) information can be display on T3/T3IP phones and output in
SMDR. The information is provided in the form of charge units. This setting is used to
enter the call cost per charging unit set by the line provider. The values are
1/10,000th of a currency unit. For example if the call cost per unit is £1.07, a value of
10700 should be set on the line. Refer to Advice of Charge.

Admin

Default = In Service.
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Field

Description

This field allows a trunk to be taken out of service if required for maintenance or if the
trunk is not connected.

Send original calling
party for forwarded
and twinning calls

Default = Off.
Use the original calling party ID when forwarding calls or routing twinned calls.
This setting applies to the following ISDN lines:
* PRI24 with subtypes:

- PRI

- QSIGA

- QSIGB

- ETSI

- ETSI CHI
* PRI30 with subtypes

- QSIGA

- QSIGB

- ETSI

- ETSI CHI

Originator number for
forwarded and
twinning calls

Default = blank.

The number used as the calling party ID when forwarding calls or routing twinned
calls. This field is grayed out when the Send original calling party for forwarded
and twinning calls setting is enabled.

This setting applies to the following ISDN lines:
* PRI24 with subtypes:
- PRI
- QSIGA
- QSIGB
- ETSI
- ETSI CHI
» PRI30 with subtypes
- QSIGA
- QSIGB
- ETSI
- ETSI CHI

The following fields are shown for a US T1 trunk card set to ETSI or QSIG operation. These cards
have the same settings E1 PRI trunk cards set to ETSI or QSIG but only support 23 channels.
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Line

These settings are not mergeable. Changing these settings requires a system reboot.

Field Description

CSU Operation Check this field to enable the T1 line to respond to loop-back requests from the line.

Haul Length Default = 0-115 feet
Sets the line length to a specific distance.

Channel Unit Default = Foreign Exchange This field should be set to match the channel signaling
equipment provided by the Central Office. The options are Foreign Exchange,
Special Access or Normal.

Related links

E1 Line on page 265

E1 Short Codes

Navigation: Line | E1 Short Codes

For some types of line, Line short codes can be applied to any digits received with incoming calls.

The line Short Code tab is shown for the following trunk types which are treated as internal or
private trunks: QSIG (T1, E1, H.323), BRI S0, H.323, SCN, IP Office. Incoming calls on those
types of trunk are not routed using Incoming Call Route settings. Instead the digits received with
incoming calls are checked for a match as follows:

Extension number (including remote numbers in a multi-site network).

* Line short codes (excluding ? short code).

» System short codes (excluding ? short code).

* Line ? short code.

» System ? short code.

Short codes can be added and edited using the Add, Remove and Edit buttons. Alternatively you
can right-click on the list of existing short code to add and edit short codes.

Changes to these settings do not require a reboot of the system.

Related links

E1 Line on page 265

E1 PRI Channels

Navigation: Line | E1 PRI Channels

This tab allows settings for individual channels within the trunk to be adjusted. To edit a channel
either double-click on it or click the channel and then select Edit.

To edit multiple channels at the same time, select the required channels using Ctrl or Shift and
then click Edit. When editing multiple channels, fields that must be unique such as Line
Appearance ID are not shown.

The following settings are mergeable:
 Line Appearance ID (ETSI, ETSI CHI)
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* Admin (ETSI CHI)
* Incoming Group ID (ETSI CHI)
* Outgoing Group ID (ETSI CHI)

The remaining settings are not mergeable. Changes to these settings require a system reboot.

Field

Description

Line Appearance ID

Default = Auto-assigned. Range = 2 to 9 digits.

Used for configuring Line Appearances with button programming. The line
appearance ID must be unique and not match any extension number. Line
appearance is not supported for trunks set to QSIG operation and is not
recommended for trunks be used for DID.

If the trunk Line Sub Type is set to ETSI CHI, outgoing line appearance calls must
use the corresponding channel.

The following additional fields are shown for lines where the Line Sub Type is set to ETSI CHI.

Field

Description

Incoming Group ID

Default = 0, Range 0 to 99999. The Incoming Group ID to which a line belongs is
used to match it to incoming call routes in the system configuration. The matching
incoming call route is then used to route incoming calls. The same ID can be used
for multiple lines.

Outgoing Group ID

Default = 1. Range 0 to 99999.

Short codes that specify a number to dial also specify the line group to be used.
The system will then seize a line with a matching Outgoing Group ID.

In a Server Edition network, the Outgoing Group ID used on a system must also
be unique within the network. The same ID cannot be used in the configuration of
any lines on another server system in the network. For Standard Edition
deployments, the same ID can be used for multiple lines.

Reserved Group ID Numbers:
* 90000 - 99999 Reserved for system use (not enforced).

* 99999 and 99998 In a Server Edition network, reserved for the IP Office lines to
the Primary Server and Secondary Server respectively.

99901 to 99930 In a Server Edition network, reserved for the IP Office lines from
the Primary Server to each expansion system in the network.

« 0 In a Server Edition network, the ID 0 cannot be used.

98888 For IP Office deployed in an Enterprise Branch environment, reserved for
the SM line.

Direction Default = Bothways
The direction of calls on the channel. The options are:
* Incoming
* Outgoing
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Line

Field Description
* Bothways
Bearer Default = Any

The type of traffic carried by the channel. The options are:
* Voice

» Data

* Any

Admin Default = Out of Service.

This field can be used to indicate whether the channel is in use or not. On trunks
where only a limited number of channels have been requested from the trunk
provider (known as sub-equipped trunks), those channels not provided should be
set as Out of Service. For channels that are available but are temporarily not
being used select Maintenance.

Tx Gain Default = 0dB. Range = -10dBb to +5dB.
The transmit gain in dB.
Rx Gain Default = 0dB. Range = -10dBb to +5dB.

The receive gain in dB.

Related links
E1 Line on page 265

E1 R2 Line
Navigation: Line | E1-R2 Line

Related links
PRI Trunks on page 264
E1-R2 Options on page 273
E1-R2 Channels on page 275
E1 R2 MFC Group on page 277
E1-R2 Advanced on page 277

E1-R2 Options
Navigation: Line | E1-R2 Options

Changing the Admin setting is mergeable. The remaining settings are not mergeable. Changes to
these settings will require a reboot of the system.

Field Description
Card/Module Indicates the card slot or expansion module being used for the trunk device providing
the line.
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Field Description
For IP500 V2 control units: 1 to 4 match the slots on the front of the control unit from
left to right. Expansion modules are numbered from 5 upwards, for example trunks on
the module in Expansion Port 1 are shown as 5.

Port Indicates the port on the Card/Module above to which the configuration settings relate.

Network Type Default = Public.

This option is available if System | Telephony | Telephony | Restrict Network
Interconnect is enabled. It allows the trunk to be set as either Public or Private. The
system will return number busy indication to any attempt to connect a call on a
Private trunk to a Public trunk or vice versa. This restriction includes transfers,
forwarding and conference calls.

Due to the nature of this feature, its use is not recommended on systems also using
any of the following other system features: multi-site networks, VPNremote,
application telecommuter mode.

Line Number

Allocated by the system.

Line SubType

Default = E1-R2
The options are:
* E1-R2

« ETSI

* QSIGA

* QSIGB

QSIG trunks trunks are not supported on IP500 V2 systems without IP500 Voice
Networking licenses.

Channel Allocation

Default =30 | 1

The order, 30 | 1 or 1 | 30, in which channels are used.

Country (Locale)

Default = Mexico. Select the locale that matches the area of usage. Note that
changing the locale will return the MFC Group settings to the defaults for the selected
locale. Currently supported locales are:

» Argentina
* Brazil

* China

* India

* Korea

* Mexico

¢ None

Admin

Default = In Service.

This field allows a trunk to be taken out of service if required for maintenance or if the
trunk is not connected.
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Line

Field

Description

The table at the base of the form displays the settings for the individual channels
provided by the line. For details of the channel settings see the E1-R2 Channel form.

To edit a channel, either double-click on it or right-click and select Edit. This will
display the Edit Channel dialog box. To edit multiple channels at the same time select
the channels whilst pressing the Shift or Ctrl key. Then right-click and select Edit.

Related links
E1 R2 Line on page 273

E1-R2 Channels
Navigation: Line | E1-R2 Channels

The channel settings are split into two sub-tabs, E1R2 Edit Channel and Timers.

The Timers tab displays the various timers provided for E1-R2 channels. These should only be
adjusted when required to match the line provider's settings.

This tab allows settings for individual channels within the trunk to be adjusted. To edit a channel,
select the required channel or channels and click Edit.

The following settings are mergeable:

* Incoming Group ID
* Outgoing Group ID

* Admin
The remaining settings are not mergeable. Changes to these settings require a system reboot.
Field Descriptions
Channel The channel or channels being edited.
Incoming Group ID Default = 0, Range 0 to 99999.

The Incoming Group ID to which a line belongs is used to match it to incoming
call routes in the system configuration. The matching incoming call route is
then used to route incoming calls. The same ID can be used for multiple lines.

Outgoing Group ID Default = 1. Range 0 to 99999.

Short codes that specify a number to dial also specify the line group to be
used. The system will then seize a line with a matching Outgoing Group ID.

In a Server Edition network, the Outgoing Group ID used on a system must
also be unique within the network. The same ID cannot be used in the
configuration of any lines on another server system in the network. For
Standard Edition deployments, the same ID can be used for multiple lines.

Reserved Group ID Numbers:
» 90000 - 99999 Reserved for system use (not enforced).

* 99999 and 99998 In a Server Edition network, reserved for the IP Office
lines to the Primary Server and Secondary Server respectively.
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Field Descriptions
* 99901 to 99930 In a Server Edition network, reserved for the IP Office lines
from the Primary Server to each expansion system in the network.
» 0 In a Server Edition network, the ID 0 cannot be used.
» 98888 For IP Office deployed in an Enterprise Branch environment,
reserved for the SM line.
Direction Default = Both Directions
The direction of calls on the channel. The options are:
* Incoming
» Outgoing
» Both Directions
Bearer Default = Any
The type of traffic carried by the channel. The options are:
» Voice
» Data
* Any
Admin Default = Out of Service.

This field can be used to indicate whether the channel is in use or not. On
trunks where only a limited number of channels have been requested from the
trunk provider (known as sub-equipped trunks), those channels not provided
should be set as Out of Service. For channels that are available but are
temporarily not being used select Maintenance.

Line Signaling Type

Default = R2 Loop Start

The signaling type used by the channel. Current supported options are:
* R2 Loop Start

* R2DID

- R2DOD

R2 DIOD

* Tie Inmediate Start

+ Tie Wink Start

+ Tie Delay Dial

* Tie Automatic
 WAN Service

« Out of Service

Dial Type

Default = MFC Dialing
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Line

Field Descriptions
The type of dialing supported by the channel. The options are:, or .
* MFC Dialing
» Pulse Dialing
« DTMF Dialing
Related links

E1 R2 Line on page 273

E1 R2 MFC Group
Navigation: Line | E1-R2 MFC Group
These settings are not mergeable. Changes to these settings will require a reboot of the system.

These tabs show the parameter assigned to each signal in an MFC group. The defaults are set
according to the Country (Locale) on the Line tab. All the values can be returned to default by the
Default All button on the Advanced tab.

These settings are not mergeable. Changes to these settings will require a reboot of the system.
To change a setting either double-click on it or right-click and select Edit.
Related links
E1 R2 Line on page 273
E1-R2 Advanced
Navigation: Line | E1IR2 Advanced

These settings are not mergeable. Changes to these settings will require a reboot of the system.

Field Description

Zero Suppression Default = HDB3
Selects the method of zero suppression used (HDB3 or AMI).
Clock Quality Default = Network

Refer to the IP Office Installation Manual for full details. This option sets whether the
system should try to take its clock source for call synchronization and signalling from
this line. Preference should always be given to using the clock source from a central
office exchange if available by setting at least one exchange line to Network.

« If multiple lines are set as Network, the order in which those lines are used is
described in the IP Office Installation Manual. If additional lines are available,
Fallback can be used to specify a clock source to use should the Network source
not be available.

 Lines from which the clock source should not be taken should be set as Unsuitable.

* If no clock source is available, the system uses its own internal 8KHz clock source.
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Field Description

* In scenarios where several systems are network via digital trunk lines, care must be
taken to ensure that all the systems use the same clock source. The current source
being used by a system is reported within the System Status Application.

Line Signaling Default = CPE
The options are:
+ CPE
+ CO
+ CO

The feature is intended to be used primarily as a testing aid. It allows T1 and E1 lines
to be tested in a back-to-back configuration, using crossover (QSIG) cables.

The CO feature operates by modifying the way in which incoming calls are
disconnected for system configuration in Brazil and Argentina. In these locales, the
CO setting uses Forced-Release instead of Clear-Back to disconnect incoming calls.
The Brazilian Double-Seizure mechanism used to police Collect calls, is also disabled

in CO mode.
Incoming Routing Default = 4
NS Sets the number of incoming digits used for incoming call routing.
CRC Checking Default = On
Switches CRC on or off.
Default All Group Default the MFC Group tab settings.
Settings

Line Signaling Timers | To edit one of these timers, either double-click on the timer or right-click on a timer
and select the action required.

Related links
E1 R2 Line on page 273

T1 Line

Related links
PRI Trunks on page 264
US T1 Line on page 278
T1 Channels on page 281

US T1 Line
Navigation: Line | US T1 Line
The following settings are mergeable:
* Admin
* Prefix

The remaining settings are not mergeable. Changes to these settings require a system reboot.
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Line

Field

Description

Line Number

Allocated by the system.

Card/Module

Indicates the card slot or expansion module being used for the trunk device
providing the line.

For IP500 V2 control units: 1 to 4 match the slots on the front of the control
unit from left to right. Expansion modules are numbered from 5 upwards,
for example trunks on the module in Expansion Port 1 are shown as 5.

Port Indicates the port on the Card/Module above to which the configuration
settings relate.
Network Type Default = Public.

This option is available if System | Telephony | Telephony | Restrict
Network Interconnect is enabled. It allows the trunk to be set as either
Public or Private. The system will return number busy indication to any
attempt to connect a call on a Private trunk to a Public trunk or vice versa.
This restriction includes transfers, forwarding and conference calls.

Due to the nature of this feature, its use is not recommended on systems
also using any of the following other system features: multi-site networks,
VPNremote, application telecommuter mode.

Line Sub Type Default = T1
Setto T1 for a T1 line.
Channel Allocation Default =24 | 1

The order, 24 to 1 or 1 to 24, in which channels are used.

Prefix

Default = Blank

Enter the number to prefix to all incoming numbers for callback. This is
useful if all users must dial a prefix to access an outside line. The prefix is
automatically placed in front of all incoming numbers so that users can dial
the number back.

Framing

Default = ESF

Selects the type of signal framing used. The options are:
» ESF

- D4

Zero Suppression

Default = B8ZS

Selects the method of zero suppression used. The options are:
- B82S

+ AMI ZCS

Clock Quality Default = Network
Refer to the IP Office Installation Manual for full details. This option sets
whether the system should try to take its clock source for call
synchronization and signalling from this line. Preference should always be
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Field

Description

given to using the clock source from a central office exchange if available
by setting at least one exchange line to Network.

« If multiple lines are set as Network, the order in which those lines are
used is described in the IP Office Installation Manual. If additional lines
are available, Fallback can be used to specify a clock source to use
should the Network source not be available.

 Lines from which the clock source should not be taken should be set as
Unsuitable.

+ If no clock source is available, the system uses its own internal 8KHz
clock source.

* |In scenarios where several systems are network via digital trunk lines,
care must be taken to ensure that all the systems use the same clock
source. The current source being used by a system is reported within the
System Status Application.

Haul Length

Default = 0-115 feet.

Sets the line length to a specific distance.

Channel Unit

Default = Foreign Exchange

This field should be set to match the channel signaling equipment provided
by the Central Office. The options are:

* Foreign Exchange
+ Special Access

* Normal

CRC Checking

Default = On
Turns CRC on or off.

Line Signaling

Default = CPE

This field affects T1 channels set to Loop-Start or Ground-Start. The field
can be set to either CPE (Customer Premises Equipment) or CO (Central
Office). This field should normally be left at its default of CPE. The setting
CO is normally only used in lab back-to-back testing.

Incoming Routing Digits

Default=0 (present call immediately)

Sets the number of routing digits expected on incoming calls. This allows
the line to present the call to the system once the expected digits have
been received rather than waiting for the digits timeout to expire. This field
only affects T1 line channels set to E&M Tie, E&M DID, E&M Switched 56K
and Direct Inward Dial.

CSU Operation

Enable this field to enable the T1 line to respond to loop-back requests
from the line.

Enhanced Called Party Number

Default = Off
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Line

Field Description

This option is not supported for systems set to the United States locale.
Normally the dialed number length is limited to 15 digits. Selecting this
option increases the allowed dialed number length to 30 digits.

Admin Default = In Service.
This field allows a trunk to be taken out of service if required for
maintenance or if the trunk is not connected.

Related links

T1 Line on page 278

T1 Channels

Navigation: Line | T1 Channels

The settings for each channel can be edited. Users have the option of editing individual channels
by double-clicking on the channel or selecting and editing multiple channels at the same time.
Note that the Line Appearance ID cannot be updated when editing multiple channels.

When editing a channel or channels, the settings available are displayed on two sub-tabs; T1 Edit
Channel and Timers.

The following settings are mergeable:

* Incoming Group ID

* Outgoing Group ID

* Line Appearance ID

* Admin
The remaining settings are not mergeable. Changes to these settings require a system reboot.
Field Description
Channel Allocated by the system.

Incoming Group
ID

Default = 0, Range 0 to 99999.

The Incoming Group ID to which a line belongs is used to match it to incoming call routes
in the system configuration. The matching incoming call route is then used to route
incoming calls. The same ID can be used for multiple lines.

Outgoing Group
ID

Default = 1. Range 0 to 99999.

Short codes that specify a number to dial also specify the line group to be used. The
system will then seize a line with a matching Outgoing Group ID.

In a Server Edition network, the Outgoing Group ID used on a system must also be
unique within the network. The same ID cannot be used in the configuration of any lines
on another server system in the network. For Standard Edition deployments, the same ID
can be used for multiple lines.

Reserved Group ID Numbers:

* 90000 - 99999 Reserved for system use (not enforced).
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Field

Description

* 99999 and 99998 In a Server Edition network, reserved for the IP Office lines to the
Primary Server and Secondary Server respectively.

* 99901 to 99930 In a Server Edition network, reserved for the IP Office lines from the
Primary Server to each expansion system in the network.

* 0 In a Server Edition network, the ID 0 cannot be used.

» 98888 For IP Office deployed in an Enterprise Branch environment, reserved for the SM
line.

Line Appearance
ID

Default = Auto-assigned. Range = 2 to 9 digits.

Used for configuring Line Appearances with button programming. The line appearance ID
must be unique and not match any extension number. Line appearance is not supported
for trunks set to QSIG operation and is not recommended for trunks be used for DID.

Direction

Default = Bothway

The direction of calls on the channel. The options are:
* Incoming

» Outgoing

* Bothway

Bearer

Default = Any

The type of traffic carried by the channel. The options are:
+ Voice

* Data

* Any

Admin

Default = In Service.

This field allows a trunk to be taken out of service if required for maintenance or if the
trunk is not connected.

Type

Default = Loop-Start.

The T1 emulates the following connections:
* Ground-Start

» Loop-Start

+ E&M - TIE

- E&M - DID

+ E&M Switched 56K

* Direct Inward Dial

* Clear Channel 64K

Trunks set to E&M - DID will only accept incoming calls.
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Line

Field Description
If E&M - TIE is selected and the Outgoing Trunk Type is set to Automatic, no secondary
dial tone is provided for outgoing calls on this line/trunk.

Dial Type Default = DTMF Dial

Select the dialing method required. The options are:
+ DTMF Dial

* Pulse Dial

Incoming Trunk
Type

Default = Wink-Start

Used for E&M types only. The handshake method for incoming calls. The options are:
* Automatic

* Immediate

* Delay Dial

» Wink-Start

Outgoing Trunk
Type

Default = Wink-Start

Used for E&M types only. The handshake method for outgoing calls. The options are:
* Automatic

* Immediate

+ Delay Dial

* Wink-Start

If the line Type is set to E&M-TIE and the Outgoing Trunk Type is set to Automatic, no
secondary dial tone is provided for outgoing calls on this line/trunk.

Tx Gain Default = 0dB.

The transmit gain in dB.
Rx Gain Default = 0dB.

The receive gain in dB.
Admin Default = In Service.

This field allows a trunk to be taken out of service if required for maintenance or if the
trunk is not connected.

Timer Settings

This sub-tab allows various timers relating to operation of an individual channel to be adjusted.
These should only be adjusted to match the requirements of the line provider. The following is a
list of the default values. To reset a value, click on the current value and then right click and select
from the default, minimize and maximize options displayed.

Incoming Automatic Delay: 410. Silent Interval: 1100.
Incoming Wink Delay: 100. Outgoing Seizure: 10.
Wink Signal: 200. Wink Start: 5000.
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Incoming Dial Guard: 50.
First Incoming Digit: 15000.
Incoming Inter Digit: 5000.
Maximum Inter Digit: 300.
Flash Hook Detect: 240.
Incoming Disconnect: 300.

Incoming Disconnect Guard: 800.

Disconnected Signal Error: 240000.

Outgoing Disconnect: 300.
Outgoing Disconnect Guard: 800.
Ring Verify Duration: 220.

Ring Abandon: 6300.

Ping Verify: 600.

Long Ring Time: 1100.

Related links

T1 Line on page 278

T1 PRI Line
Related links

PRI Trunks on page 264

T1 ISDN on page 284

T1 ISDN Channels on page 289
T1 ISDN TNS on page 291

T1 ISDN Special on page 291

Call By Call (US PRI) on page 292

T1 ISDN

Navigation: Line | T1 ISDN Line

The following settings are mergeable:

* Prefix
» Send Redirecting Number
* Admin

Wink Validated: 80.

Wink End: 350.

Delay End: 5000.

Outgoing Dial Guard: 590.
Outgoing IMM Dial Guard: 1500.
Outgoing Pulse Dial Break: 60.
Outgoing Pulse Dial Make: 40.

Outgoing Pulse Dial Inter Digit: 720.

Outgoing Pulse Dial Pause: 1500.
Flash Hook Generation: 500.
Outgoing End of Dial: 1000.
Answer Supervision: 300.

Incoming Confirm: 20.

» Send original calling party for forwarded and twinning calls

* Originator number for forwarded and twinning calls

The remaining settings are not mergeable. Changes to these settings require a system reboot.
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Line

Variable

Description

Line Number

Allocated by the system.

Card/Module

Indicates the card slot or expansion module being used for the trunk device
providing the line.

For IP500 V2 control units: 1 to 4 match the slots on the front of the control unit
from left to right. Expansion modules are numbered from 5 upwards, for
example trunks on the module in Expansion Port 1 are shown as 5.

Port Indicates the port on the Card/Module above to which the configuration settings
relate.
Network Type Default = Public.

This option is available if System | Telephony | Telephony | Restrict Network
Interconnect is enabled. It allows the trunk to be set as either Public or
Private. The system will return number busy indication to any attempt to connect
a call on a Private trunk to a Public trunk or vice versa. This restriction includes
transfers, forwarding and conference calls.

Due to the nature of this feature, its use is not recommended on systems also
using any of the following other system features: multi-site networks,
VPNremote, application telecommuter mode.

Line Sub Type

: Default = PRI

Set to PRI. If setto T1 see Line Form (T1). If set to ETSI, ETSI CHI, QSIG A or
QSIG B see Line (E1).

QSIG trunks trunks are not supported on IP500 V2 systems without IP500 Voice
Networking licenses.

Channel Allocation

Default = 23 | 1

The order, 23 to 1 or 1 to 23, in which channels are used.

Switch Type

Default = NI2
The options are
+ 4ESS

+ 5ESS

+ DMS100

* NI2

Provider

Default = Local Telco
Select the PSTN service provider (AT&T, Sprint, WorldCom or Local Telco).

Prefix

Default = Blank

Enter the number to prefix to all incoming numbers for callback. This is useful if
all users must dial a prefix to access an outside line. The prefix is automatically
placed in front of all incoming numbers so that users can dial the number back.

Add 'Not-end-to-end ISDN'
Information Element

Default = Never*.
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Variable

Description

Sets whether the optional 'Not end-to-end ISDN' information element should be
added to outgoing calls on the line. The options are

* Never
+ Always
» POTS (only if the call was originated by an analog extension)

*The default is Never except for the following locales; for Italy the default is
POTS, for New Zealand the default is Always.

Progress Replacement

Default = None.

Progress messages are defined in the Q.931 ISDN connection control signaling
protocol. Generally, If a progress message is sent, the caller does not get
connected and so typically does not accrue call costs.

Not all ISDN lines support Q.931 Progress messages. Use this setting to
configure alternative signaling to the ISDN line for internally generated Progress
messages. The options are:

+ Alerting: Map to Q.931 Alerting. The call is not connected. The caller does not
hear the message and typically does not accrue call costs.

+ Connect: Map to Q.931 Connect. The caller hears the message and typically
will accrue call costs.

Send Redirecting Number

Default = Off.

This option can be used on ISDN trunks where the redirecting service is
supported by the trunk provider. Where supported, on twinned calls the caller ID
of the original call is passed through to the twinning destination. This option is
only used for twinned calls.

Send Names

This option is available when the Switch Type above is set to DMS100. If set,
names are sent in the display field. The Z shortcode character can be used to
specify the name to be used.

Names Length

Set the allowable length for names, up to 15 characters, when Send Names is
set above.

Test Number

Used to remember the external telephone number of this line to assist with loop-
back testing. For information only.

Framing

Default = ESF
Selects the type of signal framing used (ESF or D4).

Zero Suppression

Default = B82S
Selects the method of zero suppression used (B8ZS or AMI ZCS).

Clock Quality Default = Network
Refer to the IP Office Installation Manual for full details. This option sets whether
the system should try to take its clock source for call synchronization and
signalling from this line. Preference should always be given to using the clock
Table continues...
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Line

Variable

Description

source from a central office exchange if available by setting at least one
exchange line to Network.

« If multiple lines are set as Network, the order in which those lines are used is
described in the IP Office Installation Manual. If additional lines are available,
Fallback can be used to specify a clock source to use should the Network
source not be available.

 Lines from which the clock source should not be taken should be set as
Unsuitable.

* If no clock source is available, the system uses its own internal 8KHz clock
source.

* In scenarios where several systems are network via digital trunk lines, care
must be taken to ensure that all the systems use the same clock source. The
current source being used by a system is reported within the System Status
Application.

CSU Operation

Tick this field to enable the T1 line to respond to loop-back requests from the
line.

Haul Length Default = 0-115 feet
Sets the line length to a specific distance.
Channel Unit Default = Foreign Exchange

This field should be set to match the channel signaling equipment provided by
the Central Office. The options are

* Foreign Exchange
» Special Access

* Normal

CRC Checking

Default = On
Turns CRC on or off.

Line Signaling

The field can be set to either CPE (Customer Premises Equipment) or CO
(Central Office). This field should normally be left at its default of CPE. The
setting CO is normally only used in lab back-to-back testing.

Incoming Routing Digits

Default=0 (present call immediately)

Sets the number of routing digits expected on incoming calls. This allows the line
to present the call to the system once the expected digits have been received
rather than waiting for the digits timeout to expire. This field only affects T1 line
channels set to E&M Tie, E&M DID, E&M Switched 56K and Direct Inward
Dial.

Admin Default = In Service.
This field allows a trunk to be taken out of service if required for maintenance or
if the trunk is not connected.
Table continues...
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Variable

Description

Send original calling party
for forwarded and
twinning calls

Default = Off.
Use the original calling party ID when forwarding calls or routing twinned calls.
This setting applies to the following ISDN lines:
* PRI24 with subtypes:
- PRI
- QSIGA
- QSIGB
- ETSI
ETSI CHI
+ PRI30 with subtypes
- QSIGA
- QSIGB
- ETSI
ETSI CHI

Originator number for
forwarded and twinning
calls

Default = blank.

The number used as the calling party ID when forwarding calls or routing twinned

calls. This field is grayed out when the Send original calling party for
forwarded and twinning calls setting is enabled.

This setting applies to the following ISDN lines:
* PRI24 with subtypes:
- PRI
- QSIGA
- QSIGB
- ETSI
ETSI CHI
+ PRI30 with subtypes
- QSIGA
- QSIGB
- ETSI
- ETSI CHI

Related links

T1 PRI Line on page 284
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Line

T1 ISDN Channels
Navigation: Line | T1 ISDN Channels

This tab allows settings for individual channels within the trunk to be adjusted. This tab is not
available for trunks sets to ETSI or QSIG mode.

The following settings are mergeable:

* Incoming Group ID

* Outgoing Group ID

* Line Appearance ID

« Admin

The remaining settings are not mergeable. Changes to these settings require a system reboot.

Field

Description

Channel

Allocated by the system.

Incoming Group ID

Default = 0, Range 0 to 99999.

The Incoming Group ID to which a line belongs is used to match it to incoming call
routes in the system configuration. The matching incoming call route is then used to
route incoming calls. The same ID can be used for multiple lines.

Outgoing Group ID

Default = 1. Range 0 to 99999.

Short codes that specify a number to dial also specify the line group to be used. The
system will then seize a line with a matching Outgoing Group ID.

In a Server Edition network, the Outgoing Group ID used on a system must also be
unique within the network. The same ID cannot be used in the configuration of any lines
on another server system in the network. For Standard Edition deployments, the same
ID can be used for multiple lines.

Reserved Group ID Numbers:
* 90000 - 99999 Reserved for system use (not enforced).

» 99999 and 99998 In a Server Edition network, reserved for the IP Office lines to the
Primary Server and Secondary Server respectively.

* 99901 to 99930 In a Server Edition network, reserved for the IP Office lines from the
Primary Server to each expansion system in the network.

* 0 In a Server Edition network, the ID 0 cannot be used.

98888 For IP Office deployed in an Enterprise Branch environment, reserved for the
SM line.

Line Appearance ID

Default = Auto-assigned. Range = 2 to 9 digits.

Used for configuring Line Appearances with button programming. The line appearance
ID must be unique and not match any extension number.

Direction

Default = Both Directions
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Field

Description

The direction of calls on the channel. The options are:
* Incoming
» Outgoing

* Both Directions

Bearer

Default = Any

The type of traffic carried by the channel. The options are:
» Voice

» Data

* Any

Service

Default = None.

If the line provider is set to AT&T, select the type of service provided by the channel.
The options are:

 Call by Call

» SDN (inc GSDN)
* MegaCom 800

* MegaCom

+ Wats

» Accunet

* ILDS

- 1800

« ETN

* Private Line

+ AT&T Multiquest

For other providers, the service options are None or No Service.

Admin

Default = Out of Service

Used to indicate the channel status. The options are:
* In Service

» Out of Service

* Maintenance

Tx Gain

Default = 0dB

The transmit gain in dB

Rx Gain

Default = 0dB

The receive gain in dB.
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Line

Related links

T1 PRI Line on page 284

T1ISDN TNS

Navigation: Line | T1 ISDN TNS

This tab is shown when the line Provider is set to AT&T. It allows the entry of the Network

Selection settings. These are prefixes for alternative long distance carriers. When a number dialed
matches an entry in the table, that pattern is stripped from the number before being sent out. This
table is used to set field in the TNS (Transit Network Selection) information element for 4ESS and

5ESS exchanges. It is also used to set fields in the NSF information element.

These settings are not mergeable. Changes to these settings will require a reboot of the system.

Field Description
TNS Code The pattern for the alternate long distance carrier. For example: The pattern 10XXX is
added to this tab. If 10288 is dialed, 10 is removed and 288 is placed in the TNS and
NSF information.
Related links

T1 PRI Line on page 284

T1 ISDN Special

Navigation: Line | T1 ISDN Special

This tab is shown when the line Provider is set to AT&T. This table is used to set additional fields
in the NSF information element after initial number parsing by the TNS tab. These are used to
indicate the services required by the call. If the channel is set to Call by Call, then further parsing
is done using the records in the Call by Call tab.

These settings are not mergeable. Changes to these settings will require a reboot of the system.

Field Description
Short code The number which results from the application of the rules specified in the User or
System Short code tables and the Network Selection table and the Call-by-call table to
the number dialed by the user.
Number The number to be dialed to line.
Special Default = No Operator.
The options are:
* No Operator
* Local Operator
* Presubscribed Operator
Plan Default = National.
The options are:
* National
* International
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Typical values are:

Short Code Number Service
011N N No Operator, International
010N N Local Operator, International
01N N Local Operator, National
OON N Presubscribed Operator, National
ON N Presubscribed Operator, National
1N 1N No operator, National
Related links

T1 PRI Line on page 284

Call By Call (US PRI)
Navigation: Line | T1 ISDN Call by Call

This tab is shown when the line Provider is set to AT&T. Settings in this tab are only used when
calls are routed via a channel which has its Service set to Call by Call.

It allows short codes to be created to route calls to a different services according to the number
dialed. Call By Call reduces the costs and maximizes the use of facilities. Call By Call chooses the
optimal service for a particular call by including the Bearer capability in the routing decision. This is

particularly useful when there are limited resources.

These settings are not mergeable. Changes to these settings will require a reboot of the system.

Field

Description

Short Code

The number which results from the application of the rules specified in the User or
System Short code tables and the Network Selection table to the number dialed by the

user.

Number

The number to be dialed to line.

Bearer

Default = Any

The type of traffic carried by the channel. The options are:

* Voice
» Data
* Any

Service

Default = AT&T

The service required by the call. The options are:

 Call by Call

» SDN (inc GSDN)
* MegaCom 800

*+ MegaCom

+ Wats
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Line

Field Description
* Accunet

» ILDS
+ 1800
* ETN

* Private Line
AT&T Multiquest

Related links
T1 PRI Line on page 284

S0 Line

E

These settings are used for SO ports provided by an S08 expansion module connected a control
unit. For full details of installation refer to the IP Office Installation manual.

Though displayed as lines, these BRI ports are used for connection of ISDN2 devices such as
video conferencing units or ISDN PC cards.

Calls received on IP, SO and QSIG trunks do not use incoming call routes. Routing for these is
based on incoming number received as if dialed on-switch. Line short codes on those trunks can
be used to modify the incoming digits.
Related links
Line on page 250
S0 Line on page 293
S0 Short Codes on page 295
Line | SO Channels on page 296

SO0 Line

Navigation: Line | SO Line

The following settings are not mergeable. Changes to these settings require a system reboot.
* Line Sub Type
* Network Type

The remaining settings are mergeable.
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Field

Description

Line Number

This parameter is not configurable. It is allocated by the system.

Card/Module

Indicates the card slot or expansion module being used for the trunk device providing
the line.

For IP500 V2 control units: 1 to 4 match the slots on the front of the control unit from left
to right. Expansion modules are numbered from 5 upwards, for example trunks on the
module in Expansion Port 1 are shown as 5.

Port

Indicates the port on the Card/Module above to which the configuration settings relate.

Line Sub Type

Default = ETSI Select to match the particular line type provided by the line provider.

Network Type

Default = Public.

This option is available if Restrict Network Interconnect (System | Telephony |
Telephony) is enabled. It allows the trunk to be set as either Public or Private. The
system will return number busy indication to any attempt to connect a call on a Private
trunk to a Public trunk or vice versa. This restriction includes transfers, forwarding and
conference calls.

Due to the nature of this feature, its use is not recommended on systems also using any
of the following other system features: multi-site networks, VPNremote, application
telecommuter mode.

Telephone Number

Used to remember the telephone number of this line. For information only.

Prefix

Default = Blank.
The prefix is used in the following ways:

* For incoming calls The ISDN messaging tags indicates the call type (National,
International or Unknown). If the call type is unknown, then the number in the Prefix
field is added to the ICLID.

» For outgoing calls The prefix is not stripped, therefore any prefixes not suitable for
external line presentation should be stripped using short codes.

National Prefix

Default =0

This indicates the digits to be prefixed to a incoming national call. When a number is
presented from ISDN as a "national number" this prefix is added. For example
1923000000 is converted to 01923000000.

International Prefix

Default = 00

This indicates the digits to be prefixed to an incoming international call. When a number
is presented from ISDN as an "international number" this prefix is added. For example
441923000000 is converted to 00441923000000.

Incoming Group ID

Default = 0, Range 0 to 99999.

The Incoming Group ID to which a line belongs is used to match it to incoming call
routes in the system configuration. The matching incoming call route is then used to
route incoming calls. The same ID can be used for multiple lines.

Outgoing Group ID

Default = 1. Range 0 to 99999.
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Line

Field

Description

Short codes that specify a number to dial also specify the line group to be used. The
system will then seize a line with a matching Outgoing Group ID.

In a Server Edition network, the Outgoing Group ID used on a system must also be
unique within the network. The same ID cannot be used in the configuration of any lines
on another server system in the network. For Standard Edition deployments, the same
ID can be used for multiple lines.

Reserved Group ID Numbers:
* 90000 - 99999 Reserved for system use (not enforced).

* 99999 and 99998 In a Server Edition network, reserved for the IP Office lines to the
Primary Server and Secondary Server respectively.

* 99901 to 99930 In a Server Edition network, reserved for the IP Office lines from the
Primary Server to each expansion system in the network.

¢ 0 In a Server Edition network, the ID 0 cannot be used.

» 98888 For IP Office deployed in an Enterprise Branch environment, reserved for the
SM line.

TEI

Default = 0

Not used. The Control Unit will ignore any entry.

Number of
Channels

Default = 2

Defines the number of operational channels that are available on this line. 2 for BRI and
up to 30 for PRI - depending upon the number of channels subscribed.

Outgoing Channels

Default = 2

This defines the number of channels available, on this line, for outgoing calls. This
should normally be the same as Number of Channels field, but can be reduced to
ensure incoming calls cannot be blocked by outgoing calls.

Voice Channels

Default = 2

The number of channels available for voice use.

Data Channels

Default = 2

The number of channels available for data use. If left blank the value is 0.

Related links

S0 Line on page 293

S0 Short Codes

Navigation: Line | SO Line | Short Codes

For BRI SO lines , these settings are mergeable.

For some types of line, Line short codes can be applied to any digits received with incoming calls.

The line Short Code tab is shown for the following trunk types which are treated as internal or
private trunks: QSIG (T1, E1, H.323), BRI S0, H.323, SCN, IP Office. Incoming calls on those
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types of trunk are not routed using Incoming Call Route settings. Instead the digits received with
incoming calls are checked for a match as follows:

Extension number (including remote numbers in a multi-site network).

* Line short codes (excluding ? short code).

» System short codes (excluding ? short code).
* Line ? short code.

» System ? short code.

Short codes can be added and edited using the Add, Remove and Edit buttons. Alternatively you
can right-click on the list of existing short code to add and edit short codes.

Related links
S0 Line on page 293

Line | SO Channels

Navigation: Line | SO Line | Channels
For SO channels this form is not used.

Related links
S0 Line on page 293

H.323 Line

These lines are added manually. They allow voice calls to be routed over data links within the
system. They are therefore dependent on the IP data routing between the system and the
destination having being configured and tested.

Calls received on IP, SO and QSIG trunks do not use incoming call routes. Routing for these is
based on incoming number received as if dialed on-switch. Line short codes on those trunks can
be used to modify the incoming digits.

Network Assessments

Not all data connections are suitable for voice traffic. A network assessment is required for internal
network connections. For external network connections a service level agreement is required from
the service provider. Avaya cannot control or be held accountable for the suitability of a data
connection for carrying voice traffic.

QSIG trunks trunks are not supported on IP500 V2 systems without IP500 Voice Networking
licenses.

This type of configuration record can be saved as a template and new records created from a
template. See Working with Templates on page 547.
Related links
Line on page 250
VolIP Line on page 297
Short Codes on page 299

VoIP Settings on page 299
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VoIP Line

Line

Navigation: Line | H.323 Line | VoIP Line
Configuration Settings

These settings are mergeable. Changes to these settings does not require a reboot of the system.

Field

Description

Line Number

Default = Auto-filled. Range = 1 to 249 (IP500 V2)/349 (Server Edition).

Enter the line number that you wish. Note that this must be unique. On IP500 V2
systems, line numbers 1 to 16 are reserved for internal hardware.

Telephone Number

Used to remember the telephone number of this line. For information only.

Network Type

Default = Public.

This option is available if System | Telephony | Telephony | Restrict Network
Interconnect is enabled. It allows the trunk to be set as either Public or Private.
The system will return number busy indication to any attempt to connect a call on a
Private trunk to a Public trunk or vice versa. This restriction includes transfers,
forwarding and conference calls.

Due to the nature of this feature, its use is not recommended on systems also using
any of the following other system features: multi-site networks, VPNremote,
application telecommuter mode.

Prefix

Default = Blank.
The prefix is used in the following ways:

* For incoming calls The ISDN messaging tags indicates the call type (National,
International or Unknown). If the call type is unknown, then the number in the
Prefix field is added to the ICLID.

* For outgoing calls The prefix is not stripped, therefore any prefixes not suitable
for external line presentation should be stripped using short codes.

National Prefix

Default =0

This indicates the digits to be prefixed to a incoming national call. When a number is
presented from ISDN as a "national number" this prefix is added. For example
1923000000 is converted to 01923000000.

International Prefix

Default = 00

This indicates the digits to be prefixed to an incoming international call. When a
number is presented from ISDN as an "international number" this prefix is added.
For example 441923000000 is converted to 00441923000000.

Location

Default = Cloud.

Specify a location to associate the extension with a physical location. Associating
an extension with a location:

» Allows emergency services to identify the source of an emergency call.

+ Allows you to configure call admission control settings for the location.
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Field Description
The drop down list contains all locations that have been defined on Location |
Location.

Description Default = Blank. Maximum 31 characters.

Use this field to enter a description of this configuration.

Send original calling
party for forwarded and
twinning calls

Default = Off.

Use the original calling party ID when forwarding calls or routing twinned calls.

Outgoing Group ID

Default = 1. Range 0 to 99999.

Short codes that specify a number to dial also specify the line group to be used. The
system will then seize a line with a matching Outgoing Group ID.

In a Server Edition network, the Outgoing Group ID used on a system must also
be unique within the network. The same ID cannot be used in the configuration of
any lines on another server system in the network. For Standard Edition
deployments, the same ID can be used for multiple lines.

Reserved Group ID Numbers:
* 90000 - 99999 Reserved for system use (not enforced).

* 99999 and 99998 In a Server Edition network, reserved for the IP Office lines to
the Primary Server and Secondary Server respectively.

* 99901 to 99930 In a Server Edition network, reserved for the IP Office lines from
the Primary Server to each expansion system in the network.

¢ 0 In a Server Edition network, the ID 0 cannot be used.

98888 For IP Office deployed in an Enterprise Branch environment, reserved for
the SM line.

Number of Channels

Default = 20, Range 1 to 250.

Defines the number of operational channels that are available on this line.

Outgoing Channels

Default = 20, Range 0 to 250.

This defines the number of channels available, on this line, for outgoing calls. This
should normally be the same as Number of Channels field, but can be reduced to
ensure incoming calls cannot be blocked by outgoing calls.

TEI Default = 0. Range = 0 to 127.
The Terminal Equipment Identifier. Used to identify each Control Unit connected to a
particular ISDN line. For Point to Point lines this is typically (always) 0. It can also
be 0 on a Point to Multi-Point line, however if multiple devices are actually sharing a
Point to Multi-Point line it should be set to 127 which will result in the exchange
deciding on the TEI's to be used by this Control Unit.

Related links

H.323 Line on page 296
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Line

Short Codes
Navigation: Line | H.323 Line | Short Codes
For some types of line, Line short codes can be applied to any digits received with incoming calls.

The line Short Code tab is shown for the following trunk types which are treated as internal or
private trunks: QSIG (T1, E1, H.323), BRI S0, H.323, SCN, IP Office. Incoming calls on those
types of trunk are not routed using Incoming Call Route settings. Instead the digits received with
incoming calls are checked for a match as follows:

Extension number (including remote numbers in a multi-site network).

* Line short codes (excluding ? short code).

» System short codes (excluding ? short code).
* Line ? short code.

» System ? short code.

Short codes can be added and edited using the Add, Remove and Edit buttons. Alternatively you
can right-click on the list of existing short code to add and edit short codes.

Changes to these settings do not require a reboot of the system.
Related links
H.323 Line on page 296
VoIP Settings
Navigation: Line | H.323 Line | VolIP Settings
This form is used to configure the VoIP setting applied to calls on the H.323 line.

Configuration Settings
These settings are mergeable. Changes to these settings does not require a reboot of the system.

Field Description
Gateway IP Address Default = Blank

Enter the IP address of the gateway device at the remote end.
Port Default = 1720

The H.323 line is identified by the IP Address:Port value. Specifying a unique port
value for this IP address allows multiple lines to use the same IP address.

Codec Selection Default = System Default

This field defines the codec or codecs offered during call setup. The available
codecs in default preference order are:

« G.711 A-Law
* G.711 U-LAW
+ G.729
+ G.723.1
Table continues. ..
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Configuration Mode Field Descriptions

Field

Description

Note that the default order for G.711 codecs varies to match the system's default
companding setting. G.723.1 is not supported on Linux based systems.

The G.722 64K codec is also supported on IP500 V2 systems with IP500 VCM,
IP500 VCM V2 or IP500 Combo cards. For Server Edition, it is supported on
Primary Server, Secondary Server and Expansion System (L) systems and on
Expansion System (V2) systems fitted with IP500 VCM, IP500 VCM V2 or IP500
Combo.

The codecs available in this form are set through the codec list on System | VolP.

Within a network of systems, it is strongly recommended that all the systems and
the lines connecting those systems use the same codecs.

The options are:

» System Default This is the default setting. When selected, the codec list below
matches the codecs set in the system wide list.

» Custom This option allows specific configuration of the codec preferences to be
different from the system list. When Custom is selected, the list can be used to
select which codecs are in the Unused list and in the Selected list and to change
the order of the selected codecs.

Supplementary
Services

Default = H450.

Selects the supplementary service signaling method for use across the H.323 trunk.
The remote end of the trunk must support the same option. The options are:

* None: No supplementary services are supported.
¢ H450: Use for H.323 lines connected to another PBX or device that uses H450.
* QSIG: Use for H.323 lines connected to another PBX or device that uses QSIG.

Call Initiation Timeout

Default = 4 seconds. Range = 1 to 99 seconds.

This option sets how long the system should wait for a response to its attempt to
initiate a call before following the alternate routes set in an ARS form.

VolIP Silence
Suppression

Default = Off.

When selected, this option will detect periods of silence on any call over the line and
will not send any data during those silent periods. This feature is not used on IP
lines using G.711 between systems. On trunk's between networked systems, the
same setting should be set at both ends.

Enable FastStart for
non-Avaya IP Phones

Default = Off

A fast connection procedure. Reduces the number of messages that need to be
exchanged before an audio channel is created.

Fax Transport Support

Default = Off

This option is only supported on trunks with their Supplementary Services set to
IP Office SCN or IP Office Small Community Network - Fallback. Fax relay is
supported across H.323 multi-site network lines with Fax Transport Support
selected. This will use 2 VCM channels in each of the systems. Fax relay is only
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Line

Field Description
supported on IP500 V2 systems with IP500 VCM, IP500 VCM V2 and or IP500
Combo cards. Fax relay is not supported on Server Edition Linux servers.
Local Tones Default = Off

When selected, the tones are generated by the local system to which the phone is
registered. This option should not be used with lines being used for a multi-site
network.

DTMF Support

Default = Out of Band

DTMF tones can be sent to the remote end either as DTMF tones within the calls
audio path (In Band) or a separate signals (Out of Band). Out of Band is
recommended for compression modes such as G.729 and G.723 compression
modes where DTMF in the voice stream could become distorted.

Allow Direct Media Path

Default = On

This settings controls whether IP calls must be routed via the system or can be
routed alternatively if possible within the network structure.

« If enabled, IP calls can take routes other than through the system, removing the
need for system resources such as voice compression channels. Both ends of the
calls must support Direct Media and have compatible VolP settings such as
matching codec, etc. If otherwise, the call will remain routed via the system.
Enabling this option may cause some vendors problems with changing the media
path mid call.

« If disabled, the call is routed via the system. In that case, RTP relay support may
still allow calls between devices using the same audio codec to not require a
voice compression channel.

Progress Ends Overlap
Send

Default = Off.

Some telephony equipment, primarily AT&T switches, over IP trunks send a H.323
Progress rather than H.323 Proceeding message to signal that they have
recognized the digits sent in overlap state. By default the system expects an H.323
Proceeding message. This option is not available by default. If required, the value
ProgressEndsOverlapSend must be entered into the Source Numbers tab of the
NoUser user.

Default Name From Default = Off.
Display IE When set, the Display IE is used as the default source for the name.
Related links

H.323 Line on page 296

IP DECT Line

This type of line can be manually added. They are used to route voice calls over an IP data
connection to an Avaya IP DECT system. Only one IP DECT line can be added to a system. Refer
to the IP DECT R4 Installation manual for full details.
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Configuration Mode Field Descriptions

Currently, only one IP DECT line is supported on a system.

This type of configuration record can be saved as a template and new records created from a
template. See Working with Templates on page 547.
Related links
Line on page 250
Line | IP DECT Line on page 302
Gateway on page 302
VolIP on page 305

Line | IP DECT Line
Navigation: Line | IP DECT Line | Line

When creating an IP DECT line, these settings are mergeable. You can also remove an IP DECT
line without rebooting. Changing an IP DECT line that has been imported into the configuration is
not mergeable.

Field Description

Line Number This number is allocated by the system and is not adjustable.

Associated Extensions | Lists all the DECT extensions associated with the IP DECT line.

Description Default = Blank. Maximum 31 characters.

Use this field to enter a description of this configuration.

Related links
IP DECT Line on page 301

Gateway
Navigation: Line | IP DECT Line | Gateway

This form is used to configure aspects of information exchange between the IP Office and IP
DECT systems.

When creating an IP DECT line, these settings are mergeable. You can also remove an IP DECT
line without rebooting. Changing an IP DECT line that has been imported into the configuration is
not mergeable.

Field Description
Auto-Create Default = Off.
Extension

If enabled, subscription of a handset with the DECT system causes the auto-creation of a
matching numbered extension within the system configuration if one does not already
exist. This setting is not supported on systems configured to use WebLM server licensing.

For security, auto-create is automatically disabled after 24 hours.
Auto-Create User | Default = Off.
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Line

Field

Description

This option is only usable if Auto-Create Extension is also enabled. If enabled,
subscription of a handset with the DECT system causes the auto-creation of a matching
user within the system configuration if one does not already exist.

For security, any auto-create settings set to On are automatically set to Off after 24 hours.

Enable DHCP
Support

Default = Off

This option is not supported for use with Avaya IP DECT R4. The IP DECT base stations
require DHCP and TFTP support. Enable this option if the system is being used to
provide that support, using IP addresses from its DHCP range (LAN1 or LAN2) and its
TFTP server setting. If not enabled, alternate DHCP and TFTP options must be provided
during the IP DECT installation.

* Ifit is desired to use the system for DHCP support of the ADMM and IP DECT base
stations only, the system address range should be set to match that number of
addresses. Those addresses are then taken during the system restart and will not be
available for other DHCP responses following the restart.

» For larger IP DECT installations, the use of a non-embedded TFTP software option
other than Manager is recommended.

Boot File

Default = ADMM_RFP_1_0_0.tftp. Range = Up to 31 characters.

The name and path of the ADMM software file. The path is relative to the TFTP server
root directory.

ADMM MAC
Address

Default = 00:00:00:00:00:00

This field must be used to indicate the MAC address of the IP DECT base station that
should load the ADMM software file and then act as the IP DECT system's ADMM. The
address is entered in hexadecimal format using comma, dash, colon or period separators.

VLAN ID

Default = Blank. Range = 0 to 4095.

If VLAN is being used by the IP DECT network, this field sets the VLAN address assigned
to the base stations by the system if Enable DHCP Support is selected.

* The system itself does not apply or use VLAN marking. It is assumed that the addition
of VLAN marking and routing of VLAN traffic is performed by other switches within the
customer network.

* An ID of zero is not recommended for normal VLAN operation.
» When blank, no VLAN option is sent to the IP DECT base station.

Base Station
Address List

Default = Empty

This box is used to list the MAC addresses of the IP DECT base stations, other than the
base station being used as the ADMM and entered in the ADMM MAC Address field.
Right-click on the list to select Add or Delete. or use the Insert and Delete keys. The
addresses are entered in hexadecimal format using comma, dash, colon or period
separators.

Enable Provisioning

This option can be used with DECT R4 systems. It allows the setting of several values in the system
configuration that previously needed to be set separately in the master base stations configuration. For full
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Configuration Mode Field Descriptions

Field

Description

details refer to the DECT R4 Installation manual. The use of provisioning requires the system security settings
to include an IPDECT Group.

SARI/PARK

Default =0

Enter the PARK (Portable Access Rights Key) license key of the DECT R4 system. DECT
handset users enter this key when subscribing to the DECT system.

Subscriptions

Default = Disabled

Select the method of subscription supported for handsets subscribing to the DECT R4
system. The options are:

» Disabled:Disables subscription of handsets.

» Auto-Create: Allow anonymous subscription of handsets. Once subscribed, the
handset is assigned a temporary extension number. That extension number can be
confirmed by dialing *#. A new extension number can be specified by dialing
<Extension Number>*<Login Code>#. The Auto-Create Extension and Auto-Create
User settings above should also be enabled. While configured to this mode, Manager
will not allow the manual addition of new IP DECT extensions.

» Preconfigured: Allow subscription only against existing IP DECT extensions records in
the system configuration. The handset IPEI number is used to match the subscribing
handset to a system extension.

Authentication
Code

Default = Blank.

Set an authentication code that DECT handset users should enter when subscribing to
the DECT system.

Enable Resiliency
Default = Off.

Enables resiliency on the IP DECT Line. To configure resiliency, you must also configure an IP Office Line with
Backs up my IP Dect Phones set to On.

Status Enquiry
Period

Default = 30 seconds.

The period between successive verifications on the H.323 channel. The smaller the
interval, the faster the IP DECT system recognizes that IP Office is down.

Prioritize Primary

Default = Off.
Only available when Enable Provisioning is set to On.

Set to On for automatic fail-over recovery. When on, the IP DECT system switches
automatically from the backup IP Office to the "primary" IP Office.

Note that the IP DECT system does not switch back automatically from the backup IP
Office to the primary. The IP DECT system must be manually switched using Web
Manager.

Supervision Default = 120 seconds.
Timeout Only available when Enable Provisioning is set to On.
Table continues. ..
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Line

Field Description
The period of time the IP DECT system will wait between attempts to switch from the
backup IP Office to its "primary" IP Office.
Related links

IP DECT Line on page 301

VolP

Navigation: Line | IP DECT Line | VolP
Used to configure the VoIP setting applied to calls on the IP DECT line.

When creating an IP DECT line, these settings are mergeable. You can also remove an IP DECT
line without rebooting. Changing an IP DECT line that has been imported into the configuration is

not mergeable.

Field

Description

Gateway IP Address

Default = Blank.

not be shared by any other IP line (H.323, SIP, SES or IP DECT).

Enter the IP address of the gateway device at the remote end. This address must

Standby IP Address

Default = Blank.
IP Address of the Standby Master IP Base Station or the second Mirror Base

address.

Station. When the primary Mirror Base Station or Master Base Station is offline the
second Mirror or the Standby Master will take over and the system will use this IP

Codec Selection

Default = System Default

This field defines the codec or codecs offered during call setup. The available
codecs in default preference order are:

* G.711 A-Law
+ G.711 U-LAW
+ G.729

* G.723.1

companding setting. G.723.1 is not supported on Linux based systems.

IP500 VCM V2 or IP500 Combo cards. For Server Edition, it is supported on

Combo.

the lines connecting those systems use the same codecs.

Note that the default order for G.711 codecs varies to match the system's default

The G.722 64K codec is also supported on IP500 V2 systems with IP500 VCM,

Primary Server, Secondary Server and Expansion System (L) systems and on
Expansion System (V2) systems fitted with IP500 VCM, IP500 VCM V2 or IP500

The codecs available in this form are set through the codec list on System | VolP.

Within a network of systems, it is strongly recommended that all the systems and
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Configuration Mode Field Descriptions

Field Description
The options are:

» System Default This is the default setting. When selected, the codec list below
matches the codecs set in the system wide list.

» Custom This option allows specific configuration of the codec preferences to be
different from the system list. When Custom is selected, the list can be used to
select which codecs are in the Unused list and in the Selected list and to
change the order of the selected codecs.

TDM | IP Gain Default = Default (0dB). Range = -31dB to +31dB.

Allows adjustment of the gain on audio from the system TDM interface to the IP
connection. This field is not shown on Linux based platforms.

IP | TDM Gain Default = Default (0dB). Range = -31dB to +31dB.

Allows adjustment of the gain on audio from the IP connection to the system TDM
interface. This field is not shown on Linux based platforms.

VolIP Silence Default = Off.
Suppression

When selected, this option will detect periods of silence on any call over the line
and will not send any data during those silent periods. This feature is not used on
IP lines using G.711 between systems. On trunk's between networked systems,
the same setting should be set at both ends.

Allow Direct Media Path | Default = On

This settings controls whether IP calls must be routed via the system or can be
routed alternatively if possible within the network structure.

« If enabled, IP calls can take routes other than through the system, removing the
need for system resources such as voice compression channels. Both ends of
the calls must support Direct Media and have compatible VoIP settings such as
matching codec, etc. If otherwise, the call will remain routed via the system.
Enabling this option may cause some vendors problems with changing the
media path mid call.

« If disabled, the call is routed via the system. In that case, RTP relay support may
still allow calls between devices using the same audio codec to not require a
voice compression channel.

Related links
IP DECT Line on page 301

SIP Line

IP Office supports SIP voice calls through the addition of SIP lines to the system configuration.
This approach allows users with non-SIP phones to make and receive SIP calls.

Deleting a SIP line requires a “merge with service disruption”. When the configuration file is sent to
the system, the SIP trunk is restarted and all calls on the line are dropped.
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This type of configurat

Line

ion record can be saved as a template and new records created from a

template. See Working with Templates on page 547.

Related links
Line on page 250
SIP Line on page 307
Transport on page 311
SIP URI on page 314
VoIP on page 319
T38 Fax on page 322

SIP Credentials on page 324
SIP Advanced on page 325

Engineering on page 330

SIP Line
Navigation: Line | SIP
Configuration Setti

Line | SIP Line
ngs

These settings are mergeable with the exception of the Line Number setting. Changing the Line
Number setting requires a “merge with service disruption”. When the configuration file is sent to
the system, the SIP trunk is restarted and all calls on the line are dropped.

Field

Description

Line Number

Default = Auto-filled. Range = 1 to 249 (IP500 V2)/349 (Server Edition).

Enter the line number that you wish. Note that this must be unique. On IP500 V2
systems, line numbers 1 to 16 are reserved for internal hardware.

ITSP Domain Name

Default = Blank.

This field is used to specify the default host part of the SIP URI in the From, To,
and R-URI fields for outgoing calls. For example, in the SIP URI

name@example . com, the host part of the URI is example . com. When empty, the
default host is provided by the SIP Line | SIP Transport | ITSP Proxy Address
field value. If multiple addresses are defined in the ITSP Proxy Address field, then
this field must be defined.

For the user making the call, the user part of the From SIP URI is determined by
the settings of the SIP URI channel record being used to route the call (see SIP
Line | SIP URI | Local URI). This will use one of the following:

* a specific name entered in Local URI field of the channel record.

« or specify using the primary or secondary authentication name set for the line
below.

« or specify using the SIP Name set for the user making the call (User | SIP | SIP
Name).

For the destination of the call, the user part of the To and R-URI fields are
determined by dial short codes of the form 9N/N"@example.com” where N is the
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Configuration Mode Field Descriptions

Field

Description

user part of the SIP URI and "@example.com" is optional and can be used to
override the host part of the To and R-URI.

Local Domain Name

Default = Blank.

An IP address or SIP domain name as required by the service provider.
When configured, the Local Domain Name value is used in

+ the From and Contact headers

+ the PAI header, when the setting Line | SIP Line | Advanced | Use Domain for
PAl is checked

* the Diversion header

If both the ITSP Domain Name and the Local Domain Name are configured,
then Local Domain takes precedence.

Local Domain Name is not used in the Remote Party ID header.

URI

Default = SIP.

When SIP or SIPS is selected in the drop-down box, the SIP URI format is used
(for example, name@example.com).

When Tel is selected in the drop-down box, the Tel URI format is used (for
example, +1-425-555-4567). This affects the From field of outgoing calls. The To
field for outgoing calls will always use the format specified by the short codes used
for outgoing call routing. Recommendation: When SIP Secured URI is required,
the URI Type should be set to SIPS. SIPS can be used only when Layer 4 Protocol
is set to TLS.

Location

Default = Cloud.

Specify a location to associate the line with a physical location. Associating a line
with a location:

» Allows emergency services to identify the source of an emergency call.
+ Allows you to configure call admission control settings for the location.

The drop down list contains all locations that have been defined in the System |
Location form.

Prefix

Default = Blank.

This prefix is removed from the called number on outgoing calls if present.

National Prefix

Default = 0.

This prefix is added to calls identified as not being international.

International Prefix

Default = 00.

This prefix is added to calls identified as not being national.

Country Code

Default = Blank.

Set to match the local country code of the system location.

Name Priority

Default = System Default.
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Line

Field

Description

For SIP trunks, the caller name displayed on an extension can either be that
supplied by the trunk or one obtained by checking for a number match in the
extension user's personal directory and the system directory. This setting
determines which method is used by the line. The options are:

» System Default: Use the system setting System | Telephony | Telephony |
Default Name Priority.

» Favor Trunk: Display the name provided by the trunk. For example, the trunk
may be configured to provide the calling number or the name of the caller. The
system should display the caller information as it is provided by the trunk. If the
trunk does not provide a name, the system uses the Favor Directory method.

» Favor Directory: Search for a number match in the extension user's personal
directory and then in the system directory. The first match is used and overrides
the name provided by the SIP line. If no match is found, the name provided by
the line, if any, is used.

Description

Default = Blank. Maximum 31 characters.

Use this field to enter a description of this configuration.

Network Type

Default = Public.

This option is available if System | Telephony | Telephony | Restrict Network
Interconnect is enabled. It allows the trunk to be set as either Public or Private.
The system will return number busy indication to any attempt to connect a call on a
Private trunk to a Public trunk or vice versa. This restriction includes transfers,
forwarding and conference calls.

Due to the nature of this feature, its use is not recommended on systems also
using any of the following other system features: multi-site networks, VPNremote,
application telecommuter mode.

In Service

Default = On.

When this field is not selected, the SIP trunk is unregistered and not available to
incoming and outgoing calls.

Check O0S

Default = On.

If enabled, the system will regularly check if the trunk is in service using the
methods listed below. Checking that SIP trunks are in service ensures that
outgoing call routing is not delayed waiting for response on a SIP trunk that is not
currently usable.

For UDP and TCP trunks, OPTIONS message are regularly sent. If no reply to an
OPTIONS message is received the trunk is taken out of service.

For trunks using DNS, if the IP address is not resolved or the DNS resolution has
expired, the trunk is taken out of service.

Session Timers

Refresh Method

Default = Auto.
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Configuration Mode Field Descriptions

Field

Description

The options are:
* Auto

* Reinvite

* Update

When Auto is selected, if UPDATE is in the Allow: header from the far SIP
endpoint, then it is used. Otherwise INVITE is used.

Timer (seconds)

Default = On Demand. Range = 90 to 64800

This field specifies the session expiry time. At the half way point of the expiry time,
a session refresh message is sent. When set to On Demand, IP Office will not
send a session refresh message but will respond to them.

Redirect and Transfer

Redirection and blind transfer are configured separately. By default, they are disabled.

A supervised transfer occurs when a consultation call is made and the REFER contains a Replaces: header
indicating the CalllD of another call leg which the REFERing agent has already initiated with the REFER target.

° Note:

Do not change these settings unless directed to by the SIP service provider.

Incoming Supervised
REFER

Default = Auto.

Determines if IP Office will accept a REFER being sent by the far end. The options
are:

» Always: Always accepted.

» Auto: If the far end does not advertise REFER support in the Allow: header of
the OPTIONS responses, then IP Office will reject a REFER from that endpoint.

* Never: Never accepted.

Outgoing Supervised
REFER

Default = Auto.

Determines if IP Office will attempt to use the REFER mechanism to transfer a
party to a call leg which IP Office has already initiated so that it can include the
CalllD in a Replaces: header. The options are:

» Always: Always use REFER.

» Auto: Use the Allow: header of the OPTIONS response to determine if the
endpoint supports REFER.

¢ Never: Never use REFER.

Send 302 Moved
Temporarily

Default = Off.

A SIP response code used for redirecting an unanswered incoming call. It is a
response to the INVITE, and cannot be used after the 200 OK has been sent as a
response to the INVITE.

Outgoing Blind REFER

Default = Off.
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Line

Field Description

When enabled, a user, voicemail system or IVR can transfer a call by sending a
REFER to an endpoint that has not set up a second call. In this case, there is no
Replaces: header because there is no CalllD to replace the current one. This
directs the far end to perform the transfer by initiating the new call and release the
current call with IP Office.

Related links
SIP Line on page 306

Transport
Navigation: Line | SIP Line | Transport

Behavior during Service unavailable

A proxy server is considered Active once the system has received a response to an INVITE,
REGISTER or OPTIONS.

In the case of the proxy server responding with 503 - Service Unavailable, it should be considered
Active - In Maintenance. In this case, the following should occur:

If the response 503 - Service Unavailable was in response to an INVITE request:

« If calls are tied to registrations (Calls Route via Registrar enabled) and there are other
proxies available, the tied registrations should issue an Un-REGISTER and try to REGISTER
with a different proxy. The call should fail with cause = Temporary Fail.

« If calls are not tied, the INVITE should be immediately tried to a different proxy.
If the response 503 - Service Unavailable was in response to a REGISTER request:

* If there are other proxies available, this registration only should issue an Un-REGISTER and
try to REGISTER with a different proxy.

« If Explicit DNS Server(s) are configured, a DNS request should be sent out to see whether
the proxy server has disappeared from those being offered.

An Active-InMaintenance proxy server should not be used for a new transactions (INVITE or
REGISTER) until:

» There is a change in DNS responses indicating the proxy has become active.

» The configuration does not leave any better option available. In this case, there should be a
throttle so that no more than 5 failures (without successes) in 1 minute should be allowed.

* A configuration merge has occurred where the ITSP Proxy Address has been changed.
* 10 minutes has expired.
Behavior during Not Responding

A proxy server that is not-responding (UDP) is indicated when 3 requests are sent and no replies
are received. This would normally occur during a single INVITE transaction.

Consideration should be given whether this is caused by a local network fault or is caused by the
Proxy being out of service. Since it is likely to be local, no action should be taken unless traffic is
received from an alternative proxy while this proxy is actually not responding. The state should be
"Possibly non responding".
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Configuration Mode Field Descriptions

If explicit DNS servers are configured, a DNS request should be sent out to see whether this
Proxy server has disappeared from those being offered.

If possible, an alternative proxy should be stimulated simultaneously with stimulating the suspect

server.

The server should be considered non-responding if it is persistently non-responding while other
proxies are responding or if it is non-responding and has disappeared from the DNS

advertisement.

While in the "possibly not responding" state, it would be better to send an INVITE to an alternative
proxy while simultaneously sending any appropriate message to this proxy. This will help to
resolve whether it is really not responding rather than there being local network problems.
However, there is no requirement to blacklist the proxy.

Once in the "definitely not responding"” state:

+ If there are other proxies available: this registration only issues an Un-REGISTER, and try to
REGISTER with a different proxy. Calls do not automatically clear.

* If a SIP message is received from it, the state should immediately go"Active".

 This proxy should be blacklisted unless there are no better options available. While
blacklisted, only one transaction per 10 minutes is allowed.

» Even if not blacklisted, there should be a throttle so that no more than 5 failures (without
successes) in 1 minute should be allowed.

Configuration settings

The ITSP Proxy Address and Calls Route via Registrar settings are mergeable. Changing the
remaining settings requires a “merge with service disruption”. When the configuration file is sent to
the system, the SIP trunk is restarted and all calls on the line are dropped.

Field

Description

ITSP Proxy Address

Default = Blank

This is the SIP Proxy address used for outgoing SIP calls. The address can be
specified in the following ways:

« If left blank, the ITSP Domain Name is used and is resolved by DNS resolution in
the same way as if a DNS address had been specified as below.

* An IP address.
» Alist of up to 4 IP addresses, with each address separated by a comma or space.

- The addresses can include an indication of the relative call weighting of each
address compared to the others. This is done by adding a w N suffix to the
address where N is the weighting value. For example, in the list 213.74.81.102w3
213.74.81.100w2, the weighting values assigns 1.5 times the weight of calls to the
first address. The default weight if not specified is 1. A weight of 0 can be used to
disable an address. Weight is only applied to outgoing calls.

If there is more than one proxy defined, and no weight indication, then calls are
only sent to the first in the list until there is a failure at which point the next proxy is
used.
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Line

Field

Description

- If the Calls Route via Registrar setting below is enabled, the weighting is applied
to registrations rather than calls.

* A DNS address, for example sbc.example.com.

- The DNS response may return multiple proxy addresses (RFC 3263). If that is the
case, the system will resolve the address to use based on priority, TTL and
weighting information included with each address.

- A load balancing suffix can be added to specify that multiple proxy results should
be returned if possible, for example sbc.example.com(N). where N is the required
number of addresses from 1 to 4.

This field is mergeable. However, no more than 4 IP Addresses should be in use at
any time. So, if the combined new and old address settings exceed 4, the new
addresses are only phased into use as transactions in progress on the previous
addresses are completed.

Network Configuration

Layer 4 Protocol

Default = UDP.

The options are:

+ TCP

+ UDP

* TLS

* Auto

TLS connections support the following ciphers:
* TLS_RSA_WITH_AES_128_CBC_SHA

+ TLS_RSA_WITH_AES_256_CBC_SHA

* TLS_DHE_RSA_WITH_AES_128_CBC_SHA
+ TLS_DHE_RSA_WITH_AES_256_CBC_SHA

Use Network
Topology Info

Default = None.

This field associates the SIP line with the LAN interface System | LAN | Network
Topology settings. It also applies the System | LAN | VoIP | DiffServ Settings to the
outgoing traffic on the SIP line. If None is selected, STUN lookup is not applied and
routing is determined by the system's routing tables.

If no STUN server address is set for the interface, then the System | LAN | Network
Topology | Binding Refresh Time is ignored by SIP Lines when calculating the
periodic OPTIONS timing unless the Firewall/NAT Type is set to Open Internet.

Send Port When Network Configuration is set to TLS, the default setting is 5061. When Network
Configuration is set to TCP or UDP, the default setting is 5060.
Listen Port When Network Configuration is set to TLS, the default setting is 5061. When Network
Configuration is set to TCP or UDP, the default setting is 5060.
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Field Description
Explicit DNS Default = 0.0.0.0 (Off)
Server(s)

If specific DNS servers should be used for SIP trunk operation rather than the general
DNS server specified or obtained for the system, the server addresses can be
specified here. If exported or imported as part of a trunk template.

Calls Route via Default = On

Registrar If selected, all calls are routed via the same proxy as used for registration. If multiple

ITSP proxy addresses have been specified, there is no load balancing of registrations.

Separate Registrar Default = Blank

This field allows the SIP registrar address to be specified if it is different from that of
the SIP proxy. The address can be specified as an IP address or DNS name.

Related links
SIP Line on page 306

SIP URI
Navigation: Line | SIP Line | SIP URI

Having setup the SIP trunk to the SIP ITSP, the SIP URI's registered with that ITSP are entered on
this tab. A SIP URI (Uniform Resource Identifier) is similar to an internet email address and
represents the source or destination for SIP connection. The URI consists of two parts, the user
part (name) and the host part (example.com).

SIP URI records are used to describe content of SIP headers when working with various ITSPs,
since they use these SIP headers for various purposed and match them to IP Office interpretation
of this headers. For incoming calls, headers in the SIP message must match the headers
described in the appropriate URI. For outgoing calls, IP Office internal displays and calling/called
numbers are mapped to appropriate headers in a way provider expects them to be formatted.

If the Auto setting is used in the SIP trunk's Local URI, Contact and Display fields, that SIP trunk
will accept any incoming SIP call. The incoming call routing is still performed by the system
incoming call routes based on matching the values received with the call or the URI's incoming
group setting. On outgoing calls, Auto passes the calling and called party numbers from IP Office
call unchanged to the SIP provider. The Auto setting has replaced the wildcard * used in previous
releases.

For outgoing calls using this SIP URI, all valid short code CLI manipulations are used
(transforming calling party number to ISDN will be ignored). For a full list of valid CLI
manipulations, see “Telephone Number Field Characters” in the chapter “Short Code Overview”.
For example, character ‘i’ is not supported since it sets calling party number plan to isdn and
number type to national.

For the system, each SIP URI acts as a set of trunk channels. Outgoing calls can then be routed
to the required URI by short codes that match that URI's Outgoing Group setting. Incoming calls
can be routed by incoming call routes that match the URI's Incoming Group setting.

Note that the system only supports up to 150 URI records on a SIP line.
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Line

Configuration Settings

These settings require a “merge with service disruption”. When the configuration file is sent to the
system, the SIP trunk is restarted and all calls on the line are dropped.

Field

Description

Via

This field is for information only and cannot be edited. It shows the IP address of the
system LAN interface with which the SIP trunk is associated.

Local URI

Default = Auto

This field sets the 'From' field for outgoing SIP calls using this URI. The value can
either be entered manually or one of the following options can be selected:

» Use Credentials User Name: Use the value Line | SIP Line | SIP Credentials |
User Name for the user making the call.

» Use Internal Data: Use the value User | SIP | Display Name (Alias) for the user
making the call.

The system can also use
- Group | SIP | SIP Display Name (Alias) for a group
- System | Voicemail | SIP Display Name (Alias) for voicemail

» Use Credential Authentication Name: Use the value Line | SIP Line | SIP
Credentials | Authentication Name.

» Use Credentials Contact: Use the value Line | SIP Line | SIP Credentials |
Contact.

» Auto: Use the number that IP Office is using to make the call as the From field. The
number will be aligned with IP Office internal numbering schema.

The Auto setting has replaced the wildcard * used in previous releases.

Contact

Default = Auto

This field sets the 'Contact' field for SIP calls using this URI. The value can either be
entered manually or one of the following options can be selected:

» Use Credentials User Name: Use the value Line | SIP Line | SIP Credentials |
User Name for the user making the call.

» Use Internal Data: Use the value User | SIP | Display Name (Alias) for the user
making the call.

The system can also use
- Group | SIP | SIP Display Name (Alias) for a group
- System | Voicemail | SIP Display Name (Alias) for voicemail

* Use Credential Authentication Name: Use the value Line | SIP Line | SIP
Credentials | Authentication Name.

» Use Credentials Contact: Use the value Line | SIP Line | SIP Credentials |
Contact.

» Auto: Use the number that IP Office is using to make the call as the From field. The
number will be aligned with IP Office internal numbering schema.
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Field Description
The Auto setting has replaced the wildcard * used in previous releases.
Display Name Default = Auto
This field sets the '"Name' value for SIP calls using this URI. The value can either be
entered manually or one of the following options can be selected:
» Use Credentials User Name: Use the value Line | SIP Line | SIP Credentials |
User Name for the user making the call.
» Use Internal Data: Use the value User | SIP | Display Name (Alias) for the user
making the call.
The system can also use
- Group | SIP | SIP Display Name (Alias) for a group
- System | Voicemail | SIP Display Name (Alias) for voicemail
» Use Credential Authentication Name: Use the value Line | SIP Line | SIP
Credentials | Authentication Name.
* Use Credentials Contact: Use the value Line | SIP Line | SIP Credentials |
Contact.
» Auto: Use the number that IP Office is using to make the call as the From field. The
number will be aligned with IP Office internal numbering schema.
The Auto setting has replaced the wildcard * used in previous releases.
Identity
Identity Default = None.
You can enable P-Asserted-Identity (PAI) headers to assert the identity of users in
outgoing SIP requests or response messages. Use this setting to select the source of
the user identity information or enter a value manually.
© Note:
You can enter the wildcard character “*”. Entering this value populates the SIP
PAI header with the caller information available to IP Office.
The options are:
* None
» Use Credentials User Name: Use the value Line | SIP Line | SIP Credentials |
User Name for the user making the call.
» Use Internal Data: Use the value User | SIP | Display Name (Alias) for the user
making the call.
The system can also use
- Group | SIP | SIP Display Name (Alias) for a group
- System | Voicemail | SIP Display Name (Alias) for voicemail
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Line

Field

Description

» Use Credential Authentication Name: Use the value Line | SIP Line | SIP
Credentials | Authentication Name.

» Use Credentials Contact: Use the value Line | SIP Line | SIP Credentials |
Contact.

Header

Default = P Asserted ID.
The options are:

» P Asserted ID: When selected, identity information is provided in the P Asserted
Identity header of SIP messages.

» P Preferred ID: When selected, identity information is provided in the P Preferred
Identity header of SIP messages.

Forwarding and Twinn

ing

Originator number

Default = Blank.

This field can be used to set an originator number for forwarded and twinned calls
when using any of the Send Caller ID options above other than None. If exported or
imported as part of a trunk template.

Send Caller ID

Default = None.

Set the type of header for to use for the originating calling party information. The
options are:

 Diversion Header: Use the information from the Diversion Header.

» P Asserted ID: Use the information from the P Asserted ID header.

* Remote Party ID: Use the information from the Remote Party ID header.
* P Preferred ID: Use the contact information from the P Preferred ID.

* None: This option corresponds to the ISDN withheld setting.

This setting is also used for forwarded calls. For incoming calls to a hunt group, the
hunt group details will be provided and not the details of the answering agent. This
setting is mergeable.

The SIP line Send Caller ID setting takes priority.

Diversion Header

Default = None.

Sets the Diversion header for outgoing SIP calls using this URI. The value can either
be entered manually or one of the following options can be selected:

* None

» Use Credentials User Name: Use the value Line | SIP Line | SIP Credentials |
User Name for the user making the call.

» Use Internal Data: Use the value User | SIP | Display Name (Alias) for the user
making the call.
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Field

Description

The system can also use
- Group | SIP | SIP Display Name (Alias) for a group
- System | Voicemail | SIP Display Name (Alias) for voicemail

» Use Credential Authentication Name: Use the value Line | SIP Line | SIP
Credentials | Authentication Name.

» Use Credentials Contact: Use the value Line | SIP Line | SIP Credentials |
Contact.

« Auto: Use the caller information available to IP Office.

Registration

Default = 0:<None>

This field is used to select from a list of the account credentials configured on the line's
SIP Credentials tab.

Incoming Group

Default = 0, Range 0 to 99999.
Enter a numeric value or select None .

The Incoming Group ID to which a line belongs is used to match it to incoming call
routes in the system configuration. The matching incoming call route is then used to
route incoming calls. The same ID can be used for multiple lines.

Selecting None indicates that this SIP URI will not be used for incoming calls.

Outgoing Group

Default = Previous external line + 1, Range 0 to 99999.
Enter a numeric value or select None .

Short codes that specify a number to dial can also specify the line group to be used.
The system will then seize a line from those with the matching Outgoing Group ID.

In a Server Edition network, the Outgoing Group ID used must be unique within the
network. The same ID cannot be used in the configuration of any lines on another
server system in the network. For non-Server Edition deployments, the same ID can
be used for multiple lines.

Selecting None indicates that this SIP URI will not be used for incoming calls.
Reserved Group ID Numbers:
* 90000 - 99999 Reserved for system use (not enforced).

* 99999 and 99998 In a Server Edition network, reserved for the IP Office lines to the
Primary Server and Secondary Server respectively.

* 99901 to 99930 In a Server Edition network, reserved for the IP Office lines from the
Primary Server to each expansion system in the network.

¢ 0 In a Server Edition network, the ID 0 cannot be used.

98888 For IP Office deployed in an Enterprise Branch environment, reserved for the
SM line.
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Line

Field Description
Max Calls Default =10 This field sets the maximum number of simultaneous calls that can use
the URI before the system returns busy to any further calls. For capacity information,
see Deploying Avaya IP Office™ Platform Server Edition.
Related links

SIP Line on page 306

VolP

Navigation: Line | SIP Line | VolIP

This form is used to configure the VoIP settings applied to calls on the SIP trunk.

Configuration Settings

These settings are mergeable. Changes to these settings do not require a reboot of the system.

Field

Description

Codec Selection

Default = System Default

This field defines the codec or codecs offered during call setup. The available codecs
in default preference order are:

* G.711 A-Law
+ G.711 U-LAW
+ G.729

* G.723.1

Note that the default order for G.711 codecs varies to match the system's default
companding setting. G.723.1 is not supported on Linux based systems.

The G.722 64K codec is also supported on IP500 V2 systems with IP500 VCM, IP500
VCM V2 or IP500 Combo cards. For Server Edition, it is supported on Primary
Server, Secondary Server and Expansion System (L) systems and on Expansion
System (V2) systems fitted with IP500 VCM, IP500 VCM V2 or IP500 Combo.

The codecs available in this form are set through the codec list on System | VolP.

Within a network of systems, it is strongly recommended that all the systems and the
lines connecting those systems use the same codecs.

The options are:

» System Default This is the default setting. When selected, the codec list below
matches the codecs set in the system wide list.

» Custom This option allows specific configuration of the codec preferences to be
different from the system list. When Custom is selected, the list can be used to
select which codecs are in the Unused list and in the Selected list and to change
the order of the selected codecs.

Fax Transport Default = Off.
Support
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Field Description
This option is only available if Re-Invite Supported is selected.
IP500 V2 systems can terminate T38 fax calls. IP Office Linux systems can route the
calls between trunks/terminals with compatible fax types. If the media is routed by IP
Office between trunks/terminals with incompatible fax types or if fax is terminated by
IP Office, IP Office will detect fax tones and renegotiate the call as needed.
This setting must be configured based on what is supported by the SIP ATA. The
options are:
* None Select this option if fax is not supported by the line provider.
* G.711 G.711 is used for the sending and receiving of faxes.
+ T38 T38 is used for the sending and receiving of faxes.
» T38 Fallback When you enable this option, T38 is used for sending and receiving
faxes on a SIP line. If the called destination does not support T38, the system will
send a re-invite to change the transport method to G.711.
DTMF Support Default = RFC2833.

This setting is used to select the method by which DTMF key presses are signalled to
the remote end. The options are:

 In Band: Send DTMF digits as part of the audio path.

* RFC2833: Send DTMF digits using a separate audio stream from the voice path.
Note that use of RFC2833 is negotiated with the remote end of the call. If not agreed
or not supported, the line reverts to using in band signalling.

* Info: Send the DTMF digits in SIP INFO packets.

Media Security

Default = Disabled.

These setting control whether SRTP is used for this line and the settings used for the
SRTP. The options are:

» Same as System: Matches the system setting at System | VolP Security.

» Disabled: Media security is not required. All media sessions (audio, video, and
data) will be enforced to use RTP only.

» Preferred: Media security is preferred. Attempt to use secure media first and if
unsuccessful, fall back to non-secure media.

» Enforced: Media security is required. All media sessions (audio, video, and data)
will be enforced to use SRTP only.

A Warning:

Selecting Enforced on a line or extension that does not support media security
will result in media setup failures.

Advanced Media

Not displayed if Media Security is set to Disabled. The options are:

Security Options + Same as System: Use the same settings as the system setting configured on
System | VoIP Security.
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Line

Field

Description

* Encryptions: Default = RTP This setting allows selection of which parts of a media
session should be protected using encryption. The default is to encrypt just the RTP
stream (the speech).

» Authentication: Default = RTP and RTCP This setting allows selection of which
parts of the media session should be protected using authentication.

* Replay Protection SRTP Window Size: Default = 64. Currently not adjustable.

* Crypto Suites: Default = SRTP_AES_CM_128 SHA1_80. There is also the option
to select SRTP_AES_CM_128_SHA1_32.

VolIP Silence
Suppression

Default = Off

When selected, this option will detect periods of silence on any call over the line and
will not send any data during those silent periods. This feature is not used on IP lines
using G.711 between systems. On trunks between networked systems, the same
setting should be set at both ends.

Local Hold Music

Default = Off.

When enabled, if the far end puts the call on HOLD, the system plays music received
from far end (SIP Line) to the other end. RTCP reports are sent towards SIP Line.
When disabled, the system plays local music to the other endpoint and no RTCP
packets are sent to SIP trunk.

Re-Invite Supported

Default = Off.

When enabled, Re-Invite can be used during a session to change the characteristics
of the session. For example when the target of an incoming call or a transfer does not
support the codec originally negotiated on the trunk. Requires the ITSP to also
support Re-Invite. This setting must be enabled for video support.

Codec Lockdown

Default = Off.

Supports RFC 3264 Section 10.2 when RE-Invite Supported is enabled. In response
to a SIP offer with a list of codecs supported, some SIP user agents supply a SDP
answer that also lists multiple codecs. This means that the user agent may switch to
any of those codecs during the session without further negotiation. The system does
not support multiple concurrent codecs for a session, so loss of speech path will occur
if the codec is changed during the session. If codec lockdown is enabled, when the
system receives an SDP answer with more than one codec from the list of offered
codecs, it sends an extra re-INVITE using just a single codec from the list and
resubmits a new SDP offer with just the single chosen codec.

Allow Direct Media
Path

Default = On

This settings controls whether IP calls must be routed via the system or can be routed
alternatively if possible within the network structure.

« If enabled, IP calls can take routes other than through the system, removing the
need for system resources such as voice compression channels. Both ends of the
calls must support Direct Media and have compatible VolIP settings such as
matching codec, etc. If otherwise, the call will remain routed via the system.
Enabling this option may cause some vendors problems with changing the media
path mid call.
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Field Description
« If disabled, the call is routed via the system. In that case, RTP relay support may still
allow calls between devices using the same audio codec to not require a voice
compression channel.
PRACK/100rel Default = Off.
Supported

When selected, supports Provisional Reliable Acknowledgement (PRACK) on SIP
trunks. Enable this parameter when you want to ensure that provisional responses,
such as announcement messages, have been delivered. Provisional responses
provide information on the progress of the request that is in process. For example,
while a cell phone call is being connected, there may be a delay while the cell phone
is located; an announcement such as “please wait while we attempt to reach the
subscriber” provides provisional information to the caller while the request is in
process. PRACK, which is defined in RFC 3262, provides a mechanism to ensure the
delivery of these provisional responses.

Force direct media
with phones

Default = On

The setting is only available when the trunk's Re-invite Supported and Allow Direct
Media Path settings are enabled and its DTMF Support option is set to RFC2833/
RFC4733. It also requires the H.323 IP extension involved in the call to also have
Allow Direct Media Path enabled. This feature is only supported with Avaya H.323 IP
telephones. For calls where the Avaya H.323 IP extension using the trunk is doing so
as a direct media call, this feature allows digits pressed on the extension to be
detected and the call changed to an indirect media call so that RFC2833 DTMF can
be sent. The call remains as an indirect media call for 15 seconds after the last digit
before reverting back to being a direct media call.

G.711 Fax ECAN

Default = Off

This setting is only available on IP500 V2 systems when Fax Transport Support is
set to G.711 or T.38 Fallback. When IP Office detects a fax call, the IP Office
negotiates to G.711 (if not already in G.711) and reconfigures the connection with
echo cancellation (ECAN) based on the 'G.711 Fax ECAN field. This can be used to
avoid an ECAN mismatch with the SIP trunk service provider. Also for fax calls, the
connection’s NLP is disabled, a fixed jitter buffer is set and silence suppression is
disabled.

Related links

SIP Line on page 306

T38 Fax

Navigation: Line | SIP Line | T38 Fax

The settings are available only on IP500 V2 since it can terminate T38 fax. On the VoIP settings
for the line type, Fax Transport Support must be set to T38 or T38 Fallback.

These settings are mergeable.

Field

Description

Use Default Values Default = On.
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Line

Field

Description

If selected, all the fields are set to their default values and greyed out.

T38 Fax Version

Default = 3.

During fax relay, the two gateways will negotiate to use the highest version which
they both support. The options are:

0
1
° 2
3
Transport Default = UDPTL (fixed).
Only UDPTL is supported. TCP and RTP transport are not supported. For
UDPTL, redundancy error correction is supported. Forward Error Correction
(FEC) is not supported.
Redundancy

Redundancy sends additional fax packets in order to increase the reliability. However increased
redundancy increases the bandwidth required for the fax transport.

Low Speed Default = 0 (No redundancy). Range = 0 to 5.
Sets the number of redundant T38 fax packets that should be sent for low speed
V.21 T.30 fax transmissions.

High Speed Default = 0 (No redundancy). Range = 0 to 5.
Sets the number of redundant T38 fax packets that should be sent for V.17, V.27
and V.28 fax transmissions.

TCF Method Default = Trans TCF. TCF = Training Check Frame.

Max Bit Rate (bps)

Default = 14400.

Lower rates can be selected if the current rate is not supported by the fax
equipment or is found to not be reliable.

EFlag Start Timer
(msecs)

Default = 2600.

EFlag Stop Timer
(msecs)

Default = 2300.

Tx Network Timeout | Default = 150.
(secs)

Scan Line Fix-up Default = On.
TFOP Enhancement | Default = On.
Disable T30 ECM Default = Off.

When selected, disabled the T.30 Error Correction Mode used for fax
transmission.
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Field Description
Disable EFlags For | Default = Off.
First DIS

Disable T30 MR Default = Off.
Compression

NSF Override Default = Off.

If selected, the NSF (Non-Standard Facility) information sent by the T38 device
can be overridden using the values in the fields below.

Country Code: Default = 0.
Vendor Code: Default = 0.

Related links

SIP Line on page 306

SIP Credentials

Navigation: Line | SIP Line | SIP Credentials

Used to enter the ITSP username and password for the SIP account with the ITSP. If you have
several SIP accounts going to the same ITSP IP address or domain name, you can enter up to 30
sets of ITSP account names and passwords on this tab.

Use the Add, Remove, and Edit buttons to manage the set of credentials for the SIP trunk
accounts. The settings for each account are listed below.

Configuration Settings

These settings are mergeable. Changes to these settings do not require a reboot of the system.

Field Descriptions

Index This number is assigned automatically and cannot be edited. If the From field on the
SIP URI being used for the call is set to Use Authentication Name , the registration
field of the SIP URI will indicate the index number of the SIP credentials to use for calls
by that SIP URI.

User Name This name must be unique and is used to identify the trunk. The name can include the

domain if necessary.

Authentication Name

Default = Blank.

This field can be blank but must be completed if a Password is also specified. This
value is provided by the SIP ITSP. Depending on the settings on the Local URI tab
associated with the SIP call, it may also be used as the user part of the SIP URI. The
name can include the domain if necessary.

Contact Default = Blank.
This field is used to enter a contact and can include the domain if necessary.
Password Default = Blank.
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Line

Field Descriptions
This value is provided by the SIP ITSP. If a password is specified, the matching
Authentication Name must also be set.

Expiry Default = 60 minutes.

This setting defines how often registration with the SIP ITSP is required following any
previous registration.

Registration
Required

Default = On.

If selected, the fields above above are used for registration when making calls. If
exported or imported as part of a trunk template.

Related links

SIP Line on page 306

SIP Advanced

Navigation: Line | SIP Line | SIP Advanced
Additional configuration information

For additional information regarding the Media Connection Preservation setting, see Media
Connection Preservation on page 589.

Configuration settings

These settings are mergable, with the exception of the Media Connection Preservation setting.
Changing the Media Connection Preservation setting requires a “merge with service disruption”.
When the configuration file is sent to the system, the SIP trunk is restarted and all calls on the line

are dropped.

Field

Description

Addressing

Association Method

Default = By Source IP Address.

This setting sets the method by which a SIP line is associated with an incoming SIP
request.

The match criteria used for each line can be varied. The search for a line match for an
incoming request is done against each line in turn using each lines Association
Method. The order of line matching uses the configured Line Number settings until a
match occurs. If no match occurs the request is ignored. This method allows multiple
SIP lines with the same address settings. This may be necessary for scenarios where
it may be required to support multiple SIP lines to the same ITSP. For example when
the same ITSP supports different call plans on separate lines or where all outgoing
SIP lines are routed from the system via an additional on-site system. The options are:

» By Source IP Address: This option uses the source |P address and port of the
incoming request for association. The match is against the configured remote end of
the SIP line, using either an IP address/port or the resolution of a fully qualified
domain name.
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Field

Description

* "From" header hostpart against ITSP domain: This option uses the host part of
the From header in the incoming SIP request for association. The match is against
the ITSP Domain Name above.

* R-URI hostpart against ITSP domain: This option uses the host part of the
Request-URI header in the incoming SIP request for association. The match is
against the ITSP Domain Name above.

» "To" header hostpart against ITSP domain: This option uses the host part of the
To header in the incoming SIP request for association. The match is against the
ITSP Domain Name above.

* "From" header hostpart against DNS-resolved ITSP domain: This option uses
the host part of the FROM header in the incoming SIP request for association. The
match is found by comparing the FROM header against a list of IP addresses
resulting from resolution of the ITSP Domain Name above or, if set, the Line | SIP
Line | Transport | ITSP Proxy Address setting.

* "Via" header hostpart against DNS-resolved ITSP domain: This option uses the
host part of the VIA header in the incoming SIP request for association. The match
is found by comparing the VIA header against a list of IP addresses resulting from
resolution of the ITSP Domain Name above or, if set, the Line | SIP Line |
Transport | ITSP Proxy Address setting.

* "From" header hostpart against ITSP proxy: This option uses the host part of the
“From” header in the incoming SIP request for association. The match is against the
Line | SIP Line | Transport | ITSP Proxy Address setting.

» "To" header hostpart against ITSP proxy: This option uses the host part of the
From header in the incoming SIP request for association. The match is against the
Line | SIP Line | Transport | ITSP Proxy Address setting.

* R-URI hostpart against ITSP proxy: This option uses the host part of the Request-
URI in the incoming SIP request for association. The match is against the Line | SIP
Line | Transport | ITSP Proxy Address setting.

Call Routing Method

Default = Request URI.

This field allows selection of which incoming SIP information should be used for
incoming number matching by the system's incoming call routes. The options are to
match either the Request URI or the To Header element provided with the incoming
call.

Suppress DNS SRV
Lookups

Default = Off.

Controls whether to send SRV queries for this endpoint, or just NAPTR and A record
queries.

Identity

Use Phone Context

Default = Off.

When set to On, signals SIP enabled PBXs that the call routing identifier is a
telephone number.

Add user=phone

Default = Off.
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Line

International

Field Description
This setting is available when Use Phone Context is set to On.
This setting adds the SIP parameter user with value phone to the From and To SIP
headers in outgoing calls.

Use + for Default = Off.

When set to On, outgoing international calls use E.164/International format with a ‘+’
followed by the country code and then the directory number.

Use PAI for Privacy

Default = Off.

When set to On, if the caller ID is withheld, the SIP message From: header is made
anonymous, and the caller’s identity, for admission control, billing, and emergency
services, is inserted into the P-Asserted-ldentity header. This mechanism should only
be used in a trusted network and must be stripped out of the SIP message before it is
forwarded outside the trusted domain.

Use Domain for PAI

Default = Off.

When set to Off, the DNS resolved IP address of the ITSP Proxy is used for the host
part in the P-Asserted-ldentity header. When set to On, the the Domain for PAl is
used.

Swap From and PAI/
Diversion

Default = Off.

When set to on, swaps the values in the From: and P-Asserted-ldentity headers, as
required by some networks.

0 Important:

This setting is ignored if the line contains at least one SIP URI with both
Diversion and PAI header defined.

Caller ID FROM
Header

Default = Off.

Incoming calls can include caller ID information in both the From field and in the PAI
fields. When this option is selected, the caller ID information in the From field is used
rather than that in the PAl fields.

Send From In Clear

Default = Off.

When selected, the user ID of the caller is included in the From field. This applies
even if the caller has selected to be or is configured to be anonymous, though their
anonymous state is honored in other fields used to display the caller identity.

Cache Auth
Credentials

Default = On.

When set to On, allows the credentials challenge and response from a registration
transaction to be automatically inserted into later SIP messages without waiting for a
subsequent challenge.

Add UUI header

Default — Off.

When set to On, the User-to-User Information (UUI) is passed in SIP headers to
applications.

Add UUI header to Default — Off.
redirected calls
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Server Headers

Field Description
When set to On, the UUI is passed in SIP headers for calls that are redirected, for
example, forwarded calls, twinned calls. This field can be modified only if the Add UUI
header is set to On.

User-Agent and Default = Blank (Use system type and software level).

The value set in this field is used as the User-Agent and Server value included in SIP
request headers made by this line. If the field is blank, the type of IP Office system
and its software level used. Setting a unique value can be useful in call diagnostics
when the system has multiple SIP trunks.

Send Location Info

Default = Never.
The options are:
¢ Never: Do not send location information.

* Emergency Calls: When set to Emergency Calls, the location defined at Location
| Address is sent as part of the INVITE message when emergency calls are made.

Media

Allow Empty INVITE

Default = Off.

When set to On, allows 3pcc devices to initiate calls to IP Office by sending an INVITE
without SDP.

Send Empty re-
INVITE

Default = Off.

This option is only available if Line | SIP Line | VoIP | Re-Invite Supported is
selected.

If set to On, when connecting a call between two endpoints, IP Office sends an
INVITE without SDP in order to solicit the full media capabilities of both parties.

Allow To Tag Change

Default = Off.

When set to On, allows the IP Office to change media parameters when connecting a
call to a different party than that which was advertised in the media parameters of
provisional responses, such as 183 Session Progress.

P-Early-Media
Support

Default = None.
The options are:

* None: IP Office will not advertise support of this SIP header and will always take
incoming early media into account regardless of presence of this header

* Receive: IP Office will advertise support of this SIP header and will discard
incoming early media unless this header is present in the sip message.

« All: IP Office will advertise support of this sip header, will discard incoming early
media unless this header is present in the sip message and will include this sip
header when providing early media.

Send
SilenceSupp=off

Default = Off.

Used for the G711 codec. When checked, the silence suppression off attribute is sent
in SDP on this trunk.
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Line

Field

Description

Force Early Direct
Media

Default = Off.

When set to On, allows the direct connection of early media streams to IP endpoints
rather than anchoring it at the IP Office.

Media Connection
Preservation

Default = Disabled.

When enabled, allows established calls to continue despite brief network failures. Call
handling features are no longer available when a call is in a preserved state.
Preservation on public SIP trunks is not supported until tested with a specific service
provider.

Indicate HOLD

Default = Off.
When enabled, the system sends a HOLD INVITE to the SIP trunk endpoint.

Call Control

Call Initiation Timeout

(s)

Default = 4 seconds. Range = 1 to 99 seconds.

Sets how long the system should wait for a response to its attempt to initiate a call
before following the alternate routes set in an ARS form.

Call Queuing Timeout

(m)

Default = 5 minutes.

For incoming calls, how many minutes to wait before dropping a call that has been
queued waiting for a free VCM resource, or has remained in the unanswered state.

For outgoing calls, how many minutes to wait for the call to be answered after
receiving a provisional response.

Service Busy

Default = 486 - Busy Here (503 - Service Unavailable for the France2 locale).

Responding Send

FEHPEITER For calls that result in a busy response from IP Office, this setting determines the
response code. The options are:
* 486 - Busy Here
* 503 - Service Unavailable

on No User Default = 408-Request Timeout.

Specifies the cause to be used when releasing incoming calls from SIP trunks, when
the cause of releasing is that user did not respond. The options are 408-Request
Timeout or 480 Temporarily Unavailable.

Action on CAC
Location Limit

Default = Allow Voicemail

When set to Allow Voicemail, the call is allowed to go to a user's voicemail when the
user's location call limit has been reached. When set to Reject Call, the call is
rejected with the failure response code configured in the Service Busy Response
field.

Suppress Q.850
Reason Header

Default = Off.

When SIP calls are released by sending BYE and CANCEL, a release reason header
is added to the message. When set to On, the Q.850 reason header is not included.
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Field Description
Emulate NOTIFY for Default = Off.
REFER

Use for SIP providers that do not send NOTIFY messages. When set to On, after IP
Office issues a REFER, and the provider responds with 202 ACCEPTED, IP Office will
assume the transfer is complete and issue a BYE.

No REFER if using Default = Off.
Diversion

When enabled, REFER is not sent on the trunk if the forwarding was done with 'Send
Caller ID = Diversion Header'. Applies to Forwards and Twinning.

Related links
SIP Line on page 306

Engineering
Navigation: Line | SIP Line | Engineering

This page is used to enter values that apply special features to the SIP line. These are entered
using the Add, Edit and Remove buttons.

These settings are mergeable. Changes to these settings do not require a reboot of the system.

Related links
SIP Line on page 306

SIP DECT Line

A SIP DECT line can be manually added. SIP DECT lines are used to manage D100 Base Station
operation.

Related links
Line on page 250
SIP DECT Base on page 330
VolIP on page 331

SIP DECT Base

Navigation: Line | SIP DECT Line | SIP DECT Base
Currently, IP Office supports four D100 Base Stations.

These settings are not mergeable. Changes to these settings requires a reboot of the system.

Field Description
Line Number Default = Blank. A unique line number associated with the SIP DECT Base Station.
Associated Extensions are other extensions that can log into the base station.
Base Name Default = Blank. Maximum 16 characters.
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Line

Field Description
A name assigned to the base station. Each base station provisioned on the IP Office must
have a unique name. The field cannot be blank. The format is an alphanumeric string with
no special characters.

Base MAC Default = Blank.

Address

The MAC Address of the base station. If only one base station is provisioned, the field can
remain at the default value. If multiple base stations are provisioned, the MAC address for
each base station must be entered.

Configure Base IP

Configure Base IP

Default = Off.

Set to On to configure IP address attributes for the base station. When enabled, the
Configure Base IP settings are displayed.

DHCP Client

Default = On.

When enabled, specifies that the base station operates as a DHCP client. When enabled,
not other IP address attributes can be configured.

IP Address

Default = Blank.

The IP address of the base station. The IP address must be on the same subnet as one of
the LAN interfaces.

IP Mask

Default = Blank.

IP address mask.

IP Gateway

Default = Blank.

The default gateway address

Provisioning

Default = IP Office interface address. The server address from where the Base Station

Server configuration files can be retrieved.
Description Default = Blank. Maximum 31 characters.
Use this field to enter a description of this configuration.
Related links

SIP DECT Line on page 330

VolP

Navigation: Line | SIP DECT Line | VolP
This form is used to configure the VoIP setting applied to calls on the SIP DECT line.

These settings are not mergeable. Changes to these settings requires a reboot of the system.

Field

Description

IP Address

Default = Blank.
The IP address of the SIP DECT extension.

Codec Selection

Default = Custom
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Field Description

This field defines the codec or codecs offered during call setup. The codecs available
to be used are set through System | VolP.

The Custom option allows specific configuration of the codec preferences to be
different from the system Default Selection list. When Custom is selected, the list
can be used to select which codecs are in the Unused list and in the Selected list and
to change the order of the selected codecs. The D100 Base Station supports only
G711 codecs.

TDM | IP Gain Default = Default (0dB). Range = -31dB to +31dB.

Allows adjustment of the gain on audio from the system TDM interface to the IP
connection. This field is not shown on Linux based platforms.
IP | TDM Gain Default = Default (0dB). Range = -31dB to +31dB.

Allows adjustment of the gain on audio from the IP connection to the system TDM
interface. This field is not shown on Linux based platforms.

DTMF Support Default =RFC2833
The D100 Base Station supports only RFC2833.
VolP Silence Default = Off

ERBRIESSIE When selected, this option will detect periods of silence on any call over the line and

will not send any data during those silent periods. This feature is not used on IP lines
using G.711 between systems. On trunk's between networked systems, the same
setting should be set at both ends.

Local Hold Music Default = Off
Allow Direct Media Default = On
Path

This settings controls whether IP calls must be routed via the system or can be routed
alternately if possible within the network structure.

« If enabled, IP calls can take routes other than through the system. This removes the
need for a voice compression channel. Both ends of the calls must support Direct
Media and be using the same protocol (H.323 or SIP). Enabling this option may
cause some vendors problems with changing the media path mid call.

« If disabled or not supported at on one end of the call, the call is routed via the
system. RTP relay support allows calls between devices using the same audio
codec to not require a voice compression channel.

RE-Invite Supported | Default = Off.

When enabled, Re-Invite can be used during a session to change the characteristics
of the session. For example when the target of an incoming call or a transfer does not
support the codec originally negotiated on the trunk. Requires the ITSP to also
support Re-Invite.

Related links
SIP DECT Line on page 330
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Line

SM Line

This type of line is used to create a SIP connection between an IP Office and an Avaya Aura®
Session Manager. The other end of the SIP connection must be configured on the Session
Manager as a SIP Entity Link.

An SM Line can only be added to IP Office system Standard Mode or Server Edition
configurations. It is typically used in IP Office Standard mode in Enterprise Branch deployments
connected to the Avaya Aura® network. For more details about IP Office Enterprise Branch
deployments refer to Deploying Avaya IP Office™ Platform as an Enterprise Branch with Avaya
Aura® Session Manager.

An SM Line can also be used in IP Office Server Edition to connect to an Avaya Aura® Session
Manager. Through the SM Line, IP Office Server Edition supports interoperability with Avaya
Aura® Session Manager. It also supports interoperability, via the Avaya Aura® Session Manager,
with Avaya Aura® Communication Manager systems and with CS 1000 systems. Note that IP
Office Server Edition is not used as an enterprise branch product and does not support some of
the IP Office enterprise branch functionality, such as management by Avaya Aura® System
Manager, WebLM licensing, Centralized Users or voicemail over the SM Line.

If the Avaya Aura® network has multiple Avaya Aura® Session Managers to provide redundancy,
two SM lines can be added, one configured for each Avaya Aura® Session Manager.

Related links

Line on page 250

Session Manager on page 333
VoIP on page 336

T38 Fax on page 339

Session Manager

Navigation: Line | SM Line | Session Manager
Additional configuration information

For additional information regarding the Media Connection Preservation setting, see Media
Connection Preservation on page 589.

Configuration settings
These settings are not mergeable. Changes to these settings require a reboot of the system.

Changing the In Service setting to Disabled (out of service) requires a system reboot. However,
changing the In Service setting to Enabled is mergeable. Configuration changes made while the
line is out of service are also mergeable.

Field

Description

Line Number

Default = Auto-filled. Range = 1 to 249 (IP500 V2)/349 (Server Edition).
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Field

Description

Enter the line number that you wish. Note that this must be unique. On IP500 V2
systems, line numbers 1 to 16 are reserved for internal hardware.

» Session Manager line prioritization: Up to two Session Manager lines can be
configured. The two Session Manager lines are prioritized based on the line
number. The lower line number is considered the primary Session Manager line.
For example, if the first Session Manager line is configured as line number 17
and the second Session Manager line is configured as line 18, then line number
17 is considered the primary Session Manager line. If you want to designate the
second Session Manager line (line 18 in this example) as the primary Session
Manager line, you must change one or both of the line numbers so that the
second Session Manager line is configured with a lower number than the current
primary line.

+ Session Manager line redundancy: Based on the priority of the Session
Manager lines designated by the line number, the active line to which the IP
Office> sends all calls will always be the highest priority Session Manager line in
service. That is, if the primary Session Manager line is in service, it will be the
active line for sending calls. If the connection to the primary Session Manager
line is lost, causing the IP Office to switch to the secondary Session Manager
line, then when the primary line comes back up later, the IP Office reverts back
to the primary Session Manager line.

In Service

Default = Enabled

This option can be used to administratively disable the SM Line. It does not reflect
the dynamic state of the line. If an SM Line is administratively disabled it is not
equivalent to being in the dynamic out of service state.

SM Domain Name

This should match a SIP domain defined in the Session Manager system's SIP
Domains table. Unless there are reasons to do otherwise, all the Enterprise Branch
systems in the Avaya Aura® network can share the same domain.

SM Address

Enter the IP address of the Session Manager the line should use in the Avaya
Aura network. The same Session Manager should be used for the matching Entity
Link record in the Avaya Aura® configuration.

Outgoing Group ID

Default = 98888

This value is not changeable. However note the value as it is used in Enterprise
Branch short codes used to route calls to the Session Manager.

Prefix

Default = Blank

This prefix will be added to any source number received with incoming calls.

Max Calls

Default = 10

Sets the number of simultaneous calls allowed between the Enterprise Branch and
Session Manager using this connection. Each call will use one of the available
licenses that are shared by all SIP trunks configured in the system.

Network Type

Default = Public.

This option is available if System | Telephony | Telephony | Restrict Network
Interconnect is enabled. It allows the trunk to be set as either Public or Private.
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Line

Field

Description

The system will return number busy indication to any attempt to connect a call on a
Private trunk to a Public trunk or vice versa. This restriction includes transfers,
forwarding and conference calls.

Due to the nature of this feature, its use is not recommended on systems also
using any of the following other system features: multi-site networks, VPNremote,
application telecommuter mode.

Include location specific
information

Default = Off.

Enabled when Network Type is set to Private. Set to On if the PBX on the other
end of the trunk is toll compliant.

URI Type

Default = SIP.

When SIP or SIPS is selected in the drop-down box, the SIP URI format is used
(for example, name@example.com). This affects the From field of outgoing calls.
The To field for outgoing calls will always use the format specified by the short
codes used for outgoing call routing. Recommendation: When SIP Secured URI is
required, the URI Type should be set to SIPS. SIPS can be used only when Layer
4 Protocol is set to TLS.

Media Connection
Preservation

Default = Enabled.

When enabled, attempts to maintain established calls despite brief network
failures. Call handling features are no longer available when a call is in a
preserved state. When enabled, Media Connection Preservation applies to Avaya
H.323 phones that support connection preservation.

Network Configuration

TLS connections support the following ciphers:
+ TLS_RSA_WITH_AES_128_CBC_SHA

« TLS_RSA_WITH_AES_256_CBC_SHA

« TLS DHE_RSA_WITH_AES_128 CBC_SHA
« TLS_DHE_RSA_WITH_AES 256_CBC_SHA

Layer 4 Protocol

Default = TCP.

Send Port When Network Configuration is set to TLS, the default setting is 5061. When
Network Configuration is set to TCP, the default setting is 5060.
Listen Port When Network Configuration is set to TLS, the default setting is 5061. When

Network Configuration is set to TCP, the default setting is 5060.

Session Timer

Default = 1200. Range = 90 to 64800

This field specifies the session expiry time. At the half way point of the expiry time,
a session refresh message is sent. Setting the field to On Demand disables the
session timer.

Communication Manager supports SIP session refresh via UPDATE in
Communicaton Manger release 6.2 SP1 and later. If using an earlier release of
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Field Description
Communication Manager, then the Session Timer parameter must be set to On
Demand.
Description Default = Blank. Maximum 31 characters.
Use this field to enter a description of this configuration.
Related links

SM Line on page 333
VoIlP

Navigation: Line | SM Line | VoIP

These settings are mergeable. Changes to these settings do not require a reboot of the system.

These settings can be edited online. Changes to these settings do not require a reboot of the

system.

Field

Description

Codec Selection

Default = System Default

This field defines the codec or codecs offered during call setup. The available
codecs in default preference order are:

* G.711 A-Law
* G.711 U-LAW
+ G.729

+ G.7231

Note that the default order for G.711 codecs varies to match the system's default
companding setting. G.723.1 is not supported on Linux based systems.

The G.722 64K codec is also supported on IP500 V2 systems with IP500 VCM,
IP500 VCM V2 or IP500 Combo cards. For Server Edition, it is supported on
Primary Server, Secondary Server and Expansion System (L) systems and on
Expansion System (V2) systems fitted with IP500 VCM, IP500 VCM V2 or IP500
Combo.

The codecs available in this form are set through the codec list on System | VolP.

Within a network of systems, it is strongly recommended that all the systems and
the lines connecting those systems use the same codecs.

The options are:

- System Default This is the default setting. When selected, the codec list below
matches the codecs set in the system wide list.

» Custom This option allows specific configuration of the codec preferences to be
different from the system list. When Custom is selected, the list can be used to
select which codecs are in the Unused list and in the Selected list and to
change the order of the selected codecs.

July 2017

Table continues...

Administering Avaya IP Office™ Platform with Manager 336

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Administering Avaya IP Office™ Platform with Manager

Line

Field Description
Fax Transport Support Default = None.

This option is only available if Re-Invite Supported is selected. When enabled,

the system performs fax tone detection on calls routed via the line and, if fax tone

is detected, renegotiates the call codec as configured below. The SIP line provider
must support the selected fax method and Re-Invite. The system must have
available VCM resources using an IP500 VCM, IP500 VCM V2 or IP500 Combo
base card.

For systems in a network, fax relay is supported for fax calls between the systems.

The options are:

* None Select this option if fax is not supported by the line provider.

« G.711 G.711 is used for the sending and receiving of faxes.

» T38 T38 is used for the sending and receiving of faxes. This option is not
supported by Linux based systems.

» T38 Fallback When you enable this option, T38 is used for sending and
receiving faxes on a SIP line. If the called destination does not support T38, the
system will send a re-invite to change the transport method to G.711. This option
is not supported on Linux based systems.

Location Default = Cloud.

Specify a location to associate the extension with a physical location. Associating
an extension with a location:

» Allows emergency services to identify the source of an emergency call.
+ Allows you to configure call admission control settings for the location.

The drop down list contains all locations that have been defined in the Location
form.

Call Initiation Timeout

Default = 4 seconds. Range = 1 to 99 seconds.

This option sets how long the system should wait for a response to its attempt to
initiate a call before following the alternate routes set in an ARS form.

DTMF Support

Default = RFC2833.

This setting is used to select the method by which DTMF key presses are signalled
to the remote end. The options are:

¢ In Band
« RFC2833

¢ Info

Media Security

Default = Same as System.

These setting control whether SRTP is used for this line and the settings used for
the SRTP. The options are:

» Same as System: Matches the system setting at System | VolP Security.
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Configuration Mode Field Descriptions

Field

Description

» Disabled: Media security is not required. All media sessions (audio, video, and
data) will be enforced to use RTP only.

» Preferred: Media security is preferred. Attempt to use secure media first and if
unsuccessful, fall back to non-secure media.

» Enforced: Media security is required. All media sessions (audio, video, and
data) will be enforced to use SRTP only.

A Warning:

Selecting Enforced on a line or extension that does not support media
security will result in media setup failures.

Advanced Media
Security Options

Not displayed if Media Security is set to Disabled. The options are:

» Same as System: Use the same settings as the system setting configured on
System | VoIP Security.

» Encryptions: Default = RTP This setting allows selection of which parts of a
media session should be protected using encryption. The default is to encrypt
just the RTP stream (the speech).

» Authentication: Default = RTP and RTCP This setting allows selection of which
parts of the media session should be protected using authentication.

* Replay Protection SRTP Window Size: Default = 64. Currently not adjustable.

* Crypto Suites: Default = SRTP_AES_CM_128 SHA1_80. There is also the
option to select SRTP_AES CM_128 SHA1_32.

VolIP Silence
Suppression

Default = Off.

When selected, this option will detect periods of silence on any call over the line
and will not send any data during those silent periods. This feature is not used on
IP lines using G.711 between systems. On trunk's between networked systems,
the same setting should be set at both ends.

Allow Direct Media Path

Default = On

This settings controls whether IP calls must be routed via the system or can be
routed alternatively if possible within the network structure.

« If enabled, IP calls can take routes other than through the system, removing the
need for system resources such as voice compression channels. Both ends of
the calls must support Direct Media and have compatible VoIP settings such as
matching codec, etc. If otherwise, the call will remain routed via the system.
Enabling this option may cause some vendors problems with changing the
media path mid call.

* If disabled, the call is routed via the system. In that case, RTP relay support may
still allow calls between devices using the same audio codec to not require a
voice compression channel.

Re-Invite Supported

Default = On.
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Line

Field

Description

When enabled, Re-Invite can be used during a session to change the
characteristics of the session. For example when the target of an incoming call or a
transfer does not support the codec originally negotiated on the trunk. Requires the
ITSP to also support Re-Invite.

Codec Lockdown

Default = Off.

Supports RFC 3264 Section 10.2 when RE-Invite Supported is enabled. In
response to a SIP offer with a list of codecs supported, some SIP user agents
supply a SDP answer that also lists multiple codecs. This means that the user
agent may switch to any of those codecs during the session without further
negotiation. The system does not support multiple concurrent codecs for a
session, so loss of speech path will occur if the codec is changed during the
session. If codec lockdown is enabled, when the system receives an SDP answer
with more than one codec from the list of offered codecs, it sends an extra re-
INVITE using just a single codec from the list and resubmits a new SDP offer with
just the single chosen codec.

Force direct media with
phones

Default = On

The setting is only available when the trunk's Re-invite Supported and Allow
Direct Media Path settings are enabled and its DTMF Support option is set to
RFC2833/RFC4733. It also requires the H.323 IP extension involved in the call to
also have Allow Direct Media Path enabled. This feature is only supported with
Avaya H.323 IP telephones. For calls where the Avaya H.323 IP extension using
the trunk is doing so as a direct media call, this feature allows digits pressed on the
extension to be detected and the call changed to an indirect media call so that
RFC2833 DTMF can be sent. The call remains as an indirect media call for 15
seconds after the last digit before reverting back to being a direct media call.

G.711 Fax ECAN

Default = Off

This setting is only available on IP500 V2 systems when Fax Transport Support
is set to G.711 or T.38 Fallback. When IP Office detects a fax call, the IP Office
negotiates to G.711 (if not already in G.711) and reconfigures the connection with
echo cancellation (ECAN) based on the 'G.711 Fax ECAN field. This can be used
to avoid an ECAN mismatch with the SIP trunk service provider. Also for fax calls,
the connection’s NLP is disabled, a fixed jitter buffer is set and silence suppression
is disabled.

Related links

SM Line on page 333

T38 Fax

Navigation: Line | SM Line | T38 Fax

The settings are available only on IP500 V2 since it can terminate T38 fax. On the VoIP settings
for the line type, Fax Transport Support must be set to T38 or T38 Fallback.

These settings are mergeable.
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Configuration Mode Field Descriptions

Field

Description

Use Default Values

Default = On.

If selected, all the fields are set to their default values and greyed out.

T38 Fax Version

Default = 3.

During fax relay, the two gateways will negotiate to use the highest version which
they both support. The options are:

0
1
2
3
Transport Default = UDPTL (fixed).
Only UDPTL is supported. TCP and RTP transport are not supported. For
UDPTL, redundancy error correction is supported. Forward Error Correction
(FEC) is not supported.
Redundancy

Redundancy sends additional fax packets in order to increase the reliability. However increased
redundancy increases the bandwidth required for the fax transport.

Low Speed Default = 0 (No redundancy). Range = 0 to 5.
Sets the number of redundant T38 fax packets that should be sent for low speed
V.21 T.30 fax transmissions.

High Speed Default = 0 (No redundancy). Range = 0 to 5.
Sets the number of redundant T38 fax packets that should be sent for V.17, V.27
and V.28 fax transmissions.

TCF Method Default = Trans TCF. TCF = Training Check Frame.

Max Bit Rate (bps)

Default = 14400.

Lower rates can be selected if the current rate is not supported by the fax
equipment or is found to not be reliable.

EFlag Start Timer
(msecs)

Default = 2600.

EFlag Stop Timer
(msecs)

Default = 2300.

Tx Network Timeout | Default = 150.
(secs)

Scan Line Fix-up Default = On.
TFOP Enhancement | Default = On.
Disable T30 ECM Default = Off.

When selected, disabled the T.30 Error Correction Mode used for fax
transmission.
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Line

Field Description
Disable EFlags For | Default = Off.
First DIS

Disable T30 MR Default = Off.

Compression

NSF Override Default = Off.

If selected, the NSF (Non-Standard Facility) information sent by the T38 device
can be overridden using the values in the fields below.

Country Code: Default = 0.
Vendor Code: Default = 0.

Related links
SM Line on page 333

IP Office Line

This line type is used to connect two IP Office systems.

In previous releases, connecting two IP Office systems was achieved using H.323 Lines
configured with Supplementary Services set to IP Office SCN. In the current release, the IP
Office line type is used to connect IP Office systems. Separating out the IP Office line type from
the H.323 line type allows for the logical grouping of features and functions available when
connecting two IP Office systems, including IP Office systems connected through the cloud.

© Note:

Setting an IP Office line with Transport Type = Proprietary and Networking Level = SCN
will interwork with a previous release system configured with an H.323 SCN line.

Related links
Line on page 250
Line on page 341
Short Codes on page 346
VolP Settings on page 346

T38 Fax on page 349
Line
Navigation: Line | IP Office Line | Line
Additional configuration information
For information on the SCN Resiliency Options, see Server Edition Resiliency on page 687.

Configuration Settings
These settings are mergeable. Changes to these settings do not require a reboot of the system.
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Configuration Mode Field Descriptions

Field

Description

Line Number

Default = Auto-filled. Range = 1 to 249 (IP500 V2)/349 (Server Edition).

Enter the line number that you wish. Note that this must be unique. On IP500 V2
systems, line numbers 1 to 16 are reserved for internal hardware.

Transport Type

Default = Proprietary.
The options are
» Proprietary: The default connection type when connecting two IP Office systems.

* WebSocket Client / Websocket Server: A WebSocket connection is an HTTP /
HTTPS initiated TCP pipe through which Call signalling and Network Signaling is
tunneled. This transport type is used to connect IP Office systems through the cloud.

Selecting one of the WebSocket options enables the Security field and the
Password fields.

Networking Level

Default = SCN.
The options are
* None: No supplementary services are supported.

« SCN: This option is used to link IP Office system within a multi-site network. The
systems within a multi-site network automatically exchange information about users
and extensions, allowing remote users to be called without any additional
configuration on the local system.

Security

Default = Unsecured.

The Security field is available when Transport Type is set to WebSocket Client or
WebSocket Server.

The options are
* Unsecured : The connection uses HTTP/TCP.
¢ Medium: The connection uses HTTPS/TLS